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PREFACE 
The Apple Macintosh Encyclopedia provides easily accessible, brief and 

understandable information on the topics that you are most likely to have questions 
about. We have carefully digested the manuals, books, magazine articles, and other 
information sources for the Macintosh. These, combined with our own experience 
in using the Macintosh and other personal computers, have been integrated into an 
alphabetical sequence of short entries in the style of an encyclopedia. The goal is to 
provide concise, useful and easy-to-understand information on a particular topic 
that is quickly accessible when you need it. 

Much of the information in the entries is not contained in the manuals provided 
with the Macintosh and various software products. For example, notice the discussion, 
under WIDTH, of the "deferred" nature of this command when used with a device 
name, the discussion of the colon (:) in Multiplan for ranges, or Saving, Problems 
With. These topics are omitted or inadequately covered in the standard manuals. 

The Macintosh is the first truly visual computer. In keeping with the highly visual 
nature of using the Macintosh, we have provided over 100 illustrations. Each shows 
exactly what you will see on the screen when exploring topics discussed in the text. 
The Macintosh Encyclopedia opens with a visual guide to icons, and remains highly 
visual in orientation throughout the text. 

In addition to the operating software provided with the Macintosh, we have 
provided detailed coverage of Multiplan, Microsoft BASIC, MacWrite, MacPaint 
and many other major programs for the Macintosh. Dozens of other programs and 
hardware accessories for the Macintosh are also described. Entries which describe 
commercial products are distinguished by an asterisk (*) following the entry title. 
There are also category entries which list the available products for that category. 
For example, the entry under Word Processors lists the various word processing 
programs available for the Macintosh. See the Appendix on Vendors for further 
guidance in using the product descriptions and the categorical listings. 

The Macintosh Encyclopedia also offers reference data on such topics as books 
for the Macintosh, magazines and user groups. We invite new user groups, authors 
or publishers of new Macintosh books, programs or hardware to send us information 
and review products for inclusion in future editions of the Apple Macintosh Ency
clopedia. Any suggestions from our readers will also be greatly appreciated. 

The entries are alphabetized by ignoring spaces and special characters. in a few 
cases we have departed from a strictly alphabetical ordering when many entries 
have similar titles. Our goal has been to make the entries easy to find and to group 
closely-related entries together whenever possible. The cross references are ordinarily 
optional pointers for further information. In a few cases the cross reference is 
slightly abbreviated or modified from the full entry title to save space or avoid 
potential confusion. 

While we have made every effort to ensure the accuracy of all information in the 
Apple Macintosh Encyclopedia, the reader should verify on the Macintosh any 
information to be used in potentially sensitive situations. Neither the authors nor 
the publisher assume any liability with respect to the use of the material in the 
Encyclopedia. 

We have attempted to provide adequate cross-referencing without redundancy. 
We trust that you will find the Apple Macintosh Encyclopedia a valuable tool in 
exploring the marvelous capabilities of your Macintosh. 

Gary Phillips 
Donald J. Scellato 
Petaluma, California 
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A 
A ASCII 65, HEX 41. a ASCII 97, HEX 61. Also the hexadecimal symbol for decimal 
10. The following all represent the same number: 

A base 16 = 10 
10 base 10 = 10 
12 base 8 = 10 
1010 base 2 = 10 

A The symbol used in MacPaint to signify text entry. The letter appears in the 
MacPaint drawing tool palette on the left-hand side of the Mac Paint screen. When 
the pointer arrow is positioned on this icon and the mouse button is pressed 
once, a text cursor which resembles a pair of parentheses)( may be moved about 
the screen by moving the mouse. This is called the 1-beam. A font may be selected 
from the pull-down Font menu at the top of the screen by dragging the mouse 
pointer down the menu until the desired font is highlighted. Then the mouse 
button is released. Font size and style may be selected in a similar fashion. 
Once the proper font, font size and font style have been selected, the cursor 
may be placed at the desired point on the screen by moving the 1-beam and pressing 
the mouse button. A straight vertical line appears in the 1-beam's place and the 
user may start entering text. See Icon, Mouse, 1-Beam, Pull-down Menu, Fonts, 
Change Font Size, Menu, MacPaint, Pointer, Arrow. 

A The abbreviation used in Microsoft BASIC to SAVE a file in ASCII format. 
See ASCII. 

Abort The process of ending a program which has encountered an error condition 
in an orderly manner, and returning control to an operator or operating system. 
For the Macintosh, this is accomplished by pressing Command-( together or by 
pressing the reset button on the lower left-hand side of the Macintosh's left 
side. 

About the .finder Option The Apple menu on the Desktop display of a boot 
disk has an option called "About the Finder". When this option is displayed, 
a drawing entitled "The Macintosh Finder" is displayed on the screen. This display 
also shows the version of the Finder on the disk, the year it was implemented 
and names the authors of the Finder. 

ABS A Microsoft BASIC function which returns the positive (absolute) value of the 
expression <X> without regard of negative signs. The format is: 

<variable> = ABS(<x>) 

<X> may be any numeric expression. For example: 
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PRINT ABS(-100) 
100 

The positive (absolute) value of -100 is 100. 

This function may be used in a mathematical expression or algebraic equation 
where an absolute number is required. The example listed below is a brief Microsoft 
BASIC program that il lustrates the ABS function: 

10 REM TEST OF ABS FUNCTION 
20 PRINT " INPUT A POSITIVE OR NEGATIVE NUMBER AND ITS ABSOLUTE" 
30 INPUT " VALUE WILL BE DISPLAYED FOR YOU .. . " ; N 
35 PRINT: PRINT: PR INT 
40 PRINT " THE ABSOLUTE VALUE OF ";N;" IS " ;ABS(N) 
45 PRINT: PRINT: PR INT 
50 INPUT " WOULD YOU LIKE TO TRY AGAIN ?(Y/ N) ";R$ 
55 IF R$ = " Y" GOTO 10 
60 PRINT " THANK YOU .. . " 
65 END 

This program is set up to accept the input of a number by the user (Line 30), 
print out the number that was input as an absolute number (Line 40), and allow 
the user to either try again or to quit (Line 55). 

• file 
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THE MACPAINT DRAWING TOOL PALETTE 

Fig. A1 The MacPaint drawing tool palette. Note the large letter A that is used to select text. 

ABS A built-in fu nction available in many electronic spreadsheet programs such 
as Microsoft Mu ltiplan. When used, this function returns the absolute value of 
the numbers or of the form ula included in the pa rentheses following the function. 
The cell containing the function could include the formula shown below: 
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=ABS(AVERAGE(4,12,8)) 

and would return the value 8. It could also contain the formula: 

=ABS(-99) 

and would return the value 99. See Spreadsheet, Multiplan, AVERAGE. 

Absolute Reference Used in spreadsheet programs such as Microsoft MultiPlan 
when a formula is copied from one column or row to another, and references 
to other cells now refer to new cells in the same position relative to the moved 
cell (relative reference). Example 1 below shows a formula copied from cell R12C2 
to cells R13C2 and R14C2 using the Fill Down option on the Multiplan Edit menu 
from the menu bar at the top of the screen. 

Since the Absolute Reference command was not used, all references are relative. 
The formula refers to cell R13C2 by the relative reference Rl-9) to use the inflation 
factor inserted by the user. This relative reference was carried down to the next 
two cells under cell R12C2 when the Fill Down option was used although the 
user intended to refer always to cell R13C2. 
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Fig. A2 Example 1. Using relative references. 

To avoid relative reference use the Absolute Reference command by pressing 
the Command key along with the T key as soon as the R[-9] reference was entered. 
This would have changed the formula to read R13C2 instead of R[-9] when moved. 
This is shown in Example 2 below. 

Thus, an Absolute Reference refers to a specific cell in a spreadsheet while a 
Relative Reference refers to a cell in the same relative position in a different 
column or row. See Cell, Spreadsheet, Fill Down Option, Microsoft Multiplan, 
Relative Reference. 

Absolute Value The value of the number without reference to positive or negative 
sign. The value of a number or the result of a formula provided by using the 
ABS function in Microsoft BASIC or Microsoft Multiplan. 

In mathematical notation this is denoted by enclosure in vertical bars ( ). 
Thus, if a number is positive or zero x = x. If x is negative: x = -x. See ABS. 



4 • Accented Characters 

2 

~~F.~~f~9~:~~:t~(~:~~~~~~~:~:::::::::::::::::::::::::::::::::::::::::::::::~??:::::::::::::::::::::::::::::::::::::: 

~~.~.~.~.~~ ~~~ .~R~!~ ......................................................... : ........................................ . 
f.~.~·~·····.············ ........................................................... ~?.~.~~ ................................. . 
~.1. ~.I.T.I.~-~ ...................................................................... ~?.~.9 ................................... . 
REPAIRS ;goo 
:::::i~f ~~: :::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: ~~~~~:( Ri~~i~~~F:~):~)::::: ::::: 
INFLATED COSTS f:ur L ............................................................................. ~~fit .::s·ic~ (" R.[ .::9i·C/ i ·oo) ....... . 
iri'it: ir.iEi · · · · · · ·· · · · · · · · · · · · · · · · · · · · · · · · · · ·· · ··· ·· · · ·· ·· ·· ·· · · · · · · · · · · · · · · · ·· · ~~fit.:.·s·ic~<"Rt·::9i"C/ i'ao·; · · · · · · · · 
iir.F>:.\.iR"s· ....................................................................... ~~fi[.:.·si·c·*c·R'[.:.·9i.C/i.oo) ....... . 
·····:rorAl.························· ·············································~~sut1.(R[~3ic!fi[.::i·id·········· 

Fig. A3 Example 2. The same spreadsheet section where formulas were copied using the 
absolute reference. 

Accented Characters Characters that are given a specific inflection in a language 
such as French or Spanish. The accent 'is portrayed by a symbol that generally 
appears above the letter to be stressed or pronounced in a particular fashion. 
Accented characters are displayed by the Macintosh by pressing the Option key 
along with another key. The Option key with the(') key in the upper left-hand 
corner of the Macintosh keyboard prints a grave accent('). The Option key with 
the e key produces an acute accent symbol ( '). The Option Key along with the 
i key produces a circumflex("). The Option Key and the u key produce an umlaut 

(''). The Option Key and the n key produce a tilde (-). This use of the Option 
Key makes the Macintosh useful for foreign languages such as French, German, 
and Spanish. See Option Key. 

Accessories Items that supplement a basic computer system. The basic Macintosh 
system consists of the Macintosh computer, the keyboard and the mouse. Acces
sories could consist of an lmageWriter printer, a second disk drive, a modem, 
a numeric keypad, the security accessory kit and a carrying case. For specific 
products, see Carrying Cases, Covers, Hardware, Maccessories Cleaning Kit, Mac
cessories Disk Case, Maccessories Printer Stand, Maccessories Starter Pak, 
Maccessories Swivel, MAGICphone, Microdisk Minder, Power Supplies, Security 
Kits, Video-Digitizer. 

Accumulator A register into which the results of arithmetic operations are stored. 
More than one accumulator can be present in a central processor. The DD-D7 
registers of the Macintosh's MC68000 often function as accumulators. The 
Macintosh's MC68000 has no accumulators. Instead, it uses general purpose 
registers. 

ACM Association for Computing Machinery 
11 W. 42nd St. 3rd Floor 
New York, NY 10036 
212-869-7440 

The major international society for computer technology. With its numerous 
publications and special interest groups that discuss many topics, ACM will be 
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of interest to many Macintosh users. For more information write to ACM or find 
the journal of the ACM at your library. 

Acoustic Coupler A mechanical instrument for connecting the telephone handset 
to a computer, through a modem. The data is converted to tones, usually audible, 
for transmission over the phone lines. 

Activate Event The activity or event that results from a window changing state 
between inactive and active. The activity is generated by the Window Manager 
program, part of the Macintosh Operating System, when the user places the pointer 
on a button or any place in a window and clicks the mouse button. See Button, 
Window, Window Manager, Operating System. 

Activating a Window If more than one window is being displayed at once on the 
Macintosh screen, one window may be activated by moving the arrow pointer into 
the desired window and clicking the mouse button. This process is used when 
Finder windows for more than one disk are being displayed on the screen at 
the same time, more than one Multiplan window is being displayed, or when the 
list window and the output menu are being displayed together in Microsoft BASIC. 
See Mouse Pointer, Clicking, Mouse Button, Window. 

Active Cell An active cell in a spreadsheet such as Microsoft Multiplan is the 
cell that is currently being used to enter a value, a label or a formula. This 
cell could also have been activated to paste data from the Clipboard or Scrapbook, 
to cut data to the Clipboard or Scrapbook, or to copy data to the Clipboard or 
Scrapbook. A cell is made active in Multiplan by placing the plus sign pointer 
on the cell and clicking the mouse button. See Clipboard, Scrapbook, Cell, Mouse 
Button. 

Active Selection The menu selection or icon currently in use. See Icon, Dimmed 
Commands, Menu. 

Active Window When a number of windows are being displayed on the Macintosh 
screen, the topmost window is the active window. This window may be rendered 
inactive by closing it or by placing the mouse pointer on another window and 
clicking the mouse button. MacBASIC and other programming languages allow 
more than one window to be active at a time. Windows are rendered active, in 
this context, by clicking them and inactive by closing them. 

AID "A to D." Analog to Digital. Conversion from a sensor's analog voltages and 
currents to the digital representation used by computer systems. Computers can 
then process data directly from the external world. 

Add Characters In Between Existing Characters In Microsoft BASIC, position the 
pointer in the Command window at the location where a character is to be inserted 
and press the mouse button. A vertical line cursor will appear at the location. 
The character to be inserted can then be typed from the keyboard. Pressing the 
Return key will cause the computer to accept the line along with the newly added 
characters. See EDIT. 

Add-On A system or circuitry attached to a computer to increase memory or 
performance. For the Macintosh these ordinarily attach to the ports at the back 
of the computer (mouse, serial RS-422, etc.). 

Address Position of a word in memory, expressed by a number. In the Macintosh, 
addresses range from 0 to 128K, and will go up to 512K on the upgraded Macintosh 
when 256K chips are available. 
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e File Edit Control 

GLOBE.BRS 
List 

280 FOR 1:0 TO 760:1NPUT 6 1 ,E%(1):NEXT 
290 CLS 
3\0 X:269:V:49 
31 0 PUT (X, V) ,A%,PSET 
320 PUT (X,V),8%,PSET 

30 PUT (X,V),C%,PSET 
340 PUT (X,V),D:t:,PSET 
350 PUT (X,V),E%,PSET 
360 IF MOUSE(0):-1 THEN PUT(X,V),E%,XOR: X:MOUSE( 1 )-51 :V:MOUSE(2)-51 
370 A$:1NKEV$:1F A$:"" THEN 3 10 ELSE END 
380 OPEN "MGLOBE.DA T" FOR OUTPUT AS '1 
390 CX:CV:CZ:SX:SV:SZ: I:J:R:A:B:C:A 1 :B2:C 1 :C2 

Command 
300 X: 269:V:49 

Fig. A4 Selecting a program l ine for editing from the List window. 

• File Edit Control 

GLOBE.BRS 
List 

280 FOR 1=0 TO 760:1NPUT •1 ,E:t:(I):NEXT 
290 CLS 
300 X:269:V:49 
310 PUT (X,V),A:t:,PSET 
320 PUT (X,V),B:t:,PSET 
330 PUT (X.V) ,C.v,:-=·SET 
340 PUT (X,V),D%,PSET 
350 PUT (X,'f'),E%,PSET 
360 IF MOUSE(0):-1 THEN PUT(X,V),E:t:,XOR: X:MOUSE( 1 )-51 :V: MOUSE(2)-51 
370 A$: 1NKEV$:1F A$: "" THEN 310 ELSE END 
380 OPEN "MGLOBE.DAT" FOR OUTPUT AS' 1 
390 CX: CV:CZ:SX:SV:SZ:I=J:R:A:B:C:A 1 :B2:C 1 :C2 

Command 
300 X:269:V:4q? 

~ 

Fig. AS Inserting a character between two other characters. 

(;)] 
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Address of Variable in Memory See VARPTR. 

Adjusting References This term is used in Microsoft Multiplan to describe the 
process of changing the cells referred to in a formula on a spreadsheet, to agree 
with the column or row to which a formula is moved or copied by the user. If a 
formula called for the sum of the cells in column 3 rows 12 through 19 (R12:19C3) 
in Multiplan, and this formula was copied into column 5, the references in the 
formula would be adjusted to read the sum of the cells in column 5 rows 12 
through 19 (R12:19C5) automatically by the program. The same automatic adjust
ments are made by other electronic spreadsheet programs such as Lotus 1-2-3 
when a formula is moved along with the row or column that contains the column, 
or when a formula is copied from one location to another on the spreadsheet. 

Advance One Line on the Printer To space up (advance) one line on the printer 
without carriage return enter Microsoft BASIC statement: 

LPRINT CHR$(27);CHR$(102) 

Or use the line feed (Lf) button of the printer. 
just LPRINT gives a line feed, both space up one line (line feed) and return 

to left margin (carriage return). 

Advance to Top of Page How to Form Feed Printer. Enter Microsoft BASIC 
statement: 

LPRINT CHR$(27);CHR$(12) 

Or use the top of form or form feed (Ff) manual control button on the printer. 
You may then need to adjust the paper in the printer so it actually is at the 

top of a page as defined by the perforations. 
In a program, you may want to provide instructions to the operator and a pause 

to allow for adjustment of the paper. 

AgDisk• AgDisk agricultural programs are directed toward farm management and 
available on separate disks. They consist of Profit Projector, Financial Management, 
Machinery Management, Swine Management and a collection of Multiplan tem
plates for use in farm management. Although these programs are directed toward 
the farmer, the Financial Management disk could have some use outside of 
agriculture. Harris Technical Systems. 

Alarm Clock One of the options available from the Macintosh desk accessories 
accessed by using the Apple menu (signified by an apple symbol in the upper left 
corner of the Macintosh screen display) on the menu bar when an application 
program is in use. It is activated by dragging down the Apple menu until Alarm 
Clock is highlighted, then releasing the mouse button. The Alarm Clock is displayed 
in the upper right-hand corner of the screen. This display may be moved anywhere 
on the screen by placing the arrow pointer inside the display, pressing the mouse 
button, dragging the display to the desired location on the screen and releasing 
the mouse button. The alarm may be set by placing the arrow pointer on the small 
alarm clock symbol to the right of the time displayed on the screen and pressing 
the mouse button. This will cause the display to be expanded to show the date or 
another time on a line below the time display, and three symbols below the 
second line. These symbols are a large clock, a calendar and an alarm clock. 
Any of these items may be reset by placing the arrow pointer on the appropriate 
icon and pressing the mouse button. 
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The next step is to place the crosshair that replaces the pointer over the hours, 
minutes or seconds on the time display on the second line and then press the 
mouse button. This will highlight the time segment under the pointer and cause 
an up arrow and a down arrow to be displayed to the right of the time display. 
The highlighted time may be adjusted upward or downward by placing the crosshair 
over the appropriate arrow and clicking the mouse button. Once the desired 
setting is made to the time, the crosshair is moved to the icon on the second 
line that resembles a lock (but is called the bell icon) then press the mouse 
button. See Arrow, Crosshair, Icon. 

0 7:03:04 RM r 
lA} 6:ili]:29 PM 

@~ 
Fig. A6 Alarm Clock opened for setting. The pointer is on the set box. 

Alert A warning message displayed in a special window, called an alert box, on 
the Macintosh. When a problem arises with a command given to the computer, 
a program or the computer itself, an alert message is displayed on the screen 
and is usually accompanied by a beep from the Macintosh speaker. One or more 
options are displayed as command buttons within the box to allow the user to 
avoid the problem he is being warned about. 

Alert Box A special window that displays a warning message for the Macintosh 
user. These messages warn of disks that are too full to allow the storage of a 
letter, picture or program. They also warn the user that something is about to 
be lost if he proceeds to the next step in a process, such as saving or deleting 
a file. The alert box is generated by the Dialog Manager in the User Interface 
Toolbox. See User Interface Toolbox, Dialog Manager. 

( OK J 

Fig. A7 A typical alert box. 

Can't throw away an item belonging to 
a locked folder or disk. 

Algorithm A solution to a problem with step-by-step specifications endiYig in a 
finite time. A problem is stated, an algorithm developed for its solution, the 
solution steps flowcharted and the program developed from the flowchart. 

Align Left Option This command is available from the pull-down Style menu on 
the menu bar at the top of the MacPaint display, and executed by clicking the 
mouse button while the pointer rests on the Style menu, dragging the pointer 
down until the Align left command is highlighted and releasing the mouse button. 
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This command is used in conjunction with text entry in MacPaint. An alternate 
method of giving this command is to press the Command key and the L key together. 
The use of this command causes letters to be printed on screen from left to 
right starting at the cursor position. See Pull-down Menu, MacPaint, Command 
Key, Mouse Button, Dragging. · 

Align Middle Option This command is available in Mac Paint and is used by placing 
the pointer on the pull-down Style menu and clicking the mouse button. When 
this menu is displayed, move the pointer down until the Align Middle command 
is highlighted, then release the mouse button. This command can also be invoked 
by pressing the Command key and theM key at the same time. The use of this 
command causes letters to be printed to the left of the text cursor location and 
also causes the cursor to move one- half of a space to the right of its location 
when the letter is printed. See Style Menu, Pull-down Menu, Command Key, Mouse 
Button. 

Align Right Option This MacPaint command is invoked by locating the cursor on 
the pull-down Style menu on the menu bar and clicking the mouse button to cause 
the menu to be displayed. The pointer must then be dragged down the menu until 
the Align Right command is highlighted. The mouse button is then released. 
The Command key may be pressed at the same time as the R key to invoke this 
command. The use of this command causes letters to be printed from right to 
left, starting at the location of the text cursor. The text cursor remains stationary. 
See MacPaint, Command Key, 1-beam. 

Alignment Controlled in MacWrite by using the left- alignment box icon,. the 
center-alignment box icon, the right- alignment box icon, or the full-justification 
box icon under the ruler at the top of the MacWrite screen display. Alignment for 
text is selected by placing the pointer arrow on the appropriate box and pressing 
the mouse button. See MacWrite, Left Alignment, Center Alignment, Ruler, Full 
Justification, Icon. 

All Cells Option Available in Microsoft Multiplan from the pull-down Select menu 
on the menu bar of the Multiplan screen display. It is used to format all cells on 
the work sheet in the same fashion. It can also be used to retain cell formats while 
erasing cell contents. See Multiplan, Select Menu, Menu Bar, Spreadsheet. 

Allocation of Space Assigning particular areas of memory (internal, disk, etc.) to 
particular files, programs, or functions. Allocation is sometimes done by a pro
grammer, or sometimes automatically by a program such as the Memory Manager 
which is built into the Macintosh ROM. Disk space allocation is handled by 
the Finder. 

Alpha Test Site vs. Beta Test Site New software requires testing prior to its release 
in the marketplace. While some testing can be done by the programmers that 
develop the software, final testing should be done in a user environment similar 
to the ultimate market environment for the software. Testing of new software is 
ordinarily divided into two phases. 

Alpha testing involves a very few test sites. In some cases, only those inside 
the software development company and other cases including a few companies 
outside. Individuals or companies participating in alpha testing understand that 
this software is highly incomplete and very likely to contain bugs. Usually com
panies are paid or promised some future value for participating in such tests. 
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In beta testing, the product is considered to be essentially complete. Companies 
that participate in beta testing ordinarily plan to use the product when it is 
finished, and begin to use it early by participating in the beta test. They expect the 
software to work correctly in the vast majority of cases. When bugs are encountered, 
the beta test site accepts a responsibility to report the bug accurately and promptly 
to the software development company. In return they expect the bugs will be fixed 
promptly so that the company can continue to operate on the software. In most 
cases, beta testing goes reasonably smoothly. A few bugs are detected and corrected 
and the product goes on its way to the market. In some cases, numerous or serious 
bugs are detected, and the product may need to undergo a major revision or, in 
the worst possible cases, go back through alpha testing before the next round of 
beta testing. In this case, companies that made any significant investment in acting 
as beta test sites may experience significant inconvenience, such as the inability 
to continue to use files if a file format is changed. Alpha test sites and beta 
test sites are used for hardware as well as software. 

Alphanumeric A set composed of all alphabetic and numeric characters. 

Alterable Memory Storage media, such as a disk, which can be written onto or 
changed. 

Ampersand The Ampersand (&) is used in Microsoft Multiplan for the Macintosh 
to concatenate (join together) two text values so they appear as a single value. 
See Multiplan, Concatenation of Data or Programs. 

Analog Having a continuous range of voltage or current values. Contrasted with 
digital. 

Analog Board This is a printed circuit board inside the computer case that contains 
the Macintosh's power supply, a power regulator, vertical scanning circuits for the 
video display, horizontal scanning circuits for the video display, other video control 
devices and the computer's internal speaker. See Power Supply. 

Analyser/Analyzer Any device that checks or regulates a component, board or 
system and presents the data for review. 

Anchor Pad• A security device designed to protect the Macintosh system. A pad 
is fastened to a table top, a desk or similar permanent station. The Macintosh is 
placed on the pad and bolted into place. The base pad is fitted with a swivel 
allowing for a 360 degree rotation. A lock down pad is included for the keyboard. 
The computer and keyboard may be removed from the pads by using a key to unlock 
the framework that holds the units in place. Anchor Pad International, Inc. 

AND A term for a logical procedure defined by the rule: If A and Bare 1, then 
(A AND B) is 1, otherwise (A AND B) is 0. The AND of 10110111 and 10000100 
is 1000100. For logical situations such as the conditional test in an IF statement, 
substitute TRUE for 1 and FALSE for 0. 

ANSI American National Standards Institute. 

Apostrophe (')or single quotation. In Microsoft BASIC, a synonym for REM as a 
way of including remarks or explanatory comments in a program. The colon (:) 
allows multiple Microsoft BASIC statments on one line. The apostrophe can be 
used without a colon to indicate that the rest of the line is a remark. 
Examples: 



20 REM Just a comment 
30' Just a Comment 
40 LET X= 1: REM Just a comment 
50 LET X = 1: ' just a comment 
60 LET X = 1' Just a comment 

Apple Modem 1200 • 11 

The computer takes no action when it encounters a REM statement. It moves to 
the next line in the program it is running. 

Append To add to the end of a character string or list. 

AppleBus• An external device that allows a Macintosh to be connected to other 
computers to form a network so information may be passed from one computer 
to another. One of the computers on the AppleBus system acts as a master that 
controls the passing of information among computers. Only one computer may 
transmit at a time. Different computers in the system may act as the master 
at any given time. Large scale data storage devices such as hard disk systems 
may act as servers for the entire system and may be linked to all of the devices 
connected via the AppleBus. Apple Computer, Inc. See Hard Disk, Network. 

Appleline• A hardware device that enables a Macintosh to emulate an IBM 3278-2 
computer terminal and gives the Macintosh the ability to exchange information 
with IBM mainframe systems. The device is connected to the Macintosh serial 
interface circuits via one of the RS-232/RS-422 serial ports on the back panel 
ofthe Macintosh. The device will be released late in 1984. See Hardware, Emulation, 
Serial Port, Back Panel. Apple Computer, Inc. 

Apple Macintosh Book, The• By Cary Lu. One of the standard works on the 
Macintosh. This book is a pleasant discussion of the Macintosh and how to use it. 
It is a richly illustrated work that explains the Macintosh in a conversational 
style. Microsoft Press. 

Apple Menu One of the menus available from the menu bar at the top of the 
screen display of all of the applications released for the Macintosh to date. This is a 
pull-down menu displayed by placing the mouse pointer on the Apple symbol in 
the upper left-hand corner of the screen and pressing the mouse button. 

The Apple menu offers several options to the user that are called "desk acces
sories." It also offers a brief description of the application being used. The options 
available from this menu are About the Finder ... , Calculator, Alarm Clock, 
Key Caps, Note Pad, Scrapbook, Control Panel and Puzzle. For more information 
on each of these items, see their respective entries. Selection is made by moving 
the pointer down the menu until the desired item is highlighted, then releasing 
the mouse button. See About the Finder ... , Calculator, Alarm Clock, Key Caps, 
Note Pad, Scrapbook, Control Panel, Puzzle. 

Apple Modem 300• A 300-baud modem designed to work with the Macintosh, 
with cables designed to connect the modem to the Macintosh. This modem is pack
aged with a Demopack from Compuserve and a Premium Pak from the Source. The 
accessory kit contains manuals for using and installing the modem and the neces
sary cables. It has a self-diagnostic feature, built-in autodial (touch tone or pulse) 
and auto answer. Apple Computer, Inc. In UK: Apple Computer (UK) Ltd. 

Apple Modem 1200• A 120Q-baud modem for use with the Macintosh. It features 
built-in autodial, auto answer and diagnostics. Its accessory kit contains the neces
sary manuals to use and install the modem, as well as the proper cables to install 
the modem. Apple Computer, Inc. IN UK: Apple Computer (UK) Ltd. 
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Fig. AS The Apple menu from the menu bar. 

Mouse Bas Statistics 

Application Software Computer programs (software) are divided into two major 
categories. Application software consists of programs that actually perform some 
useful function directly related to what he wants done. Examples are word process
ing programs that produce letters, reports, etc., database programs that allow 
the user to manage his inventory, appointments and various other items of data, 
accounting programs, educational programs and even games, etc. System programs 
(system software) perform functions necessary to the use of the computer yet 
not directly relevant to solving a particular applications problem. An example 
of this would be the disk operating system used by the computer, various utilities 
such as sort, copy or programs which facilitate the use of the program and may 
be used by application software, but do not directly produce useful results (keeping 
track of your bank balance, allowing you to play a game, produce a letter, etc.). 

Applications Disk An applications disk is a disk that contains the System file, the 
Finder and at least one application. If the application uses print functions, the 
lmageWriter file must also be present. An application is a program such as Mac
Write, MacPaint, Microsoft Multiplan and Microsoft Word. 
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Architecture The special selection, design and inter-connection of the principal 
components of a system. In a microprocessing unit this could be the number and 
function of registers, the instruction addressing modes and the bus structure and 
timing. 

Arctangent See A TN. 

Argument Data passed from one process or program to another. Similar to a foot
ball pass, except that one or more bytes of data replaces the football, and the 
receiver is a program. The sender may be a program or a person typing the data 
onto a command line to be passed to a program. The most common example would 
be a Microsoft BASIC program passing variables to a subroutine. 

Arithmetic Logic Unit (ALU) The element which performs the basic data manipula
tions in the central processor like add, subtract, complement, negate, rotate, 
AND and OR. 

Arithmetic Statement An instruction specifing an arithmetic operation. 

Arrays See DIM, OPTION BASE. 

Arrow The Macintosh is able to translate the motion and location of the mouse 
on a real Desktop to a related location on the screen. An arrow is used to represent 
the mouse location. Menus, applications, commands and other activities are selected 
by moving the mouse around the physical Desktop until the arrow pointer is on 
top of the activity being selected. The mouse button is then pressed to activate 
the menu, command or application. See the illustration below. See Menu, Mouse 
Button, Desktop. 

ASC A Microsoft BASIC function which returns the ASCII cod~ for the first character 
of the string <X$>. The format is: 

<variable> = ASC(<x$>) 

<x$> may be any string expression. For example: 

10 X$ = "SAMPLE" 
20 PRINT ASC(X$) 
RUN 
83 

In this example the ASCII code for S, the first character of the string "SAMPLE", 
is 83. If x$ is null, the error message "Illegal function call" is returned. For a listing 
of the ASCII codes see ASCII Codes for Characters. 

ASCII American Standard Code for Information Interchange. 

ASCII Code to Characters See CHR$. 
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Fig. A9 An example of the arrow on the Desktop. 

ASCII Codes for Characters 

Va lue Character Value Character 
Hex Dec Key Hex Dec Key 

Strokes Strokes 

00 0 *Ctrl-@ 40 64 @ 
01 1 Ctri-A 41 65 A 
02 2 Ctri-B 42 66 B 
03 3 Ctri-C 43 67 c 
04 4 Ctri-D 44 68 D 
OS 5 Ctri-E 45 69 E 
06 6 Ctri-F 46 70 F 
07 7 Ctri-G 47 71 G 
08 8 Ctri-H 48 72 H 

Bkspace 49 73 I 
09 9 Ctrl-1 4A 74 J 
OA 10 Ctri-J 48 75 K 
OB 11 Ctri-K 4( 76 L 
oc 12 Ctri-L 4D 77 M 
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00 13 Ctri-M 4E 78 N 
OE 14 Ctri-N 4F 79 0 
OF 15 Ctrl-0 50 80 p 
10 16 Ctri-P 51 81 Q 
11 17 Ctri-Q 52 82 R 
12 18 Ctri-R 53 83 s 
13 19 Ctri-S 54 84 T 
14 20 Ctri-T 55 85 u 
15 21 Ctri-U 56 86 v 
16 22 Ctri-V 57 87 w 
17 23 Ctri-W 58 88 X 
18 24 Ctri-X 59 89 y 

19 25 Ctri-Y SA 90 z 
1A 26 Ctri-Z SB 91 I 
18 27 ESC 5C 92 
1C 28 FS 50 93 
10 29 GS 5E 94 
1E 30 RS SF 95 
1F 31 us 60 96 
20 32 SpaceBr 61 97 a 
21 33 ! 62 98 b 
22 34 63 99 c 
23 35 # 64 100 d 
24 36 $ 65 101 e 
25 37 % 66 102 f 
26 38 & 67 103 g 
27 39 68 104 h 
28 40 69 105 
29 41 6A 106 j 
2A 42 68 107 k 
28 43 + 6C 108 I 
2C 44 60 109 m 
20 45 6E 110 n 
2E 46 6F 111 0 

2F 47 I 70 112 p 
30 48 0 71 113 q 
31 49 1 72 114 r 
32 50 2 73 115 s 
33 51 3 74 116 t 
34 52 4 75 117 u 
35 5 5 76 118 v 
36 54 6 77 119 w 
37 55 7 78 120 X 

38 56 8 79 121 y 
39 57 9 7A 122 z 
3A 58 78 123 ( 
38 59 7C 124 
3C 60 70 125 
3D 61 = 7E 126 
3E 62 7F 127 DEL {Rubout) 
3F 63 

*Ctrl means the Command key plus the indicated character. 
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ASCII Control Characters To set the print size, strike method or number of lines 
per inch down the page for the lmageWriter printer, the nonstandard type format 
you want must be turned on by sending control codes to the printer. See Control 
Characters for Printer. 

ASCII Program In Microsoft BASIC if you want to SAVE the program in ASCII 
format, which allows you to MERGE two programs together, put ,A after the close 
quote of the program name thus: 

SAVE "SAMPLE",A 

See MERGE. 

Instructions for saving a program named "SAMPLE" are as follows: 
On disk (the default drive) enter: 

SAVE "SAMPLE" 

On disk (external drive) enter: 

SAVE "diskname/SAMPLE" 

On disk (from File menu}: activate File menu with pointer, scroll pointer to Save 
and click mouse button. A Dialog box will be displayed asking for file name and 
disk name. Enter SAMPLE and click the OK button. 

To SAVE the program as a protected file in encoded binary form use ,P instead 
of ,A . Then it cannot be listed, saved, edited (or unprotected). While a clever 
programmer can get around this, it will at least prevent a quick and casual or 
accidental modification to your program. 

The SAVE instruction does not alter your program in memory. It is important 
to be aware that if you write a Microsoft BASIC program, it will be lost (erased) 
unless you SAVE it before you either: turn off the Macintosh; go to the Desktop 
(System Command); or use the NEW command. See also EDIT. 

To run the program at a later time, use the LOAD command to copy it from the 
disk you saved it on, back into the. Macintosh's memory. See LOAD. 

Assembly Assembler Language. A programming language related very directly to 
the machine language of the computer. The Macintosh uses an MC68000 processor 
chip, so the Macintosh Assembler uses instructions based on MC68000 machine 
language. We can only give a brief introduction to Assembler here, with references 
for further study. 

The MC68000 handles information essentially one byte at a time. Larger units 
of data such as character string, floating point numbers and records are fictitious 
entities. 

Originally, only assemblers were available for writing programs. The tedious and 
time-consuming nature of Assembler programming led to the invention of high-level 
languages such as Microsoft BASIC, FORTRAN, COBOL and Pascal. These languages 
are high level in the sense that they highly abbreviate the description of the work 
to be done by the computer. A complex translation process is required to turn 
the high-level program into a machine language program that the MC68000 can 
use. This translation process is time consuming and usually results in a machine 
language program that runs many times slower than a corresponding program written 
in Assembler. 

The compiled program is also many times larger than a corresponding program 
written in Assembler. Why is this? Because higher-level languages simplify the 



Association for Computing Machinery • 17 

programmer's job by using very general program procedures to handle all possible 
circumstances in which the statements might be used. Since only a small fraction 
of this generalized code is needed for a particular program, much of the generalized 
code is not needed in one particular program. Compilers convert the source program 
to an object program that can be run after debugging. 

lnterpeted languages (such as Microsoft BASIC) have an additional performance 
disadvantage. They do the translation of higher-level source code into executable 
machine code every time the program is executed, rather than only once. 

Assembly language programs can run much faster, use less memory and access 
more special machine-level functions such as direct 1/0 devices, than Microsoft 
BASIC or other high-level languages. Assembler is popular with software houses 
for writing programs that must run very fast (action games or programs to run 
fast devices such as disk drives, etc.). But because Assembler is harder to code, 
few individual users write programs in Assembler. Those who do write only selected 
time-critical or highly specialized routines. More commonly, a program written 
largely in Microsoft BASIC, for example, may use a short section of code written in 
Assembler to do one particular time-critical or memory-size critical task. The 
Assembler code will be called as a subroutine by the Microsoft BASIC program. 

In summary, Assembly language is highly techincal and more adapted to the 
needs of the MC68000 processor than to the needs of the Macintosh user. It is 
invaluable when speed or memory size is critical, for highly specialized applications 
and for conimerical software development. But for most Macintosh users it will not 
be practical to use. They will rely on commerical software packages or write 
programs in a high-level language such as Microsoft BASIC. If an Assembly language 
program or subroutine is required for your application, paying an experienced 
Assembly language programmer would be an alternative to learning Assembler. But 
if you enjoy getting to the nuts and bolts of the computer, Assembly language is 
the only route to the inside workings of the MC68000. To learn more about Assembler, 
see the following books: 

68000 Assembly Language Programming 
By Kane, Hawkins, and Leventhal! 
Osborne/McGraw Hill 

68000 Microprocessor Handbook 
By Gerry Kane 
Osborne/McGraw Hill 

Macintosh Assembly Language 
By leo j. Scanlan 
Brady 

Programming the MC68000 
By Tim King and Brian Knight 
Addison-Wesley 

Assignment Giving a variable a value. In Microsoft BASIC, a simple assignment 
would be: 

LET X=S 

This assigns the value 5 to the variable X. 

Association for Computing Machinery See ACM. 
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Asynchronous An event or device which does not have the same timing as the 
central processing unit. 

Athens One of the fonts available to the user of MacPaint and MacWrite. This 
font is illustrated below. It may be selected by placing the arrow pointer on top 
of the Font menu on the menu bar at the top of the MacPaint screen display and 
pressing the mouse button to activate the menu. The pointer is then scrolled 
down the menu until the Athens font is highlighted. The font is selected by 
releasing the mouse button. This font is used while MacPaint is in the Text mode 
selected from the drawing tool palette on the left-hand side of the MacPaint 
display. See Fonts, Menu Bar, Highlight, Drawing Tool Palette, Icon. 

1111111 BD llllup1l af llliBtb•lpdDt plaiD tilt fat. 
ftla II liD BUlJII altha &aaa.ID pamt plaiD tat flld. 
Tbia ism mmple Df tJaa llbeDa 12 pobal JlaiD tat faat. 
This i1a aaaple1f da1 Btlla114 Jlilat aid fat. 

~ ftl!1 a ~~ -rif miD fil{Ujv:JjviJ noo Jjldl 

rnilfa IIIIDiiDJra II IJ!iDIIii 
Fig. A10 Example of the Athens font style. 

ATN A Microsoft BASIC function which returns the arctangent of x. The format is: 

<variable> = A TN{ <X>) 

<X> may be a numeric expression of any numeric type. The evaluation of ATN 
is always performed in single precision. ATN returns the angle whose tangent 
is x, b measured in radians in the range -PI/2 to +PI/2, where PI = 3.141593. 
To convert radians to degrees, multiply by 180/PI. 



B 
B ASCII 66, HEX 42. b ASCII 98, HEX 62. 

B An abbreviation for Bytes or Baud. B is used as an abbreviation for Bytes when 
referring to memory, or Baud rate when referring to communications. KB = 1000 
bytes or baud (technically 1K = 1024 bytes). Also, the hexadecimal symbol for the 
decimal number 11: 

B base 16 = 
11 base 10 = 
13 base 8 = 
1011 base 2. 

Back Panel The back of the computer case, with a number of sockets for connecting 
peripheral devices to the computer. The back panel of the Macintosh has sockets for 
connecting the mouse, a printer, a modem, a second disk drive, an external speaker 
and a power cord. It also has a small compartment for the battery that runs the 
computer's clock. 

Background Program A low-priority program which is run when the processor has 
no higher priority tasks. 

Backing Up a Disk Used to describe the process of making a copy of an entire disk. 
This practice is very important if you wish to have a second copy of a disk that 
contains a program important to you or if you wish to have a second copy of data 
important to a program you are using. Generally, commercial programs cannot be 
backed up by the user. Instead, the manufacturer generally supplies a backup copy 
to the user at a nominal cost. Sometimes, this copy is ordered when the user sends in 
the registration card for the program he purchased. Otherwise, the backup copy can 
be ordered separately as long as proof of purchase is provided. Consult the 
documentation for commercial programs when you purchase them. Public domain 
programs and programs that you write may be copied. See Copy a Disk, Public 
Domain. 

Backing Up a Document A phrase used to describe the process of copying a 
document. This process should be used whenever you have a data file or program 
you wish to avoid losing. See Copy a Document. 

Backslash MacBASIC assigns extended precision real characteristics to any variable 
name followed by a backslash ( ). These are decimal numbers accurate to 18+ 
decimal places. 

Backspace Key One of the special purpose keys on the Macintosh keyboard, which 
moves the insertion point for a character on the screen backward one space, and 
erases the character to the left of the cursor position. This key may also be used to 
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remove unintended returns from the text being entered. The Backspace key may be 
used to remove whole words, phrases, sentences or large sections of text by first 
highlighting the material to be deleted, then pressing the Backspace key. The 
Backspace key is used in MacWrite, the Text Mode of MacPaint, and while programming 
with Microsoft BASIC or MacBASIC. See Keyboard, Cursor, Return Key, Text Mode, 
MacPaint, Microsoft BASIC, MacBASIC. 

Backup Copy A backup copy of any disk or document is a second or even third copy 
of the document or program. Copies should be made regularly of files and programs 
important to you, so that you have something to work with if the original is damaged 
in any way. Disks may be damaged by exposing them to magnets, spilling liquids on 
them, exposing them to flames or high heat or similar exposure. Files may be lost if 
you accidentally move them into the Trash Can and then Empty Trash. Backups 
ensure that you have something to use if you accidentally lose a file, lose a program, 
or damage a disk. 

Backup Diskettes Diskettes are relatively fragile. They can be rendered unreadable 
by minor physical damage such as spillage of liquid or dirt on the magnetic surface, 
or even by fingerprints. It is, therefore, wise to always maintain an extra or backup 
copy of any important data contained on diskettes. Backing-up diskettes on a 
file-by-file basis has the added advantage that fragmented files can be regrouped 
into a single area on the new diskette. This allows the file to be processed more 
rapidly by many programs. See also File Management (Disk Maintenance). 

Backup Disks and the Write-protect Tab A disk is write-protected (or locked) if the 
write-protect square is open. This is detected by a small spring-loaded switch or a 
light beam inside the drive and is sensed by Macintosh disk driver programs. You will 
get an error message (locked Disk) anytime you attempt to change, delete or copy a 
file onto the write-protected disk or attempt to format a write-protected disk. 

You are allowed to use files, load them or copy them from the write-protected 
disk. The purpose of these limitations is to prevent accidental loss of the only copy 
of programs or data. In most cases the procedure is to copy the write-protected disk 
onto a disk with a closed square, put away the write-protected disk as a permanent 
copy, then modify the unlocked disk. In some cases you will close the square of the 
locked disk (after thinking it over) and proceed to change the disk. 

It is a good practice to lock any important disk you are copying or backing up. 
Then, if you accidentally ask for the backup in the wrong direction (from the old disk 
to your important disk), you will get a second chance to make the backup, rather 
than losing your data. 

Bad Sector A sector on the disk which will not read/write data correctly. Usually 
due to a minor physical flaw in the disk. One or two bad sectors will not seriously 
affect the disk's use, Macintosh will mark them as bad and avoid using them. More 
then a few bad sectors indicates the disk should be used as a frisbee rather than to 
hold your valuable data. 

Bar Graph Option Microsoft Multiplan and other electronic spreadsheet programs 
are capable of displaying numbers as crude bar charts, using such symbols as 
asterisks (*) or slashes (/) to represent the numbers being graphed in this fashion. 
The Bar Graph command in Multiplan is invoked for the cell or range of cells 
highlighted by the cursor by positioning the pointer on the Format menu on the 
program's menu bar, clicking the mouse button, scrolling the highlight down to the 
Bar Graph option and releasing the mouse button. Presentation-quality graphics are 
generally available from such business graphics programs as Multiplan Chart and as 
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an option on Lotus 1-2-3. See Highlight, Menu Bar, Format Menu, Mouse Button, 
Business Graphics. 

BASIC Beginner's All purpose Symbolic Instruction Code. A popular computer 
language invented at Dartmouth for educational purposes. While similiar to the 
FORTRAN programming language it is easy to use and learn, and is now on almost all 
microcomputer systems. Some BASICs have just the bare essentials of regular 
Microsoft BASIC (a form of Dartmouth original BASIC). Super BASICs may have 
features from other languages. Compatibility problems between various BASIC's do 
exist. MacBASIC has its own unique features, notably the use of alphabetic labels 
instead of line numbers and new statements to allow structured programming 
somewhat in the manner of more modern languages such as Pascal. 

BASIC Compiler All programs that run directly on the Macintosh are machine 
language programs, in the· actual numeric instruction code of the Macintosh's 
MC68000 microcomputer chip. Most were orginally written by a programmer as text 
files known as source programs. The source program contains relatively readable 
statements in a language such as FORTRAN, COBOL or Microsoft BASIC. These 
were then translated by a compiler program, producing an object program. 

The object program contains the machine language instructions for the Macintosh's 
MC68000 which correspond to the instructions of the original source program. 
Microsoft BASIC programs work in this way with a Microsoft BASIC Compiler. 

Regular Microsoft BASIC works in a slightly different way. It is a program (in 
machine language) which uses your Microsoft BASIC program as a guide to what it 
should do. It is therefore an interpreter, processing each line of your source program 
and interpreting what should be done. Since it must reinterpret your source program 
each time you run it, interpreted Microsoft BASIC can be as much as 100 times 
slower than compiled Microsoft BASIC. 

When you write a Microsoft BASIC program, you have produced a source program 
in text form. The Microsoft BASIC interpreter, itself a machine language program, 
uses your source program as data, a source of instructions or commands to control 
its execution. 

To speed up a Microsoft BASIC source program by compiling it into a faster 
machine language program, you will need a Microsoft BASIC Compiler, a program 
not supplied with the Macintosh, but available from other software houses. Run 
your Microsoft BASIC Compiler, giving it as input the source program that you 
wrote, and it wi II translate your source program into an executable machine language 
program. 

The resulting program is no longer a Microsoft BASIC program, it is a machine 
language program based on (or is a translation of) your Microsoft BASIC source 
program. 

BASIC, Delete Program Lines in Microsoft BASIC. Program lines may be deleted in 
Microsoft BASIC on the Macintosh by first listing the program using the List option 
from the pull-down Command menu or by typing LIST in the Command window. 
This will cause a List window to be displayed on the screen. Scroll through the 
program listing until the line or lines you wish to delete are displayed in the window. 
Then type the line number of the line to be deleted in the Command window and 
press Return. This will cause the line to be deleted. To delete more than one line, you 
would type: 

DELETE [linenumber] [linenumber] 

This would cause the lines from the first line number to the second line number to 
be deleted. 
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Basic Disk• A disk containing a number of games, including Shooting Stars, Black 
Jack, and Tic-Tac-Toe. The disk requires Microsoft BASIC. rds labs. 

BASIC, Display Program Lines in Microsoft BASIC To display the program lines of a 
program currently in the Macintosh's memory, you would ensure that the program is 
stopped by pressing the Command key and the C key together, or by selecting Stop 
from the pull-down Command menu on the menu bar. Then type LIST in the 
Command box on the lower portion of the display screen or select the List option 
from the Command menu. This would cause a List window to be displayed on the 
screen. To display program lines from start up to line 100 enter: 

LIST -100 

To display program lines from line 100 to end enter: 

LIST 100-

To display program lines from line 100 to line 200 enter: 

LIST 100-200 

To display program line 100 only enter: 

LIST 100 

BASIC, Display Files on Disk in Microsoft BASIC The files on a disk may be 
displayed by using the FILES command in Microsoft BASIC, which causes the names 
of the files on the disk to be printed on the computer screen. If you enter FILES in the 
Command window by itself, the file names of the files in the internal disk drive will 
be displayed. For example: 

FILES "MACPAINT.BAK" 

This command causes the names of all files on the disk MACPAINT.BAK to be 
displayed. 

BASIC, Largest Line Number in Microsoft BASIC The largest possible line number 
for a Microsoft BASIC program is 65529. 

BASIC, LOAD Instructions for Microsoft BASIC Used to LOAD a program that was 
saved on disk back into the Macintosh's memory to modify or run it. For a program 
named "SAMPLE" on the internal disk drive or the last disk drive used, enter: 

LOAD ''SAMPLE'' 

If SAMPLE is on the disk in the external disk drive, enter: 

LOAD '' diskname:SAMPLE'' 

All LOAD instructions erase any program lines in memory up to the line number of 
the last line of the program being loaded. Therefore, always clear the computer's 
memory by typing NEW in the Command window followed by pressing the Return 
key before loading a second program into memory. If you want to combine a saved 
program with the one you are writing, see MERGE. 
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These instructions assume that the program you wish to load is in the internal disk 
drive on the same disk as the disk that contains Microsoft BASIC. If this is not the 
case, you will need to use the Finder to load the program from the disk on a single 
drive system. This process requires you to eject the disk with Microsoft BASIC and 
insert the disk containing the program you wish to load. Once this disk has been 
loaded, you must double- click the disk icon for the disk you just inserted. This will 
display the directory for that disk. You may be required to swap the disk that 
contains Microsoft BASIC with the disk containing the program you wish to load a 
couple of times, but the Macintosh will prompt you as needed. Once the directory 
has been displayed, place the pointer on the icon of the program you wish to load 
and double-click the mouse button. This will cause the program to be loaded and 
RUN. To stop the program and to list it, you would use the Stop option from the 
Command menu on the menu bar. Then you could use the List option or could enter 
the word LIST in the Command menu and press Return. 

BASIC, Multiple Statements On One Line in Microsoft BASIC You can put a colon 
(:)at the end of one statement and continue entering another statement on the same 
line, without giving a new line number. The line number at the left refers to all 
statements on the line. An apostrophe(') allows a comment or remark to be added 
after a statement with or without a separating colon. Examples: 

40 LET X= 1 :REM Comment 
50 LET X= 1 :LET Y = 2 
60 LET X = 1' Comment 

BASIC, New Programs in Microsoft BASIC You can clear the computer's memory of 
old program lines prior to beginning to write a new program or prior to loading a new 
program by typing the word NEW in the Command window then pressing the Return 
key. You can accomplish the same thing by using the Edit menu from the menu bar 
and selecting New. This completely erases all lines now in Microsoft BASIC's 
memory, so if it is something you want to keep and have not already got on disk, 
SAVE it first. If you do not erase the program in memory before starting on another, 
you will usually wind up with an unuseable combination of mixed lines from your 
old and new programs. 

BASIC, Reserved Words in Microsoft BASIC Reserved words have particular meanings 
in Microsoft BASIC and are used for commands, statements, function and operator 
names. These words cannot be used as variable names and variable names cannot be 
a reserved word followed by a type declaration character($, %, !, #). 

When reserved words are used, they are to be delimited (separated with space or 
spaces around them) so that they are easily recognized by Microsoft BASIC. If you 
accidentally use one of the reserved words, you may see an error message or have 
strange results when you execute the program. See also Debugging. 

Following are the reserved words in Microsoft BASIC: 

ABS 
APPEND 
ATN 
BASE 
CDBL 
CINT 
CLOSE 
CONT 
CVD 
DATA 

All 
AS 
AUTO 
BEEP 
CHAIN 
CIRCLE 
CLS 
cos 
CVI 
DATE$ 

AND 
ASC 
BACKPAT 
CALL 
CHR$ 
CLEAR 
COMMON 
CSNC 
cvs 
DEF 
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DEFDBL 
DEFSTR 
EDIT 
EOF 
ERASEARC 
ERL 
EXP 
FILLARC 
FILLRECT 
FOR 
FRAMERECT 
GET 
GOTO 
HIDEPEN 
INITCURSOR 
INPUT# 
INT 
INVERTRECT 
LEFT$ 
LINE 
LUST 
LOF 
LPRINT 
MID$ 
MKS$ 
MOVE 
NEW 
NOT 
OPEN 
OUTPUT 
PAINTRECT 
PENMODE 
PEN SIZE 
POS 
PSET 
RANDOMIZE 
RENUM 
RETURN 
RSET 
SETCURSOR 
SHOWPEN 
SPC( 
STOP 
STRING$ 
TAB( 
TEXTFONT 
THEN 
TO 
USING 
VARPTR 
WHILE 
XOR 

DEFINT 
DELETE 
ELSE 
EQV 
ERASEOVAL 
ERR 
FIELD 
FILLOVAL 
FIX 
FRAMEARC 
FRE 
GET PEN 
HEX$ 
IF 
IN KEY$ 
INPUT$ 
INVERT ARC 
KILL 
LEN 
LINETO 
LOAD 
LOG 
LSET 
MKD$ 
MOD 
MOVETO 
NEXT 
OCT$ 
OPTION 
PAINT ARC 
PEEK 
PEN NORMAL 
POINT 
PRESET 
PTAB 
READ 
RESTORE 
RIGHT$ 
RUN 
SGN 
SIN 
SQR 
STR$ 
SWAP 
TAN 
TEXT MODE 
TIME 
TROFF 
USR 
WAIT 
WIDTH 

DEFSNG 
DIM 
END 
ERASE 
ERASEERECT 
ERROR 
FILES 
FILLROUNDRECT 
FN 
FRAMEOVAL 
FRAMEROUNDRECT 
GOSUB 
HIDECURSOR 
IMP 
INPUT 
INSTR 
INVERTOVAL 
I NVERTROUNDRECT 
LET 
LIST 
LOC 
LPOS 
MERGE 
MKI$ 
MOUSE 
NAME 
OBSCURECURSOR 
ON 
OR 
PAINTOVAL 
PAINTROUNDRECT 
PENPAT 
POKE 
PRINT 
PUT 
REM 
RESUME 
RND 
SAVE 
SHOWCURSOR 
SPACE$ 
STEP 
STRING 
SYSTEM 
TEXTFACE 
TEXTSIZE 
TIMER 
TRON 
VAL 
WEND 
WRITE 

BASIC, Rules for Variable Names in Microsoft BASIC Variable names: 
(a) must start with a letter 
(b) can have up to forty characters 
(c) cannot be a reserved word (such as IF, ON, THEN, GOTO, etc.) or a reserved 

word followed by a variable type declaration character($,%,?,!,#). 
(d) end with a type declaration character. The default value for the type of 
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variable is numeric, so any variable name not ending in a$, !, or# is automatically 
treated as a numeric integer variable. 

DEFINT for integer numbers, 
DEFSNG for single-precision numbers, 
DEFDBL for double-precision numbers, 
DEFSTR for string variables. 

For example, if you place the statement: DEFSTR ABC at the beginning of your 
program, all variables starting with ABC (such as ABCDATA, ABCMISC, etc.) will be 
string variables because they start with a series of characters defined in the DEFSTR 
to be a string variable prefix. 

BASIC, SAVE Instructions for Microsoft BASIC If you wanted to SAVE the program 
currently in the computer's memory, you would enter the command SAVE in the 
Command window followed by the name of the program. You could accomplish the 
same thing by using the Save option from the pull-down File menu on the menu bar. 
A Dialog box that requests the name and the format of the file will be displayed on 
the screen. This dialog box also allows a particular disk (currently stored in the 
Finder) to be selected by clicking the drive button. 

Filename: I SRUE.TEST 

0 RSC II @ Binary 0 Protected 

Fig. B1 The Dialog box that requests the name of the file to save. 

( OK J 

(Cancel) 

To run the program at a later time, use the LOAD command to copy it from the 
disk you saved it on, back into the Macintosh's memory. See LOAD. If you want to 
SAVE the program in ASCII format, which allows you to MERGE two programs 
together, put ,A after the close quote of the program name thus: 

SAVE "SAMPLE" ,A 

See MERGE. 

To SAVE the program as a protected file in encoded binary form use ,P instead of 
,A . Then it cannot be listed, saved, edited (or unprotected). While a clever 
programmer could probably get around this, it will at least prevent a quick and 
casual or accidental modification to your program. 

The SAVE instruction does not alter your program in memory. It is important to be 
aware that if you write a Microsoft BASIC program, it will be lost (erased) unless you 
SAVE it before you: turn off the Macintosh, go to the Desktop (System command) or 
use the NEW command. 

BASIC, Special Characters in Microsoft BASIC The following characters have special 
meanings in Macintosh Microsoft BASIC, and cannot be used to have meanings 
other than what is stated below: 
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blank space 
+ plus sign or concatenation symbol 
I slash or division symbol 
"' caret or exponential symbol 
% percent sign or integer type declaration character 
$dollar sign or string type declaration character 
& ampersand 
'single quotation mark (apostrophe) or remark delimiter 
; semicolon 
? question mark or PRINT abbreviation 
" double quotation mark or string delimiter 
( left parenthesis 
) right parenthesis 
= equal sign or assignment symbol 
-minus sign 
backslash or integer division symbol 
* asterisk or multiplication symbol 
# number or pound sign, or double-precision type declaration character 
! exclamation point or single-precision type declaration character 
, comma 
. period or decimal point 
:colon 
-underline 
<less than 
> greater than 

BASIC, Statements Cross-referenced by Function for Microsoft BASIC: 

Address of variable in memory- VARPTR(<variable>) 
Arctangent- ATN(<x>) 
Arrays- DIM <variable subscripts> and OPTION BASE <n> 
ASCII codes for characters- ASC(<X$>) 
ASCII code to characters- CHR$(<n>) 
Branch - GOTO <line> 
Ca·ll Microsoft BASIC subroutine- GOSUB and RETURN 
Carriage position- printer- LPOS(<n>) 
Change a Microsoft BASIC line- EDIT dine> , 
Change memory byte with Microsoft BASIC- POKE <n,m> 
Character read from keyboard - IN KEY$ 
Clear the screen - CLS 
Color of a point- find- POINT (<x,y>) 
Communications buffer space -

LOC(<filenum>) and LOF(<filenum>) 
Convert decimal to hexadecimal string- HEX$(<n>) 
Convert decimal to octal string- OCT$(<n>) 
Convert number to string- MKI$(<x>), MKS$(<x>), MKD$(<x>) 
Cursor- find current location- POS(<n>) 
Decimal to hexadecimal string conversion- HEX$(<n>) 
Decimal to Octal string conversion- OCT$(<n>) 
Disk- list directory of files- FILES [<filespeC>] 
Double-precision number- convert to- CDBL(<x>) 
e - powers of - EXP( <X>) 
Ellipse- draw- CIRCLE(<x,y>),<r> 
End of File- EOF(<filenum>) 
Erase a file from Microsoft BASIC- KILL <filespeC> 
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Erase current Microsoft BASIC program and variables ~ NEW 
Erase current Microsoft BASIC variables (not program)~ 

CLEAR, [ <n>[],<m>]] 
Error~ line number where it occured ~ERR and ERL 
Error code number of last error ~ ERR 
Execute Microsoft BASIC program~ RUN 
Exponential ~ EXP(<X>) 
File~ erase from Microsoft BASIC~ KILL <filespeC> 
File~ length of~ LOF(<filenum>) 
Find character or string in a string~ INSTR([<n>,]<x$,y$>) 
Generate line numbers automatically-

AUTO[mumbeo[,<increment>]] 
Graphics- PUT (<x1,y1>)[-(x2,y2)],<array>[,<actiom] 
Immediate response to one~character answers 

(without using return)- Y or N, etc.- INKEY$ 
Integer- convert to by rounding- CINT(<x>) 
Keyboard- read characters- INKEY$ 
Keyboard - read data from -

INPUT[;][<'' prompt''>; ]<variable>[,<variable>] 
and LINE INPUT#<filenum>,<stringvariable> 

Left justify a string~ LSET <stringvariable> = <string exp> 
Large programs~ use of overlays- CHAINMERGE]<filespee> 
Length of file- LOC(<filenum>) and LOF(<filenum>) 
Length of string- LEN(<x$>) 
Line numbers- generate automatically -

AUTO[<numbeo[,<increment>]] 
Line numbers - renumber-

RENUM ([<newnumbeo][,[<oldnumbeo][,<increment>]]] 
Line number where error occured- ERL 
Location of cursor- find- POS(<n>) 
Loop- FOR and NEXT statements 

and WHILE and WEND statements 
Machine language program (subroutine)-

CALL <variable>[, (<variable> ... )] 
Memory address of variable- VARPTR(<variable>) 
Memory~ amount free- FRE(<m) 
Memory - change - POKE <n,m> 
Memory- read byte- PEEK(<m) 
Natural logarithm - LOG(<x>) 
Number- convert from string-

CVI(<x$>), CVS(<x$>), or CVD(<x$>) 
Number- convert to string- MKI$(<x>), MKS$(<x>), 

or MKD$(<x>) 
Numeric value of string- VAL(<x$>) 
Octal string~ convert to from decimal- OCT$(<n>) 
Overlays- CHAINMERGE<filespee> 
Position of carriage- printer- LPOS(<n>) 
Print Microsoft BASIC program listing on printer-

LLIST[<Iine1>[ -[<I ine2> 111 
Print on printer- LPRINT[<Iist of expressions>] 
Printer- carriage position- LPOS(<n>) 
Program, Microsoft BASIC ~ run or execute - RUN and LOAD 
Random number- RND[(<x>)] 
Read character from keyboard- INKEY$, 

INPUT[;][<'' prompt">; ]<variable> 
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Read data from file-
GET[# ]<fi lenum>[,<number>] 
(READ reads from DATA statements and INPUT# and LINE INPUT#) Repeat a 

character <n> times-
STRING$(<n,m>) and STRING$(<n,x$>) 

Repeat program lines- FOR <variable> =<X> TO <Y> [STEP <Z>] 
Screen, clear - CLS 
Screen, graphics- PUT(<x1,y1>)[-(<x2,y2>)],<arraY> 

[,<action>] and COLORFL Screen- width- WIDTH <size> 40 or 80 
Search string for character or shorter string-

INSTR([<m,]<x$,y$>) 
Sign- SGN(<x>) 
Single-precision numbers- convert- CSNG(<x>) 
Spaces in PRINT or LPRINT- SPC(<n>) 
Speaker- BEEP 
Square Root- SQR(<X>) 
Stop Microsoft BASIC program- END 
String- convert from number- MKI$(<x>), MKS$(<x>), 

and MKD$(<x>) 
String- convert to number- CVI(<x$>), CVS(<x$>), 

or CVD( <X$>) 
String- left justify- LSET <stringvariable> = <stringexp> 
String- length of- LEN(<x$>) 
String- numeric value of- VAL(<x$>) 
String- right justify- LSET <stringvariable> = <stringexp> 
Subroutine- GOSUB <line> 
Subroutine - machine language -

CALL <variable>[ (<variable> ... )] 
Trace off- TROFF 
Trace on- TRON 

BASIC, Statements for Microsoft BASIC Table of formats with descriptions and 
types: 

Statement Type Description 

ABS(<X>) F Absolute value of <X> 
ASC(<x$>) F Gives ASCII code of 1st character of <x$> 
ATN(<X>) F Returns the arctangent of <X> 
AUTO[<num> c Automatically numbers lines 

[,<inc rem> I I 
BEEP S-1/0 Speaker emits beep sound 
CALL <numvan s Machine language program called 

[(variable list)] 
CDBL(<X>) F <X> converted to a double-precision number 
CHAIN[ MERGE] s Calls and passes variables to another program 

<files pee> 
CHR$(<m) F Gives character with ASCII code <n> 
CINT(<X>) F Converts <X> to integer 
CIRCLE(<x,y>),m S-1/0 Draws circle with center <X,y> and radius m 
CLEAR[,[<m,<m>)] c Program variables cleared, optionally sets 

memory area 
CLOSE[# ]<fi lenum> S-1/0 Closes a file 
CLS S-1/0 Clears the screen 
COMMON <list of s Variables passed to a chained program 

variables> 
CONT c Continues program execution 



COS(<x>) 
CSNG(<x>) 
CVI(<x$>) 
CVS(<x$>) 
CVD(<x$>) 
DATA <list of 

expressions> 
DATE$,DATE$=<exp> 
DEF FN<name> 

[(<arg>)]=<expr> 
DEF <type> 

DELETE[<Iine1>] 
[-<line2>] 

DIM <list of 
subscripted variables> 

EDIT <linenum> 
END 

EOF(<filenum>) 
ERASE<arraynames> 
ERL 

ERR 
ERROR<n> 
EXP(<X>) 
FIELD[# ]<filenum> 

,<Width> AS <V$> 
FILES[ <fi lespeo] 

FIX(<X>) 
FOR <variable> = 

<X> TO <y> 
[STEP <Z>) 
FRE(<n>) 
GET[#)<filenum> 

[,<number>] 
GET ( <x1, y1 > )

(<X2,y2>), 
<arrayname> 

GOSUB <linenum> 

GOTO <linenum> 
HEX$(<n>) 

I F<expressiom 
THEN<clause>[ ELSE 
<clause>) 

IN KEY$ 
INPUT[;] 

[$NCHprompt$NCH>;) 
cvariable list> 

INPUT#<filenum>, 
<variable list> 

INPUT$( em 
(,( # ]<filenum>]) 

INSTR([<n>, 1 
<x$>,<y$>) 

.INT(<X>) 

F 
F 
F 

S-1!0 

s 
s 

s 

c 

s 

c 
s 

S-1/0 
s 
s 

s 
s 
F 
S-1/0 

c 

F 
s 

F 
S-1/0 

S-1/0 

s 

s 
F 

s 

s 
S-1/0 

S-1/0 

F 
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Computes cosine of angle (<X>) (in radians) 
Converts <X> to a single-precision number 
Converts (x$) to integer, single-, or double-

precision number 

Data table is created to be read by READ 
statement 

Gives or sets the system date 
Defines numeric or string function 

Defines default variable types- <type> is SNG, DBL, 
INT, STR 

Deletes specified lines in a program 

Sets up maximum subscript values for arrays and 
makes available space for them 

Displays a program line for editing 
Terminates the program, closes all files, and 

returns you to command level 
End of file condition on <filenum> is indicated 
Removes arrays from a program 
Gives the line number where the last error 

occurred 
Gives the error code number of the last error 
Simulates error number <n> 
Returns the number e raised to the <X> power 
Fields are defined in a random file buffer 

Files in the disk directory that match a file 
specification are listed 

Makes (<X>) an integer by truncation 
Used with NEXT statement to repeat program 

lines a specified number of times 

Gives the amount of unused space in memory 
Record is read from a random file 

Reads graphic information from the screen 

Used with the RETURN statement to execute and 
return from a subroutine 

Delivers control to a specified line 
Gives a string representing the hexadecimal value 

of<m 
If <expression> is true, statements(s) in THEN 

clause are performed. Otherwise, performs the 
ELSE <clause> or goes to the next line 

Reads character from keyboard 
Reads data input from the keyboard 

Reads data from file <filenum> 

Reads <n> characters from <filenum> 

Returns the position of the first occurrence of 
cy$> in <X$> starting at position <n> 

Gives greatest integer that is less than or equal 
to <X> 
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KILL <filespeo 
LCOPY 

LEFTS(<xS>,<n>) 
LEN(oc$>) 
I LET]<Variable>= 

<exp> 
Ll NE( (<x1, y1>) )-

(<X2,y2>)(.( 
<colon]I,B(F))) 

LINE INPUT(;) 
[<$NCHprompt$NCH>;] 
<stri ngvariable> 

LINE INPUT# 
<filenum>, 
<Stringvariable> 

LIST [<line1>] 
(-[dine2>]] 
,<filespeo 

LLIST[dine1> 
(-[<line2>))) 

LOAD( <filespec>) 
[,R] 

LOC(<filenum>) 
LOF ( <fi lenum>) 

LOG(<X>) 
LPOS(m>) 
LPRINT(<Iist of 

expressions>] 
LPRINT USING 

<stringvan;<list 
of expressions> 

LSET <stringvan 
= <stringexp> 

MERGE <filespeo 

MID$(<x$>,<n> 
[,<m>)} 

MKI$(<X>) 
MKS$(<X>) 
MKO$(<x>) 
MOUSE(<n>) 

NAME <oldname> AS 
mewname> 

NEW 

NEXT[<variable>] 
OCT$(<n> 

ON ERROR GOTO 
<linenum> 

ON <expression> 
GOSUB <linenum
list> 

ON <expression> 
GOTO<Iinenumlist> 

c 
s 

F 
F 
s 

S-1/0 

S-1/0 

S-1/0 

c 

c 

c 

F 
F 

F 
F 
S-1/0 

S-1/0 

S-1/0 

c 

c 

c 

s 
F 

s 

s 

s 

Erases a disk file 
Sends the exact image of the Macintosh screen to 

the printer 
Gives the leftmost <n>) character of <x$> 
Returns the number of characters in <xS> 
Assigns the value <exp> to <variable> 

Draws a line(s) or box on the screen and fills the 
box with color 

Reads an entire line from the keyboard, ignoring 
commas or other delimiters 

Reads an entire line from file <filenum> to 
<stri ngvariable> 

List specified program <line>(s) to screen or other 
device 

List specified program <line>(s) to the printer 

Loads a program from a specified device and 
optionally runs it 

Gives the location of file <filenum> 
Returns the number of bytes (in multiples of 128) 

in a sequential or random file, and gives the 
number of free bytes in communications input 
buffer 

Returns the logarithm to base e of <X> (natural log) 
Gives the carriage position of the printer 
Prints data on the printer (LPT1 :) 

Prints data on the printer using the format 
specified in <stringvan 

Left justifies a string in a field 

Merges the lines from an ASCII program file into 
the program currently in memory 

Returns <m> characters from the string <x$> starting 
at position <n> 

Converts <X> in integer, single- ,or double
precision string values 

Retums information on the state of the mouse 
button or the location of the mouse based on 
parameter (<m) 

Changes the name of a disk file 

Deletes the current program in memory and clears 
all variables 

Ends a FOR ... NEXT loop 
Gives a string which is the octal value of the 

decimal argument 
Moves program control to error handling routine 

when error is encountered 
Branches to specific line number or listed line 

numbers; requires RETURN statement 

Branches to specific line number or listed line 
numbers 
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OPEN<filespee> S-1/0 Opens file or other device to allow 1/0 
FOR <mode> ]AS(#] 
<filenum>[LEN= 
<reel>] 

OPEN<mode>,[ #] S-1/0 Another form of OPEN 
<filenum>, 
<filespeC> 
(,<reel>] 

OPTION BASE <n> s Declares minimum values for array subscripts 
PEEK(<n>} F Reads the byte from the memory position (<n>) 
POINT(<x,y>) F Returns the color of the specified point on the 

screen (graphics mode only) 
POKE <n,m> S-1/0 Places a byte in a memory location 
POS(<m) F Gives the current cursor column position 
PRESET(<x,y>) S-1/0 Draws a point on the screen in background color 

(,<color>] 
PRINT[<Iist of S-1/0 Prints data on the screen 

expressions>] 
PRINT USING S-1/0 Prints data using specified format 

<x$>;<1ist of 
expressions> 

PRINT#<filenum>, S-1/0 Writes the <list of expressions> sequentially to a file 
<list of 
expressions> 

PRINT #<fi lenum>, S-1/0 Writes the <list of expressions> sequentially to a file 
(USING <x$>;] using the format specified by <x$> 
<list of 
expressions> 

PSET(<x,y>) 5-1/0 Draws a point on the screen in the foreground 
[.<coloo]) color if the <color> is not specified 

PTAB (<X>) F Moves screen print position to pixel <X> 
PUT[# ]<fi lenum> 5-1/0 Puts an image in a rectangular area on the screen. 

[,<number>] The upper left-hand corner of the area is 
specified by (x, y) 

PUT(<x1,y1>) S-1/0 Draws a rectangular image on the screen. The 
[ -( <X2, y2>) ), upper left-hand corner or the area is specified 
<array>(, by <X1,y1> 
<action>] 

RANDOMIZE[<m] s Reseeds the random number generator 
READ <variable> S-1/0 Reads data from a DATA statement and assigns 

[,<variable>] them to variables 
REM <remark> s Inserts <remark>s in a program 
RENUM [[<newnum>) c Renumbers program lines 

[.[ <oldnum>] 
[,<increment>]]] 

RESET c Closes all disk files and clears the system buffer 
RESTORE s Allows DATA statements to be reread from a 

[<linenum>] specified <linenum> 
RESUME [0], s Continues program execution after an error 

RESUME NEXT, or recovery procedure is executed 
RESUME <line> 
RETURN [<line>] s Returns from a subroutine 
RIGHT$(<x$>,<n>} F Gives the rightmost <n> characters of string <x$> 
RND[(<X>)] F Returns a random number between 0 and 1 
RSET <stringvao=o s Moves data from RAM to file buffer to prepare 

<stringexp> for a PUT statement 
RUN <filespeC> c Executes a program; the R option is used to keep 

[,R] files open 
RUN [<line>] c Executes a program at the <line> specified 
SAVE[ <fi lespeo c Saves a Microsoft BASIC program file on disk; 

[,A]] the A option saves the program in ASCII format 
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SAVE[ <filespec> c 
[,P]] 

SGN(<x>) F 
SIN(<X>) F 
SPACE$(<n>) F 
SPC(<n>) F 
SQR(<X>) F 
STOP s 

STR$(<X>) F 
STRING$(<n>,<m>) F 

or 
STRING$( <n>,<x$>) 
SWAP <variable1 >, s 

<variable2> 
SYSTEM c 

TAB(<n>), 
PRINT TAB(<n>),or 
LPRINT TAB(<n>) 
TAN(<X>) F 
TIME$ or s 
TIME$= <v$> 
TIMER 

TROFF c 

TRON c 

VAL(<x$>) F 
VARPTR <variable> F 
WEND s 
WH ILE<expression> s 

[<Statements> 1 
WIDTH <size>/ S-1/0 

<fi lenum,si ze>/ 
<device,size> 

WRITE[<Iist of S-1/0 
expressions> 1 

WRITE#<filenum>, S-1/0 
<list of 
expressions> 

Abbreviations used: 
x, y, n = a numeric variable 
v$ = a string variable 
x$ =a string 

Type: 
C =Command 
S = Statement (not Input/Output) 
S-1/0 = Input/Output Statement 
F =Function 

Saves a program on disk; the P format saves the 
program in an encoded binary format 

Returns the sign of <X> 
Returns the trigonometric sine function of <X> 
Gives a string constant of <n> spaces 
Prints <n> spaces in a PRINT or LPRINT statement 
Gives the square root of <X> 
Stops program execution and returns to command 

level 
Converts the value of (<X>) to a string value 
Returns a string of length <n> whose characters all 

ASCII code <m> or the first character of <x$> 

Exchanges the values of two <variable>s 

Exits Microsoft BASIC, closes all files, and returns 
to Desktop 

Tabulates to position (<n>) 

Gives the trigonometric tangent of (<X>) 
Retrieves or sets the current time 

Retrieves number of seconds elapsed since 
midnight 

Turns the tracer for execution of program 
statements off 

Turns on the tracer for executed program 
statements 

Returns the numerical value of the string <x$> 
Returns the address of <variable> in memory 
Closes a WHILE ... WEND loop 
Starts a loop which continues to execute 

<statement> as long as the <expression> is true 
Sets screen width- options let you specify width 

printer or communications file 

Outputs data on the screen 

Outputs data to a sequential file 

Basket Case• A hard-sided carrying case, with pockets for the mouse, the numeric 
keypad, the power cord, the keyboard and the Macintosh. There are two latches on 
the front for locking the case. It has metal corners and a carrying handle. Justin Case. 
In UK: P+ P micro distributors. 

Batch Processing A program or series of programs is run to completion or aborted 
with no interaction between the user and the program possible. 
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Battery Backup Auxilliary power is provided through batteries to the processor so 
volatile information is stored during a power failure. 

Baud Rate The number of bits per second that can be passed from one device to 
another via a cable connection or a telephone connection. A baud rate of 300 bits 
per second equates to about 30 characters per second. 

Beep An audible sound produced by the Macintosh's speaker, used to warn the user 
of potential problems when alert boxes are displayed. Such a sound is generated 
when the Macintosh has been turned on and no disk has been inserted in the disk 
drive for loading. See Alert Box. 

BEEP A Microsoft BASIC Statement which causes the speaker to emit a sound at 800 
Hz for 1/4 second. The format is: 

BEEP 

Benchmark Program A specific program written to calibrate the speed of a computer 
in a well-defined situation, or type of computation, e.g., scientific number crunching, 
sorting or compilation. 

Beta Test Site See Alpha Test Site vs. Beta Test Site. 

Bidirectional Data flow may go in either direction on a wire. At each end of the 
wire there are transceivers to both receive and transmit. Common bidirectional 
buses are tristate or open collector transistor-transistor logic. 

Bidirectional Printing Alternately printing in either direction. A line printed left to 
right is followed by a line printed right to left, avoiding a carriage return delay and 
greatly increasing output. 

Binary Number A representation of an integer as a sum of powers of 2, using a 
sequence of Os and 1 s. 

Bit A contraction of binary digit. A bit is a 0 or a 1. Bits are used in computer systems 
to code information, instructions and data. Larger units of bits are: nibbles (4), bytes 
(8) or words (16, 24, 32, 96 or more). 

Bit Image A collection of bits stored in the computer's memory, arranged into a 
matrix that is rectangular in concept. The Macintosh screen is a bit image that is 
visible to the user. 

Bit Map An abbreviated means of defining the position of bit images in the 
computer's memory. Each bit map contains a pointer to a bit image, the row width of 
that image and the boundaries of the rectangle occupied by the image. 

Bit-mapped Screen A screen display that associates each pixel on the screen with a 
memory location in the computer's RAM. Pixels are turned on or off depending upon 
the state of the memory location associated with each pixel. See RAM, Pixel. 

Blank Line on Printer An LPR I NT statement with no other specifications will print a 
blank line (that is, feed the paper up one line and return to left margin) so you can 
space your printout format neatly. 
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Blank Lines, Inserting A blank line may be inserted in the midst of MacWrite text by 
moving the cursor down to the left-hand side of the line to be located below the 
blank line. The mouse button is then clicked to display the insertion cursor (a 
straight vertical line). Then the Return key is pressed causing a line to be inserted. 
See Cursor, Mouse Button, Vertical Bar Cursor. 

Blanking On the monitor screen, not displaying a character or leaving a space. 

Blinking Vertical Bar Used to mark the insertion point for text when a dialog box 
requests the name of a program or file being saved, to mark the insertion point for 
text when MacPaint is being used and to show the insertion point for text when 
MacWrite is being used. See Insertion Point, Dialog Box. 

Block The memory of the Macintosh is divided into blocks that may vary in size. A 
block is a contiguous range of memory locations in the same heap zone. See Heap. 

Block Within a logical record, information is stored in units or blocks. Block is also 
sometimes used to mean a collection of logical records, as in blocked records or 
blocking factor. Block size is usually expressed in bytes. 

Block Contents The contents of a block of memory is the data stored there. In 
effect, this is the space in the block that is available for storing data, programs, etc., 
whether or not data is present. 

Block Header A brief record of data that describes a block of memory and its 
contents. 

Board (Breadboard) The fiberglass or pressed-paper sheet used for mounting the 
integrated circuits. Interconnections may be wire-wrapped, soldered or printed on 
the board. The term breadboard refers to a prototype circuit and dates from the time 
when radios were made on mother's breadboard. Also called a "card" when referring 
to smaller boards that plug into the motherboard. 

Bold One of the options available from the MacPaint pull- down Style menu 
located on the menu bar of the MacPaint screen display. This option is used in the 
Text mode selected from the icon menu on the left-hand side of the Mac Paint screen 
display. Bold is also an option available from the Style menu of MacWrite. It is 
selected in the same fashion in both applications. The pointer is positioned on the 
word Style on the menu bar, the mouse button is clicked and the pointer is moved 
down the pull-down menu until Bold is highlighted. Then, the mouse button is 
released. This selection will produce boldface type in both programs for whichever 
font is active. See Menu Bar, Pull-down Menu, Icon, Drawing Tools Palette, Mac Paint, 
MacWrite. 

Books To find books on a particular topic, scan the Vendor/Product List noting the 
underlined entries. 

Boolean Logic Named after George Boole, who defined an algebra of logical 
operations such as And, Or and Not, on the two values true and false. 

Boot To use a bootstrap. Generally used to describe starting up a computer. 

Bootstrap A program used for starting the computer, which usually clears memory, 
sets up 1/0 devices and loads the operating system from ROM, disk or cassette. 
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Border Borders of varying width are used to surround each of the shapes generated 
by the icons on the tool palette (icon menu) on the left-hand side of the MacPaint 
screen display. Borders are selected from the line and border width menu in the 
lower left corner of the MacPaint display. See Icon, Drawing Tools, MacPaint. 

Bottom Margin The height of the bottom margin in MacWrite is set by opening the 
Footer window in the program and pressing Return for as many lines (up to six) as 
may be required for the bottom margin of each page. The Footer may then be hidden 
by using the Hide Footer option from the Format menu on the menu bar. See Footer, 
Hide Footer Option, Return Key, MacWrite. 

Bound Processor-bound or I/O-bound indicating which component of a system is 
the bottleneck preventing faster performance. 

Boundaries In Microsoft Multiplan, the edges of highlighted areas on the screen are 
called boundaries. Boundaries are set by placing the plus sign (+)(used as a pointer) 
on the first cell to be formatted, included in a formula or value copy process or 
moved. The mouse button is clicked and the pointer is dragged to the end of the 
range of cells to be included within the boundaries. This process will highlight the 
range of cells to be included, which may consist of a single cell, a pair of cells 
arranged horizontally or vertically, a column or row of cells, or a series of adjacent 
rows or cells that make up a square or rectangle. See Multiplan, Cell, Highlight, 
Mouse Button, Pointer, Clicking, Dragging. 

BPI Bits Per Inch. Used to specify the density of data recorded on tape or disk. 

Braces Braces() are used in Multiplan to denote the position of cells referred to in a 
formula for cells on the Clipboard for handling via the Clipboard. See Cell, Multiplan, 
Clipboard. 

Branch A programming instruction which causes transfer of control to another 
program sequence. In Microsoft BASIC, for example, the COTO statement. See 
GOTO. 

Breakpoint A point at which the processor will stop a program sequence and display 
the current machine status, implemented through hardware, software or a combination 
of both. 

Brush Mirrors An option available from the pull-down Goodies menu in MacPaint, 
which is located across the top of the Mac Paint screen display. When Brush Mirrors 
is selected, a square is displayed in a window on the screen. Horizontal, vertical and 
diagonal lines are displayed inside of the square. One or all of these lines may be 
selected for producing a mirror image of any line drawn with the brush tool from the 
tool palette of MacPaint by placing the pointer on each of the axes to be selected 
and pressing the mouse button. After the desired brush mirrors have been selected, 
the OK button is activated in the window by placing the pointer on the button and 
pressing the mouse button. This will cause the window to be closed and make the 
brush mirror available for use. Brush mirrors produce images similar to the image 
shown below. They cause the mirror image of any line drawn to be produced on the 
opposite side of the axis or axes selected by the Brush Mirrors option. See Paintbrush, 
Button, Window, MacPaint, Drawing Tools, Pointer, Mouse Button. 
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MIRRORS 

Fig. 82 Drawing done with brush mirrors from M ac Paint. 
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Fig. 83 The Brush Shape menu from M acPaint. 
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Brush Shape Brush shapes and thicknesses for use with the Brush icon on the tool 
palette of MacPaint may be selected by using the Brush Shapes option available 
from the pull-down Goodies menu on the menu bar of Mac Paint. When selected, a 
window containing a variety of brush shapes and thicknesses is displayed on the 
screen. The current brush shape is inside of the square displayed within the window. 
A new brush may be selected by moving the pointer to the desired brush and clicking 
the mouse button. Once the mouse button has been pressed, the window will close 
automatically and you will be able to use the selected brush when you select the 
Brush icon from the tool palette. 

Buffer In software, any memory structure provided for the temporary storage ot 
data. In hardware, a device which restores logic-drive signal levels in order to drive a 
bus or a large number of inputs. 

Buffering The delaying and temporary storage of data in a data communications 
path. 

Bug Errors in a Program. A programmer must ensure that a program will correctly 
process all of the types of data it is intended for. Samples of the data are prepared 
(test data) and the program is executed using this data (a test run). The program's 
outputs (reports, screen displays, files, etc.) are then verified to be as specified. An 
error in the processing logic of a program is called a "bug," hence the term "debug" 
and "bug-free." 

Bulk Storage Large capacity data storage, generally long term. 

Burn-in A phase of component testing where basic flaws or early failures are 
screened out by running the circuit for a specified length of time generally at 
elevated temperatures in some sort of oven. 

Bus A path for signals having a common function. Every Standard MPU creates 
three buses: the data bus, the address bus and the control bus. 

Business Graphics Applications programs that allow the user to display data as bar 
graphs, line graphs, scattergrams, pie charts or combinations of these various 
graphs. An example of such an application is Microsoft Graph. See Graphics. 

Business Software Applications that are commonly used by businesses. The applications 
covered by this generic description are generally accounting, personnel, forecasting 
or inventory applications. See Business Simulation, Dow Jones Market Manager, 
Dow jones Spreadsheet Link, Habadex, Mac Manager, Mac Project, Management 
Edge, Negotiation Edge, Sales Edge, SEACAS, Telofacts 2, Template Disk No.1 for 
Multiplan, Trade*Pius. 

Button A small square or rectangle within a window that allows the user to take a 
course of action. Alert boxes contain buttons that suggest the most prudent action 
when a problem has been encountered. Dialog boxes may offer one or more options 
for proceeding, or may only communicate a message. Those dialog boxes that 
require a response are called "modal." Those that require no response are called 
"modeless." Action is initiated in a dialog box by placing the pointer on the desired 
button and clicking the mouse button. See Dialog Box, Alert Box, Pointer, Modal 
Dialog Box, Modeless Dialog Box. 
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Cut 

® Shift Cells Up 

0 Shift Cells Left 

You are cutting a 4 by 1 selection 

( OK ) ( Cancel ] 

Fig. B4 A Dialog box with an "OK" button. 

By Date Option When you double-click the disk icon of the disk in the Macintosh's 
disk drive, the directory of that disk will be displayed on the Macintosh screen as a 
window. The directory is normally displayed in the icon format. If you wished to 
view this directory in date order with the date of the latest file modified showing first 
on the list, select the View menu from the menu bar at the top of the display on the 
Macintosh screen. Then move the pointer down this menu until by Date highlighted. 
Then release the mouse button and this directory appears on the screen in date 
order. This type of directory is displayed below: 

j File Edit Special 
~~----------------------------

§0 
Size 

OK 
10K 

10K 
10K 
10K 
10K 

10K 

by Icon 
by Nome 

~by Dote 
by Size 
by Kind 

MacDriue 
Name Kind 

Emptg F o ldeor folder 

pbg.budget document 

pbg .addtobudgeot MS-B ASIC document 

pbg.changeobudgeot MS-B ASIC document 

pbg.meonu MS-B ASIC document 

pbg _listthebudgeot MS-BASIC document 

pbg .nevbudget MS-B ASIC document 

Fig. BS The By Date directory from the View menu. 

Last Hedifird 

Mon 1 Oct 1, 1984 

Mon1 Oct 1 1 1984 

Sun, Sep 30, 1984 

Sun, Sep 30, 1984 

Sun, Sep 30, 1984 

Sun, Sep 30, 1984 

Sun, Sep 30, 1984 
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By Icon Option An option available from the View menu on the menu bar at the top 
of the Macintosh screen display. When selected, the directory of the disk in the 
Macintosh's disk drive is displayed with each file name appearing as an icon. This 
directory is illustrated below: 

ti file 

3061 K availab1• 

0 Q 
Applications MS-BASIC Life Mcuse.Bas 

0 Q 0 Q CIS Folder 
MacPaint Det ANALOG CLOCK GLOBE.BAS 

0 0 (g (g 

Fig. 86 The By Icon directory from the Macintosh Desktop display. 

By Kind Option An option available from the View menu on the menu bar of a 
Macintosh screen display. When selected, the names of the files in the directory of 
the disk are displayed in orderoffile type. This directory display is illustrated below. 

By Name Option An option available from the View menu on the menu bar of a 
Macintosh screen display. When selected, the names of the files in the disk directory 
are displayed in alpabetical order by name. This directory is illustrated below. 

By Size Option An option available from the View menu on the menu bar of the 
Macintosh screen display. When this option is selected, the disk directory is displayed 
in order of size with the largest file at the top of the list. This type of directory is 
illustrated below. 

Byte A group of eight bits, universally used to represent a character. Microcomputer 
instructions generally require one, two or three bytes. One byte has two nibbles (4 
bits). 
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• File Edit Special 

Sin R.ne 

51K Stuff -!by Kind · 
40K SF AC L•tt• ... 
30K Applications folder 

317K 

1021< 

10K 

HacPaint Doc folder 

CIS Fold•r foldtr 

DaYinci Ext•riors folder 

92K Jun• DOH folder 

1 OK HS-Basic Prog folder 

419K DaYioci Landsca ... foldtr 

71K T•xt FiJ.s foldtr 

Fig. B7 The By Kind directory as selected f rom the View menu. 

c File 

Sizt ~ 

101< GLOBE.B 

101< Jt.xDump 

10K hom• MacP aint document 

20K ICONPIC MacPaint document 

20K lmag•vritu System document 

92K Jun• DOH folder 

10K Lif• application 

61K HacPaint application 

317K HacP aint Doc folder 

Fig. B8 The By Name directory from the M acintosh Desktop as selected from the View menu. 
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s File Edit 

acDriue 
Sizt Namt Last Hedifitd 

71K Sa~ 1 Aug 18 1 1984 

61K HacPaint Wt>d 1 May 21 1984 

61K HacYritt applica~ion 'Wed 1 May 21 1984 

51K Fiftdtr Sys~em document 'w'ed 1 May 21 1984 

51K HS-BASIC application Fri 1 Jan 11 1904 

51K Stuff folder Sat I Aug 18 I 1 984 

40K SF AC Lttttrs folder Fri 1 Auo 101 1984 

30K Applications folder 

Fig. 69 The By Size directory from the View menu on the Macintosh Desktop. 
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C ASCII 67, HEX 43.c ASCII 99, HEX 63. Also the hexadecimal notation for the 
decimal number 12: 

C base 16 = 12 
12 base 10 = 12 
14 base 8 = 12 
1100 base 2 = 12 

C Programming Language Cis a high-level programming language developed at Bell 
laboratories, associated with the UNIX Operating System. This is a compiled 
language and is sometimes substituted for Assembly language because it operates at 
a very high speed. (-compilers are available for the Macintosh and Unipress, Inc. is 
working on a C Development Environment. 

C for the Macintosh• A (-Compiler for the Macintosh. The current version is 
intended for the student; however, a full professional package will be available 
shortly from the manufacturer. Hippopotamus Software. 

CAD Computer-Aided Design. A software/hardware system providing tools for the 
designer. MacPaint and MacDraw can be used as limited CAD packages. 

CAl Computer-Assisted Instruction. Any program that instructs or trains the student. 
particularly where instant feedback and customized rate and progression through 
topics is offered. 

Calculate Menu The Calculate menu is one of the pull-down menus that is avai I able 
in Microsoft Multiplan. This menu contains seven options: Calculate Now, Automatic 
Calculation, Manual Calculation, Iterate, Don't Iterate, Set Completion Test and 
Select Completion Test. Calculate Now is used to calculate the cells in a worksheet 
when the Manual Calculation mode is in effect. Automatic Calculation is the default 
calculation mode. It must be selected to return to automatic calculation when the 
Manual Calculation option is in force. Manual Calculation is used to set the 
worksheet to the manual mode of calculation to save time while large amounts of 
data are being entered into a worksheet or while a worksheet is being created. No 
calculations take place while this option is in force unless the Calculate Now option 
is selected. The Iterate option is used to calculate certain formulas in a worksheet 
until a certain condition is met. The condition for completing iteration is called a 
completion test. A completion test is set up by using the Set Completion test 
command option. Such a test is selected by using the Select Completion Test 
command option. The Don't Iterate command option is used to prevent Multiplan 
from attempting iteration even though a formula that requires iteration is encountered. 

Calculate Now Option Calculate Now is a command option that may be selected 
from the Calculate menu in Multiplan. This command is used to cause all of the cells 
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in a worksheet to be calculated at time when Automatic Calculation has been tu rned 
off and Manual Ca lculat ion has been turned on. See Calculate Menu. 

Calculator O ne of the desk accessories available from the Apple menu in the upper 
left-hand corner of the M acintosh display screen. The Calculator is selected by 
scrolling down this menu with the mouse button depressed until the word " Calculator" 
is high lighted. The mouse button is then released and the Calculator is d isplayed on 
the screen. (See illustration shown below.) Many of the features of a normal10-key 
desktop ca lculator are available on this Calculator. It may be used with the mouse 
by pointing at the keys to be used in the calculation you are making. It may also be 
used from the keyboard, by pressing any number or arithmetic symbol. The results of 
a calculation are displayed in the window at the top of the Calculator and may be 
t ransferred to the Clipboard by using the Cut option from the Edit menu on the menu 
bar at the top o f the screen. These ca lculations may then be transferred to a 
MacWrite document or another applica tion document by using the Paste option 
from the Clipboard. The Calculator is closed by placing the po inter on the Calculator's 
close box and clicking the mouse button . See Apple Menu, Clicking, Close Box. 

File Edit Uiew Special 
Hbout the Finder ... 

Scrapbook 
Hlarm Cloclc 
Note Pad 

Key Caps 
Control Panel 
Puzzle 

0 Calculator 

Fig. Cl The Calculator from the Macintosh Desktop accessories. 

Calendar, The• A time-management p rogram that allows the user to schedule his 
activit ies and appointments, make notes about appointments, d isp lay an on-screen 
ca lendar of planned activities, update schedules and appointments, and print out 
dai ly, monthly and yearl y schedules. Hayden Software, Inc. 

CALL A M icrosoft BAS IC statement which allows a machine language subroutine or 
an internal Macintosh subroutine to be accessed th rough a Microsoft BASIC program. 
The format is: 
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CALL mumvao[ (<variable>! ,<variable>] ... )] 

mumvao refers to the name of a numeric variable, the value of which indicates 
the starting memory address of the subroutine being called. 

<variable> is the name of a variable to be passed as an argument to the machine 
language subroutine. 

Call Program execution is temporarily transferred to a subroutine or subprogram. 
When completed, execution resumes at the instruction following the call. 

Call Microsoft BASIC Subroutine. See GOSUB and RETURN. 

Call by Reference The actual storage locations of the parameters are passed to the 
subroutine by the call, rather than passing a copy of the values. 

Call by Value A subroutine or procedure call in which the actual values of the 
parameters are passed to the subroutine. 

Cancel Some alert boxes and some dialog boxes offer the user a Cancel button as 
well as an OK button. The Cancel button allows the user to cancel the operation just 
started. In the case of an alert box, this option prevents a potential loss of data. In the 
case of a dialog box, it offers a chance to back out of a process started. An example 
of an alert box and a dialog box with a cancel button are shown below. See Alert Box, 
Dialog Box, Button. 

[! 
Saue thanges before 
closing? 

I Yes )( Cancel ) ( No ) 

Fig. C2 An alert box that uses a Cancel button. 

Saue the document as: MAC DRRW 

( Ejett ) 

( Saue ) [ Cancel ) 

Fig. C3 A dialog box that uses a Cancel button. 
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Cancel Button A Cancel button is presented in most dialog boxes that are used in 
Macintosh applications. This button is a hollow rectangle with the word "Cancel" 
inside. It allows the user to back out of the last activity or command that he selected. 
This button is activated by placing the mouse pointer inside the button and then 
clicking the mouse button. 

Cancel the Current Operation When Command-C is pressed while a Microsoft 
BASIC program is being run, the program operation is interrupted and will also cause 
the line being edited in the Command window to be left as it was before editing 
began. It also discards the contents of the Command window if you are writing a 
program line and wish to discard it. Pressing the Command key and the period(.) key 
will cancel the operation of a file command or a print command at the point where 
these two keys are pressed. These are both useful shortcuts when you are involved in 
the operations described and wish to interrupt or stop the operation. See Command 
Key, Command-C, Command-., Command Window. 

Candy Apple IEEE 488* A user interface used to connect the Macintosh to testing 
and measurement equipment. It is Apple Bus compatible and uses the INTEL 8291A 
and 8292 integrated circuits. It has its own power supply and is the same color as the 
Macintosh. Tecmar, Inc. 

Caps Lock Located on the left-hand side of the Macintosh keyboard, this key may 
be locked down to produce all capital letters. To release the key, press it down one 
time and release it. 

Carriage position See LPOS. 

Carriage Return A term carried over from the days when computer keyboards 
resembled teletype keyboards. The carriage return key on this keyboard acted the 
same as the carriage return lever on a manual typewriter and the carriage return key 
on the electric typewriter. It advanced the paper one line and returned the print 
element to the left-hand margin. The Return key serves a similar purpose with word 
processors. In programming, the Return key indicates to the computer that it should 
accept the data entered prior to the Return key being pressed. Press Return to end 
the current line, give the line to the requesting program and put the cursor at the 
start of the next line. See Keyboard, Return Key, Word Processor. 

Carrier A frequency used to "carry" information, modulated to denote 0 or 1. 

Carrying Case, ATS Cases• A hard-shell case intended as a shipping case to transport 
the Macintosh via surface or air transportation. The exterior is laminated plastic and 
plywood, and the interior is foam-lined. It has pockets for the keyboard, the mouse, 
disks and the power cord. ATS Cases, Inc. In UK: P+ P micro distributors. 

Carrying Cases See Basket Case, Carrying Case, MacBag, Macfreighter, MacPak, 
Mac Sac, MacSak, Mac Tote, Scottie MacCase, Totem Pak. 

CDBL A Microsoft BASIC function which converts any numeric expression <X> to a 
double-precision number. The format is: 

<variable> = CDBL(<x>) 

See Numeric Precisions in Microsoft BASIC Conversions. 
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Cell A repeated unit in a RAM chip stori ng one unit of information and returning it 
in response to a particular address signal. In electroni c spreadsheets, a cell is the 
point of conjunction of a column and a row. Cells are designated by their row and 
cell number. For example, in M ultiplan, the cell R12C3 is in row 12, column 3. 

Center Alignment Used wi th word processors to describe the alignment of text lines 
so the text is equally d istributed on either side of t he center line of t he page. Used for 
titles and in some poetry, center alignment is accomplished in M acWrite by selecting 
the center alignment box under the ruler at the top of the MacWrite screen display 
and placing the pointer on the box i l lust rated below and clicking the mouse button . 
The blinking verti ca l bar cursor is then displayed in the center of the screen on the 
line being entered. As text is entered, it remains in the center of the display. If you 
wish to center a ti t le in M acWrite. you would insert a new ruler immediately after 
you have f inished typing the title line by usi ng the Insert Ruler option from the 
Format menu on the menu bar at t he top of the screen display. Once the second ruler 
is in position, you may change the alignment of the text to be entered he low the ruler 
by select ing another alignment option in the same manner. A simila r option avai lable 
in MacPaint is called A lign Middle. See Word Processor, MacWrite, M ouse Button. 
Verti ca l Bar Cursor, Ruler, A lign Middle Option. M acPaint. 

ti File Edit Search Format Font Style 

iiO Untitled 

.~ .. 1 ...• ... L. •... 1 ...•.. .J.? •... 1 ...• .. .1 ...•... 1 ...•.. .J.~ •... 1 ...• .. .1 ....... 1 ...• .. .J.1 ... 1 .•.•.. .1 ...•... 1 ...•. ..J.~ •... 1 ...•. ;!·•···l ...•. ..J.~ •... 1 ...•... L . ... 1 ...•.. 1? ~ 
~~ ~&§JEJ ~~~~ ~m 

~· 
QJ 

Fig. (4 The pointer marks the Center A lignment box on the MacWrite Ruler. 

CHAIN A Microsoft BASIC statement which transfers contro l to another program 
and passes variables from the current program to that program. The format is: 

CHAIN I MERGE ]<filespeol, ldine> ][.ALL] j.DELETE <range> II 

<fil espeC> This follows the rules for naming f iles. For addi tiona l information refer 
to Naming Files Microsoft BASIC. 
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<line> This is a line number or an expression that evaluates to a line number in the 
chained-to program which will begin running at this line number, or, if no line 
number is specified, execution will begin at the first line. For example: 

CHAIN "PROGX",SOO 

Should PROGX be renumbered using the RENUM command, dine> will not be 
affected. In this example the old line number 500 would be changed to point to the 
new "renumbered" line number. 

ALL specifies that every variable in the current program is to be passed to the 
chained-to program. If the ALL option is omitted, you must include a COMMON 
statement in the chaining program to pass variables to the chained-to program. See 
COMMON. For example: 

CHAIN "PROGX",SOO,ALL 

MERGE brings a section of code, as an overlay, into the Microsoft BASIC program. 
The MERGE operation is performed with the chaining and chained-to program. The 
chained-to program must be an ASCII file if it is to be merged. For example: 

CHAIN MERGE "OVERLAY",SOO 

After using an overlay, delete it so a new overlay may be brought in. To do this, use 
the Delete option, which behaves like the DELETE command where the line numbers 
specified as the first and last line of the <range> must exist, or an "Illegal function 
call" error occurs. For example: 

CHAIN MERGE "OVERLAY",500,DELETE 500-1000 

Here lines 500 through 1000 of the chaining program will be deleted before 
loading in the overlay chained-to program. The numbers in <range> are affected by 
the RENUM command. 

Remember: 1. The CHAIN statement with MERGE option preserves the current 
OPTION BASE setting. 
2. When the MERGE option is omitted, the OPTION BASE setting is not preserved in 
the chained-to program. Without MERGE, CHAIN does not preserve variable types 
or user-defined functions for use by the chained-to program. Any DEFINT, DEFSNG, 
DEFDBL, DEFSTR or DEF FN statements containing shared variables must be restated 
in the chained program. 
3. When the MERGE option is being used, user-defined functions should be included 
and defined before the CHAIN MERGE statement is used in the program. 

Chaining A method of allowing the execution of programs larger than the main 
memory of a computer, by loading and executing modules of the same program 
sequentially. 

Change One of the options in the dialog box presented by MacWrite when the 
pull-down Search menu is selected from the menu bar at the top of the screen. This 
dialog box is illustrated below. When the Change command is selected from this 
menu, the dialog box is displayed on the screen. The Change button would be used 
as one of the available options, after the word to be changed and its replacement 
have been entered in the two rectangles on the top two lines of the dialog box. This 
option is used to change only a single occurrence of the old word or phrase. The Find 
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Next option would be used to find and change the next occurrence. See Change All, 
Dialog Box, Menu Bar. 
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Fig. C5 The dialog box that is used when the Change option is selected from the 
Search menu. 

Change a Microsoft BASIC Line See EDIT. 

Change All A button available in the dialog box presented by MacWrite when the 
Change command is selected from the pull- down Search menu from the menu bar at 
the top of the screen. This dialog box first asks for the word in the text that must be 
changed, then asks for the text that must replace the old text. The dialog box then 
presents four options in the form of buttons placed in a row along the bottom of the 
dialog box: Find Next, Change Then Find, Change and Change All. The selection of 
this option causes all incidents of the old word that occur in the text to be changed 
to the new word. Phrases may also be changed in the same fashion. The Change All 
option is called a "Global Search and Replace" in many word processors for 
computers other than the Macintosh. See Button, Dialog Box, Change, Search 
Menu, Menu Bar, Global Search And Replace. 

Change Contents of a File Edit means to change the contents of program or data fi I e. 
Several different editors are used with the Macintosh. Mac Write may be used to edit 
documents and letters. A public domain text editor called RudE by Loftus E. Becker, 
Jr. is available from noncommercial sources. This may be used to edit text files or 
programs. The Edit menu on the menu bar of Microsoft BASIC allows the user to cut, 
copy and paste material to the Clipboard from or to a program listing. 

Editing may also be accomplished by listing a program, placing the pointer on the 
line to be edited, and clicking the mouse button. This transfers the line from the List 
window to the Command window of Microsoft BASIC and allows text to be added by 
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placing the pointer at the insertion point and clicking the mouse button to obtain a 
vertical bar cu rsor. The insertion may then be made. Material may be deleted from a 
program line by placing the pointer to the right of the material to be deleted and 
clicki ng the mouse button. This places a vertical bar cursor in this posi tion and 
allows the Backspace key to delete the material to the left of the cursor. Blocks of 
material may be deleted by plac ing the cursor at the leftmost point from wh ich the 
deletion must take place, clicking the mouse button, and dragging the pointer to the 
rightmost point of the block of material to be deleted and pressing the Backspace 
key. 

Editors are classified as line-oriented if they work on one line at a time and deal 
with text by line number. 

Full screen editors allow you to change any data currently displayed on the screen 
and treat paragraphs or even enti re documents as a unit, allowing reformatting, 
change of margins with justification, block moves, etc. Most word processing 
programs are fu ll screen editors . 

The Microsoft BASIC editing functions lie between these two categories. They 
al low you to change any Microsoft BASIC l ine on the screen, but still treat the data 
as a collection of lines. You must press enter while the cursor is on a line you have 
changed or the changes are not effective. See MacWrite, Ed itor, Public Domain, List 
Window, Command Window, Pointer, Mouse Button, Insertion Point, Program Line, 
Dragging, Backspace Key. 

Change Date in System The date in the Macintosh Alarm Clock can be changed by 
using the Apple menu to access the Control Panel. Once the Control Panel is 
displayed, place the crosshair inside the date box and click the mouse button. Then 
place the crosshair on the month and click the mouse button again. Two arrows are 
displayed on the side of the date box. To move the date forward, place the crosshai r 
on the up arrow and click the mouse button until the proper date is d isplayed. The 
number that designates the day of the month is changed in the same fashion. See 
Apple Menu, Control Panel. 

Fig. C6 The Control Panel with the Set Date section under the pointer. 

Change Font Size Font size may be changed eas il y in MacPaint, M acWrite and 
other appl ications that use Font menus, Font Size menus and Style menus. The Font 
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Size menu is used in MacPaint to select a font size when text is being entered. The 
Style menu is used in MacWrite to select font size. The current font size will be 
retained in both applications unless it is changed by the user. If the vertical bar 
cursor has been activated by clicking the mouse button while the 1-beam is in use as 
a pointer, a new font size may be selected for future entry while the current font size 
is retained for earlier entries. 

Change Memory Byte with Microsoft BASIC See POKE. 

Change Name of a File File names can be changed on Macintosh disks by placing 
the pointer on the file name under the icon for the file and clicking the mouse 
button, displaying a vertical bar cursor. The new name can be typed in at the cursor. 
When the new name has been entered, press Return. See Icon, Vertical Bar Cursor. 

j File Edit Uiew Special 
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Fig. C7 The Desktop with the vertical bar cursor next to a file name that has been 
highlighted for changing. 

Change Time in System See Set the Time. 

Character File Contains character data, letters, numbers or special characters. 
These files may have any file extension. Most data and programs that you write will 
be in text files. See Data File. 

Character Generator A circuit which forms the letters or numbers on a screen or 
printer. ·Characters may also be generated by software as well as hardware. The 
Macintosh relies heavily on software-generated character sets. 
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Character Insert In Microsoft BASIC characters may be inserted in BASIC program 
lines by listing the program using the List command on the command line or by 
selecting List from the Command menu at the top of the screen display. Either 
method will cause the program in memory to be displayed in a list box on the screen. 
The line to be edited is then selected by typing LIST in the Command window 
followed by the line number to be edited or by placing the pointer on the line to be 
edited and clicking the mouse button. Once the line is displayed in the Command 
window, place the pointer at the point in the line where you wish to insert a 
character and click the mouse button again. This will cause a vertical line cursor to 
be displayed at the insertion point and new characters can then be typed in. Once all 
of the new characters have been inserted, press the Return key. See Command 
Menu, Command Window, LIST, Clicking, Pointer, Vertical Bar Cursor, Insertion 
Point. 

Character Keys Keys used to enter letters, numbers, symbols and punctuation 
marks. They also include the Tab key, the Return key and the space bar. See Tab Key, 
Return Key, Space Bar. 

Character Read from Keyboard See INKEY$, INPUT. 

Character Set The collection of characters available for display or processing on a 
particular computer or peripheral. 

Character String A one-dimensional array or sequence of characters, encoded as 
bytes. Character strings have a length field or are terminated by the zero byte. See 
Arrays, Byte, Zero Byte. 

Characters Per Inch The type size and style used by dot- matrix and daisy-wheel 
printers determines the number of characters printed per inch on the paper. The 
Apple lmageWriter printer uses the following type sizes selected by passing control 
characters to the printer from a basic program, a printer driver, a word processor, an 
electronic spreadsheet or from any other application that has been set up to use the 
lmageWriter. 

CHARACTERS 
PER INCH 

9 
10 
12 
13.4 
15 
17 

STYLE 

Extended 
Pica 
Elite 
Semi condensed 
Condensed 
Ultracondensed 

CONTROL 
CHARACTERS 

ESCAPE n 
ESCAPE N 
ESCAPEE 
ESCAPEe 
ESCAPE q 
ESCAPE Q 

The ESCAPE character and the letter following the ESCAPE character are usually 
passed in the program as an ASCII character. For example, the ASCII characters for 
ESCAPE N are CHR$(27) CHR$(78). See lmageWriter, Control Characters, Printer 
Driver, ASCII, Escape. 

Checksum A field of one or more bytes appended to a block of n words containing a 
truncated binary sum or some other function value based on the contents of that 
block. The sum is used to verify the integrity of data. 
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Chicago A text font available in MacWrite and MacPaint which may be selected by 
placing the pointer on the Font menu marker at the top of the display screen, moving 
the pointer down the list until Chicago is highlighted and releasing the mouse 
button. The Chicago font is illustrated below. See MacWrite, MacPaint, Fonts. 

Thta ilan •• ...,.. •f tile tldcqa t palalt plela tal fat. 
11da II u •••mpleoflhe tillage 11 paint plain t•t foat. 
This Is an eaample of the Chicago 12 paint plain teat font. 
This is en eaemple of the Chicago 14 point plain t 
Tllia Ia •• ••••,t• af Clllc•1• 14 p•l•t lll•li 
~ ~ ~ um (]XDDmQ OII){IDJ 

111' iJil1 ID lEilJQiitU)OJ H4J 
lll&ll 

Fig. C8 An example of the Chicago font in various font sizes. 

Chip A rectangular silicon die cut from a wafer. For example, the Macintosh's 
MC68000 processor is on a single chip. 

CHR$ A Microsoft BASIC function which converts an ASCII code to its character 
equivalent. The format is: 

<stringvariable> = CHR$(<m) 

For example, CHR$(83) would return the one-character string "S." For a listing of 
ASCII codes refer to ASCII Character Codes. 

CineMAC• A video port for the Macintosh. It must be installed by a dealer. This 
hardware upgrade is an additional video output port and may be used to connect the 
Macintosh to an external monitor. Micrographic Images Corporation. 

CINT A Microsoft BASIC statement which converts <X> to an integer (whole number) 
by rounding the fractional portion of that integer. The format is: 

<variable> = CINT(<x>) 

<X> must be in the range of -32768 to + 32767 or an "Overflow" error occurs. For 
additional information refer to FIX and INT. 

CIRCLE A Microsoft BASIC statement which draws an ellipse on the screen with 
center <X, y> and radius m. The format is: 

Cl RCLE(<x, y> ),<r>[,<color>[,[<start> ),[<end> ][,<aspect>]]] 

<X,y> are the coordinates of the center of the ellipse in either absolute or relative 
form. 
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<r> is the radius (major axis) of the ellipse in points. 
<color> is a number which specifies the color of the ellipse. The default color is 

black. If a value of 50 is used, white is produced. All other values produce black on a 
black and white screen Macintosh. 

<start>,<end> are the angles in radians and may range from- 2*PI to+ 2*PI, where PI 
= 3.141593. 

<aspect> is a numeric expression. If <aspect> is less than one, then <r> is the x-radius. 
That is, the radius is measured in points in the horizontal direction. If <aspect> is 
greater than one, then <r> is they-radius. The default for aspect is 1.0, which produces 
a circle. Other aspect numbers produce ellipses. 

CLEAR A Microsoft BASIC command which erases all memory used for data by 
setting all numeric variables to zero and all string variables to null. This is done 
without erasing the program currently in memory. The format of is: 

CLEAR [,[<m](,<m>]] 

<n> is used if you need to reserve space in storage for machine language programs. 
It sets the maximum number of bytes for the Microsoft BASIC work area in the 
computer (where your program and data are stored), along with the interpreter work 
area. 

<m> could be used if a number of nested GOSUB statements or FOR ... NEXT loops 
are used in your program, or if you use PAINT to do complex scenes. <m> sets aside 
stack space for Microsoft BASIC. The default is 512 bytes or one-eighth of the 
available memory (whichever is smaller). 

After a CLEAR, arrays are undefined, numeric variables have a value of zero, string 
variables have a null value and any information set with any DEF FN, DEF USC, 
DEFINT, DEFDBL, DEFSNG and DEFSTR statement is lost. 

Executing a CLEAR command turns off any sound running and resets to Music 
Foreground. Also, PEN and STRING are reset to Off. 

The ERASE statement can be used to free some memory without erasing all the 
data in the program. It erases only specified arrays from the work area. 

Clear A command option available from the Edit menu of Microsoft Multiplan for 
the Macintosh. This clears all variable values entered in a spreadsheet application. 
In effect, this command clears out all entries added to an application by the user and 
allows a spreadsheet to be reused without reloading a blank version of the same 
application. See Variable, Multiplan. 

Clear the Screen See CLS. 

Clicking A term used to describe the pressing of the button on the top of the 
Macintosh mouse. When the mouse pointer is placed on a menu at the top of the 
screen display, clicking the mouse button causes the menu to pull down so that it 
may be used to make a selection. When the pointer is placed on an icon on a disk 
directory or on a file name and the button is clicked, it is highlighted. Clicking is 
used to accomplish some action with the mouse. See Mouse Button, Pull-Down 
Menu, Icon, Disk Directory. 

Click Art• This is a disk of high-quality drawings, pictures, political figures, etc., 
which are ready to clip out and use in Macintosh documents or print-outs. These are 
excellent graphics works, highlighted by the outstanding rendition of Michaelanglo's 
David. T/Maker Graphics. IN UK: Softsel. 
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Clipboard A portion of the Macintosh's Random Access Memory set aside to store 
data being transferred from one file or application to another. Any time you transfer 
a picture from MacPaint to MacWrite or a spreadsheet from Microsoft Multiplan to 
Microsoft Chart , this is accomplished by cutting or copying the material to be 
transferred. This process moves this data to the Clipboard. The file that provided the 
data must then be closed and the file into which the data is moved must be opened if 
you only have the internal disk drive and if data is being transferred to a file in 
another appl ication program. The fi le and the application program must be closed 
and the disk contain ing the applicat ion from which data is being transferred must be 
ejected. The disk containing the application to which data is being transferred must 
then be loaded and the file that wi ll use the data must be opened. Once this activity 
is f inished, you are ready to transfer data from the Clipboard to the appli cation, 
which is done by placing the cursor at the insertion point for the data and using the 
Paste option from the Edit menu. The new data w ill then be inserted . The Clipboard 
may only hold one set of data at a time. When new data is placed in the Clipboard, 
the o ld data is erased. See Insertion Point, Cut Option, Copy Option, Paste Option. 
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Fig. C9 An example of material on the Clipboard. 

CLIP 1* A disk of clipboard art for the Macintosh. It includes over 100 images. The 
package includes a disk and a complete manual. Frazier, Peper, & Associates. 
In UK: P+ P micro distributors. 

Clock Frequency The oscillation rate (clock rate) of a clock, is usually expressed in 
megahertz. The Macintosh has a basic c lock rate of 7.8 MHz. For reference, 
compare th is to the IBM PC, with a clock rate of 4.77 Mhz. The Macintosh executes 
instructions approximately twice as fast as the IBM PC, and since it is a 32-bit 
processor, the Macintosh is also doing more work with each instruction executed. 

CLOSE A Microsoft BASIC statement which concludes 1/0 to a device or fi le. The 
format is : 

CLOSE II# ]<fi lenum>[,[# ]<filenum> ... ]J 

The associa tion between a particular f i le or device and its <fi lenum> stops when 
CLOSE is executed, and subsequent 1/0 operations specifying that file number will 
be invalid. The file or device may be opened again using the same or a different fi le 
number, or the file number may be reused to open any device or fi le. 

A CLOSE to a fi le or device opened for sequential output causes the final buffer to 
be written to the file or device. 

A CLOSE wi th no file numbers specified causes a ll devices and files that have 
been opened to be closed. 
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Executing an END, NEW, RESET, SYSTEM or RUN without the R option causes all 
open files and devices to be automatically closed. STOP does not close any files or 
devices. 

CLOSE is used in conjunction with the OPEN statement. Refer to OPEN. 
Open files may be closed by selecting the Close or Close All optiona 32-bit 

processor, the Macintosh is also doing more work with each instruction executed. 

CLOSE A Microsoft BASIC command from the File menu at the top of the screen 
display. This will cause the icons to close and the files to close with the icons. 

Close Disassociation of a file from a particular program, including flushing unwritten 
buffers and updating the directory and File Allocation Table if required. 

Close a Document To close a document in use with an application program, either 
place the pointer on the close box on the upper left-hand corner of the document's 
title bar and click the mouse button or select the Close option from the File menu. 
Either of these methods will close the document. See Close Box, Title Bar, Menu Bar, 
File Menu. 

Close All An option available on the File menu at the top of the Macintosh display 
screen which causes all open files and the file directory display to be closed and 
returned to the disk icon at the upper right-hand corner of the display screen. See 
Close, File Menu, Icon, Disk Icon, File. 

Close Box All file windows and application windows have a small square in the 
upper left-hand corner of the window on the title bar, called the "close box." When 
the pointer is moved to the square and the mouse button is clicked, the application 
or the file is closed. See Window, Title Bar, Mouse Button. 

j File Edit Uiew Special 
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Fig. (10 The pointer marks the close box on the illustrated window. 
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CLS A Microsoft BASIC statement is used to clear the screen. The format is: 

CLS 

The CLS statement will also return the cursor to the home position. In the text 
mode this is the upper left-hand corner of the screen. This means the "last referenced 
point" for future graphics statements is the point in the center of the screen. 

CMOS Complementary MOS. Technology characterized by extremely low-power 
consumption, widely used in portable applications and for battery-assisted memory 
systems. CMOS requires both p-channel and n-channel transistors, with speed and 
density characteristics intermediate between NMOS and PMOS. CMOS devices may 
operate from 3 to 12 V and have ideal noise immunity characteristics. Macintosh 
uses CMOS for the clock/calendar. 

COBOL Common Business Oriented Language. A high-level programming language 
developed for business applications with statements based on English. COBOL is 
popular on mainframes but not currently available for the Macintosh. 

Code A synonym for Program Instructions Code. This applies to program instructions, 
language statements or a symbolic representation for data, in any language, including 
Microsoft BASIC, machine language and others. See Program. 

Colon(:) Used for multiple statements on one line in Microsoft BASIC. You can put 
a colon(:) at the end of one statement and continue entering another statement on 
the same line, without giving a new line number. The line number at left refers to all 
statements on the line. An apostrophe(') allows a comment or remark to be added 
after a statement with or without a separating colon. 

The colon is also used in Microsoft Multiplan to designate a range of cells to be 
acted upon. For instance, if you wished to sum a range of cells between Row 12 and 
Row 15 in Column 3, you would designate this range in the formula with a colon as 
shown below: 

(@SUM(R12:15C3) 

See Microsoft BASIC Multiple Statements on One Line. 

Command Key Immediately to the left of the space bar on the Macintosh keyboard 
is the Command key, which works very much like the Control key or the Alternate 
key on other computers. It provides a number of special functions to the Macintosh 
user, one of which is to provide shortcuts for functions or options available from the 
various menus on the menu bar at the top of the screen. When you use one of these 
shortcuts, it has the same effect as using the mouse to select an option from a 
pull-down menu. It may also be used in combination with other keys on the 
keyboard to interrupt or suspend a program running in Microsoft BASIC, or to send a 
communication character to another computer. The table below lists the various 
uses of the Command key for the Macintosh applications currently available. 

APPLICATION MENU COMBINATION FUNCTION 

MPL Select CommA All Cells 
MD/MPL Edit CommA Select All 
MD Type Comm B Bold Type 
MP/MW Style CommB Bold Text 
MP/MW/MPL Edit Comm B Clear 
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MD/MP/MW/MPL Edit CommC Copy 
MB Control CommC Stop Program 
All File(Dir) Comm D Duplicate 
MD Edit Comm D Duplicate 
MPL Edit Comm D Fill Down 
All File(Dir) Comm E Eject Disk 
MP/MW Edit Comm E Trace Edges 
MPL Format Comm F Align Left 
MPL Format CommG Align Center 
MPL Format Comm H Align Right 
All File(Dir) Comm I Get Info 
MD Type Comm I Italic Type 
MP/MW Style Comm I Italic Text 
MP/MW Style Comm l Align Text to left 
MP/MW Style CommM Align Text from 
Middle 
MD File Comm N New 
MPL Select Comm N Define Name 
MP/MW Style CommO Outline Text 
MD File CommO Open 
MD Type Comm P Plain Type 
MP/MW Style Comm P Plain Text 
MPL Options Comm P Set Page Break 
MD Edit Comm R Reshape 
MP/MW Style Comm R Align Text to Right 
MPL Edit Comm R Fill Right 
MD File Comm S Save 
MP/MW Style CommS Shadow Text 
MPL Select Comm S Show Active Cell 
MB Control CommS Suspend Program 
MPL Edit CommT Absolute Reference 
MD Type Comm U Underline 
MP/MW Style Comm U Underline 
MPL Options Comm U Remove Cell 
Protection 
MD/MP/MW/MPL Edit CommV Paste 
MD/MP/MW/MPL EditComm X Cut 
MD Edit Comm Z Clear 
MP/MW/MPL Edit CommZ Undo 
MPL Calculate Comm = Calculate Now 

MD = MacDraw, HP = MacPaint, MPL = Microsoft Multiplan, MB = Microsoft BASIC, 
MW = MacWrtie and File(Dir) = File command menu while disk directory is being displayed. 

Command-C Refers to the process of pressing the Command key and the C key 
together. This key combination is used in Microsoft BASIC to stop a program. The 
program may be restarted by selecting Run from the Control menu or by entering 
RUN in the Command window. This key combination is also used in many applications 
as a shortcut used to copy highlighted material from the application to the Clipboard 
or from the Clipboard into an application. See Command Window, Clipboard. 

Command-. Refers to the process of pressing the Command key and the period(.) 
key together. This key combination is used to stop an action that is already in 
progress. For example, it is used to stop printing a document. 

Command Window The Command window is the window at the bottom of the 
Microsoft BASIC screen display when the user is editing program lines from a list or 
is entering program lines. This window only holds two lines of text unless the 
window is dragged up the screen to a new location and then stretched by placing the 
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mouse pointer on the size box in the lower right corner of the window and dragging 
the box down. I twill show up to five lines when it is at its largest size. It is used for the 
entry of commands and program lines in Microsoft BASIC. It is also used to edit 
program lines selected from a program list. Lines are selected from the list by placing 
the mouse pointer on the line number to be edited and clicking the mouse button. 

Comma(,) Each group of spaces across the print line, as defined by the WIDTH 
statement, is called a "print zone." A comma(,) in an LPRINT list of items means 
"start printing the following item at the start of the next print zone." Contrast this 
with the semicolon(;), which means the next item is to print immediately after this 
one, without a space between. See also WIDTH, Print Lines {Spacing). 

Comma, Double(,) To leave a lot of space on the print line between items, put an 
extra comma(,) in the print list. 

Enter Microsoft BASIC statement: LPRINT A,B 

This would print A in print zone 1, nothing in print zone 2 and put Bin print zone 
3. See also Print Zones, Print Lines (Spacing), SPACE$. 

Command A statement to cause a computer to carry out a specific action. Commands 
differ from instructions in several ways. A command is usually a complete specification 
of an action, while instructions must usually be combined in dozens or hundreds to 
make a useful program. Commands are immediate if they can be acted upon by 
typing them directly on screen and pressing the Return key. They are deferred if they 
must be included in a program line for the computer to act upon them. Commands 
are acted on by the operating system of the computer, while instructions must be 
processed by a particular program, such as the Microsoft BASIC interpreter, a 
FORTRAN or Pascal compiler, etc. 

Command Processor A program which accepts a command (usually from a keyboard) 
and causes it to be carried out. Some command processors contain the programming 
required for all commands they process. Others do not carry out commands directly. 
Instead, they examine the command, determine what other program (if any) can 
carry it out, locate the required program and start it running. Still another type of 
command processor carries out some commands directly (internal commands), but 
locates and runs other programs for some commands (external commands). 

Comment Field A field within an instruction, which contains explanations or remarks, 
ignored by the interpreter, the compiler or the assembler. 

Comments For insertion in Microsoft BASIC Programs, use REM as a way of including 
remarks or explanatory comments in a program. The apostrophe (') can be used 
interchangeably with REM, and the apostrophe can be used without a colon to 
indicate that the rest of the line is a remark. Examples: 

20 REM Just a comment 
30 ' Just a comment 
40 LET X = 1: REM Just a comment 
50 LET X = 1: ' Just a comment 
60 LET X = 1' Just a comment 

The colon(:) allows multiple Microsoft BASIC statements on one line. 
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COMMON A Microsoft BASIC statement used in conjunction with the CHAIN 
statement to pass variables to a chained program. The format is: 

COMMON <variable>,<variable> ... 

<variable> This refers to the name of a variable to be passed to the chained-to 
program. Array variables are specified by placing parentheses ()around the variable 
name. 

COMMON statements may appear anywhere in a program, but usually are placed 
at the beginning. Any number of COMMON statements may appear in a program, 
but the same variable cannot appear in more than one COMMON statement. If all 
variables are to be passed, use CHAIN with the All option and omit the COMMON 
statement. See CHAIN. Any arrays that are passed do not need to be dimensioned in 
the chained-to program. For example: 

100 COMMON A,SAMPLE1,C,D(),f$ 
11 0 CHAIN " PROGX" 

This example chains-to program PROGX on the disk in drive A:, and passes array'D 
along with the variables A, SAMPLE1, C and F$. 

Communications Programs These programs allow you to transfer data from your 
Macintosh to and from other Macintoshes, other computers and commerical services, 
such as The Source, Compuserve, etc. See Era 2, Mac Terminal, Trade*Pius. 

Compatible, Upward The term upward compatible indicates that programs developed 
for one version of a programming language, operating system, application software 
package or computer will work without alterations on an expanded, more powerful 
version of the same language, system or package. 

In hardware, upward compatibility refers to the possibility of building up to more 
powerful models without reprogramming. The Macintosh fits this definition to a 
large extent, since the new lisa models can run Macintosh software and provide a 
substantial increase in processing power. A program released by Apple Computer, 
Inc., called MacWorks is an example of a measure taken by Apple to ensure that 
Macintosh software will run on the lisa. 

Compile Time The point in the processing of a program when it is being translated 
from source code to object code by a translator (compiler or assembler). 

Compiler A translation program which converts high-level instructions into binary 
instructions for direct processor execution. Any high-level language, such as Microsoft 
BASIC or COBOL, requires a compiler or an interpreter. 

An interpreter translates each statement of the program each time the statement 
is executed, whereas a compiler translates the complete program once, producing 
object code that can be executed repeatedly. Any change in the program requires 
recompilation. The code produced by compilers may be longer and/or slower than 
that generated from assembly language source code. 

Compiler Programs See Programs, Source and Object. 

Complementing The action of changing each 1 to a 0, and each 0 to a 1. 

Complete Guide to Your Macintosh, The• By Joseph Caggiano and Roy Robinson. 
This book explains the Macintosh, its features and the peripherals that may be used 
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with it. Advanced applications and troubleshooting are presented in depth. It 
includes sections on BASIC and Pascal programming. Sybex. 

Computer A general purpose computing system incorporating at least a central 
processing unit, memory and 1/0 facilities. This describes a single board computer. 
Most computers also include a power supply and cabinet or case. 

Computer Accessories See Supplies, Accessories. 

Computer Memory See Memory. 

Computer System A complete system including the MPU, keyboard, CRT and other 
peripherals such as printers, disks, tapes, etc., and often includes programs. 

Concatenation of Data or Programs It is often desirable to produce a large data file 
or program by combining several existing files. This process is called "concatenation." 
In this process, two or more small files are combined to produce one large file 
without mixing the information together. All of the information from one file 
constitutes the first part of the resulting large file. The final part or parts of the large 
file contain additional files in one big chunk. 

Console The terminal with the most control in a system. For a microcomputer, the 
keyboard or the front panel and the monitor is the console. 

Constant An explicit value in a program instruction or statement rather than a 
symbolic value. The value is fixed throughout a program. 

CONT A Microsoft BASIC statement which causes program execution to resume 
after a Ctri-Break has been pressed, a STOP or END statement has been executed in 
the program or an error has occurred. The format is: 

CONT 

Execution of the program will continue at the point where the break occurred. If 
the break occurred following a prompt from an INPUT statement, execution will 
continue with the reprinting of the prompt. 

CONT is useful in conjunction with STOP for debugging purposes. When execution 
is stopped, you can examine or change the values of variables using direct mode 
statements. You may then use CONT to resume execution, or use a direct mode 
GOTO, which resumes execution at a particular line number. CONT is invalid if the 
program has been edited during the break. 

Control Characters Characters having specific system- dependent meanings. 

Control Characters for Printer To set the lmageWriter printer's print size, strike 
method or number of lines per inch down the page, the nonstandard type format you 
want must be turned on by sending control codes to the printer. This is a description 
of one nonstandard format: normal size, emphasized, double-strike, six lines per 
inch. 

To return to the default normal ten-character per inch print size and six lines per 
inch down the page (such as this sentence), the nonstandard type size currently in 
effect must be reversed. To do this use the ASCII codes in the following table: 
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Type Format 

Boldface 
Condensed Print 
Elite 
Elite Proportional 
Extended 
Headline 
Pica 
Pica Proportional 
Ultracondensed 
8 Lines/Inch 
6 Lines/Inch* 

Turn On 

27 33 
27 113 
27 69 
27 80 
27110 
14 
27 78 
27 112 
27 81 
27 66 
27 65 

Turn Off 

27 34 

15 

*Standard twelve dots per line (72/12 = 6 Lines/Inch). Set when printer is initialized or 
powered on. 

The following Microsoft BASIC program will help clarify how the lmageWriter 
printer can be set up for various types of printing. Alternatively, you may choose to 
key in the program and use it as a utility for controlling the printer. 

100' THIS PROGRAM WAS WRITTEN TO SET 
101 'THE IMAGEWRITER FROM THE MAC 
102 PRINT:PRINT:PRINT 
120 PRINT "THIS IS A PROGRAM TO ALLOW" 
121 PRINT "YOU TO SET UP VARIOUS" 
130 PRINT ''PARAMETERS OF YOUR IMAGEWRITER'' 
131 PRINT" PRINTER FROM THE MAC" 
140 PRINT "PRESS THE SPACE BAR TO CONTINUE" 
141 S$ = INKEY$ : IF INKEY$ = CHR$(32) GOTO 150 
150 CLS: PRINT: PRINT: PRINT 
160 PRINT TAB ( 5)" 1. PRINT EXTENDED PRINT" 
170 PRINT TAB ( 5)" 2. PRINT IN PICA PRINT" 
180 PRINT TAB ( 5)" 3. PRINT IN ELITE PRINT" 
190 PRINT TAB ( 5)" 4. PRINT IN PICA PROPORTIONAL" 
200 PRINT TAB ( 5)" 5. PRINT IN ELITE PROPORTIONAL" 
210 PRINT TAB ( 5)" 6. PRINT IN SEMICONDENSED" 
220 PRINT TAB ( 5)" 7. PRINT IN ULTRACONDENSED" 
230 PRINT TAB ( 5)" 8. PRINT IN CONDENSED" 
240 PRINT TAB ( 5)" 9. TURN ON BOLDFACE" 
250 PRINT TAB ( 5)"10. TURN OFF BOLDFACE" 
300 PRINT 
310 PRINT" ENTER THE NUMBER Of YOUR CHOICE" 
320 INPUT" AND PRESS RETURN ...... "; C 
330 CLS 
340 ON C GOTO 400,500,600,700,800,900,1000,1100,1200,1300 
350 IF C < 1 OR> 10 GOTO 150 
400 REM SET EXTENDED PRINT 
405 P$ = CHR$(4): EC$ = CHR$(27): ET$ = CHR$(110) 
410 LPRINT EC$; ET$ 
420 PRINT "YOUR PRINTER HAS BEEN SET FOR EXTENDED TYPE" 
425 GOTO 1600 
500 REM SET PICA PRINT 
505 EC$ = CHR$(27): PT$ = CHR$(78) 
510 LPRINT EC$ ; PT$ 
515 PRINT "YOUR PRINTER HAS BEEN SET FOR PICA PRINT" 
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600 REM SET ELITE TYPE 
605 EC$ = CHR$(27): ET$ = CHR$(69) 
610 LPRINT EC$; EP$ 
612 PRINT "YOUR PRINTER HAS BEEN SET FOR ELITE PRINT" 
615 PRINT: PRINT: GOTO 1600 
700 REM SET PICA PROPORTIONAL 
705 EC$ = CHR$(27) : PP$ = CHR$(112) 
710 LPRINT EC$; PP$ 
715 PRINT "YOUR PRINTER HAS BEEN SET FOR PICA PROPORTIONAL" 
720 PRINT: PRINT: GOTO 1600 
800 REM SET FOR ELITE PROPORTIONAL 
805 EC$ = CHR$(27): EP$ = CHR$(80) 
810 PRINT "YOUR PRINTER HAS BEEN SET TO ELITE PROPORTIONAL" 
820 PRINT: PRINT: GOTO 1600 
900 REM SET UP SEMICONDENSED 
905 EC$ = CHR$(27): SC$ = CHR$(101) 
910 LPRINT EC$; SC$ 
915 PRINT "YOUR PRINTER HAS BEEN SET TO SEMICONDENSED" 
920 PRINT: PRINT: GOTO 1600 
1000 REM SET UP UL TRACONDENSED 
1005 EC$ = CHR$(27): UC$ = CHR$(81) 
1010 LPRINT EC$; UC$ 
1020 PRINT "YOUR PRINTER HAS BEEN SET TO ULTRACONDENSED" 
1025 PRINT: PRINT: GOTO 1600 
1100 REM SET UP CONDENSED 
1105 EC$ = CHR$(27): CC$ = CHR$(113) 
1110 LPRINT EC$; CC$ 
1115 PRINT "YOUR PRINTER HAS BEEN SET TO CONDENSED" 
1120 PRINT: PRINT: GOTO 1600 
1200 REM SET UP BOLDFACE 
1205 EC$ = CHR$(27): BF$ = CHR$(33) 
1210 LPRINT EC$; BF$ 
1215 PRINT "YOUR PRINTER HAS BEEN SET FOR BOLDFACE" 
1220 PRINT: PRINT: GOTO 1600 
1300 REM TURN OFF BOLDFACE 
1305 EC$ = CHR$(27): BO$ = CHR$(34) 
1310 LPRINT EC$; BO$ 
1315 PRINT" BOLDFACE IS NOW TURNED OFF" 
1320 PRINT: PRINT: GOTO 1600 
1600 REM TEST PRINTER OR RETURN TO MENU 
1605 INPUT "WOULD YOU LIKE TO MAKE ANOTHER SETTING ?" ; R$ 
1610 CLS : PRINT: PRINT: PRINT 
1620 IF R$ = "Y" GOTO 150 
1700 REM TEST PRINTER 
1705 CLS : PRINT : PRINT : PRINT 
1710 INPUT "ENTER A 'Y' II 
1711 PRINT" IF YOU WOULD LIKE TO TEST THE PRINTER"; T$ 
1720 IF T$ = "Y" GOTO 1800 
1725 GOTO 1900 
1800 LPRINT "11111111222222223333333344444444" 
1805 LPRINT "ABCDEFGHIJKLMNOPQRSTUVWXYZ @ #$%&*()" 
1810 CLS:PRINT : PRINT: PRINT 
1820 INPUT "WOULD YOU LIKE TO MAKE ANOTHER SETTING ?(Y/N) "; U$ 
1830 IF U$ = "Y" GOTO 150 
1900 REM QUIT 
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1910 CLS: PRINT: PRINT: PRINT: PRINT: PRINT 
1920 PRINT TAB{ 20)"THANK YOU FOR USING THIS PROGRAM ... " 
1930 END 

Control Key The Control key on most computers extends the use of another key on 
the keyboard to accomplish a specific purpose, such as instructing a printer to print 
in condensed print, sound the computer's bell tone or whatever is defined by the 
application currently in use. This process is carried out on the Macintosh by the 
Command key instead of the Control key. See Command Key. 

Controlled Test Environment The software in the Macintosh with a program to be 
tested (which may determine your ability to detect and interpret errors) is the test 
environment. 

Similar features are included in Microsoft BASIC, via TRON, TROFF and the 
ability to stop the program at any time to examine the contents of variables with 
PRINT. This TRACE feature is a fundamental way of following the sequence of 
instructions executed in a program to ensure that the program's logic is correct. The 
Control menu also contains Trace On and Trace Off as options which may be 
selected with the mouse in Microsoft BASIC for the Macintosh. 

Control Menu Microsoft BASIC uses a Control menu to control the operation of 
programs. This menu contains seven command options: Stop, Continue, Suspend, 
list, Run, Trace On and Trace Off. Stop is used to halt a program that is currently 
running in memory. Continue is used to resume the running of a program that was 
halted by the Stop command. I twill also restart a program that was stopped with the 
Command-C keypress. Suspend stops the running of a program until a key is pressed. 
This works the same as stopping the program with a Command-S keypress. list opens 
a list window and lists the program currently in memory. Run is used to start the 
operation of the program currently in memory. Trace turns on a trace feature for use 
in debugging a program. It causes each program line to be listed as the program 
executes the line. Trace Off is used to turn off the trace feature. 

Control Panel The Macintosh Control Panel is a special interactive window allowing 
the user to change the time on the computer's clock, the date, the volume of the 
sounds generated by the computer's built-in speaker, the number of clicks required 
by the mouse button to run an application or select a command, the amount of 
linear movement required by the mouse to move the pointer across the screen, the 
nature of the background pattern displayed on the Desktop when disk icons are 
being displayed, the speed that a command blinks when it is being displayed, the 
rate at which the vertical bar cursor blinks when you are inserting material, the rate 
at which keys repeat when they are pressed continuously and the amount of time 
required to press a key to produce repeating characters. The Control Panel features 
are illustrated below. 

Convert Change from one form to another. 

Convert Decimal to Hexadecimal String See HEX$. 

Convert Decimal to Octal String See OCT$. 

Convert Number to String and String to Number See MKI$, MKS$, MKD$. 

Copy an Application Certain applications such as MacPaint and MacWrite may be 
copied from one disk to another or from a disk to a hard disk. These applicatons are 
most easily copied by opening the disk icon of the disk or hard disk to which the 
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application is to be copied, opening the disk icon or hard disk from which the 
application is to be copied, and dragging the application icon from one Directory 
window to the o ther. This process will ca use the applica tion to be copied from one 
disk to the other. If only the internal disk drive is in use, you will be prompted 
whenever it is necessary to swap disks. A n application may also be copied from one 
disk to another by dragging the application icon f rom the Directory wi ndow of the 
disk from which it is to be copied onto the disk icon of the disk to which it is to be 
copied. See Disk Icon, Directory, Window, Dragging. 

Control Panel 

Fig. C11 The Macintosh Control Panel. 

Copy a Disk The entire contents of one disk may be copied to another disk by using 
the Disk Copy program ava ilable from the disk directory of the MacWrite/ M acPaint 
disk. This application allows this entire operation to be accomplished in only four 
passes on a 128K Macintosh. The program prompts the user to exchange disks when 
required, if no external disk drive is available to the user and the copy is being made 
with only the internal disk drive. If the second disk is not a blank disk, an alarm box is 
d isplayed on the screen and the user is allowed to cancel or carry on the Copy 
process. If the user elects to carry on, the contents of the disk wi ll be overwri tten by 
the contents of the disk being copied . If the disk to which the copy is being made is 
not initia li zed, the copy program wi ll display a message informing the user that the 
disk is being initialized. A Cancel button is displayed in the lower left-hand corner of 
the screen. If the user places the pointer on this button and clicks the mouse button, 
the process will be cancelled. 

While the copy process is in progress, the screen display w ill show a bunch of 
meaningless garbage. This does not mean that something has gone wrong. It only 
means that the memory usally dedicated to video display is being used to hold the 
material being copied from one disk to the other. When the copy has been successfully 
made, the follow ing message is displayed at the bottom of the screen: " Disk copied 
successfully. Copy Another?" This message is accompanied by an OK button and a 
Quit button. If the user points to the OK button and cl icks the mouse button, the 
program directs that the disk to be copied be inserted in the disk dri ve. If this disk 
contains programs or data, the program asks the user if the disk should be erased by 
displaying a message that says " Erase Write/ Paint?" except the words " Write/ Paint" 
wi ll be replaced by the name of the disk inserted into the disk dri ve. It is a very good 
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practice to write-protect any disk that is being copied in case it has been inserted 
into the disk drive in the wrong sequence. See Button, Cancel Button, Disk Copying. 

Copy a Document Documents, applications or other files stored on a disk may be 
copied by first opening the disk icon of the disk containing the program to be 
copied. This is done by placing the pointer on the icon and double-clicking the 
mouse button, then the copy can be made by placing the pointer on the icon of the 
document to be copied and clicking the mouse button once. This causes the 
document's icon to be highlighted. Then move the pointer to the File menu on the 
menu bar, click the mouse button, and drag the highlight to the Duplicate option on 
the menu. When the mouse button is released, the document will be copied. 

A new icon will appear on the directory and will be given the name Copy of 
followed by the name of the file that was copied. The user can change the name of 
the document by placing the pointer on the extreme right side of the name, clicking 
the mouse button to cause the vertical bar cursor to be displayed, backspacing over 
the Copy of name and typing in the new file name. Copying can also be accomplished 
by pressing the Control key followed by the D key when the document's icon has 
been highlighted as discussed earlier in this entry. See Menu Bar, Icon, Document 
Icon, Dragging, Double-clicking, Control Key, Highlight. 

Copy Backup Disks Because disks can be rendered unreadable by physical damage, 
magnetic contamination, or dirt, it is wise to keep at least two copies of any 
important information. See Copy a Disk. 

Copy Option Used to copy information from one place to another. The original file 
is always left undisturbed. While an application is in use on the Macintosh, a menu 
bar is visible at the top of the screen. The Edit menu may be selected by moving the 
pointer to the word Edit. The Copy option may then be selected from this menu. This 
option allows the highlighted material in an application to be saved to the Clipboard 
without erasing the material. If the Cut option had been selected, this material 
would have been erased. Once material has been transferred to the Clipboard, it can 
then be used in another file or another application by using the Paste option from 
the Edit menu. See Edit Menu, Cut Option, Paste Option, Menu Bar, Pointer. 

Core A small magnetic torus (or doughnut) of ferrite used to store a bit of information. 
Cores can be strung on wires so that memory organizations of 32K 18-bit words can 
be packed into a space 1/2 by 6 by 6. One advantage of core is that it is nonvolatile. 
Also, as a holdover from the days when nearly all computer internal memory was 
core, the word is still sometimes used as a synonym for internal memory: core
image, in core, etc. 

CoreEdit A routine available from disk to supplement the text editor called TextEdit 
in the Macintosh's ROM. This supplement to TextEdit allows the Macintosh to use 
different type fonts and sizes from those in ROM. See TextEdit, Text Editor, ROM, 
Fonts. 

COS A Microsoft BASIC function which returns the trigonometric cosine function 
of <X>. The format is: 

<variable>= COS(<x>) 

<X>. is the angle whose cosine is to be calculated. The value of <X> must be in radians. 
To convert degrees to radians, multiply the degrees by Pl/180, where PI = 3.141593. 
The calculation of COS(<x>) is performed in single precision. 
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Covers See MacCover, Macintosh Covers. 

CP/M Control Program for Microcomputers. A popular single- user operating system 
for 808()-, Z8Q- and 8085-based microcomputers created by Digital Research. CP/M 
can not currently be run on the Macintosh. 

CPS Characters Per Second or Cycles Per Second. 

CPU Central Processing Unit. The computer device in charge of fetching, decoding 
and executing instructions, containing a control unit, an ALU and other related 
facilities with registers, clocks or drivers. The Macintosh uses the MC68000 CPU chip 
as a CPU. It not only does the things described above, but is also capable of storing 
and retreiving data from all of the Macintosh's memory addresses. The MC68000 
chip can process 32 bits of data at a time. It can put 16 bits of data at a time on the 
address bus for input or output. See Bit, Address Bus, Memory Address. 

CR Carriage return, 13 decimal or OD base 16. Command Register or Card Reader. 

Crash A situation where the system becomes inoperative due to a hardware or 
software malfunction. A head crash refers to the accidental impact of the read/write 
head upon the disk surface. 

Create Refers to making a new file on disk as opposed to modifying an existing file. 

Creating a Document Each time the Macintosh user opens an application program, 
such as MacWrite or MacPaint, and decides not to open a document file for an 
existing document, the application treats any entries made in the application as a 
new document. When this document is saved, a dialog box requests that the 
document be named. If an existing document is opened with the application 
program, and the user wishes to retain the old document with no changes along with 
the document as changed, the Save as ... option must be selected from the File menu 
on the menu bar. See MacWrite, MacPaint, Menu Bar. File Menu. Dialog Box, 
Document. 

Creator, The• A database program and report generator for the Macintosh that 
requires Microsoft Basic. A template is provided by the program to allow the design 
of a database. Each file may be made up of 32,767 records. Search and sort features 
are available. TNT Software, Inc. 

Crosshair· A crosshair pointer is used to change the controls on the Control Panel 
when it has been selected from the Apple menu. The crosshair pointer first appears 
as soon as the arrow pointer has been moved inside the limits of the Control Panel. 
The crosshair is used to select the item on the Control Panel to be adjusted. It is also 
used to make the actual adjustment. The crosshair is also used to set the time on the 
Alarm Clock when it has been selected from the Apple menu. See Control Panel, 
Alarm Clock. 

Crosstalk Two signals interfering with one another. 

CRT Cathode Ray Tube. A computer terminal using a CRT that displays characters 
or pictures. Also called a monitor, screen, terminal, etc. 

CSNG A Microsoft BASIC function which converts <X> to a single-precision number. 
The format is: 
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<Variable> = CSNG(<X>) 

<X> is the numeric expression which is to be converted to single-precision. 
See Numeric Precisions in Microsoft BASIC Conversions for details. 

Cursor Used by a computer to designate the point on the screen where the next 
action, such as inserting characters or entering a response, will take place. While 
actions are being taken with the mouse, a pointer shaped like an arrowhead is used 
to mark insertion points and to select options. Once an insertion point has been 
selected by moving the pointer to that location and clicking the mouse button, a 
vertical bar appears. This vertical bar is the cursor for character insertion for the 
Macintosh. It will blink to attract your attention to its location. 

Cursor POS is used in Microsoft BASIC to find the current location of the cursor. 

Cut 'N' Paste• A series of disks containing clip art for the Macintosh. Each disk is 
devoted to a particular subject, such as people or computers, and is accompanied by 
documentation that explains how each drawing was made. These drawings may be 
moved from the disk into an application via the Clipboard. Dreams of Phoenix, Inc. 

Cut Option An option from the top of the Edit menu on the Macintosh screen 
display. It is selected by placing the pointer on the word Edit and clicking the mouse 
button. Once this has been done, Cut is selected by scrolling the highlight down this 
menu until Cut is highlighted:The mouse button is then released and any highlighted 
material in the application on the screen will be erased from the screen and 
transferred to the Clipboard for pasting into another application or another file. The 
Clipboard may only hold one set of data at a time, so make sure that the material has 
been transferred to the new file prior to saving additional material to the Clipboard 
with a Cut or a Copy command. See Menu Bar, Edit, Mouse Button, Copy Option, 
Paste Option, Clipboard. 

CVI, CVS, CVD Microsoft BASIC functions used to convert string variable types to 
numeric variables. The formats are: 

<variable>= CVI(<2-byte string>) 
<variable> = CVS(<4-byte string>) 
<variable> = CVD(<B-byte string>) 

When numeric values are read from a random file, they must be converted from 
strings into numbers. CVI converts a <two-byte string> to an integer, CVS converts a 
<four-byte string> to a single-precision number and CVD converts an <eight-byte 
string> to a double-precision number. 

The CVI, CVS and CVD functions do not change the bytes of actual data, only the 
way Microsoft BASIC interprets those bytes. 

Related functions are MKI$, MKS$ and MKD$, which convert numeric-type data 
to string-type data. 

Cyborg* A text adventure game where the player is half man and half machine. His 
new powers assist him in solving the puzzle of the game. The adventure starts with 
the player lost in the woods with no food and power. Sentient Software. 
In UK: Softsel. 
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D ASCII = 68, HEX 44. d ASCII= 100, hex= 64. Also, the hexadecimal symbol for 
the decimal number 13. The following all represent the same number: 

Dbase 16 = 13 
13 base 10 = 13 
15 base 8 = 13 
1101 base 2 = 13 

Daisy Chain A method for prioritizing interrupts. Units capable of interrupting the 
system can either pass on a processor, acknowledge signal or block it. The highest 
priority is given to the unit electrically closest to the processor. Daisy chain is also 
used to describe the process of hooking up peripherals one to another, such as disk 
drives, rather than with separate connections from a single controller card. 

Daisy-wheel Printer An impact printer which has a wheel with radial spokes bearing 
type to produce letter-quality output. Currently the Macintosh is not set up to use a 
daisy-wheel printer. Printing with a Macintosh is a graphics dump rather than a text 
dump as required by a daisy-wheel printer. See Printers. 

Darker More Solid Printing Double Strike Printing causes the dot-matrix printer to 
reprint every character with a slight shift down on the page. The dots printed the 
second time fill in the vertical spaces between original dots creating a darker, more 
solid character. The lmageWriter does not produce double struck characters. It 
produces boldface characters in a similar fashion to double-struck characters. The 
lmageWriter final copy print is comparable to double striking with other printers. 
See lmageWriter, Bold. 

Data A synonym for information. In a computer context, it refers to data in some 
machine-readable format, such as a diskette file, information stored in ROM, 
cassette tape or another type of machine-readable media, that can be placed 
directly into the machine and processed without an intervening manual operation 
such as keying the data. 

DATA A nonexecutable Microsoft BASIC statement used in conjunction with the 
READ statement. It stores the numeric and string constants that are accessed by the 
program's READ statement(s). The format is: 

Data <constant><, constant> ... 

<constant> is a numeric or string constant. String constants in Data statements do 
not need to be surrounded by quotation marks, unless the string contains commas, 
colons or significant leading or trailing blanks. 

Data statements are nonexecutable. They can be placed anywhere in a program. A 
Data statement may contain as many constants as will fit on a line, and any number 
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of Data statements may be used in a program. The READ statements access the Data 
statements in line number order. The information that is in a group of Data 
statements can be thought of as one continuous list of items, regardless of the 
number of items on one line. 

If the variable type is defined in the READ statement as numeric, the corresponding 
constant in the Data statement must be numeric as well. If the variable type is 
defined as string in the READ statement, the corresponding constant in the Data 
statement must be string. For examples see READ. 

Data statements can be "reread" through the use of the RESTORE statement. In 
such cases, they are reread from their beginning. See RESTORE for details. 

Data Acquisition The collection of data from external sensors, usually in analog 
form. 

Database A systematic organization of data files for central access, retrieval and 
update. 

Database Programs See Creator, dBase Ill, Factfinder, FilePian, Friday, Habadex, 
Helix, NPL, Information Management System, Jack 2, Keystroke Data Base, Keystroke 
Report Base, Lotus Macintosh Product, Main Street Filer, Megafinder, Microsoft 
File, Omnis 1, Omnis 2, Omnis 3, PFS File, PFS Report, RGS Softmaker II, R:base 
2000, Telofacts 2. 

Data Bits The number of bits required by the Macintosh to make up a character sent 
or received by a communications program. Data bits are used to encode characters 
sent between computers. Either seven or eight bits make up each character. See Bits. 

Data Disk Used to store data. A disk is called a "data disk" when it is used primarily 
or totally to store data rather than programs. A data disk will usually not contain all 
of the system files {to save space). Likewise, "program disk" refers to a disk primarily 
used to store programs used to process data. A system disk is used principally to 
store system files (fonts, the Finder, etc.) and related utility-type programs. Often a 
disk will contain both data and the programs needed to process the data. 

Data File A named collection of information usually stored on magnetic media, 
which contains data to be processed by a program. 

Data or Program Concatenation Adding one item on at the end of the others to 
produce one longer data or program item. 

Datasaver• A back up AC power supply for the Macintosh. It is a 90-watt battery
powered unit providing power from five to fifteen minutes after an AC power failure. 
It includes transient suppression for voltage spikes, EMI noise filtering, a sealed 
rechargeable battery, two outlets, an audible alarm and a visible alarm. Cuesta 
Systems. 

Data Security In any computing system which keeps track of dollar amounts, 
quantities, etc., there is the possibility that data will be modified improperly. For 
example, in a payroll system, an individual with access to the computer system 
could modify their rate of pay, thereby causing the computer to produce a larger 
payroll check. Data security consists of measures that prevent tapering with data, 
tampering with programs and access to secret or private information. 

Data Statement A nonexecutable statement in a program, which contains data 
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elements separated by commas for use in the program by a READ statement. See 
DATA. 

Data Types A specific interpretation applied to binary data, such as integer, real, 
character, etc. 

Data-transfer Rate The rate of transfer of data from one place to another, such as 
from disk to memory or from memory to memory. 

Date, Setting The current date may be set on the Macintosh computer by placing 
the pointer at the Apple menu indicator in the left-hand corner of the display screen, 
clicking the mouse button, dragging the highlight to the Control Panel line and 
releasing the mouse button. This wi ll cause the Control Panel to be displayed on 
screen. One option that may be reset on the Control Panel is the date. This is reset by 
placing the pointer on the month, day, or year portion of the date on the clock and 
clicking the mouse button. This w ill cause an up-arrow button and a down-arrow 
button to be displayed in the clock section of the Control Panel display. The part of 
the date that is highlighted wi ll be advanced by using the up-arrow and retarded by 
using the down-arrow. See Control Panel, Alarm Clock, Set Date. 

j File Edit Uiew Special 

Fig. 01 The Clock Set portion of the Control Panel. 

DATE$ A Microsoft BASIC function and statement which is used to set or retrieve 
the date. The format is: 

As a function: 

<stringvariable> = DATE$ 
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$emA 10-character string of the form mm-dd-yyyy is returned. mm represents two 
digits for the month, dd represents two digits for the day and yyyy represents a four 
digit number for the year. 

As a statement: 

DATE$= <X$> 

Here <x$> is a string expression which is used to set the current date and may be 
entered in any one of the following forms: 

mm-dd-yy 
mm/dd/yy 
mm-dd-yyyy 
mm/dd/yyyy 

The year must be in the range 1980 to 2099. A 0 (zero) is assumed in front of the 
month or day if only one digit is used. If only one digit is used for the year, a zero is 
added before the digit entered to make two digits. If only two digits (yy) are given for 
the year, the year is assumed to be 19yy. For example: 

10 DATE$= "7/4/84" 
20 PRINT DATE$ 
RUN 
07-04-1984 

Here we set the date to July 4. 1984. Using the DATE$ function, a zero was placed 
in front of the '7" and the "4", and "19" was placed in front of "84" to display 1984. 
Hyphens were also placed between month, day and year where slashes were 
entered. 

DaVinci• A graphics program for the Macintosh presented in three packages: 
Buildings, Landscapes and Interiors. Each package consists of hundreds of design 
selections that may be used with MacPaint. These packages are useful to the 
professional landscape planner, architect, office manager and interior designer, and 
just as useful to the home owner and amateur landscape planner. Each component is 
scaled to provide the best quality in output. All designs and plans generated on 
DaVinci may be printed on the lmageWriter printer. Hayden Software. 

dBase m• An advanced, full-feature database manager offering the user the ability 
to handle extremely large files and use the information in the files to perform 
accounting tasks, inventory control, payroll and a large variety of other business
related tasks. It can also be used for other applications such as investment management, 
real estate management, medical management, insurance analysis and financial 
analysis. Ashton- Tate. 

DBMS Database Management System. A program providing a general mechanism 
for systematic storage and retrieval of data from a database. See Database. 

Deadline• A text adventure game for the Macintosh, the first in a series of murder 
mysteries. lnfocom, Inc. 

Debug or Test a Program A programmer must ensure that a program will correctly 
process all of the types of data for which it is intended. Samples of the data are 
prepared (test data) and the program is executed using this data (a test run). The 
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program's outputs (reports, screen displays, files, etc.) are then verified to be as 
specified. An error in the processing logic of a program is called a " bug," hence the 
terms "debug" and " bug-free." 

Debugger An essential program designed to facilitate software debugging. At a 
minimum, it provides breakpoints, dump faci liti es, reg iste r and memory 
examine/modify, preferably in symbolic form. 

Decimal Command The Decimal command is a command option that is ava ilable 
in Microsoft Multiplan's Format pull-down menu on the menu bar at the top of the 
screen display. This command is used by selecting Decimal from this menu after a 
cell or range of cells have been highlighted with the pointer. To highlight a cell, 
place the " plus sign" pointer on the cell you wish to format and click the mouse 
button. This will cause the cell to be highlighted as black on a white background. 
Then you wou ld select the Format menu and the Decimal option from this menu. To 
highlight a range of cells, you place the cursor on the fi rst cell to be highlighted and 
drag it to the last cell in the range. This can be done in rows, columns and blocks of 
cell s. The Decimal option then causes the numeric output of the cell to be displayed 
with the number of digits to the right of the decimal point equal to the number of 
digits set by the Number of Decimals option on the same menu. See Microsoft 
Multiplan, Cell , M enu Bar, Pull-down M enu, Pointer, Plus Sign Pointer, Format 
M enu. 

* File Edit Select ~~~~~O~p_!!ti!on~s~C~o~lc~u~lo~t~e!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!l'l 
t'./General 

······ ········ ················ 

Dollar 

Decimal 
Scientific 
Bar Groph 

Number Of Decimals ... 

........................................ . . . . . . ....... ............ .............. ........ . . . . . . 
··················· ······················ . . . . . . ....... .................................. 

~------------------1 : : 
Rllgn Left 
Rllgn Center 
Rllgn Right 

3CF 
3&6 
3CH 

···:··················=····· .. ···········; . . . . ................... ...................... . . . . . . ......................................... . . . . . . ········································· 1-··-······-···-·-··-·------·-······-----·--1 : : . . ......................................... 
. . Commas . . . . ......................................... 

1-···------·-·-·---·-···· .. ·-···· .. ··---·-··1 : : . . ········································· Column Width... : : 
••••• •• •••••••••••••••••OO•••••l-.;..,..------.----' ·":'"'''"''''"'''' :••oo •••••••••oo••• . . . . 
·· · · · ····· ·· ··· ·· ·~ ··················~····· · ············~····· · ············~··················~·················· 

Fig. D2 The Format Menu in Multiplan. 

Decimal Math Package Microsoft BASIC includes a subroutine ca lled the " Decimal 
Math Package." This subroutine provides the user wi th precision of up to fourteen 
digits. This degree of accuracy el iminates rounding errors in important business and 
financial calculations. See Subroutine. 
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Decimal Tab A decimal tab is a tabulation feature of a program that allows numbers 
to be ali gned in columns with the decimal point appearing in the same column. The 
dec imal tab function is a feature of some word processors. M acWrite has this 
particu lar feature. Use the arrow pointer to move the tab marker (a small triangle) 
along the ruler at the top of the screen display until the marker is in the proper 
position. This marker is moved by placing the the pointer on the triangle, pressing 
the mouse button and dragging the marker to the right column. At this point the tab 
setting is made for text. Next. p lace the pointer on the decimal tab marker icon on 
the left-hand side of the line immediately under the ruler on the display screen . This 
marker is a triangle wi th a dot in the center. This icon must be dragged to the tab 
marker that designates the column to be used for decimal alignment. Once this tab 
has been set, numbers in the column will be aligned on the decimal point in the 
column directly under the tab regardless of the number of digits entered to the right 
of the decimal point. See MacWrite, Word Processor, Ruler, Icon, Decimal Tab 
Marker, Dragging. An illustration of the MacWrite screen with decimals al igned on a 
decima l tab is presented below. 
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Decimal Tab Marker Th is is a device used by Mac Write to designate the location of 
a decimal tab on a line. The normal tab marker is a triangle. The decimal tab marker 
is a tri angle with a dot in the middle. To set a decimal tab, drag the decimal tab 
marker icon to the point on the ru ler that is marked w ith a regular tab marker. See 
Decimal Tab. 

Decimal to Hexadecimal String Conversion See HEX$ . 

Decimal to Octal String Conversion See OCT$. 



74 • DEF FN 

DEF FN A Microsoft BASIC statement which defines and names a numeric expression 
or equation. The format is: 

DEF FN<name>[<arg>[,<arg> ... >] = <expression> 

<name> is a valid variable name. This name, preceded by FN, will be the name of 
the function. 

<arg> is an argument. It represents a variable name in the function definition that 
will be replaced with a value when the function is called. 

<expression> defines the return value of the function. It can be numeric or string 
but must match the type that was declared by the <name>. 

The definition of the function is limited to one statement. Arguments <arg> that 
appear in the function definition serve only to define the function; they do not 
affect program variables that have the same name. A variable name used in the 
<expression> does not have to appear in the list of arguments. If it does, the value of 
the argument is supplied when the function is called. Otherwise, the current value of 
the variable is used. 

The function type determines whether the function returns a numeric or string 
value. The type of function is declared by <name>, in the same way as variables are 
declared. If the type of <expression> does not match the function type, a "Type 
mismatch" error is displayed. If the function is numeric, the value of the expression 
is converted to the precision specified by (name} before it is returned to the calling 
statement. 

A DEF FN statement must be executed to define a function before you may call 
that function. If a function is called before it has been defined, an "Undefined user 
function" error is displayed. On the other hand, a function may be defined more 
than once. The most recently executed definition is used. 

Default Value A program may provide a default value whenever it requires information 
to be input which is the same from one use to another in the majority of cases. This is 
a value which will be used if no other value is input. Pressing the Return key will 
cause the default value to be used, although many programs use other systems for 
specifying default values. If there are a large number of values to be specified, there 
will be a keying sequence which will cause default values to be used for all data 
items involved. 

DEFDBL A Microsoft BASIC statement which signifies that all variables listed are 
double-precision floating point numbers (numbers with decimal fractions up to 
sixteen digits). For example, if you place the statement: DEFDBL ABC at the 
beginning of your program, all variables starting with ABC (such as ABCDAT A, 
ABCMISC, etc.} will be double-precision floating point numbers. 

Otherwise double-precision floating point numbers can be declared by having 
their variable names end in #. 

Variable names must start with a letter, can have up to 40 characters, must not be 
any reserved words, such as IF, ON, THEN, COTO, etc., or a reserved word followed 
by a type declaration character($,%,!,#). See Reserved Words Microsoft BASIC for 
complete list. See also Variable Names. 

Define Name This is a command option used in Microsoft Multiplan to assign a 
name to a cell, a part of a row of cells, a part of a column of cells or a range 
of cells on this electronic spreadsheet. If the name is given to a cell that contains a 
formula such as a total of a column of cells, this name may be used in a subsequent 
formula instead of the formula in the cell which was given the name. Define Name is 
available from the Select menu on the menu bar at the top of the Microsoft 
Multiplan screen display. 
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Names assigned by this command may be up to 31 characters in length, may 
contain any keyboard character except a space and may not resemble a number or a 
cell reference. In the case of an individual cell, if the cell being named contains any 
text, this text will be proposed as the name of the cell by the program. If the cell is 
blank, the last name defined by the user will be proposed by the program in a dialog 
box. If the text in the selected cell contains blank spaces, these spaces are replaced 
with underline symbols. The Define Name command is a powerful tool for the 
Multiplan user. See Select Menu, Menu Bar. 

Define Name 

B.NHME ~ [ ) OK 
FIRST_TEN 

ro 
( Cancel ) 

Name: I H NHME I 
Fig. D4 An example of using the Define Name option in Multiplan. 

DEFINT A Microsoft BASIC statement. If you place the statement DEF INT ABC at 
the beginning of your program, all variables starting with ABC (such as ABCDAT A, 
ABCMISC, ·etc.) will be integer whole number variables because they start with a 
series of characters defined with the DEFINT string variable prefix. Otherwise 
integer variables must end in% for whole numbers from -32768 to+ 32767. Integer 
variable names must start with a letter, can have up to 40 characters, must not be any 
reserved words, such as IF, ON, THEN, GOTO, etc., or a reserved word followed by a 
type declaration character ($,%,!,#). See Reserved Words Microsoft BASIC for 
complete list. See also Variable Names. 

DEFSNG A Microsoft BASIC statement. DEFSNG signifies that all variables listed 
are single-precision floating point numbers (numbers with decimal fractions with up 
to six digits). For example, if you place the statement: DEFSNG ABC at the beginning 
of your program, all variables starting with ABC (such as ABCDATA, ABCMISC, etc.) 
will be single precision floating point numbers. 

Otherwise single-precision floating point numbers can be declared by having 
their variable names end in !. 

Variable names must start with a letter, can have up to 40 characters, must not be 
any reserved words, such as IF, ON, THEN, GOTO, etc., or a reserved word followed 
by a type declaration character($,%,!,#). See Reserved Words Microsoft BASIC for 
complete list. See Variable Names. 

DEFSTR A Microsoft BASIC statement. If you place the statement DEFSTR ABC at 
the beginning of your program, all variables starting with ABC (such as ABCDAT A, 
ABCMISC, etc.) will be string variables because they start with a series of characters 
defined with the DEFSTR string variable prefix. Otherwise string variables must end 
in $ for 0 to 255 letters, numbers, punctuation marks and other characters. String 
variable names must start with a letter, can have up to 40 characters, must not be any 
reserved words, such as IF, ON, THEN, GOTO, etc., or a reserved word followed by a 
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type declaration character ($,%,!,#). See Reserved Words Microsoft BASIC for 
complete list. See Variable Names. 

DEFtype A Microsoft BASIC statements which declares variable types as integer, 
single~precision, double~precision, or string. The format is: 

DEF type <letter>[ ~letter>][ <,letter>[ ~letter>]] ... 

<type> is INT, SNG, DBL or STR. 
(letter) is a letter of the alphabet (A~Z). 
The DEFtype statement declares that the variable names beginning with the letter 

or letters specified will be that type of variable. The DEFtype must preceed any use 
of the variables specified. See DEFDBL, DEFINT, DEFSNG, DEFSTR. 

Delay Loop Use to freeze or hold screen display (Microsoft BASIC). To freeze the 
screen briefly while the operator using your program reads a message, just write a 
delay loop after you print the message: 

1000 FOR Y = 1 TO 2000 
1010 NEXT Y 

To freeze the screen until the operator is done with it, put in a dummy input 
statement and instruct the operator to press ENTER to proceed. The input variable 
need not be used in your program: 

1000 INPUT" Press ENTER to continue" ;A$ 

DELETE A Microsoft BASIC command used to erase specified range of lines from a 
program. The format is: 

DELETE [<line1>][~1ine2>] 

<line1> is the number of the first line you want deleted. 
<line2> is the number of the last line you want deleted. 
Microsoft BASIC will return to command level after a DELETE is executed. A 

period (.) may be used in place of the line number to indicate the current line 
number. When you specify a line number that does not exist in the program, the 
error message "Illegal function call" will be displayed. 

For example: 

DELETE 100 

deletes line 100. 

DELETE 100~200 

deletes lines 100 to 200 inclusive. 
The DELETE statement is not implemented in Compiler Microsoft BASIC. 

Delete Character MacWrite, MacPaint, Microsoft BASIC, Microsoft Multiplan, and 
other applications for the Macintosh use the backspace key to delete characters 
from the screen. The I~ beam cursor must be placed to the right of the character to be 
deleted and the mouse button must be clicked. This causes a vertical bar cursor to 
appear at the pointer position if the user is in an edit mode. The backspace key is 
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then pressed causing the cursor to move one space to the left and delete tht> 
character to the left of its starting position each time the backspace key is pressed. 
See 1-beam, Mouse Button, Backspace Key. 

Delete File A f ile may be deleted f rom a Macintosh disk by dragging the file's icon 
from the Directory window to the Trash Can and instructi ng the system to Empty 
Trash. This operation is accomplished from the Finder. Fi les may be deleted while 
the user is in Microsoh BASIC by enteri ng DELETE followed by the fi lename in the 
Command window. Unless a specific volume (disk) name is provided or the fi le has 
been loaded from the external disk drive or a hard disk, Microsoft BASIC wi ll assume 
the file is located on the disk in the internal disk drive. See Trash, Command 
Window. 

Delete Name An option that is avai lable on the Microsoft Multiplan Select menu 
from the menu bar at the top of the screen display. It removes any name previously 
assigned to a cell, portion of a row, portion of a column or range of cells. This option 
may only be used if a name has been assigned to the cell or cells that were 
highlighted by the user prior to selecting the command. If this area of the spreadsheet 
has not been given a name earlier, the command option is dimmed on the menu. See 
Select Menu, Menu Bar, Define Name. 

j File Edit Search Format Font Style .. · .. swap meet 
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Fig. OS Positioning the 1-beam pointer to delete text with the backspace key. When the 
mouse button is clicked, this 1-beam becomes a vertical bar cursor. 

Deleting Cells A row or column of cells may be deleted from a Microsoft Multiplan 
worksheet by highlighting the row or column to be deleted and using the Cut option 
from the Edit Menu on the menu bar. Several rows or columns may be deleted in the 
same fashion. A single cell may also be deleted in the same way. This process 
removes the cells from the active worksheet and places them in the Clipboa rd where 
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they will remain until they are Pasted to a new location on the Worksheet or until 
another row, column, cell, or range of cells is saved to the Clipboard. See Cut 
Option, Paste Option, Menu Bar, Edit Menu, Clipboard. 

Deleting Text Text may deleted from any line in MacWrite by moving the 1-beam 
pointer to a position just to the right of the text to be deleted and clicking the mouse 
button. This action causes a vertical bar cursor to be displayed at the point in the text 
where the pointer was positioned when the mouse button was clicked. To delete the 
text to the left of the vertical bar cursor, press the Backspace key as many times as is 
required to remove the desired text from the screen. Once the desired text has been 
deleted, the pointer should be moved to the next point where text entry will begin 
and the mouse button should be clicked. This will move the insertion point for text 
to the new pointer location in the document. 

Text may also be deleted by placing the 1-beam to the left of the text to be deleted, 
clicking the mouse button and dragging the cursor over the text to be deleted. This 
text will be highlighted. It may then be Cut or Cleared from the pull-down Edit menu 
on the menu bar. Another method of clearing or deleting highlighted text is to press 
the Command key and the X key together or press the Backspace key. The same 
method can be used in MacPaint in the Text mode. It may also be used in Microsoft 
BASIC in the Edit mode when a line has been moved from the "List" window to the 
"Command" window for editing. See Mouse Button, Clicking, Vertical Bar Cursor, 
MacWrite, MacPaint, Microsoft BASIC, List Window, Command Window, Insertion 
Point. 

Delimiter A delimiter is a character which indicates the beginning or end of a 
sequence of characters, or separates one sequence of characters from another. In 
the English language, a space is the common delimiter used to separate words. Other 
delimiters are the comma, period between sentences, and a paragraph indentation 
to mark the beginning of a new paragraph. In computer language, spaces are often 
used as delimiters, as are commas, semicolons, colons, parenthesis, equal signs and 
various other special characters. 

DELTA A Microsoft Multiplan function that resets the internal value of DELTA used 
in a completion test or in iterations to zero. This function may be used to compute 
and present the amount of change in value as calculations are made in a particular 
part of a Multiplan worksheet. This type of calculation is called "finding the local 
value" of DELTA in a worksheet." 

Descenders The parts of printed or displayed characters that extend below the 
baseline. 

Descending Order To order material from highest to lowest in numeric value or 
alphabetically. The Multiplan Edit menu on the menu bar contains a Sort command 
option. When this option is selected, a dialog box is displayed. This dialog box 
allows the choice of ascending or descending order. If descending order is selected, 
the text or values in the highlighted row or column or highlighted portion of a row or 
column will be sorted in descending order. See Sort, Dialog Box, Menu Bar. 

Desk Accessories are special programs or areas of the Macintosh's memory available 
from Macintosh ROM that may be used by the applications currently available for 
the Macintosh. They are accessed by selecting the Apple menu from the menu bar of 
the screen display. They consist of a Calculator, an Alarm Clock, a Control Panel, a 
Note Pad, Key Caps, a Scrapbook and a Puzzle. 

The Calculator resembles a 10-key electronic calculator and allows routine 
calculations to be made using the mouse or the keyboard. The Alarm Clock displays 
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the current time in the upper right-hand section of the screen display when it is 
activated. It also sounds an alarm tone when it has been set. The Scrapbook can be 
used to hold text or pictures used frequently. This material may be cut from the 
Scrapbook and Pasted into various applications as needed. The Note Pad consists of 
eight pages of text notes that the user wishes to separate from documents being 
worked on . It also may be used to ed it material that cannot normall y be edited in an 
application. This material may then be cut from the Note Pad and Pasted back into 
the application from which it was cut. The Control Panel is used to set and adjust the 
volu me of the sounds generated by the Macintosh's speaker, the time and date of 
the computer's clock, the number of cl icks required to select or activate an application, 
the rate that commands on menus blink, the background pattern of the Desktop, the 
rate at which keys repeat, the rate of insertion point blinking and the response of the 
keyboard to touch. See Alarm Clock, Apple Menu, Menu Bar, Control Panel, 
Desktop Pattern, Insertion Point, Cut Option, Paste Option, Scrapbook, Note Pad. 

Desktop The Desktop is the manner in which the Macintosh's working environment 
is presented to the user. When a disk is first loaded, the desktop is presented . At that 
time, it consists of a background pattern, a menu bar, a disk icon and a trash can 
icon. It changes aspect as disk icons are opened, f ile fo lders are opened and file 
folders are closed . The Desktop is a visual representation of the applica tions and 
fi les that are available to the user. It may be organi zed by the user as he wishes by 
placing similar f iles together in f ile folders or by placing files along with particular 
applications in fi le folders. See Menu Bar, Disk Icon, Trash, Icon. 
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Fig. 06 The Macintosh Desktop display. 

Desktop File A file created by the Finder for each initialized disk and stored on the 
disk. This file is updated each time programs and data fi les are stored on or erased 
from a disk. It contains information about the disk itself and about each program or 
file on the disk. The Desktop fi le associates a data fi le with the application that 
created the data file. Thus, if you have written a letter or memo with Mac Write, it is 
asociated with MacWrite in the Desktop fi le. Then, i f you select the same memo 
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from the Desktop, MacWrite is opened automatical ly prior to opening the data file 
that is the memo. See Initialize a Disk, Finder. MacWrite. 
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Fig. 07 The Macintosh System Folder with the Desktop File high lighted. 

Desktop (From and to Microsoft BASIC) Microsoft BAS IC may be accessed from the 
Macintosh Desktop display as long as the M icrosoft BASIC disk has been inserted 
into the Macintosh's disk drive and the icon for this disk has been opened. To access 
Microsoft BASIC for the purpose of writing a new program, place. the pointer on the 
"Microsoft BASIC" icon on the Directory di splay and double-click the mouse 
button. This w ill cause Microsoft BASIC to be loaded f rom disk and make it available 
to the user. Microsoft BASIC may also be accessed at the same time that a program 
to be edited or run is loaded by p lacing the pointer on the program icon and double 
clicking the mouse button. This action w ill cause Microsoft BASIC to be loaded and 
then cause the program to be loaded and run. 

The Desktop display is accessed f rom M icrosoft BASIC by selecting the Close 
option from the Fi le menu. This causes the current program to be closed and causes 
Microsoft BASIC to be closed. Then the Desktop is d isplayed once more. See Mouse 
Button, Double-clicking, Clicking, Close, File Menu. 

Desktop Pattern The Desktop pattern is the background pattern that is d isplayed on 
screen when the Desktop display is being shown by an application. This pattern may 
be changed by accessing the Contro l Panel, placing the cursor on the right-hand 
Desktop display window and cl icking the mouse button. Then the crosshair is 
moved over to the left-hand port ion of the display w hich represents the screen 
pixels. By cl icking the mouse button while the crosshair is on a b lank spot, the pixel 
under' the crosshair is turned on. By placing it over a dark spot and clicking the 
mouse button, the pixel is turned off. The Desktop pattern may be made into a grid 
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or even changed to a blank white background by changing the pixels with the mouse 
button and the crosshair. See M ouse Button, Crosshair, Cursor, Contro l Panel, 
Desktop. 
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Fig. 08 The Desktop Pattern set on the Macintosh Contro l Panel. 

Destructive Backspace is carried out by the Backspace key on the M acintosh 
keyboard. This function causes the cursor d isplayed on the screen to move to the left 
one space and to erase the character currently to the left o f the cursor. This 
technique is useful in editing program lines or text. It is used along w ith the 
Backspace key in such applications as MacWrite and also by M acPaint in the Text 
mode. See Backspace Key, Cursor. 

Development System A computer system with the capabilities required for efficient 
hardware and software appl ication development for a given microprocessor. Such a 
system typically includes a microcomputer, monitor, printer, mass-storage (often 
disks or hard disk), PROM programmer and an in-circuit emulator. Software is often 
developed on a system to tally different from the system it will run on when the 
target system does not have enough memory or other resources to support development, 
or because the system is not actually available yet. 

Development Tools Hardware and software aids intended for use in developing 
programs and/ or hardware systems. These tools are made available to software and 
hardware developers by the computer manufacturers, as long as that company 
wishes to have products marketed for its computers by independent developers. 
Some development tools are marketed by independent manufacturers for computers 
that are manufactured by companies such as Apple. Such tools are generally not 



82 • Device Dependent 

possible unless the developer has the manufacturers support and has access to 
material supplied by the manufacturer. 

Device Dependent is a term associated with input and output. If a program or 
language is device dependent, it must be used with a particular computer or a 
particular peripheral, such as a modem or printer, or it will not function. Certain 
communications programs are device dependent as they will only function with a 
particular modem. Printer utility programs can generally be configured for several 
different printers. Computer languages are generally not device dependent in terms 
of peripherals. See Device Independent. 

Device Independent is generally used to describe a program or language that may 
address or access any device connected to a computer system by internal circuits or 
by external connectors such as plugs or ports. See Device Dependent. 

Devices and Ports A port is an address providing a connection between the computer's 
internal processor and an external device. Ports are used to attach input and output 
devices. 

Diablo A Xerox-owned company which makes computer peripherals and computer 
systems. A supplier of daisy-wheel printers. 

Diagnostics A set of routines used to diagnose system malfunctions and/or perform 
standard performance tests. The Macintosh's start-up diagnostic programs are examples. 

Dialog Box Special windows called dialog boxes are used to inform the Macintosh 
user of the options that are open when working with an application or a programming 
language. The dialog box presents a message when the user exercises an option that 
requires a decision or requires giving an instruction to the computer or its peripherals. 
It also presents two or more buttons that may be used to indicate the decision made 
or the instruction to be carried out. Dialog boxes are used to decide whether or not a 
disk should be formatted, to name a document being saved, to instruct the program 
to save a document, to provide detailed instructions for the use of a printer and all 
other things that require decisions or instructions from the user. See Window, 
Button. 

Dialog Manager The Dialog Manager is a collection of about 23 subroutines in the 
User Interface Toolbox in the Macintosh ROM. These subroutines are used to create 
and handle dialog boxes and alert boxes. 

Die/Dice The circuit elements built of small rectangular pieces of silicon on a 
wafer. Each wafer has several dozen to hundreds of rectangles or dice. Once 
mounted in a package, they are called a chip. 

Digital Having discrete states. Digital logic may have from two to sixteen states. 
Most logic is binary logic with two states, on or off. 

Digitizer A device which converts analog information to its digital equivalent. 
Often used for devices obtaining input from a plotting surface and providing 
coordinates as output, such as a graphics tablet. Digitizers are often used to convert 
images viewed by a TV camera to pictorial images on a computer screen or to images 
that may be printed on a printer such as the lmageWriter. Digitizing is used in 
mapping and in space exploration to allow data to be sent over long distances by 
radio-like transmissions. 
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Digitizers See Video-Digitizer. 
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DIM A Microsoft BASIC statement which gives BASIC information about how data 
will be named. It causes space to be reserved, but does not perform any operations 
on the data. To understand the function of DIM, you must first understand the 
fundamental concept of arrays. An array is a group of data quantities, all the same 
type, that form a group to be processed in a similar way. Suppose, for example, you 
need to write a program that accepts 20 numbers from the operator, then performs 
calculations based on all 20 numbers. A brute force approach to this problem would 
produce twenty names: NUMBER1, NUMBER2, ... , NUMBER19, NUMBER20. The 
program to read these from the operator would look like this: 

110 INPUT "FIRST NUMBER" ,NUMBER1 
120 INPUT "SECOND NUMBER" ,NUMBER2 

190 INPUT" NINETEENTH NUMBER" ,NUMBER19 
200 INPUT "TWENTIETH NUMBER" ,NUMBER20 

Subsequent calculations on the numbers would be even more cumbersome. It is 
easy to imagine the statements required to calculate the sum, the average, and other 
statistical measures. Of course this approach totally misses the point of the computer's 
ability to use loops. Arrays give us the ability to name the individual numbers (or 
character strings) in a related collection in a way that simplifies repetitive operations. 
To name our group of 20 numbers, we would use the DIM statement: 

10 DIM NUMBER(20) 

This informs BASIC that a group of 20 numbers will be used. All of the numbers 
have the generic name NUMBER followed by a number from 1 to 20 in parenthesis. 
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The first number is NUMBER(1 ), the second number is NUMBER(2) and the twentieth 
number is NUMBER(20). When we combine this flexible naming convention with 
the ability to use a variable inside the parenthesis, processing becomes very easy. To 
read in the 20 numbers, for example, use the following short program: 

10 DIM NUMBER(20) 
20 FOR SUBSCRIPT= 1 to 20 
30 INPUT" NUMBER(" ,SUBSCRIPT,") =" ,NUMBER(SUBSCRIPT) 
40 NEXT SUBSCRIPT 

Notice how we broke into the prompt in statement 30 to inset the subscript (or 
positioning number within the group of related items). Once these numbers are in 
the computer, performing various operations on each member of the group is easy. 
The following code will compute and print out the sum of the 20 numbers read 
above: 

50 FOR SUBSCRIPT =1 TO 20 
60 SUM=SUM + NUMBER(SUBSCRIPT) 
70 NEXT SUBSCRIPT 
80 PRINT SUM 

Once you have got the general idea, there are thousands of ways to use subscripts 
for both numbers and character strings. Most books on BASIC programming will give 
more examples of how to use subscripts with dimensioned arrays to solve common 
types of programming problems. 

Often data is in the form of a table, where each entry is in a certain row and 
column location. Data in this form requires two subcripts for unique specification, 
such as TABLE(2,14). This specifies a particular number at row 2, column 14 of a 
table of related data numbers known collectively as TABLE. Use the DIM (short for 
dimension) statement to let BASIC know how much space to reserve for this group of 
data items. BASIC uses the maximum subscripts stated in your DIM statement to 
determine if your loops may have gone awry by asking for a data item with a 
subscript larger than planned for or for which it does not have data values. If your 
table of data items contains 30 columns and 20 rows, the DIM statement would be: 

10 DIM TABLE(30,20) 

Looking at the DIM statement more generally, up to 255 different maximum 
subscripts may be specified for a single array name such as TABLE. While problems 
requiring more than two subscripts are rare, they do occur. Also, you can list as many 
variable names with their maximum subscript values as you like in one DIM 
statement, separating them with commas. The maximum subscript value is 32767, 
large enough for most everyday problems. 

Now for some little twists. Probably because old-line computer programmers like 
to start numbering things from zero instead of 1 to squeeze the most possible 
different numbers out of a fixed number of bits, subscripts start from zero instead of 
from 1. Fortunately, you can override this often confusing situation by placing an 
OPTION BASE 1 statement at the start of your program. This informs BASIC that you 
like to count data items starting from 1. But if you leave it out, all subscripted data 
items will have one extra slot named, for example, NUMBER(O). Put in the OPTION 
BASE 1 unless there is some very good reason why you need to start counting data 
items from zero. 

Next, if you need a quick and dirty program in a hurry, BASIC will let you use an 
array without a DIM statement. In this case the maximum subscript is 10 by default. 
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However, fa iling to explicitly dimension your arrays and tables will often come back 
to byte you in the end. · 

Other interesting notes about DIM and the arrays it creates are: 
All numeri c data items in arrays have a starting value of zero. 
All strings in arrays have a starting value of null-the string of length zero. 
The rules for variable types apply to arrays just as to individual variables. 
You can only dimension an array once unless you ERASE it. 
Arrays and the DIM statement are the key to short programs which process large 

amounts of data. 

Dimmed Commands When a menu is selected from the menu bar, the commands 
that are currentl y avai lable are listed in bold text under the Command Options. 
Commands that are currently not avai lable for use appear dimmed and are genera lly 
hard to read, and may not be available in the particu lar work ing context you are 
currently using. For example, if you are using MacWrite and access the Edit menu, 
the Paste option will not be available if there is nothing on the Clipboard. The Cut, 
Copy, Undo and Show Clipboard command options will be highlighted and the 
Paste command wi ll be dimmed. See Menu Bar, Edit Menu, Cut Option, Copy 
Option, Paste Option, Undo Option. 
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Fig. 010 Example of dimmed commands on Edit menu. 

Dimmed Icon is displayed on the Desktop for a disk that is not currently in a disk 
drive. This icon is much less substantial than an icon for an active disk. The dimmed 
icon is displayed when a disk has been ejected from the disk dri ve to allow another 
disk to be loaded and used. The disk that is currently in the disk drive is highlighted 
whi le the ejected disk is dimmed. See Icon, Desktop. 

DIP Switches A collection of small switches on a Dl P, used to select options on a 
circuit board w ithout modifying the hardware. Printers such as the lmageWriter 
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have DIP switches for ensuring that certain circuits are open and certain options are 
available to the user. The DIP switch settings for the lmageWriter are listed below: 

SWITCH SETTING FUNCTION 

1-1 OPEN When all three of these switches are open. American 
1-2 OPEN text and accents are used. 
1-3 

1-1 CLOSED When these switches are set in this configuration, 
1-2 CLOSED British text and accents are used. 
1-3 OPEN 

1-1 OPEN When switches are set in this congifuration, German 
1-2 OPEN text and accents are generated. 
1-3 CLOSED 

1-1 OPEN When switches are set in this configuration, French 
1-2 CLOSED text and accents are generated. 
1-3 CLOSED 

1-1 CLOSED When switches are set in this configuration, Swedish 
1-2 OPEN text and accents are generated. 
1-3 CLOSED 

1-1 CLOSED When switches are set in this configuration, Italian 
1-2 OPEN text and accents are generated. 
1-3 OPEN 

1-1 CLOSED When switches are set in this configuration, Spanish 
1-2 CLOSED text and accents are generated. 
1-3 CLOSED 

1-1 OPEN When switches are set in this configuration, American 
1-2 CLOSED text and accents are generated. 
1-3 OPEN 

1-4 CLOSED Page Length = 72 lines. 
1-4 OPEN Page Length = 66 lines. 

1-5 CLOSED Ignores eight data bit. 
1-5 OPEN Uses eight data bit. 

1-6 OPEN Configured along with 1-7 to print Pica. 
1-7 OPEN 

1-6 CLOSED Configured along with 1-7 to print Elite. 
1-7 OPEN 

1-6 OPEN Configured along with 1-7 to print Ultracondensed. 
1-7 CLOSED 

1-6 CLOSED Configured along with 1-7 to print Elite Proportional. 
1-7 CLOSED 

1-8 OPEN Adds line feed after CR. 
1-8 CLOSED No line fee after CR. 

2-1 OPEN Configured along with 2-2 
2-2 OPEN sets baud rate at 300. 

2-1 CLOSED Configured along with 2-2 
2-2 OPEN sets baud rate at 1200. 

2-1 OPEN Configured along with 2-2 
2-2 CLOSED sets baud rate at 2400. 

2-1 CLOSED Configured along with 2-2 
2-2 CLOSED sets baud rate at 9600. 

2-3 OPEN Setx XON/XOFF protocol. 
2-3 CLOSED Sets Data Terminal Ready protocol. 
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This table summarizes all of the DIP switch settings that may be used with the 
lmageWriter. The normal switch settings for the Macintosh are as follows: 

SWITCH SETTING 

1-1 OPEN 
1-2 OPEN 
1-3 OPEN 
1-4 OPEN 
1-5 OPEN 
1-6 CLOSED 
1-7 OPEN 
1-8 OPEN 

2-1 CLOSED 
2-2 CLOSED 
2-3 OPEN 
2-4 CLOSED 

Directory The table of contents of a file system which allows convenient access to 
specific files. The Macintosh's disk Directory is used by the Finder to locate a 
particular file on a disk. The Directory includes the name of each file and a notation 
of the tracks on the disk on which the file is stored. See Finder. 

Directory Window When a disk icon is opened on the Macintosh D~sktop, a 
window is displayed. This window lists the programs, files, documents and applications 
that are stored on the disk. The window and its contents are produced by the Finder. 
It may be viewed by icon, by name, by size, by type and by date as selected from the 
Special menu on the Menu bar. The default display is by icon. See Desktop, Icon. 

Disk A flat, circular magnetic storage medium which is rotated while in use. The 
material used to record data is very much like recording tape although it is circular 
instead of flat. The Macintosh uses 3-1/2 inch disks in plastic mountings with metal 
hubs and a read/write slot that is protected by a sliding metal door. These disks may 
be write-protected by using a sliding tab on the lower right-hand corner of the disk. 
Each single-sided disk can store up to 400K of information. When double-sided disks 
become available, they will store up to BOOK of information. Data is stored on a 
flexible, magnetically sensitive, coated plastic disk that rotates very quickly inside a 
plastic envelope. These disks are sometimes called "microfloppy disks." 

Each disk drive has a read/write head that travels over the disk as it rotates and 
reads data from the disk or writes data to the disk as directed by the program or the 
user. The disk rotates at a speed between 390 and 605 revolutions per minute. Data is 
recorded on 80 concentric rings or tracks on the disk's surface. The outermost 
sixteen tracks on each disk are divided into twelve sectors. The second set of sixteen 
tracks are divided into eleven sectors. The third set of sixteen tracks are divided into 
ten sectors. The fourth set of sixteen tracks is divided into nine sectors. The fifth and 
last set of sixteen tracks is divided into eight sectors. The disk is rotated at a slower 
speed when the disk head is reading or writing the outer tracks. This speed is 
controlled by the disk drive controller circuitry on the Macintosh's analog board. 
The process of setting up a disk so that it may be used by the computer and the 
programs used with the computer is called "formatting" or "initializing." 

Disk, Backup Because disks can be rendered unreadable by physical damage, 
magnetic contamination or dirt, it is wise to keep at least two copies of any 
important information. 

See Disk Copying. 
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Disk, Bad Sector A sector on the disk which will not read/write data correctly. 
Usually due to a minor physical flaw in the disk. One or two bad sectors will not 
seriously affect the disk's use. The Macintosh will mark them as bad and avoid using 
them. If more than one or two bad sectors are found, the files that are accessible on a 
disk should be copied onto another disk and the bad disk should be trashed. 

Disk Buffer A disk buffer is an area of a computer's Random Access Memory 
(RAM) set aside to hold information that has not yet been written to disk. The 
Macintosh uses the disk buffer to keep information about those disks that have been 
inserted in a disk drive although the disks may not currently be in the disk drive 
because they have been ejected for one reason or another. Certain application 
programs used on the Macintosh also use the buffer as a holding area prior to writing 
information to disk. These programs empty the buffer by "flushing" it prior to 
allowing the disk to be ejected. Any time the Finder is used to eject a disk, it flushes 
the buffer. See RAM, Eject Disk. 

Disk Capacity Measured by the number of kilobytes of information that may be 
stored on a disk. The capacity is dictated by the size of the disk's recording surface, 
the ability of the read/write head to track on this surface in small increments as it 
moves back and forth toward or away from the center of the disk, the ability of the 
disk controller circuitry to interpret information read by the disk, the ability of this 
circuitry to control the amount of movement of the read/write head, the number of 
read/write heads and the manner in which a disk is formatted. Each of these factors 
influence the capacity of a disk. 

Currently, the Macintosh is equipped with a single-sided disk drive with only a 
single read/write head. The Macintosh uses single-sided disks that can store up to 
400K of information. Double-sided disk drives, using disks with BOOK capacity, will 
probably be available for the Macintosh shortly. This capacity could be increased 
even further if the disk controller circuitry and formatting methods were changed, 
and if the read/write heads on the disk drives could read narrower tracks as 
accurately as they read tracks with the current track width and current spacing 
between tracks. See Formatting a Disk, Initialize a Disk, Track, Sector, Double-sided 
Disk, Single-sided, Kilobyte. 

Disk Care Since disks are really made of mylar or mylar- type material that has been 
treated to record electronic signals, they are somewhat delicate. Disk manufacturers 
take measures to protect disks and to give them as much useful life as possible. The 
recording surface is attached to a metal hub that allows the disk to be rotated at high 
speeds without damage. The recording material is enclosed in a semirigid plastic 
case lined with dust- collecting material impregnated with a lubricant to protect the 
disk as it is rotated. The slot used by the read/write head is protected with a sliding 
door that is opened when a disk is inserted in a disk drive. Each disk is provided with 
a write- protect feature that allows the user to ensure that no data can be written to a 
disk if he wishes to protect the material already saved on the disk. 

All of these measures are designed to protect the disk itself from damage and to 
protect the data on the disk. The disks used by the Macintosh are hardier than those 
used on other computers. Although this is the case, these disks and the data they 
hold can still be damaged if the user does not exercise care. The door that protects 
the read/write slot should be closed when a disk is not in a disk drive. It prevents dust 
from collecting on the recording surface of the disk. and prevents the user from 
touching the surface and getting skin oil or perspiration on the surface of the disk. 

The recording surface of a disk can be damaged by dust and foreign material, and 
disks should never be left out where liquids can be spilled on them or where they can 
be crushed or bent. They should not be exposed to magnets which will disrupt the 
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data stored on the disk or may even cause it to be erased. Disks should not be 
subjected to extreme heat or to extreme cold as they could suffer physical damage 
that makes them useless. They should not be exposed to direct sunlight for long 
periods of time as this could damage the recording surface. Disks should be treated 
with respect as they normally hold programs and data that is valuable to the user. 
They should be stored in a safe place that is not subj~ct to magnetic influences, 
extreme heat, extreme cold, heavy dust or liquid damage. 

Disk Compatibility Disks are compatible if they can be used by more than one 
computer system. Compatibility depends on the similarity of the disk drive mechanisms 
used to read the disk or write to it, and on the manner that the disk has been 
formatted. Currently, the disks that have been formatted on a Macintosh can only be 
used by a Lisa2 which has the same type of disk drive as the Macintosh. See Disk 
Drive, Formatting a Disk, Lisa. 

Disk Copying As you find more and more uses for your Macintosh, you will also find 
certain programs that you use frequently and have generated document files, 
graphic files or data files that are important. Since things can go wrong with 
computer systems or disks can be damaged in a number of ways, ensure that you 
have duplicate copies of those programs that you value or use frequently. Also 
ensure that any documents, data files or graphic files you value are duplicated. 
Some commercial programs are protected from being copied by the user. The 
program documentation should tell you whether a disk may be copied or not. Disks 
that contain data that is written by commercial programs can generally be copied by 
any disk copy program. If this is not the case, the manufacturer will supply a special 
copy program that allows data to be backed up. 

Disks that contain programs you have written or programs that are not commercial 
can be copied with a utility program that is on your System Disk or on many 
application disks. This program is called "Disk Copy." To use the program, insert a 
disk that contains the program into the disk drive. When the disk icon is displayed, 
place the pointer on the disk icon and double-click the mouse button. This will 
cause a disk directory to be displayed on the Desktop. Move the pointer to the disk 
copy icon and double-click the mouse button. This will cause the program to be 
loaded from the disk and to be run. The disk that contains the program will eject 
automatically after the program has been loaded and has begun to run. 

A message will appear on the screen that describes the disk copy program and 
instructs you to insert the disk you wish to copy in the internal disk drive. The 
computer will read this disk and will copy the contents of the disk into the 
Macintosh's RAM until RAM is full. A message appears on the screen indicating that 
the first quarter of the disk is being read into memory. When RAM is full, the disk will 
be ejected automatically. A message asking you to insert the disk to be used for the 
copy will then appear on the screen. Insert a blank disk or a disk that you wish to use 
for the copy. If the disk is blank, the program wi II display a dialog box that asks if you 
wish to initialize the disk. Instruct the program to initialize the disk at this time. If 
the disk is not blank, the program will ask if you wish to erase the contents of the disk 
currently in the disk drive. If not, cancel the copy command and the disk will be 
ejected. This is done by placing the pointer on the Cancel button on the screen 
display instead of the OK button and clicking the mouse button. 

The program will then direct you to insert the disk you wish to use for the copy. 
This disk is called a "destination disk" by the program. Insert a disk that you wish to 
use, then activate the OK button. The destination disk will be formatted by the copy 
program. The program will write the material stored in RAM onto the disk and will 
eject the destination disk and instruct you to insert the source disk. Insert the disk 
you are copying. The program will then read the second quarter of this disk into 
RAM, eject the disk and instruct you to insert the destination disk. 
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This cycle will occur two more times until the entire disk has been copied. Then 
the program will inform you that the copy has been made successfully and will ask if 
you wish to make another copy. If the copy has not been made successfully, you 
may have to go through the copy process again. 

About Disk Copy 

With Disk Copy you con copy entire disks quickly using a 
one-driue system. 

Messages at the bottom of the screen will ask you to insert 
alternately the disk you want to copy and the destination disk. 
Rny uninitialized destination disk will be initialized 
automatically. 

To minimize the number of disk swaps needed, Disk Copy uses 
the space In memory that's allocated to the screen display; 
therefore, unusual patterns will appear on the screen during 
the copying process. 

OK Cancel 

Fig. D11 

Disk, Destination The same thing as a target disk. It is the disk to which a program, 
file or document is being copied from another disk. 

Disk Directory On each disk Macintosh maintains an index or directory of all files. 
See Directory. 

Disk Drive A disk drive is a device used to record data on a magnetic medium 
similar to recording tape, and to read data that has been stored on such a medium. 
This magnetic medium is cut into a very thin disk fixed inside of a protective cover. 
Since the recording medium is a disk, the device that reads from it and writes to it is 
called a "disk drive," which uses read/write heads to read data from or to write data 
to a disk. When data is written to a disk, it is copied from the computer's RAM to the 
disk via circuits within the computer or via a plug-in circuit board called a "disk 
controller card." The Macintosh uses built-in circuitry on the analog board to 
control the communication between the computer and the disk drive. 

If a disk drive has a single read/write head, it is called a "single-sided drive" and 
requires disks manufactured to accept data on a single side. If a disk drive has two 
read/write heads, these heads are located opposite each other on either side of the 
disk and are called "double-sided disk drives." The read/write head or heads on a 
disk drive are positioned over the read/write slot on the disk. If a disk drive can use 
8-inch disks, it is called an "8-inch drive." If it can handle 5-1/4-inch disks, it is called 
a "5-1/4-inch drive." The Macintosh uses 3-1/2-inch single-sided disks at present. 

Disk drives may be installed internally in the computer's case or may be external 
devices connected to the computer system by cables. The Macintosh has an internal 
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disk drive that uses single-sided disks with 400K storage capacity. It can use an 
external disk drive that is attached via the disk drive port on the back panel of the 
computer. A disk drive is very much like a typical record player, causing the disk to 
spin at a high rate of speed and reads the data from the disk or writes the data to the 
disk while it is spinning. The Macintosh varies the rate of spin according to the 
location of the read/write head on the disk. When the head is on the outer tracks of a 
disk, the speed is much slower than when it is reading from or writing to the 
innermost tracks on a disk. 

A disk drive and its controller circuits depend upon the manner in which a disk is 
formatted or initialized to use the disk. When a disk is formatted, it is set up to 
accept data and to inform the controller circuits where the head is at all times. 
Macintosh disks are formatted in the manner described in the Disk entry and in the 
Formatting Disks entry. See also Disk,• Disk Drive Controller, Read/Write Head, 
Track, Sector. 

Disk Drive, Connecting An external disk drive can be connected to the Macintosh 
via the second port from the left on the back panel of the computer. The connection 
is made by plugging one end of a connector cable with the proper plug into this port 
and tightening the locking screws on either side of the connector. The other end of 
this cable is connected to a compatible external disk drive. Currently, the only 
compatible disk drive is one produced for Apple Computer by Sony. 

Disk Drive Controller The circuits that control the communication between the 
computer and its disk drives are called the "disk drive controllers." These circuits are 
placed on plug-in cards on the Apple Ill computer and on all of the Apple II family of 
computers except the Apple I /c. The Apple I /c and the Macintosh use a single chip 
called the "IWM" (Integrated Woz Machine) as a disk drive controller. The Macintosh 
controller, which is a variable speed controller, differs from the controllers on other 
computers. The disk spins faster when the disk head is located on the outer tracks of 
the disk and spins slower when the head is located on the inner tracks. This method 
ensures that data is written accurately to the disk and read accurately from the disk. 
See Track, Chip. 

Disk File A file residing on a disk which may consist of data generated by a program, 
a program written in a computer language used by the Macintosh, a system file that 
is used by the Macintosh to operate successfully, a document generated by an 
application program or an application program written by the user or by a commercial 
software vendor. 

Disk, Floppy A flat circular sheet of mylar substrate coated with a magnetic oxide, 
rotating inside a protective jacket which continuously cleans the surface. This term 
is frequently used to describe 5-1/4-inch disks used on computer systems other than 
the Macintosh. The 3-1/2-inch disks used by the Macintosh are called "microfloppy 
disks." 

Disk, Free Space On A The free space on a disk is displayed by the Finder when the 
disk is booted and the disk icon has been clicked. The disk directory is displayed in a 
window on the screen along with the amount of free space available on the disk. 
Free space is the amount of disk capacity expressed in kilobytes available for data 
storage after subtracting the amount of space taken up by system files, data files, 
documents and programs. See Disk Icon. Directory, Window. 

Disk Icon The Macintosh uses pictorial representations of files, documents, applications 
and disk drives to identify each of these things to the user. These pictorial representations 
are called "icons." When a disk is inserted in a Macintosh disk drive, an icon 
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resembling a disk is displayed on the Desktop. This icon is positioned right over the 
name of the disk (volume). When this icon is clicked, a Directory display is opened 
on the Desktop. This directory lists all of the files, file folders, applications and 
documents on the disk. It may be viewed by icon, by name, by size, by kind and by 
date by making a selection from the View menu. See Icon, Desktop, View Menu. 

Disk, lmageWriter File The Macintosh uses programs called "drivers" to communicate 
with devices such as the lmageWriter printer. The lmageWriter driver is used to 
control the printer, its type settings, its spacing and the communication between the 
computer and the printer. This driver is located in the System Folder on Macintosh 
application disks such as Mac Write and MacPaint. The file that contains the driver is 
called "lmageWriter." It must be present on a disk for any printing activity using the 
lmageWriter to occur. See lmageWriter, Driver, System Folder. 

Disk, Initialize The process of initializing or formatting a disk is used to make the 
disk work with the computer system and controller circuitry using the disk. This 
process sets up the disk to accept data from the system. It usually involves marking 
the tracks and sectors used to star~ data. It sets up the disk with markers that enable 
the computer to know the location of the read/write head at all times and sets up 
references for the system to recognize where each file starts and stops. If an 
uninitialized disk is inserted in the Macintosh's disk drive, a dialog box is displayed 
on the screen asking if you wish to initialize the disk. If you do, you would click the 
OK button and the system will initialize the disk. Blank disks, damaged disks that 
already contain data and disks already initialized for another computer system may 
be initialized. If a disk that already contains data is initialized, all of the data 
contained on that disk will be erased. See Track, Sector, Read/Write Head, Disk, 
Initialize a Disk, Formatting a Disk. 

Disk, Listing of Files In Microsoft BASIC, use the FILES command to list all files 
on a disk. This command is useful to find a program on file, if you are unsure of 
the exact spelling of its name. This demonstrates the usefulness of mnemonic file 
names that remind you of the contents of a file. A REM at the start of each Microsoft 
BASIC program is also recommended to identify it when listed. 

Disk, Listing of Files The Macintosh Finder reads the directory of each disk that is 
inserted into the computer's disk drives. When the disk icon is opened by the user, a 
display of the files on the disk is shown on the screen. This display may be shown by 
Icon, by Date, by Name, by Size, or by Kind as dictated by the user from the View 
menu. All of these file listing displays, except the by Icon display show the name of 
each file, its type, its size and the date it was last modified. The by Icon display 
shows the file name and a special icon that identifies the file type. See Icon, By Icon 
Option, By Name Option, By Kind Option, By Date Option, View Menu, Finder. 

Disk, LOAD Instructions Any Microsoft BASIC program SAVEd on disk can be 
loaded back into the Macintosh's memory to modify or to run. Programs are loaded 
by using the LOAD command from the File menu on the menu bar at the top of 
the Microsoft BASIC screen display. When this menu is being displayed, a program 
can be removed from the computer's memory by using the New command. A new 
program may be loaded from the disk by using the Open command. When this 
command is selected, a dialog box is displayed requesting the name of the program 
to be loaded. The name must be entered where required in the dialog box. 

Programs may also be loaded from the Command window in Microsoft BASIC by 
typing "LOAD <PROGRAM NAME>'' and pressing the Return key. 
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for a program named "SAMPLE," on the disk in the internal disk drive or in the 
default drive if another drive has been activated by the user, enter: 

LOAD II SAMPLE" 

If no name is provided after a load instruction, a dialog box is displayed on the 
screen to allow the user to enter the name of the desired program. 

All LOAD instructions erase any program lines you have in memory before the 
LOAD, close all open files and delete all variables. If you want to combine a SAVEd 
program with the one you are writing, see MERGE. 

To run the program, use LOAD SAMPLE,R or its synonym, RUN SAMPLE,R. If you 
use ,R any files that are open stay open for the next program. Unless this is 
specifically needed, it is safer to use RUN SAMPLE which first closes any files now 
open, then loads SAMPLE into memory and runs it. See MERGE, CHAIN, SAVE, 
Dialog Box, Menu Bar. 

Disk, Locking Disks are locked when they have been write-protected, a measure 
tHat is taken to protect data on a disk from being written over. Macintosh disks are 
write-protected by sliding a small tab located on the upper left corner of the bottom 
of the disk toward the edge of the disk. The movement of this tab in the direction 
described exposes a hole that runs through the disk. When the tab is in the position 
described and the hole is exposed, the disk cannot be written to. The illustration 
below shows a locked disk and an unlocked disk: 

Unlook•cl Dislc 

Fig. 012 Illustration of locked and unlocked disks showing position of write protect tab. 

Disks may also be locked and unlocked by using the Get Info option from the file 
menu and clicking the Lock box. 

On disks supplied by Apple Computer, Inc., the write-protect tabs are red. On 
disks supplied by Memo rex, another manufacturer of disks, the tabs are the same 
color as the disk. On disks supplied by Hewlett-Packard, the write-protect tab does 
not slide, but must be broken off. It can then be snapped back in place. Disks 
should always be locked when they are being used in situations where the user 
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wishes to prevent data from being written to the disk. One example of thi s is when 
an entire disk is being copied, it is possible for the user to inadvertently insert 
the source disk (the di sk being copied) in the disk drive when the copy program 
requests that the destination disk (the blank disk used to receive a copy of the 
original data) be inserted in the disk drive. If the user makes this mistake without 
locking the disk, the data on the origin disk could be lost. See Write-protect. 

Disk Maintenance File management or disk maintenance are terms used to describe 
keeping track of files on disks. This includes creating them, finding them by name, 
ensuring that adequate free space is ava ilable on the d isk, maintaining backups and 
deleting files no longer needed. These functions are supported by the various 
Desktop functions, but require thoughtful planning by the user to ensure proper 
results. When a disk icon has been clicked, the Finder displays pertinent information 
about each disk when the By Icon display or any of the o ther directory displays are 
shown on the screen. 

The by Name, by Size, by Kind and by Date displays each show the size of the 
document, program, or file on a disk. The View menu should be used to select the 
directory display and the type of f ile maintenance work that is being carried out. For 
instance, if data files are being backed up, the by Kind display is more useful than 
the by Icon display because all files of the same type are listed together and the size 
of each file is shown. Each of these directories can be printed out on the lmageWriter 
by using the Command-Shift-4 key combination to perform a screen dump when the 
Caps Lock key is locked down. If the internal drive is the only disk dri ve available to 
the user, the by Icon directory of the source disk and the by Icon directory of the 
origin disk may be displayed on the screen at the same time as is shown in the 
i llustration below. 

s File Edit Uiew Special 

PRINTFUN 
335K in disk 64K nailabl" 

I . 
. • DECIMAL EX MacPaint System Foldfr 

documentsl 
3 it~ms 11K in disk 

Empty Folder MacCables Error Codes 

' 
Fig. 013 Macintosh screen with files set up to copy f rom one directory window to the next. 
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This type of display is obtained by opening the icon of the origin disk and then 
ejecting the disk without closing the icon. Then the destination disk is inserted and 
its icon is opened. The directory of the origin disk is dimmed as this disk is not in the 
disk drive. Files are copied by dragging the icon of the file to be copied from the 
origin disk to the icon or directory of the destination disk. The Finder will instruct 
you as to when the origin disk should be inserted and when the destination disk 
should be inserted. Files may be erased from a disk by moving the icon of the file 
from the directory display to the Trash Can icon, which may be opened by double
clicking the mouse button when the pointer rests on this icon. This causes the 
contents of the Trash Can to be displayed in a window in the same manner as the 
contents of a disk directory. Files may also be erased by moving the icon from the 
directory window of the disk in the disk drive to the Trash Can window. These files 
will be held in the Trash Can until you use the Special menu on the menu bar to 
select the Empty Trash option or until the disk is ejected and the system is turned off. 
See Directory, Icon, Disk Icon, Menu Bar, Mouse Button, Trash Can, Erase Files, 
Special Menu, Window, Empty Trash. 

Disk, Number of Files The number of files that may be stored on a given disk is 
dictated by the capacity of the disk and the size of each file already on the disk. The 
disks used by the Macintosh on the built-in disk drive and on external disk drives, 
except hard disk systems, are 400K capacity disks. If a disk is a start-up disk, it 
contains the System Folder which contains the Finder, the lmageWriter File, the 
System, the Clipboard file, the Scrapbook file, and the Note Pad file. 

On application disks such as MacWrite/MacPaint, this folder occupies 209K of 
space. This leaves only 191 K for application programs and document files. MacWrite 
occupies SSK of space; Mac Paint occupies 61 K of space. If these two applications 
and the System Folder are the only files on the disk, only 85K is left for additional 
files such as documents generated by MacPaint or MacWrite. MacPaint requires a 
minimum of about 10K for a document that is blank. As drawing lines are added to 
this document, more space is occupied. If the page is filled with assorted shapes, it 
then occupies about 20K of space. Thus, there is only space for about two or three 
additional documents on the disk described above. More files could be saved on the 
disk if the disk only contained Mac Paint or MacWrite and the System Folder. Even 
more files could be saved on the disk if it was only a disk used to store data 
(documents) and it contained no applications or the System Folder. Such disks can 
be created and used by making backups of the MacWrite/MacPaint disk and 
trashing those applications that are not wanted from the backups. 

Data disks may be created and used by initializing blank disks and copying 
document files from the MacWrite/MacPaint disk to the data disk and then erasing 
the document files from the applications disk. As you can see from the description 
above, there is no specific number of files that can be contained on a disk in a 
general or an average sense. See File, System Folder, Startup Disk, Backup Diskettes, 
Applications Disk. 

Disk Operating System A Disk Operating System (DOS) is a collection of programs 
or subroutines that allow the computer to communicate with mass storage devices 
such as disk drives or hard disk systems, to manage files stored on such devices and 
to inform the user about the files that are stored on a disk. The Macintosh's Finder is 
its Disk Operating System as viewed by the user. 

Disk Organization A 400K capacity disk used on the Macintosh by its internai400K 
disk drive or by an external 400K disk drive is divided into eighty concentric rings 
called "tracks." In a decimal sense, the outermost track would be called "track 0" 
and the innermost track on a disk would be called "track 79." The sixteen tracks that 
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are located on the outermost perimeter of the disk (track 0 through track 15) are 
divided into twelve sections called "sectors. " Each sector can store 512 bytes of 
data. The next sixteen tracks moving towa rd the center of the disk (track 16 through 
track 31) are divided into eleven sectors. Each of the next sixteen tracks moving 
toward the center of the disk (track 32 through track 47) is divided into ten sectors. 
Tracks 48 through 63 are divided into nine sectors. Tracks 64 through 79 are divided 
into eight sectors. A number of tracks on each disk are used for a directory which 
holds the name, location and length of each file. It also holds the date the file was 
last modified. Each file is recorded by type in the directory. This directory i s copied 
to the Desktop when a disk is inserted into a Macintosh disk drive. When a disk is 
formatted or initialized, each track and sector is marked on the disk magnetically 
and a di rectory is started on the disk. Each disk is also given a name by the user. See 
Track, Sector, Disk, Initialize a Disk, Formatting a Disk. 

""~~!!"----- TRACKS 0 - 15 < 12 SECTORS/TRACK) 
~----TRACKS 10- 31 < 11 SECTORS/TRACK) 
~~---TRACKS 32 - 47 < 10 SECTORS/TRACK) 
A~-- TRACKS 48 - 63 < 9 SECTORS/TRACK) 
~IIW_.- TRACKS 64 - 69 < 8 SECTORS/TRACK) 

ftHCIHTOSH DISK ORGHHIZHTIOH 

Fig. 014 Track and sector arrangment on a Macintosh disk. 

Disk, SAVE Instructions In a Microsoft BASIC for a program named "SAMPLE." 

On disk enter : SAVE "SAMPLE" 

On an alternate disk named B enter: SAVE "B :SAMPLE" 
To run the program at a later time, use the LOAD command to copy it from the 

disk you saved it on, back into the Macintosh's memory. See LOAD. If you want to 
save the program in ASCI I format, which allows you to MERGE two programs 
together, put ,A after the close quote of the program name thus: 

SAVE "SAMPLE" ,A 
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See MERGE. 
To SAVE the program as a protected file in encoded binary form use ,P instead of 

,A. Then it cannot be listed, saved, edited (or unprotected). While a clever programmer 
could probably get around this, it will prevent a quick and casual or accidental 
modification to your program. 

The SAVE instruction does not alter your program in memory. It is important to be 
aware that if you write a Microsoft BASIC program, it will be lost (erased) unless you 
SAVE it before you either: turn off the Macintosh, go to the Desktop (System 
command) or use the NEW command. See also EDIT. 

Disk, Source The disk from which information/data is coming. Target disk is the 
disk to which information/data is going. 

Disk, Startup A disk that contains the Macintosh System folder. This disk makes 
the portions of the Macintosh operating that are only available on disk available to 
the computer. It contains the Finder, the lmageWriter file, the System file and other 
files. 

Disk, System Used to contain system software or utility- type programs. The system 
files may reside on only one disk. Ordinarily this will be the disk in the internal disk 
drive on a two-disk drive system. On a single-drive system, the system disk will be 
loaded prior to loading the data disk. Once the system disk is loaded, it may be 
ejected and the data disk may be inserted into the disk drive. Once the data disk icon 
has been opened, the document or file to be used with the system disk may then be 
opened. Once the document or file has been loaded, the system may request that 
the system disk be inserted again. When the updated document or file is being saved 
by the user, the data disk will be requested once again. A system disk may also store 
user programs and/or data. See Data Disk, Applications Disk. 

Disk, Target The disk to which information/data is going. Source disk is the disk 
from which information/data is coming. 

Disk, Write-protected A disk is write-protected if the "lock" square is open. This is 
detected by a small spring- loaded switch or a light beam inside the disk and is 
sensed by Macintosh disk drive programs. You will get an error message (locked 
Disk) anytime you attempt to alter a file on a write- protected disk by changing it, 
deleting it, copying a file onto the write-protected disk or formatting the disk.FL 

You are allowed to use files, load them or copy from the write-protected disk. The 
purpose of these limitations is to prevent accidental loss of the only copy of 
programs or data. In most cases the procedure is to copy the write-protected disk 
onto an unlocked disk, put away the write-protected disk as a permanent copy, then 
modify the unlocked disk. In some cases, you will unlock the disk by closing the lock 
tab (after thinking it over) and proceed to change the disk. 

It is a good practice to lock any important disk you will backup. Then if you 
accidentally ask for the backup in the wrong direction (from the old disk to your 
important disk), you will get a second chance to make the backup rather than losing 
your data. See locking a Disk. 

Display Device A computer output device which displays graphic and/or alphanumeric 
information, such as a CRT or a seven-segment LED. The Macintosh's display device 
is a screen built into the system. A number of special Macintoshes have been built or 
adapted to allow external monitors or projection devices to be used with the 
Macintosh for presentations to large groups. 

DMA Direct Memory Access. A method used to provide high- speed data transfers 
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between a peripheral and the main memory. Data is exchanged at maximum 
memory speed. Several means for accessing the memory are possible. Disconnecting 
the MPU from the buses is accomplished by a HOLD signal, and requires tristate 
data and address buses. DMA is preformed under the contro l of a Direct Memory 
Access Controller (DMAC). The Macintosh has four channels of DMA, three for 1/0 
and memory transfers, one for refreshing the system's dynamic memory. 

Document A document is any fi le generated by a particular application such as 
MacWrite, MacPaint or Multiplan on the M acintosh. This file contains material 
generated by the applica tion and requires that the application be loaded prior to 
loading the document. A document fi le will automatically load the appl ication file 
prior to loading itself, if a document file is selected with the mouse from the 
directory display on the Desktop. A document file may also be loaded from the Fil e 
menu on the menu bar of all applications by choosing the Open option from this 
menu. A dialog box listing a ll avai lable documents for that application will be 
displayed on the screen. The desired document ca n then be loaded by highlighting it 
on the document list and cl icking the Open button in the dialog box. 

Close 
Close Rll 
Print 

·ect 3CE 
NE'w'DISKORI PRINTCONTROl.t 

MacDriue 
996K in disk 

~ 
Rolodtx 

Fig. D15 The Open option in use from the File menu. 
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Document Icon Pictorial representations called " icons" are used to display the 
disks in Macintosh disk drives and to display the files, documents, file folders and 
applica tions on a disk. Documents are files generated by an application such as 
MacWrite and Mac Paint. These icons have a distinctive design. A M acPaint document 
icon is a paint brush on a page with a turned down upper right-hand corner. A 
MacWrite document icon is a square with several lines suggesting text and a hand 
wri ting on the page. 

DocuPian• A word processing program designed for preparing long documents and 
itemized lists. It supports footnotes, superscripts, subscripts, indexes, and a tables of 
contents. Chang Labs. 
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Doing Business with your Macintosh* By Rudolph Langer, describes the uses of 
the Macintosh in the business environment. It explains how to use the Macintosh, 
how to select software, and describes the use of the major software types that are 
available for the Macintosh. The types of software covered are spreadsheets, databases, 
word processors and graphics programs. Sybex. 

Dollars and Sense• Dollars and Sense is a money management tool for the home 
and the small business. It is used to track income and expenses. Both income and 
expense may be classified to assist in budgeting and in handling taxes. Graphs are 
displayed to compare budget with actual experience. Checkbook reconciliation is 
also carried out. Monogram. 

()().loop A feature of a high-level language (e.g., FORTRAN) which allows a segment 
of a program to be executed repeatedly while or until a certain logical or arithmetic 
condition is fulfilled. 

DOS (D-O-S or "doss") Disk Operating System. A program or collection of programs 
functioning as an operating system whose main secondary storage medium is disk. It 
usually supplies facilities such as symbolic files, automatic space allocation, dynamic 
memory allocation, program relocation and loading, utilities, etc. The Finder is the 
Macintosh's Disk Operating System. 

Dot-matrix A method of forming characters by using small dots. Usually patterns 
are 5 by 7 or 7 by 9, though for very high-quality characters patterns of 11 by 13 dots 
or more are required, and applies to displays, printers and other output devices. The 
lmageWriter printer is a dot-matrix printer. Dot- matrix printers offer the advantage 
of flexibility in output that can be controlled by the user through various programs 
or through the use of control codes sent to the printer. low-and high- resolution 
graphics can be output by this type of printer. Many Macintosh applications 
programs such as MacWrite and ~acPaint use the graphics features of the lmageWriter 
to print documents, screens and files. Microsoft BASIC can treat the lmageWriter as 
a text printer rather than a graphics printer. A variety of text styles and sizes may be 
generated by this type of printer through the use of control codes. Daisy-wheel 
printers are not as flexible as dot-matrix printers although daisy-wheel printers can 
generate different type size and styles by changing the wheel that is being used. 
Daisy-wheel printers generally produce higher-quality output than dot-matrix printers, 
but they generally cannot be used to produce graphic images of the same nature and 
quality as dot-matrix printers. 

Double-clicking A process used to load and open an application, a document or a 
disk icon from the Desktop or from the directory display on the Desktop. Double
clicking is accomplished by placing the pointer on the icon or the name of the file, 
application, or disk to be opened and pressing the mouse button very quickly two 
times. See Mouse Button, Desktop, Directory. 

Double-density A term generally used to describe the capacity of a storage media 
such as a floppy disk. Such floppy disks are not used by Macintosh disk drives. 
They are generally organized in 48 tracks per side. 

Double-precision Double-precision numbers are assumed as the default precision 
in Microsoft BASIC for the Macintosh. These numbers are computed up to fourteen 
digits of precision. Numeric variables are assumed to have this degree of precision 
unless otherwise declared. Numbers will be printed to this degree of precision on the 
display screen or on a printer, unless otherwise defined. 
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Double-precision Floating Point Double-precision floating point numbers (numbers 
with decimal fractions with up to fourteen digits) can be declared by having their 
variable names end in #. DEFDBL signifies that all the following variables are 
double- precision floating point numbers. See also Variable Names, DEF DBL. 

Double-sided Disk Drives A double-sided disk drive is a disk drive that can read data 
from and write data to both sides of a disk at the same time. These disk drives usually 
have twice the capacity of a single-sided disk drive. The read/write heads are 
located above and below the disk. 

Double-strike Type format Some dot-matrix printers use a technique called "double 
striking" to produce darker than normal characters on paper. When this technique is 
used, the printer rolls the paper upward an extremely small distance and types the 
character once more. The lmageWriter does not use this technique to create darker 
characters. It produces darker characters called "boldface characters" in the text 
mode. These characters are printed by operating the printer at a slower speed than 
normal and printing each character twice with a slight shift of print head position. 
See Bold, lmageWriter, Dot-Matrix, Control Characters for Printer. 

Double-sided Disk A type of disk with both surfaces (sides) used for data storage. 
This includes the BOOK internal or external disk drive for Macintosh. Such disk drives 
have two read/write heads that read data from both sides of a disk or write data to 
both sides of disk simultaneously. 

Dow Jones Market Manager• A program that may be used to manage stock market 
transactions and to track the progress of investments made on the stock market. It 
allows up to 26 portfolios to be managed. The program will automatically dial Dow 
Jones News/Retrieval and record the current status of the stocks and other investments 
in the portfolio. Dow Jones Software. 

Dow Jones Spreadsheet Link• An application that links Dow Jones stock market 
information to an electronic spreadsheet program. The software may be used to dial 
the Dow Jones News/Retrieval service. This data is then assimilated into the spreadsheet. 
Dow Jones Software. 

Down One Space The cursor in a Macintosh application such as Mac Write is moved 
down one line on the screen by pressing the Return key. The same technique is used 
in Mac Paint in the Text mode. This action moves the cursor to the extreme left-hand 
side of the screen. Otherwise, the cursor must be moved to a new position by moving 
the pointer to the new position on the screen with the mouse and then pressing the 
mouse button one time. 

Draft Mode The Draft mode is one of the three printing modes available to most 
applications on the lmageWriter printer. This mode may be selected from the dialog 
box displayed when the Print option is selected from the File menu on the menu bar. 

Dragging The process of placing the mouse pointer on an icon on the Desktop, 
pressing the mouse button and moving the icon to a different place in a directory 
window, from a directory window to the Desktop, from one directory window to 
another, from one disk icon to another, or any of the other similar combinations of 
icon movements. 

Shapes may be dragged from one place to another on the screen display in such 
applications as Mac Paint by using the lasso or the rectangle to select the shape to be 
moved and then pressing mouse button to drag the image to a new position. When 
the proper position has been reached, the mouse button is released. 
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Windows can be dragged from one place to another on the screen by placing the 
pointer on the title bar, dragging them to the new location, and releasing the mouse 
button. Window sizes are enlarged by placing the pointer on the size box in the 
lower left-hand corner of the window, pressing the mouse button, dragging the 
corner until the size is proper and releasing the mouse button. The highlight is 
dragged down the entries of a pull-down menu in the same fashion with the proper 
selection being made by releasing the mouse button when the proper choice is 
highlighted. See Pointer, Desktop, Directory. 
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Fig. 016 Dialog box displayed by the Print option of MacWrite showing the three print modes 
available for the lmageWriter in this application. 

Drawing Tools The drawing tools that are available in MacPaint are represented by 
icons displayed along the left-hand side of the Mac Paint screen display. These tools 
include a lasso, for defining shapes to be manipulated; a rectangle, for defining 
areas and shapes to be manipulated; the grabber, a hand used to move the screen 
window around on the page; the letter A, used to select text entry; a paint can, used 
to fill enclosed areas with the current pattern from the pattern menu at the bottom 
of the screen display; the spray can, for shading areas of the screen with the current 
pattern from the pattern menu; the paint brush, used with selected brush sizes and 
brush mirrors for drawing brush-like lines on the screen; the pencil, for drawing 
pencil-like lines on the screen; the eraser·, for erasing screen sections and erasing the 
entire screen; the line icon, used to draw lines between an anchored point on the 
screen and any other termination point on the screen; the hollow rectangles (one 
with square corners and one with rounded corners) for drawing open squares and 
rectangles; the filled rectangles, for drawing rectangles and squares filled with the 
current pattern from the pattern menu on the bottom of the screen; the hollow oval, 
for drawing open circles and ellipses; the filled oval, for drawing circles and ellipses 
filled with the current pattern from the pattern menu; the open freehand-shape 
icon, the filled freehand-shape icon, the open polygon, and the filled polygon icon. 
All of these drawing tools enable the user to realize the power of an exceptionally 
fine mouse-driven computer assisted drawing program. 

Drive Button Whenever a dialog box is displayed in connection with saving a 
document or a Microsoft BASIC program, it contains a button called "drive." When 
this button is clicked, the disk drives and hard disk that are connected to the 
Macintosh are displayed one at a time above the button. This allows the user to save 
the document or program on a particular disk drive or on the hard disk. 

Drive, Device A mechanical and electrical/electronic device which operates a tape 
transport, a floppy disk or a hard disk medium for data storage and retrieval. It may 
include several motors for rotation, head positioning, etc., as well as position 
sensors, control circuits, lights and switches. 

Drive, Source The disk drive from which information/data is coming. 
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Drive, Target The disk drive to which information/data is going. 

Driver A special program or subroutine in a larger program, that has been written to 
allow the computer or its application to communicate with and operate an external 
device such as a printer, the keyboard or other input device, the screen display, a 
disk drive, a modem, a plotter or any similar device. 

Drives, Microfloppy A microfloppy disk drive is the generic name used to describe 
disk drives that use disks 3-1/2-inches in diameter to store data. The Macintosh's 
internal disk drives are microfloppy drives. 

Drives, Winchester Disk A Winchester Disk is a hard disk media used to record data 
in a hard disk drive. This media may be an activated metal cylinder or a high
capacity cartridge of some rigid material. These disks spin much faster than the 
floppy and minifloppy disks used by the normal disk drive. They also have a larger 
surface area. The device that is used to read data from these disks and write data to 
them has a much more precise control of the read/write head than the control 
experienced with floppy and minifloppy disk drives. 

DSR Data-Set Ready (RS-232C standard). A line on a modem indicating to the data 
terminal that the received carrier is normal. See RS-232(, CTS, DTR. 

DTE Data Terminal Equipment. Equipment which receives or originates data, as 
opposed to Data Communications Equipment, which merely transmits data from 
one device to another. 

DTR Data Terminal Ready (RS-232C standard). A line on a terminal indicating to the 
modem that it is ready to send data. See RS-232(, DSR, CTS. 

Dual Intensity A printer or display device which can reproduce symbols in regular 
and boldfaced or highlighted formats. 

Dual-sided Disk Drives Macintosh disk drives come in two varieties, single-sided 
(400K) and dual-sided (BOOK). The only difference is that the dual-sided drive has 
two read/write heads to store information on both the top and bottom side of the 
disk. You can use an BOOK dual-sided disk drive for the add-on external drive to 
suppliment the internal 400K drive which comes with the Macintosh. There may be 
additional formats available to Macintosh users through non-Apple hardware and 
software. See Double-sided Disk, Double-sided Disk Drives. 

Dumb Terminal A low-cost data terminal, ordinarily a CRT, which does not have 
advanced features such as editing keys or local processing. 

Dummy Input Statement Used to hold or freeze screen display in Microsoft BASIC. 
To freeze the screen until the operator is done with it, put in a dummy input 
statement and instruct the operator to press Enter to proceed. The input variable 
need not be used in your program: 

1000 INPUT" Press Enter to continue" ;A$ 

To freeze the screen briefly while the operator using your program reads a 
message, just write a delay loop after you print the message: 

1000 FOR Y = 1 TO 2000 
1010 NEXT Y$FL 
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Dump Transfer the con tents of one memory device to another. Internal registers 
may be dumped to memory. memory can be dumped to d isk. printer or screen, etc. 

Duplex Bidirectional commun ication method al lowing simultaneous data transfers 
in both directions. May use separate lines or multiplex a si ngle line. 

Duplicate Command When the directory window is being displayed on the Desktop 
at any time when the M acin tosh is in use, a file may be duplicated. First. highl ight 
the file by p lacing the mouse pointer on the file icon. click the mouse button and 
select Dupl ica te from the File menu on the menu bar. This wi ll ca use a copy o f the 
selected f ile to be duplicated on the disk and a new icon wi ll be opened in the 
directory showing Copy o f fo llowed by the name of the dupl icated fil e. 

Special 

Put Back 

~ ~ Close 
Close Rll 

Rolodex MacPaint 

Print 

[Q [Q 0 
CIS Folder disk tab Copy of disktab 

Fig. D17 The Desktop ait1•r one iilc has been duplica ted and before another is duplicated. 
Note the "Copy of (file name)" on the display and the highlighted Duplicate command on 
the File menu. 

Duplicate Disks See Backi ng Up a Disk. 

Dvo rak Keyboard The Dvorak keyboa rd is a non-QWERTY keyboard des igned to 
make keyboard use more natural. It is popular with some educators. 

Dynamic Ci rcuitry which stores information as charges on MOS capacitors. Usually 
volati le, i t requires periodic refreshing. 

Dynamic Memory M OS RAM memory using dynamic circu its. Every b it is stored as 
a charge on a si ngle MOS transistor. allowing very high density (on ly one transistor is 
used per bit). Since the stored charge leaks, a typical dynamic memory must be 
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refreshed every two milliseconds by rewriting its entire contents. This does not slow 
down the system, but does require additional memory refresh logic. Dynamic 
memory chips are cheaper than static ones, and are generally preferred for memory 
sizes over 16K. The Macintosh's RAM memory is dynamic. Dynamic memory is also 
volatile, i.e., the data stored is lost when power is turned off or interrupted. 

Dynamic Memory Allocation Varying allocation of memory to multiple concurrent 
programs according to their needs and a strategy for optimizing performance. 



E 
E ASCII = 69, HEX= 45 e ASCII = 101, HEX= 65 

E Enable. Also, the hexadecimal symbol for the decimal number 14: 

E base 16 = 14 
14 base 10 = 14 
16 base 8 = 14 
1110 base 2 = 14 

e Powers of in BASIC, natural logarithms. See EXP. 

Easy Guide to your Macintosh, The* By Joseph Caggiano. This book describes the 
Macintosh and its use to the new Macintosh user. It deals with MacWrite, Mac Paint, 
and Multiplan in detail. System expansion is also discussed completely and "One 
Minute Recipes" are presented to walk the new user through commony-used procedures. 
Sybex. 

Echo A character received from the keyboard is sent to the printer or screen for 
display. 

Echo, Hardware Testing. A loop-back or"echo" technique is used to test the circuits 
of an input/output device by "looping" whatever is output back into the computer 
as if it were input. In this way the circuits inside the computer are tested in isolation 
from the circuits of the external device to locate a fault. 

Echo, Keyboard to Screen Echo describes the process of sending characters keyed 
on the keyboard to the screen for a visual confirmation of what has been typed. 
There are no hardwired connections between the keyboard and the screen. The 
keyboard simply enters characters into memory. The ROM programs of Macintosh 
further copy the characters from memory to the screen, creating a duplication or 
"echo" of what was keyed. 

EDIT A Microsoft BASIC command used to display a specified line from a program 
in the Command window. The format is: 

EDIT <line> 

<line> is the line number of an existing line in a program that you want to edit. If the 
line does not exist an "Undefined line number" error is displayed. 

When the EDIT command is used, the cursor is positioned at the end of the 
specified line in the Command window. Changes or corrections may then be made 
to the line following the rules for editing. Once the line has been displayed in the 
Command window, characters may be added or deleted by moving the pointer 
arrow to the insertion or deletion point in the line and clicking the mouse button. 
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This will cause a vertical bar cursor to be displayed at that point. To add characters, 
type them in. To delete characters, backspace over them by pressing the Backspace 
key. 

The Edit menu on the menu bar at the top of the screen provides three additional 
editing options that use the Clipboard. The first is Cut which removes highlighted 
characters from a program line and saves them to the Clipboard. Characters may be 
highlighted by dragging the cursor over all of the characters to be dealt with by the 
EDIT command that follows. The second option is Copy. This option leaves the 
highlighted characters intact on the screen and places a copy of them on the 
Clipboard. The last of these options is Paste, used to copy characters from the 
Clipboard into a program line at the point specified by the location of the cursor. All 
changes made to a line are incorporated into the program when the Return key has 
been pressed. This replaces the unedited line in the program listing with the edited 
line and clears the Command window for the next line to be edited. When all editing 
has been completed, the edited program should be saved to disk by typing SAVE 
<filename> followed by Return on the Command line or by using the Save option from 
the pull-down File menu from the menu bar. If you wish to retain copies of both the 
edited and unedited programs on disk, give the program a new name when you use 
the Save command in the Command window or use the Save As ... option from the 
File menu. If you use the latter, a dialog box will request that you give the program a 
name prior to saving it. 

The Microsoft BASIC version for the Macintosh uses the List command option 
from the Control menu on the menu bar to list a program to the screen in a special 
List window. The program that is currently in memory can be listed in the List 
window by typing LIST in the Command window and pressing the Return key. If you 
wish to edit a line from this list, you would place the pointer on the line number of 
the line to be edited and click the mouse button. This causes the line to be displayed 
in the Command window at the bottom of the screen. Material can be added to the 
line by placing the pointer at the insertion point for the material and clicking the 
mouse button. This causes a vertical bar cursor to be displayed at the insertion point. 
Any new text, commands or numerals can then be inserted by typing the material 
from the keyboard. When all of the changes have been made to the line that is being 
edited, the pointer should be moved to the end of the line and the Return key 
pressed. This will cause the edited line to be moved back into the program listing in 
the List window. If Return is not pressed, the edited line will not be incorporated into 
the program. 

Edit Edit means to change the contents of a file including both program files and 
data files. Program files may be edited by loading the program into memory and 
editing the file with such tools as the List window and Command window in 
Microsoft BASIC or with special program editors that allow lines to be listed and 
changed. Some of these editors allow global search and replace activity and cross
check variables to ensure that the same variable is used in related situations. 
MacPaint documents must be edited by reloading them into MacPaint, making the 
necessary changes and saving them again. The same procedure would apply to 
MacWrite and Multiplan documents. 

Editors are classified as line-oriented editors if they basically work on one line at a 
time and deal with text by line number. 

Full-screen editors by contrast allow you to change any data currently displayed 
on the screen. Most treat paragraphs or even entire documents as a unit, allowing 
reformatting, change of margins with justification, block moves, etc. Most word 
processing programs are full-screen editors. 

The Microsoft BASIC editor lies between these two categories. It allows you to 
change any Microsoft BASIC line on the -screen, but still treats the data as a 
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collection of lines. You must press Return while the Cursor is on a line you have 
changed with the Microsoft BASIC editor or the changes are not effective. 

• File Edit Control 

Home Budqetinq 
list 

10 CLS 
30 REM Horne Budgetlng/Ceshflow Analysis 
40 DEFDBL A-V:DEFINT Z 

~0 DIM D(12), 10(3,2) , C0(3,3), Cl(5,5) , Cl$(5), E0(25,2) 

60 PU$="$$••••,•••.••· 

70 REM DO --Dey Offset Factors 
80 REM 100 --Sel erled Income 
90 REM CIO --Cr edit Instruments 
100 REM EO() --Expenses 
110 REM Cl$0 --Descriptions of credit cards 
120 REM coo --Fixed-Term Loans 
130 DATA "Mortgage· ,"Car Loan·, "Other Loan· 
140 REM expenses 

Command 
50 DIM D( 12) , 10(~2), C0(3,3), C 1(5,5) , C I $(5) , E0(25,2) 

"t ~ 

Fig. E1 The Microsoft BAS IC screen display showing the List window and the Command 
window with the vertica l bar cursor at the insertion point for changing a program line. 

Edit Menu The Edit menu is one of the four pull-down menus displayed on the menu 
bar in Microsoft BASIC for the Macintosh. This menu provides three command 
options to the user. These options are Cut, C-opy, and Paste. The Cut option removes 
highlighted characters from a program line in the Command window of Microsoaft 
BASIC and places these characters in the Macintosh Clipboard . Characters are 
highlighted by placing the pointer arrow on the fi rst character to be highlighted, 
pressing the mouse button and dragging the pointer until the last character is 
highlighted, then releasing the mouse button. The Copy option leaves the highlighted 
characters in the line being edited and copies them into the Clipboard. The Paste 
option copies characters from the Clipboard to the point designated by the vertica l 
bar cursor in the program line in the Command window. The cursor is positioned by 
moving the pointer arrow to the insertion point on the line and clicking the mouse 
button. Any characters that are in the Clipboard will be erased if new characters are 
copied or cut to the Clipboard . Make sure Cl ipboard contents are pasted where they 
are required in a program prior to cutting or copying anything new to the Clipboard. 

MacWrite's Edit menu has two additional options: a Can' t Undo option that is 
used to protect blocks of text and commands. and a Show Clipboard option to 
display the contents of the Clipboard in a window on the screen. 

MacPaint's Edit menu is even larger. It contains Undo, Invert, Trace Edges, Flip 
Hori zontal, Flip Vertical. Rotate and Clear options in addition to Cut, Copy and 
Paste. The Undo option is used to cancel the last action taken by the Mac Paint user. 
The Invert option is used to change black on white to white on b lack for the shape or 
shapes enclosed in the rectangle or the lasso from the drawing tools. The Clear 



108 • Edit Pattern 

option erases any image or images that are surrounded by the rectangle or the lasso. 
Trace Edges places an outline around any image or images contained within the 
rectangle or lasso. Flip Horizontal is used to flip any image within the rectangle or 
lasso on its vertical axis. For example, an arrow that has the arrowh.ead pointing to 
the right- hand side of the screen will be flipped so it points to the left- hand side of 
the screen when this option is selected. Flip Vertical flips an image on its horizontal 
axis. Thus an arrow with the arrowhead pointing up would point down after this 
option was used. The Rotate option turns an image ninty degrees. 

Microsoft Multiplan has an even larger Edit menu, which includes Undo, Cut, 
Copy, Paste, Clear, Show Clipboard, Paste and Link, Unlink, Paste Name, Paste 
Function, Absolute Reference, Fill Right, Fill Down and Sort. Each of these functions 
can only be carried out on a highlighted portion of a Multiplan worksheet. The first 
seven of the options are the same as described above. Paste and link takes the 
current contents of the Clipboard into the current worksheet at the cell or range of 
cells that has been highlighted. It also links the highlighted portion of the current 
worksheet with the section of the earlier worksheet that was Cut to provide the 
material on the Clipboard. Unlink is used to break the link between an earlier 
worksheet and the current worksheet. Paste Name is used to paste a named cell or 
range of cells from a place on the current worksheet into a formula in the current 
active cell. The Paste Function option is used to paste a Multiplan function into a 
formula in the current active cell in a Multiplan worksheet. The Absolute Reference 
option is used to associate a particular cell with the formula in the current active cell 
on a worksheet rather than associating a cell in the same relative position to a cell 
from which a formula is being copied. Fill Right is used to copy the values, functions, 
or formula from the current active cell or column of cells to the columns to the right 
of the current active cell or column of cells. Fill Down is used to copy the contents of 
a cell or row of cells to the rows below the current active cell or row of cells. Sort is 
used to sort the contents of a row or column within a highlighted area. The sort can 
be done in ascending or descending order as required and as specified by the user in 
a dialog box. 

The Edit Menu allows material in highlighted or outlined areas to be changed. It 
also makes use of the Clipboard as required to remove data or as a source of data to 
be added. 

Edit Pattern The patterns displayed on the pattern palette at the bottom of the 
MacPaint screen display may be edited selecting the Edit Pattern option from the 
Goodies menu. To select a pattern to be edited, double-click the pattern on the 
palette. This will cause a window containing the normal pattern and the blown up 
version of the pattern to be displayed. An OK button and a Cancel button are also 
displayed in the same window as the patterns. Individual dots are turned on and off 
in the blown up version of the pattern to alter it. Once the pattern suits the user, the 
OK button should be clicked to place the altered pattern in the palette. See OK 
Button, Cancel Button, Window, Pattern Palette. 

Editing a Document A document created with MacWrite or any word processor 
may be edited by opening the document to display it on the screen. Once the 
document is being displayed, the pointer must be moved to the point in the 
document where characters must be added, deleted or changed. When the insertion 
or deletion point has been located with the pointer, the mouse button must be 
clicked to cause a vertical bar cursor to be displayed. 

Text or other characters may be added to the document at the insertion point by 
typing the characters into the document from the keyboard. Characters may be 
deleted from the document by moving the pointer to the deletion point and clicking 
the mouse button to get the cursor. Single characters may be deleted by pressing the 
Backspace key. This removes the characters immediately to the left of the cursor. 
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Several characters may be deleted by dragging the pointer over the characters to 
highlight them and then pressing the Backspace key after the characters have been 
highlighted. Several characters may be changed or replaced by new cha racters by 
highlighting a particular portion of the screen display, typing in the correct characters 
and pressing the characters keys you wish to insert. Characters may also be cut or 
copied to the Clipboard or pasted into the document at the insertion point by using 
these options from the Edit menu on the menu bar. See Document, Mouse Button, 
Click ing, Cut Option, Copy Option, Paste Option, Menu Bar, Clipboard, Highlight. 

Editing a Footer A footer is a notation that wi ll be repeated on the bottom lines of all 
pages of a document generated by MacWri te. The contents of a footer may be 
changed once they have been set up for a MacWrite document by p lacing the 
pointer on the Format menu on the menu bar, pressing the mouse button and 
dragging the highlight for this menu to the Open Footer option . This will cause the 
contents of the footer to be displayed in a Footer window on the screen. A flashing 
vertical bar cursor w ill appear at the beginning of the characters in the footer if you 
move the pointer into the Footer window and click the mouse button. 

Characters may be deleted by using the Backspace key for a single character to the 
left of the cursor location or by pressing the Backspace key to delete all characters 
that were highlighted by placing the pointer on the first character to be deleted and 
dragging it across the screen to the last character to be deleted. Characters may also 
be cut or copied to the Clipboard by using the Cut and Copy options from the Edit 
menu. Characters may be added to the characters already in the footer by moving 
the pointer to the desired insertion point for these characters and clicking the mouse 
button. Then the characters that are to be inserted are typed in from the keyboard. 
See Footer, Menu Bar, Dragging, Pointer, Clipboard. 

ti File Edit Search Format Font Style 

Untitled I 
~ Footer 

rrn ~ 
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Fig. E2 A Footer display from MacWrite wi th the vertical bar cursor at an insertion point. 
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Editing a Header A header is edited in the same fashion as a footer in M acWrite. See 
Editing a Footer, Header. 

Editing Cells Individual cells in Multiplan may be edited by placing the plus sign 
pointer on the cell to be edited and click ing the mouse button. Th is action causes 
the contents of this cell to be displayed in the formula bar under the Menu Bar at the 
top of the Multiplan screen display. Next. move the. pointer to the formula bar and 
click the mouse button . This activa tes the formula bar and displays a vertical bar 
cursor at the end of the cell contents that are being displayed in the formula bar. 

To insert characters, move the pointer to the location where characters are to be 
inserted and click the mouse button. This moves the vertical bar cursor to the 
insertion point. Enter whatever characters are required at the insertion point by 
typing them in . Then, press the Return key or the Enter key to cause the changed 
formula, value or label to be moved to the cell that is being edited. Characters may 
be deleted at the insertion point by pressing the Backspace key to delete one 
character at a time. More than one character may be deleted by dragging the mouse 
pointer across all of the characters to be deleted. This process highlights these 
characters. Then press the Backspace key to delete all of the highlighted characters. 
Characters that have been highl ighted may also be cut or copied to the Clipboard by 
using the Edit menu after the characters have been highlighted. Ed iting changes may 
be cancelled at any time by moving the pointer to the Cancel icon that appears 
between the cell address and the formula bar. This icon is an X within a c ircle. 

* File Edit Select Format Options Calculate 
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Fig. E3 The Multiplan screen when the contents of a cell are being edited. 

Editing Text Text files that are generated by an application such as MacWrite may 
be edited in the same fashion as documents are edited. See Editing a Document . 
Text in an application such as MacPaint may be edited by opening the document 
that contains the text to be edited. This wi ll cause MacPaint to be opened at the 
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same time. The text must then be positioned in the display window and the text icon 
must be clicked to allow text to be entered or deleted. The pointer must then be 
moved to the insertion or deletion point on the display. The mouse button must be 
clicked when the pointer is at the proper screen location. 

To delete text, use the Backspace key to delete single characters. Several characters 
may be highlighted by dragging the cursor over them with the mouse button pressed 
and releasing the mouse button when the last character has been highlighted. Text 
may also be highlighted and then transferred to the Clipboard with the Cut and Copy 
options on the Edit menu. Text may also be added when the application is in the Text 
mode by using the Paste option from the Edit menu. 

Text files that are generated by Microsoft BASIC programs can be edited with a 
special text editor. Edit.BAS is available in the public domain. This editor was 
written by Loftus E. Becker, Jr. and allows the user to edit programs or text files. It is 
very likely that a number of program and text editors will be released for the 
Macintosh shortly. See Editing a Document, Document, Icon, Public Domain, Edit 
Menu, Cut Option, Copy Option, Paste Option, Editor. 

Editor A program which facilitates the entry and maintenance of text in a computer 
system. Typical operations include insert word/line, delete word/line, append, 
search for string, substitute, etc. An editor is designed to allow creation and 
modification of data. Microsoft BASIC and various word processors provide editing 
capability for any line displayed on the screen (full screen editors). Their basic 
function is to create and change text data such as a letter, report, program or book. 
Non text editors usually display and modify a byte of storage as either two hexadecimal 
digits or a three-digit numeric ASCII value. See Edit. 

Editor, Text An editor program specialized for text files. A text editor manipulates 
ASCII characters such as letters, punctuation marks, etc. 

Educational Software Software designed to teach subjects normally taught in the 
classroom atmosphere. It is also software that develops or reinforces professional 
skills such as typing, business strategy, sales strategy, etc. It may also be software 
that teaches the mastery of various programs such as lotus 1-2-3 or the mastery of a 
programming language. Most educational software consists of drills, tests and 
instruction sessions. The following educational software for the Macintosh has 
either been released or announced: How to Use your Macintosh, Mac Edge, MacMath, 
MacSpell, Run for your Money, Typing Tutor Ill. 

Eject Disk Due to the design of the Macintosh disk drive, disks may not be removed 
from the disk drive by hand as is done with most floppy disk drives. Disks must be 
ejected from Macintosh disk drives, by selecting the File menu when the Desktop is 
being displayed, scrolling down to the last option on this menu and releasing the 
mouse button. This option is called "Eject." 

Disks may also be ejected by pressing the Command key and theE key together. 
Another method not recommended unless you encounter some problems with a 

disk that do not allow you to eject a disk with the two methods described above is 
the "manual eject." This method requires that you hold the mouse button down and 
turn the computer off, then on very quickly. The disk will eject shortly after the 
computer is turned on. The dialog box displayed when you use the Open command 
option from the File menu has an Eject button that may be used to eject the disk 
currently in the Macintosh disk drive. This feature allows the user to open a file from 
a disk other than the disk currently in the disk drive. See File Menu, Eject Command, 
Eject Button. 
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Eject Button The Eject button in the dialog box presented to the user by the 
Macintosh when the Save or Open option are selected from the File menu in an 
application program such as MacPaint and MacWrite. This button may be selected 
by moving the pointer to the button and clicking the mouse button. This option 
enables the user to save a document to a disk other than the disk currently in the disk 
drive, or to load a document from a disk other than the disk currently in the disk 
drive. This feature is very useful when you wish to save space on an application disk 
and wish to store documents on a data disk. See Data Disk, Mouse Button, Button, 
File Menu, Eject Disk, Pointer. 

Saue current document as MacDriue 
I FOOTER DEMO ( Eject ) 

( Saue ) ( Cancel ) ( Driue ) 
® Entire Document QTeHt Only 

Flash.bas 
Flash. Doc ( 0Jt(~n ) MacDriue 
MacCables 
MacCopy 1.3 ( Eject ) 
MacCopy.doc 

( ) ( ) MacForth Cancel Driue 
MacNotes 

Fig. E4 The dialog box displayed by the Save command option and by the Open command 
option. Both dialog boxes illustrate the Eject button. 

Eject Command The Eject command is used to eject a disk from Macintosh disk 
drives. To eject a disk, first select the disk by clicking its icon with the mouse button. 
Then select Eject from the File menu. This will cause the disk Finder to be updated 
and will cause the disk to be ejected. See Finder, Eject a Disk. 

Electronic Disk (RAM Disk) A RAM disk is a process that makes use of the Random 
Access Memory of a computer to emulate a disk drive. This process usually requires 
more than 48K of memory depending upon how much space is going to be devoted 
to emulating a disk drive. 64K systems are usually too small to make effective use of 
such an emulation. 128K systems lend themselves very well to such a use of 
available memory space provided the applications programs or programming languages 
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that are loaded into memory do not use excessive amounts of RAM. 
Systems that are larger than 128K are generally the best systems to use RAM as an 

extra disk drive. The advantage of using a RAM disk is that it increases the speed of 
interaction between the computer and any data or program files that are stored in 
the RAM disk. 

RAM disks must be set up by some sort of preboot program that properly 
configures the RAM space as a disk drive and sets up the emulation procedures. 
Once this has been done, programs and files that the user wishes to employ with the 
RAM disk must be copied from a floppy disk or microfloppy disk into the RAM disk. 
Then the RAM disk must be opened as the active disk drive. When the user is ready 
to stop using the RAM disk and wants to shut down the system, the files that were 
changed in the RAM Disk must be copied to the conventional disk from which they 
were originally copied. Currently there are no RAM disk implementations available 
for the Macintosh. 

Ellipsis An ellipsis is used in a number of electronic spreadsheet programs, such as 
VisiCalc, to specify a range of cells. It consists of a line of three periods( ... ) and is 
placed between the first and last cell location in the range. The ellipsis is used in all 
of the menus on the menu bar of Multiplan to signify that a dialog box will be 
presented when the command is selected. See Menu Bar, Dialog Box. 

Empty Folder When the directory of a Macintosh disk is displayed on the screen, 
one of the icons or one of the files listed is called the "Empty Folder." This file shows 
OK of data on file. This folder is used to consolidate files on the Desktop into folders, 
and allows the user to classify files of the same type or files generated by the same 
application together. Before any files are transferred into the Empty Folder, it should 
be duplicated and called "Copy of Empty Folder," and used to hold the files you wish 
to store together. 

Files can be moved into the Empty Folder by dragging the file icon of any files you 
wish to place in the folder over to the folder icon and releasing the mouse button. 
This will cause the file icon to be removed from the Desktop directory display and be 
displayed when the icon for the folder is opened. In the examples below, the Copy of 
Empty Folder is shown, then the Desktop is shown with two letters transferred into 
the folder and with the folder renamed "SFAC Letters." Finally, a copy of the 
directory of that folder is illustrated. 

Empty Trash Macintosh applications use the Trash Can icon as the receptacle for 
those files that are to be erased from a disk. The Empty Trash command option from 
the pull-down Special menu on the menu bar must be used to erase the contents of 
the Trash Can from the disk. Until this option is used, or until the computer is turned 
off, the contents of the Trash Can are still available and may be recovered by 
dragging the file icon out of the Trash Can. 

Emulation Simulation in real time. Computer A emulates computer B by executing 
an emulator program that makes it behave like computer B (i.e., it interprets the 
same instructions). MacWorks is a program that allows the Lisa to emulate the 
Macintosh. MacTerm and other terminal programs used for communications allow 
the Macintosh to emulate computer terminals such as the IBM 3270or IBM 3278 for 
the purpose of communicating with these computers. See MacWorks, Mac Terminal. 

Enable To make a device ready or available to function. Opposite of disable. 

Enchanter• A sequel to the Zork series of text adventure games. The player must use 
magic to prevail in this adventure. lnfocom, Inc. In UK: Softsel. 
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II File Edit Uiew Special 

MacDriue 

MDSystemDislc 
6 it•ms 222K in disk 

0 D 
Syst~rn Foldw Mao 'w'idth 1 .1 MacCopy .doc 

0 
Empty Folder 

Fig. ES The Desktop directory with the Copy of Empty Folder illustrated. 

II File Edit Uiew Special 

MacDriue 

MDSystemDislc 
222K in disk 

0 D ~ 
Syst~m Folder Mac 'w'idth 1 . 1 MacCopy .doc 

0 
Program Doc J Empty Folder 

~ 

Fig. E6 The Empty Folder has been renamed and two letter files have been moved into 
the folder. 
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41 File Edit Uiew Special 

MacDriue 

MD 
3 it•ms 222K in disk 178K availabl• 

0 
Stjsttm Folder 

ram Doc. 
3K in folder 

D 
MaoYiidth 1 .1 MacCoptJ .doc 

Fig. E7 The file folder created by using the renamed Copy of Empty Folder to hold files. 

END END is a Microsoft BAS IC statement used to terminate program execution, 
close all files and return to command level. The format is: 

END 

END statements may be placed anywhere in a program you wish to terminate 
execution. END di f fers from STOP in that is does not cause a "Brea k" message to be 
printed, and it closes all fil es. An END statement at the end of a program is not 
imperative. 

End a Program or System Function A program or func tion may be stopped by using 
the Stop or Suspend command options from the Contro l menu on the menu bar. The 
Stop command stops the program while it is runn ing. and causes the line number at 
which the program stopped to be displayed in the O utput w indow of the Microsoft 
BASIC screen display. 

The Interrupt key on the left-hand side of the Macintosh may be used to interrup t 
or suspend a program. The Reset key in the same location w ill stop a program, erase 
it from memory, and reboot the computer. 

A program may also be stopped by pressing t he Command key and the C key at the 
same time. A program that is stopped in this manner must be restarted by using the 
Run option f rom the Contro l menu or by typing RUN fo llowed by pressing the Return 
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key in the Command window of the screen display. The Suspend command option 
stops the program until any key is pressed. See STOP, Suspend, RUN, Menu Bar, 
Control Menu, Command Key, Interrupt Reset Switch. 

End Current Line Press the Return key to end the current line, send the line to the 
requesting program and put the cursor at the start of the next line. This is valid under 
the Desktop and Microsoft BASIC. 

Enter Key The Enter key is the second key from the right on the bottom row of keys 
on the Macintosh keyboard. This key terminates an entry and may terminate a 
command, depending on the application. It communicates the completion of data 
entry to the computer. When a dialog box is displayed, pressing the Enter key is the 
same as clicking the outlined button in the dialog box. The Return key performs the 
same function with dialog boxes but serves another function in applications such as 
Mac\Vrite where it inserts a line feed in a document. See Clicking, Dialog Box. 
Return Key, Button. 

Environment The state of all registers, memory locations and other conditions in a 
system. Also used to refer to a software environment such as the Macintosh visual 
Desktop environment. 

EOF A Microsoft BASIC Function which indicates an End-Of-File condition. The 
format is: 

<variable> = EOF<filenum> 

<filenum> This is the number specified on the OPEN statement. 
The EOF function can be used to tell if the end of a specified file has been reached, 

and to avoid an "Input past end" error. EOF returns -1 (true) if end of file has been 
reached on the specified file or 0 (zero) is returned if end of file has not been 
reached. 

EOF is meaningful only for a file opened for sequential input from disk or cassette, 
or for a communication file. A -1 for a communications file means that the buffer is 
empty. 

EOF End of File. 

EPROM (11ee-prom") Erasable Programmable Read-Only Memory. A PROM which 
can he reprogrammed several times. Typically, an ultraviolet-erasable PROM which 
can be erased by exposing it for several seconds to hard ultraviolet light. It is then 
reprogrammed with a special PROM programmer and will retain its contents for 
years. A UV-erasable EPROM may be recognized by the quartz window over the 
chip. Other EPROMs are electrically erasable. 

Era 2• A communications system that allows the Macintosh to network with other 
personal computers, mainframes and large public databases. It uses the Microcom 
Networking Protocol, giving the computer access to the IBM PC, the IBM PC XT, the 
IBM PC Jr., the TRS80 Model3 and computers in the Apple II family. Era 2 consists of 
a 1200-baud modem and the communications software required to provide th 
access described above. It provides autodial and autoanswer features, and can use 
pulse or touch tone phone lines. Menu selection is available to set baud rate, parity 
and other communications settings. Microrim, Inc. In UK: P+ P micro distributors. 

ERASE A Microsoft BASIC Statement which removes (from memory) arrays from a 
program. The format is: 
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ERASE <arraynamex,arrayname> ... 

<arrayname> This refers to the name of the array you wish to erase. 
If you are running short on memory space in a program, you may wish to use the 

ERASE statement to establish more memory space to be used for other purposes. You 
may also want to redimension an array, in which case it is necessary first to erase that 
array. Otherwise, a "Duplicate definition" error occurs. 

The ERASE statement is not implemented in the Microsoft BASIC Compiler. 

Erase a File in Microsoft BASIC See KILL. 

Erase All Program Lines NEW In Microsoft BASIC, to start a new program, old 
program lines are erased. To start a new program type: 

NEW 

This completely erases all lines in Microsoft BASIC's memory. If it is something 
you want to keep and do not already have on disk, SAVE it first. If you do not erase 
the program in memory before starting on another, you wi II usually wind up with an 
unusable combination of mixed lines from your old and new programs. 

Erase Current Variables (Not Program) in Microsoft BASIC See CLEAR. 

Erase Files Files may be erased from a disk by moving the file icon from the directory 
window in the Finder into the Trash Can and using the Empty Trash command from 
the Special menu. Files may be erased from a disk in Microsoft BASIC by using the 
DELETE command followed by the filename. Files may be erased from memory in 
Microsoft BASIC by using the NEW command. This command will erase all programs, 
data and files from the memory. 

Erase Last Character Press Backspace to delete last character entered. 

Erase Program Lines in Microsoft BASIC. DELETE To delete program line 100 enter: 

DELETE 100 or 
100 

To delete program lines 100 to 200 enter: 

DELETE 10G-200 

To delete all program lines up to 100 enter: 

DELETE -100 

To delete program lines from 100 on with DELETE you must specify the final line 
number. If you want to delete lines to the end of your program, either LIST to find 
the last line number, or enter a dummy line at the largest possible line number, 
65529. Then enter: 

DELETE 100-65529 

A dummy line might be: 

65529 END. 
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ERR and ERL Microsoft BASIC Variables. The variable ERR contains the error code 
for the last error, and the variable ERL contains the line number of the line in which 
the error was detected. The formats are: 

<variable> = ERR 
<variable> = ERL 

The ERR and ERL variables are usually used in IF ... THEN statements to direct 
program flow in the error handling routine. See ON ERROR COTO. 

If you do test ERL in an IF ... THEN statement, be sure to put the line number on the 
right side of the relational operation, like this: 

IF ERL = <line number> THEN ... 

The number must be on the right side of the operator for it to be renumbered by 
RENUM. If the statement that caused the error was a direct mode statement, ERL will 
contain 65535. Since you do not want this number to be changed during a RENUM, if 
you want to test whether an error occurred in a direct mode statement you should 
use the forms at: 

IF 65535 = ERL THEN ... 

ERR and ERL can also be set using the ERROR statement. See ERROR. 

ERROR A Microsoft BASIC Statement which will simulate the occurrence of a 
Microsoft BASIC error, or will allow you to define your own error codes. The format 
is: 

ERROR <m 

<m must be an integer expression between 0 and 255. 
The Macintosh has error messages which are referenced by certain codes. If the 

value of <m is the same as an error code used by Microsoft BASIC, the ERROR 
statement simulates the occurrence of that error. If an error-handling routine has 
been defined by the ON ERROR statement, the error routine is entered. Otherwise 
the error message corresponding to the code is displayed and execution halts. 

To define your own error code, use a value that is different from any used by 
Microsoft BASIC. To be safe, use codes higher than 200 (the Macintosh's messages 
are below this range). Your new error code may then be tested in an error-handling 
routine, just like any other error. 

If you create your own code and do not handle it in an error- handling routine, an 
"Unprintable error" message is displayed and execution halts. 

Error Codes, Macintosh Operating System The Macintosh Operating System issues 
error codes in circumstances where the Macintosh encounters problems with disks, 
hardware and software. The error codes are displayed in alert boxes when encountered 
with the notation ID = (error code number). A table of Macintosh system error 
codes follows below: 

ERROR CODE 

2 
3 

General System 

General System 
General System 

DESCRIPTION 

Queue element not found during 
deletion 

Invalid queue element 
Core routine number out of range 
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4 General System Unimplemented core routine 
17 1/0 System Control error 
18 1/0 System Status error 
19 1/0 System Read error 
20 1/0 System Write error 
21 1/0 System Bad unit error 
22 1/0 System Unit empty error 
23 1/0 System File open error 
24 1/0 System File close error 
25 1/0 System Tried to remove open driver 

ERROR CODE DESCRIPTION 

26 1/0 System Driver not found in resource file 
27 1/0 System 1/0 call aborted by KILLIO 
28 1/0 System Driver not opened 
33 File System Directory full 
34 File System Disk full 
35 File System No such volume name 
36 File System File 1/0 error 
37 File System Bad file name 
38 File System File not open 
39 File System End of file 
40 File System Read/write head position before 

beginning of file 
41 File System Memory full 
42 File System Too many files open 
43 File System File not found 
44 File System Disk write-protected 
45 File System File locked 
46 File System Volume (disk) locked 
47 File System File busy (while deleting) 
48 File System Duplicate file name (while 

renaming) 
49 File System File already open 
50 File System User parameter list error 
51 File System Reference number error 
52 File System Get file position error 
53 File System Volume was ejected 
54 File System Permissions error (open file) 
55 File System Volume mounted and on line 
56 File System No such drive 
57 File System Not a Mac disk 
58 File System Named volume belongs in 

external file system 
59 File System Entry ·lost when renamed 
60 File System Bad master directory block 
61 File System Write permissions error 
64 Disk Drive Drive not installed 
65 Disk Drive Read/write attempted on 

offline drive 

66 Disk Could not find five nibbles in 200 
tries 

67 Disk Could not find valid address mark 
68 Disk Read verification failed 
69 Disk Address mark checksum wrong 

ERROR CODE DESCRIPTION 

70 Disk Bad address mark 
71 Disk No data mark header 
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72 Disk Bad data mark checksum 
73 Disk Bad data mark 
74 Disk Write underrun 
75 Disk Step handshake failed 
76 Disk Track 0 detect error 
77 Disk Controller Unable to initialize Integrated 

Woz Machine 
78 Disk Controller Tried to read second side of disk 
79 Disk Controller Unable to correctly adjust disk 

speed 
80 Disk Wrong track number on address 

mark 
81 Disk Sector number not found on track 
85 Clock Unable to read same clock value 

twice 
86 Clock Written time did not verify 
87 RAM Parameter RAM did not verify as 

written 
88 RAM INITUTIL found parameter RAM 

not initialized 
89 Serial Ports sec receiver error 
90 Serial Ports sec break received 

100 Scrap Manager No scrap exists 
102 Scrap Manager No object of that type in scrap 
108 Storage Allocator Not enough room in heap 
109 Storage Allocator Nil handle in HandleZone 
110 Storage Allocator Address odd or out of range 
111 Storage Allocator WhichZone failed 
112 Storage Allocator Tried to purge unpurgeable block 
113 Storage Allocator Address in zone check failed 
114 Storage Alocator Pointer check failed 
115 Storage Allocator Block check failed 
116 Storage Allocator Size check failed 
192 Resource Manager Resource not found 
193 Resource Manager Resource file not found 
194 Resource Manager AddResource failed 
195 Resource Manager AddReference failed 
196 Resource Manager RemoveResource failed 
197 Resource Manager Remove Reference failed 

Error Codes, Microsoft BASIC Microsoft BASIC uses error codes much like those of 
the Macintosh Operating System to inform the user of problems or errors that occur 
in Microsoft BASIC programs or in the use of programs. 

Error Code Number of Last Error See ERR. 

Error Correction Methods used to correct erroneous data produced by defective or 
unreliable data storage and transmission systems. 

Error Message A statement or code printed out or displayed on the screen by a 
program to let you know what is happening. Error messages tell you something 
about your problem. The alarm box displays typical Macintosh error messages. 

ESC ESCape. Causes the terminal and/or processor to interpret subsequent characters 
differently. Escape codes are used to indicate a sequence of control messages in 
ASCII. For example, ASCII 27 is an escape code to the lmageWriter dot-matrix 
printer to interpret one or more following bytes as control information rather than 
data to be printed. 
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Escape Use ASCII 27 (escape) for printer control in LPRINT statements to set lines 
per inch, page length and print size. See Control Characters for Printer for more 
information and examples. 

Even Parity A byte in which an even number of bits are set to 1 is said to have even 
parity. 

Event An event is an activity that may be detected by a computer and acted upon. 
On the Macintosh, an event could be the press of a key, the click of the mouse 
button, the click of a mouse button coupled with dragging the mouse or the 
double-click of the mouse button. It could also be the insertion of a disk in a disk 
drive. 

Event Manager The Macintosh's Read Only Memory consists of 64K of memory 
space dedicated to making the computer's user interface available to the programmer. 
The user interface is what the user sees on the screen in situations where he must 
select an application, select a document, make a decision, manage files, initialize 
disks, catalog disks, make programs run, etc. All of the things that the user sees and 
uses to talk to the computer or to make the computer carry out tasks are managed or 
created through over 400 subroutines or programs in ROM. This collection of 
subroutines and programs is called the "User Interface Toolbox." The Event Manager 
is one of the more important units in the toolbox. It is a collection of subroutines 
that receives and interprets keypresses from the keyboard, movements of the 
mouse, mouse button presses and disk insertion. It also generates events that are 
used to manage windows. This unit consists of about eleven subroutines. 

Execute To cause a program or batch file to start functioning or to run. In Microsoft 
BASIC, when you enter RUN in the Command window or use the Run option from 
the Control menu on the menu bar, you get the program resident in memory. If the 
program is on a disk, from the Command wtndow, use: 

LOAD<filename>,R or RUN<filename>,R 

An exception is any disk set up in "turnkey" format. These disks have a startup file 
which is executed automatically when the Macintosh is turned on or rebooted. 

Execute (Microsoft BASIC program) See RUN and LOAD. 

Execution Time The time required to execute an instruction, including fetch-decode
execute. Also used to refer to the point in the processing of a program when it is 
given control of the CPU, as contrasted with compile time, link time and load time. 

EXP A Microsoft BASIC function which calculates the exponential function and 
returns the mathematical number "e" raised to the x power. "e" is the base for 
natural logarithms. If x is greater than 145, an overflow occurs. 

Exponent The notation of the power to which a number is to be raised in a 
mathematical expression. For example, the expression X squared is expressed as X2 
in Microsoft BASIC. 

Exponential (Microsoft BASIC) See EXP. 

Expression Expressions are statements that combine such things as variables, constants, 
functions and other expressions with operators to arrive at a result. Microsoft BASIC 
uses four types of operators: Arithmetic operators, Relational operators, Logical 
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operators and Functional operators. 
Arithmetic operators are the signs that make things happen in mathematics. They 

include +, -, * (times) and I (divide). Relational operators compare values or 
expressions. They include=,<,>,<>,<=,>=. 

Logical operators test conditions of multiple operations, bit multiplication and 
Boolean operations. Logical operators allow the program flow to change based upon 
logical conditions. Such expressions as IF ... THEN ... ELSE and IF ... THEN are used to 
let the program test conditions and decide where to go next. 

Functional operators are predetermined expressions defined by the user with the 
DEF FN statement or they are expressions that are already defined in the programming 
language or the application program that is being used, such as COS, TAN and SIN. 

Extended Arithmetic Double-precision floating point operations. Also used to refer 
to expanded capabilities, such as built-in trigonometric functions. 

External Device Port Connections. An address providing a connection between the 
computer's internal processor and an external device is through the computer's 
ports. Ports are used to attach input and output devices. The Macintosh can address 
a disk drive port, a mouse port, an audio output port and two RS- 232/422 serial 
interface ports. All of these ports are located on the computer's back panel. 

External Memory See Memory. 



F 
F ASCII = 70, HEX= 46. f ASCII = 102, HEX= 66. 

F Flag, Finish in BNPF code, or the hexadecimal symbol for decimal 15, the 
largest hexadecimal digit: 

F base 16 = 15 
15 base 10 = 15 
17 base 8 = 15 
1111 base 2 = 15 

FactFinder• A program that allows the user to store both text and graphics files 
generated by the Macintosh in folders. Graphics must be moved back and forth from 
Factfinder via the Clipboard. Text may be entered directly or transferred via the 
Clipboard. Searches may be made of files based on phonetics, pattern analysis or by 
conventional means. FactFinder Software. In UK: P+ P micro distributors. 

Fan-fold Paper Continuous sheets of paper joined along perforations and folded in a 
zigzag fashion. Often used with printers because it can be continuously fed and 
folded without operator assistance. 

Fatal Error A condition occurring during the execution of a program which requires 
termination of the program. Macintosh applications warn the user of such errors 
through the display of alert boxes. Alert boxes give the user an opportunity to back 
out of the situation that may cause the fatal error. 

Fat Bits Fat Bits is an option that is available to the Mac Paint user from the Goodies 
menu on the menu bar. This option blows up a portion of a Mac Paint drawing so the 
individual dots on the screen may be seen and turned on or off to produce more 
accurate or more artistic drawings on the screen. The pencil icon is used in Fat Bits to 
turn screen dots on or off. They are turned on by placing the pencil point on a dot 
that is off and then clicking the mouse button. Dots may be turned off by placing the 
pencil point on a dot that is on (black) and clicking the mouse button. The mouse 
button may also be held down and dragged over a range of dots rather than clicking 
the button at each dot. 

Fault-tolerant A program or system capable of correct operation even when one or 
more of its components have failed. Also called "error-tolerant" or "fail-soft." 

FCB File Control Block. The block of information set up in main memory to 
maintain temporary information about a file. 

FD Floppy Disk. 

Field A logical grouping of data. It could be a group of related characters in a record 
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(name field), a work area in memory or in the CPU, a zone within an instruction, 
such as opcode, address or comment. 

FIELD A Microsoft BASIC statement which creates room for variables in a random 
file buffer. The format is: 

FIELD [#)<filenum>,<width AS stringvariablex(,width AS stringvariable> 

<filenum> is the number under which the file was opened. 
<Width> is a numeric expression which specifies the number of character positions 

to be made available to (stringvariable). 
<stringvariable> is a string variable which will be used for random file access. 
The FIELD statement defines variables that are used to remove data from a 

random buffer after a GET statement or to enter data into the buffer for a PUT 
statement. For example: 

FIELD 1, 25 AS G$, 15 AS J$, 35 AS Q$ 

Here the first 25 positions (bytes) in the random file buffer are allotted to the string 
variable G$, the next 15 positions to J$ and the next 35 positions to Q$. FIELD does 
not actually place any data into the random file buffer. This is done by the LSET and 
RSET statements. Refer also to LSET, RSET. 

FIELD does not remove information from the file. Information is read from the file 
into the random file buffer with the GET (file) statement. 

The total number of bytes made available in aFIELD statement must not be more 
than the record length that was specified when the file was opened; otherwise, a 
"Field overflow" error occurs. 

Any number of FIELD statements may be executed for the same file number, and 
all FIELD statements that have been executed are in effect at the same time. Each 
new FIELD statement redefines the buffer from the first character position. This is 
similar to having multiple field definitions for the same data. 

Be careful using a fielded variable name in an input or assignment statement. 
Once a variable name is defined in a FIELD statement, it points to the correct pl~ce 
in the random file buffer. If a subsequent input statement or LET statement with that 
variable name is replaced on the left side of the equal sign, the variable is redefined 
in string storage and no longer points to the file buffer. 

File A logical grouping of information given an identifying name and considered as 
a unit by a user. A file may be divided into records, blocks or other units, as required 
by the memory device. Files in Macintosh applications such as MacPaint and 
MacWrite are called "documents." 

File, Data. A file which contains data to be processed by a program. 

File Icon Icons are used to represent files and to identify file types in the Directory 
window on the Macintosh Desktop. MacPaintdocuments and MacWrite documents 
are files. The icons representing these files are distinctive. The icon for a MacWrite 
document icon resembles a letter with the upper right-hand corner turned down. A 
text file icon resembles a blank pad with a pencil in the middle. A MacPaint 
document icon resembles a blank piece of paper with a paint brush and a brush line 
across the bottom. See Icon. 

File, Length of (Microsoft BASIC) See LOF. 

File, Delete or ERASE Move a file to the Trash icon to remove it from the disk. The 
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file will not be actually destroyed until you select Empty Trash from the Special 
menu on the menu bar. 

File, Edit or Change Contents. Edit means to change the contents of a file, including 
both program files and data files. See Edit A Document. 

File, Erase (Microsoft BASIC) See KILL. 

File, Fragmented See Fragmentation. 

File Management (Disk.Maintenance) File management or disk maintenance is the 
record keeping on disks. This includes creating them, finding them by name, 
ensuring that adequate free space is available on the disk, maintaining backups and 
deleting files no longer needed. These functions are supported by the various 
Desktop functions, but require thoughtful planning by the user to ensure proper 
results. 

File Management System A group of programs designed to format and manage user 
files in a transparent way. The system allows symbolic names and attributes, and 
manages the physical allocation of storage. Usually part of the Operating System, as 
in the Macintosh. 

FilePian• A database management program using a spreadsheet format for data 
entry. Each record may contain from 128 to 1024 characters from 32 fields. Each field 
is limited to 99 characters but field length may vary up to that limit. Fifteen records 
may be viewed at once. Data may be sorted on five fields at once. Fields and records 
may be defined after data has been entered into the program. Chang Labs. 
In UK: Softsel. 
File, Program. A program file contains some type of program instructions specifying 
how data is to be processed. 

File Menu The File menu is one of the pull-down menus available on the Macintosh 
Desktop. It is also one of the menus available on the menu bar while applications are 
in use. This menu allows the user to access, close and print files. The File menu on 
the Desktop contains the Open, Duplicate, Get Info, Put Back, Close, Close All, Print 
and Eject options. Only the Open, Get Info, Close, Close All and Eject options are 
highlighted when no file icon has been selected by placing the mouse pointer on a 
file icon and clicking the mouse button once, then all the options on the menu are 
highlighted. 

The Open option causes the selected file or application to be opened and allows it 
to be put into use. The Duplicate option causes a copy of the highlighted file to be 
made on the current disk. The Get Info option displays key information about the 
selected file in a window on the screen. The Put Back option returns files to the 
folder or to the Desktop disk directory window from which they came. The Close 
option closes a file that is currently open or closes an open disk icon. The Close All 
option closes all the file, folder and disk icons currently being displayed on the 
Desktop. The Print option causes the contents of a document to be printed. 
Applications and utilities cannot be printed in this fashion. The Eject option causes 
the disk currently in a disk drive to be ejected. 

The MacWrite File menu has a New option, an Open option, a Close option, a 
Save option, a Save As ... option, a Page Setup option, a Print... option and a Quit 
option. 

The Open and Close options are the same as those described above. The New 
option causes the document that is currently in use to be erased. The Save option 
causes the document currently being worked on to be saved to disk. If this docu-
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ment has not been named, a dialog box will request that it be named prior to saving 
it. The Save As ... option allows a document that is currently being worked on to be 
saved under a new name. This allows several versions of the same document to be 
saved. 

The Page Setup option is used to define the type and size of paper in use. It also 
allows the user to choose Tall, Tall Adjusted and Wide formats for printing docu
ments. Tall is an upright page with the first line of text at the top of the page. Tall 
Adjusted causes pictures to be printed proportionately. Wide turns the text on its 
side. The Quit option allows the user to stop working on a document and a dialog 
box asks whether the document should be saved or not as changed. 

The Mac Paint File menu has the New option, the Open ... option, the Close option, 
the Save option, the Save As ... option, the Revert option, the Print Draft option, the 
Print Final option, the Print Catalog option and the Quit option. 

The Open, Close, Save, Save As and Quit options are the same as described above. 
The Revert option causes the last saved version of a document to be loaded. The 
Print Draft option causes a draft of a drawing to be printed. This method of printing 
is faster than the printing of a final version of a document. The Print Final option 
causes a high-quality copy of a document to be made on the lmageWriter printer. 
The Print Catalog option causes a catalog of the documents on the current disk to be 
printed on the lmageWriter printer. Miniature versions of the entire document are 
printed in this catalog. 
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File Separator A special pattern of bits or a special frequency which separates one 
file from another on magnetic media such as tape or disk. 

File, Text A file containing character data, letters, numbers or special characters. 

FILES A Microsoft BASIC Command which will display the names of files residing 
on a disk. The format is: 

FILES [<filespeC>] 

<filespeC> This is a string expression naming the disk drive or volume (disk) on 
which a file resides. If no filespec is provided, the files on the internal disk drive are 
listed. 

Files per Disk, Number of On each disk Macintosh maintains an index or directory 
of all files. The number of files that may be stored on a disk depends upon the 
capacity of the disk and the space taken up by the applications and other files on the 
disk. See Disk Capacity. 

Fill Down Option Electronic spreadsheets such as Microsoft Multiplan allow the 
contents of cells to be copied into other cells on the same worksheet. These contents 
may consist of numbers (values), text and formulas. Microsoft Multiplan accomplishes 
this copying process by using a Fill Right or a Fill Down option from the Edit menu on 
the menu bar. The Fill Down option is used to copy the contents of a single cell or the 
contents of a range of cells in a row down a column or range of columns. It will copy 
downward one row or several rows depending upon the number of rows that were 
highlighted by dragging the plus sign pointer through rows. 

Filled Shapes These are drawing options available from the Mac Paint Drawing Tool 
menu on the left-hand side of the Mac Paint screen display. The shapes available are 
the filled rectangle, the filled rectangle with rounded corners, the filled oval, the 
filled irregular curve and the filled polygon. When each of these shapes is drawn on 
the MacPaint screen, it is automatically filled with the pattern that has been 
currently selected from the pattern menu at the bottom of the MacPaint screen 
display. 

Filling in Areas (MacPaint) Areas defined by boundaries in Mac Paint may be filled 
with the currently selected pattern from the pattern menu at the bottom of the 
Mac Paint screen by using the paint can option from the drawing tools displayed on 
the left-hand side of the MacPaint screen. The spilled paint portion of the pointer 
(which looks just like the icon) must be positioned within the boundaries of the 
shape to be filled and the mouse button clicked to fill the shape with the selected 
pattern. Be careful to place the spilled paint portion of the icon within the bound
aries of the shape. If it is outside of the boundaries, the screen window will be filled 
with the pattern. The only way to reverse the fill is to use the Undo option from the 
Edit menu. See Pattern Palette, Mouse Button, Drawing Tools, Paint Can, Undo 
Option, Edit Menu. 

Financial Planning Software This software is written to assist the user with financial 
planning and analysis. It may be a spreadsheet program that allows the user to 
design and implement his own formats for analysis. It could also be written specific
ally to perform financial analysis and planning, real estate investment analysis, 
general investment analysis, stock market investment analysis, or similar planning 
and ananlysis. See Multiplan, lotus Macintosh Product, Microplan, AgDisk, Personal 
Tax Planner. 
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Find a File on a Disk If you are in Microsoft BASIC enter in the Command window 
the word: 

FILES 

or 

FILES, fi lespec (disk name) 

This is useful to find a program on file i f you are unsure of the exact spelling of its 
name. If you stil l cannot identify your program from FILES listings of al l disks, you 
may have to load and list likely looking candidates until you find i t. This points out 
the usefulness of program and f ile names that remind you of what the purpose is 
(mnemonic names), and of a REM at the start of each program to make it easy to 
identify when l isted. 

Find Character or String in a String (Microsoft BASIC) See JNSTR. 

o• o• 
oe 
c:?W 

a• 

Fig. F4 MacPaint screen dump showing the use of the paint can pointer to fill in areas. 

Find Command (MacWrite) A particular word or phrase may be fou nd in the text 
· of a MacWrite document by selecting the Find command option from the Search 
menu on the menu bar. This wi l l cause the Find window to be displayed on the 
screen . The word or phrase to be found must be typed into the rectangle in the Find 
window after the words Find What. This wi ll cause the fi rst occu rrence of the 
selected word or phrase to be found and highlighted on the screen. The entry in the 
Find What rectangle is limited to 44 characters of text. When MacWrite is carrying 
out this function, it ignores capita lizat ion, accents on characters, fonts, font size 
and font style. 
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The document is scrolled automatically by the program that carries out this 
command from the first location recognized by the user. Scro lling continues to the 
end of the document then wraps around to the beginning of the document until it 
returns to the fi rst occurrence that was found . To fi nd the next occurrence, click the 
Find Next button in the dia log box. W hen the last occurrence of a word or ph rase has 
been found, an alert box is displayed to inform the user that no other occurrences 
have been found. Click the OK button in the alert box to get back to the document. 
See Search Menu. M enu Bar, Find W indow, A lert Box, Document. 

a File Edit Seanh rormllt ront ~tljlt.> 

-~0 Find 

1 I .~ I· ,7 t ··'-•·- Find whet wo.1 . ·-r 

~ _G (Find NeHt l 0 Whole Word ® Partial Word ~ 
Thls~=====~-_:_ ___ __:::..._ _______ .J 
user to find words in a document and to replace the words with other 
words or phrases as required. 

The 11st below was written to demonstrate the use of the Find feature of 
MacWrite. 

Words 
Dns 
Worldly 
Worst 
Worsted 
Wrap 
Write 

Fig. F5 The Find window that is used in MacWrite to find a particular word or phrase. 

Find Next Button The Find Next button i s the only button that is present in the Find 
window used to instruct MacWrite to Find a particular word or phrase in the text of a 
MacWrite document. See Find Command (MacWrite). 

Find What Rectangle The Find What rectangle is the term used in MacWrite 
documentation to describe the input window used in the Find window displayed 
when the Find command is selected from the Search menu in MacWrite. See Find 
Command (MacWrite). 

Find Window The Find window is a dialog box that is displayed on the Macintosh 
screen when the Find option has been selected from the Search menu on the menu 
bar when MacWrite is in use. See Find Command (MacWrite). 

Finder The Finder is the most important unit in the Macintosh System Folder. It is a 
part of the Macintosh Operating System accessed from disk. It provides tile user 
w ith a visual manner of deal ing with documents and tools that are stored on disk. It 
allows the user to organize and manage documents stored on a disk. The Finder is 
avai lable from the Desktop when a disk is booted . It is also available from w ithin 
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applications such as MacPaint and MacWrite. The Finder can carry out many 
different tasks with disks and the files on disks. It can copy documents, open 
documents, close documents, erase (discard) documents, move documents and 
rename documents. It can also open, close, rename, copy and erase disks. The 
Finder organizes documents and applications on the Desktop in folders and on 
disks. It is responsible for ejecting and initializing disks. 

The Finder is used by selecting icons (pointing at them and clicking the mouse 
button), moving icons (pointing at them, clicking the mouse button, dragging them 
to where you want them and releasing the mouse button) and selecting commands 
from pull- down menus (pointing at the menu, dragging the highlight down to the 
proper selection, and releasing the mouse button). 

The Finder could not operate without access to ROM. It performs many of its 
functions and provides its displays by using routines stored in ROM. When you point 
at a disk icon and click the mouse button, the Finder presents a window that shows 
which files are on the disk selected. This window is called the "Directory window." 

The Finder receives information from the Event Manager when you point at a file 
or application icon and double-dick the mouse button. When this information is 
received, the Finder checks the pointer location and loads the application selected 
or loads the application and the document that was selected. To load the program 
the Finder checks the disk directory and tells the disk drive controller circuits where 
to position the disk drive's read/write head to read the document or application 
from the disk into RAM. Once an application has been loaded, the Finder screen 
display is replaced with the application's screen display. Thus, the finder is the 
conduit between the user and the computer for file manipulation and between the 
computer and its storage devices such as disks and hard disks. 

Finder Menus The Finder menus are displayed on the Desktop when a disk is 
inserted into a Macintosh disk drive and its System file and Finder file are loaded 
into the computer's memory. These menus include the Apple menu. the File menu, 
the Edit menu, the View menu and the Special menu. 

Firmware A program stored in a ROM. Originally, firmware was used only for 
microprograms inside the CPU. In microprocessors, many kinds of programs reside 
in ROM, and firmware designates any ROM-implemented program. About two
thirds of the memory space in the Macintosh ROM contains the User Interface 
Toolbox. The remainder of the space in ROM is taken up by the Operating System. 
See ROM, User Interface Toolbox, Operating System. 

FIX A Microsoft BASIC function which removes all digits to the right of the decimal 
point. The format is: 

<variable> = FIX <X> 

<X> this may be any numeric expression. For example: 

F IX(34.34) returns 34 
FIX(-76.89) returns -76 
FIX is different than INT and CINT in that FIX simply strips the decimal portion of 

your number, while INT gives the lowest integer. 

Fixed Media Fixed media cannot be removed from the device which reads and 
writes on the media. See Media. 

Fixed-point Integer representation with the decimal point assumed to be in a fixed 
position, in contrast to floating point. 
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Flag A status indicator for a special condition. A flag is normally stored in a flip-flop 
or in a register. In the MC68000 chip, the status register has five flags. These flags are 
Carry (C), Overflow (0), Zero (Z), Negative (N) and Extend (E). 

Flip-flop A circuit used to store one bit of information. An FF is bistable with two 
stable states (0 and 1 ). Registers are generally assembled out of flip-flops. 

Flip Horizontal Flip Horizontal is a command option accessed from the Edit menu 
in MacPaint. When this command is used, the shape that has been selected on the 
screen with the rectangle or the lasso icon is rotated 180 degrees around the vertical 
axis so that the shape is turned in the horizontal plane. See Edit Menu, Lasso.R 

Flip Vertical Flip Vertical is a command option accessed from the Edit menu in 
MacPaint. When this command is used, the shape that has been selected on the 
screen with the rectangle or the lasso icon is rotated 180 degrees around the 
horizontal axis so that the shape is turned in the vertical plane. See Edit Menu, Lasso. 

Floating-point (Representation) Representation of numbers in a fixed length format, 
such as 24 or 32 bits. The number N is normalized and encoded as a mantissa field M 
and an exponent field. The name reflects the fact. that the representation remains 
fixed as the decimal point floats, i.e., the changes in magnitude are reflected by 
adjustment of the exponent field with renormalization of the mantissa field. The 
precision of the representation is limited by the number of bits allocated to the 
mantissa field. This is in contrast with fixed-point. 

Floppy Disk A flexible mylar disk for mass-storage of information. The disk is sealed 
in a square plastic jacket and lined with a soft material which cleans the disk as it 
rotates. A cut-out slot provides access for the moving head which must actually 
come in contact with the disk surface in order to read or write. Other holes in the 
jacket provide access to sector index holes in the disk. Disks are hard-sectored if the 
sector start points are marked by holes in the disk. Soft-sectored disks have only one 
(or a few) holes to mark the start of the track. The sector start marks are placed on the 
soft-sectored disk, under software control, in a process known as "formatting the 
disk." The Macintosh uses soft-sectored 3-1/2-inch disks in its standard drives. 
Macintosh disks are dual-density and either 400K (single-sided) or BOOK (dual-sided). 

Floppy, Mini A smaller floppy that is 5-1/4-inches square, compared to 8 inches for 
the original floppy. 

Floppy, Micro A 3-1/2-inch disk, such as those used by the Macintosh. 

Flowchart A symbolic representation of a process. Boxes represent commands or 
computations. Diamonds represent tests and decisions (branches). A flowchart is a 
useful step between process specification and program writing. It aids in under
standing and debugging the program by segmenting it into logical, sequential steps. 

FMS File Management System. 

Folder A folder is a term used to describe a subdirectory system used in an hierarchical 
file structure such as that used with the Macintosh. The folder in the Macintosh file 
system takes the place of the subdirectory in a hierarchical system. Files and 
applications stored on a disk may be organized into folders when the disk directory 
window is being displayed by the Finder on the Desktop. To organize a number of 
files into a folder, the Empty Folder on the Desktop should first be copied and 
renamed to reflect the nature of the files and applications that will be placed in the 
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folder. Then, those applications, documents or files that you wish to store in the 
folder should be dragged into the folder from the Desktop. The organization of files 
into folders helps unclutter the Desktop while it offers the user the means of 
organizing files as he desires. See Finder, Desktop, Empty Folder. 

Font Manager The Font Manager is a unit in the User Interface Toolbox in the 
Macintosh's Read Only Memory. This unit is used to select the fonts used by 
QuickDraw. It contains about five subroutines and can return information about a 
font to an application program. See User Interface Toolbox, Fonts. 

Font Menu The Font menu is available on the menu bar in Mac Paint and Mac Write. 
This menu allows the user to select the font he desires for use in the application. 
Mac Paint offers Chicago, Geneva, New York, Monaco, Venice and Athens. Mac Write 
has the same fonts on this menu. The illustration below shows each of these fonts in 
12-point size. 

Font Mover The MacPaint/MacWrite disk contains a utility program called Font 
Mover and a file called Fonts. Both the program and the file may be copied from the 
MacPaint/MacWrite disk to the System Disk provided with the Macintosh. Before 
Font Mover can be used, it must be present on the application disk on which you 
intend to use it. This program is used to transfer fonts from the Fonts file to the 
System file in Mac Paint, MacWrite, and other applications. It is also used to transfer 
fonts from the System File in an application to the Fonts file. Font Mover presents 
two font catalogs, a command menu and a font description to the user. One catalog 
lists the fonts that are currently present in an application. The other catalog lists the 
fonts that are currently in the Font File. The command menu has four options: Help, 
«Copy«, Remove, and Quit. Help explains each option. «Copy« is used to transfer 
fonts from the System file to the Font file and vice-versa. Remove is used to remove a 
font from an application. Quit is used to get out of Font Mover. 

Fonts Fonts are character sets used to print letters and numerals to the Macintosh 
screen and on paper with the lmageWriter printer. Currently, Mac Write and Mac Paint 
offer a choice among Chicago, Athens, Geneva, New York, Monaco and Venice as 
fonts that may be used with the applications. 

Font Size MacWrite and Mac Paint offer a variety of font sizes for use in generating 
documents. MacWrite offers 9-point, 10-point, 12-point, 14-point, 18-point and 
24-point fonts. Mac Paint offers 36-point, 48-point and 72-point font sizes in addition 
to those offered by MacWrite. This variety allows such things as banners and 
headlines to be printed in sizes different from the size of the text. See Change Font 
Size, Document. 

Font Style MacWrite and MacPaint each offer a variety of type styles to the user, 
available from the Style menu on the menu bar on both applications. MacPaint 
offers two fewer options than Mac Write due to the nature of the program. Mac Paint 
offers Plain, Bold, Italic, Underline, Outline and Shadow styles. MacWrite offers 
Superscript and Subscript in addition to those offered by Mac Paint. These font styles 
may be selected from the pull-down File menu or from the keyboard using the 
Command key in combination with other keys. The Style menu from each of these 
programs is illustrated below. This menu gives examples of each style and also 
provides the Command key combinations for each style. 
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Thi• isltftacPaint Chicag• I pDint plain tgp. 
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Tbis is MacPaint 12 point New York bold type. 
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Tills Is Geneva 12 polni/Jold Italic. 
Fig. F6 The fonts that are available from the Font menu in MacPaint and MacWrite. 

Footer Footers are used in many documents generated by word processors to 
convey standard pieces of information such as page numbers on the bottom of each 
page. They are also used to make notations and references, such as footnotes, that 
are related to the text shown on a particular page of a document. MacWrite can 
generate up to six lines of footer information on each page by using the Open Footer 
command option on the Format menu. The use of this command option causes a 
Footer window to be opened to set up the footer information for a single page or for 
all of the pages of a document. 
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Fig. F7 The Style menu from M acPain t and MacWrite. Note the two additional options in 
the MacWrite menu and the Command key combinations in both menus. 



136 • Footer Window 

Tabs and line spacing may be set up within the Footer window. Text justification 
may be defined. The page number, the current time and the current date may also be 
displayed by dragging the icon for each of these options to the location within the 
window where each of these items are to be printed. Once a footer has been defined, 
the Footer window is closed by using the close box in the upper left-hand corner of 
the window. Footer windows and footers may be removed from a document by using 
the Remove Footer command option from the Format Menu. See Window, Docu
ment, Close Box, Footer Window. 

Footer Window The Footer window is displayed on the MacWrite screen when the 
user selects the Open Footer command from the Format menu. This window 
contains a ruler, a title bar, a close box, six lines for defining footer, a tab icon, a 
decimal tab icon, line space icons and text justification icons. See Footer, Format 
Menu, Close Box, Window, Ruler, Title Bar, Decimal Tab, TAB. 

FOR and NEXT Microsoft BASIC Statements. The FOR statement used in conjunc
tion with the NEXT statement performs a series of instructions in a loop a given 
number of times. The format is: 

FOR <variable> = <X> to <y> [STEP <Z>] 

NEXT !<variable> ][,<variable> ... ] 

<variable> is an integer or single-precision variable to be used as a counter. 
<X> is a numeric expression which is the initial value of the counter. 
<y> is a numeric expression which is the final value of the counter. 
<Z> is a numeric expression to be used as an increment. 
Within a single FOR ... NEXT loop, all lines following the FOR statement are 

executed until the NEXT statement is encountered. Then the counter (x} is incremented 
by the amount specified by the STEP value (z). If you do not specify a value for (z}, 
the increment is set to 1 (one}. A check is then done to see if the value of the counter 
is now greater than the final value (y}. If it is not greater, Microsoft BASIC goes back 
to the statement after the FOR statement and the process is repeated. If it is greater, 
the first statement following the NEXT statement is executed. 

If the value of (z) is negative, the check is reversed." The counter is decremented 
each time the loop is executed and execution continues until the counter (x) is less 
than the final value (y). 

The statements within the FOR ... NEXT loop are not executed if (x) is already 
greater than (y) when the STEP value is positive, or if (x) is less than the (y) when the 
STEP value is negative. If (z) is zero, an infinite loop will occur unless you provide 
some way to set the counter greater than the final value. 

"Nested loops" is the name given to a situation where one or more FOR ... NEXT 
loops are placed inside a FOR ... NEXT loop. Whenever FOR ... NEXT loops are nested, 
each loop must have a unique variable name as its counter. The NEXT statement for 
the inner loop must appear in a statement before the NEXT statement for the outside 
loop. However, if nested loops have the same end point, a single NEXT statement 
may be used for all of them. Using the format: 

NEXT variable1, variable2, variable3 

is the same as 



NEXT variable1 
NEXT variable2 
NEXT variable3 
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The variable or variables in the NEXT statement may be left out. In this case the 
NEXT statement returns to the most recent FOR statement. When using FOR ... NEXT 
loops, include the variable or variables on all the NEXT statements. It is a good rule 
of thumb to use variable names on all NEXT statements in order to avoid confusion. 

When a NEXT statement is encountered before its corresponding FOR statement, 
a "NEXT without FOR" error is displayed. Some examples are: 

10 M=2:K=10 
20 FOR I=M TO K STEP 2 
30 PRINT I; 
40 NEXT 
RUN 
2 
4 
6 
8 

10 

Foreground Program A higher-priority program in a multiprogramming environment. 
Also, a program in charge of interfacing with a user or a process. See Background 
Program. 

Form Feed Advance to top of page printer. The Microsoft BASIC statement to form 
feed is: 

LPRINT CHR$(12) 

Or use the top of form or form feed control button (FF) on the printer. You may 
then need to adjust the paper in the printer so it actually is at the top of a page as 
defined by the perforations. 

In a program, you may want to provide instructions to the operator and a pause 
through the use of a dummy input statement, or a delay loop to allow the adjustment 
of the paper. 

Format Menu Format menus are available on those applications that require or 
provide a variety of different formats for text or number presentation. Word processors 
and spreadsheet programs use format menus to set up the display of pages, text and 
numbers. MacWrite and Microsoft Multiplan each use format menus to set up the 
presentation of output on the screen or on paper. The MacWrite Format menu 
provides command options called Insert Ruler, Hide Rulers, Open Header, Open 
Footer, Display Headers, Remove Footers, Set Page# ... , Insert Page Break and Title 
Page. 

The Insert Ruler option is used to change text formats, set up tables and to 
otherwise display rulers that show tab markers, margin markers, the paragraph 
indentation marker, line spacing icons, text justification icons and the cursor 
location on the screen. The Hide Rulers option is used to remove all rulers from the 
screen display. The Open Header and the Open Footer options are used to define 
and set up headers and footers in a MacWrite document. The Remove Footers 
option allows footers to be removed from a document. The Display Headers option 
causes headers that are currently in use to be displayed on the screen at the top of 



138 • 

a File Edit Search •limilillll font Style 

Insert Ruler 

-~-L-• .. .1 ...•... ! .. •-l.? •.. ! ...•... l ...•... ! ...• ... 

~~ ~ 

Hide Rulers 
Open Header 
Open Footer 
Display Headers 
Display Footers 
Set Page# ••. 
Insert Page Break 
Title Page 

Decimal 
Scientific 
Bar Graph 

Calculate 

Number Of Decimals •.• 

Hllgn Left :JCF 
Rllgn Center 3CG 
Rllgn Right 3CH . , 

~-···-·-·--·---··---···---·····-···-··--·--····-! · .. : ........ 0 .... 0 0... • ................. : 

Commas 

Column Width ... 
·· ······· ········· ··· ··· ··· ····'--...--------' . . . . . . 
········ ·· ······ ·· ··· ······· ··· ···································· ·· ······· ········ ··· ······· .. .............. . . . . . . . . . . . . . 

Fig. FB The Format menus from Mac Paint and Microsoft Multiplan. Note the numeric slant 
of Multiplan and the text slant of MacPaint. 
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each page of a document. The Set Page# ... option sets the page number of the first 
page of a document. The Insert Page Break forces a page break where it is used in a 
document. The Title Page option causes header or footer to be displayed or printed 
on the first page of a document. 

The Format menu in Microsoft Multiplan is more oriented toward the formatting 
of numbers than text. The various formats that are available in Multiplan may be 
invoked for a single cell, a part or all of a row or a column of cells or in a range of 
cells. The cells that are to be formatted are selected by dragging the plus sign pointer 
over the cells that will contain a particular format, causing them to be highlighted. 

The Format menu in Multiplan offers the following options: General format, 
Dollar format, Per Cent format, Decimal format, Scientific format, Bar Graph 
format, the definition of the Number of Decimals in the Decimal format, Align Left 
for text, Align Center for text, Align Right for text, Comma format for numbers and 
the adjustment of Column Width from the keyboard. 

Formatting a Disk Disks must be set up with such things as directory files, track 
markers and sector markers if they are to be useful to a computer system. The 
computer's operating system generally causes this process to occur by writing the 
required references to disk in a process called "formatting" or "initializing." The 
Macintosh's Finder performs this function any time an uninitialized disk is placed in 
a Macintosh disk drive. See Disk, Initialize a Disk. 

Formula Bar Electronic spreadsheet programs such as Microsoft Multiplan use a 
portion of the screen display to show any formula that might be contained in a 
particular cell in the spreadsheet. Multiplan uses a window on the I ine just below the 
menu bar at the top of the screen display to show the formula, text or numeric value 
in the currently active cell in the spreadsheet. This window occupies more than half 
the width of the screen display on the right-hand side. See Spreadsheet, Active Cell. 

FORTH A programming language and operating system. FORTH is characterized by 
threaded code and postfix, or reverse Polish notation. FORTH is an extensible 
language; you can create new commands-defined in terms of the existing commands 
or in machine language code. Your new commands then become part of the FORTH 
language in exactly the same way as the standard commands. This feature allows 
you to build up precisely the commands you would request If you were designing a 
language especially to suit a particular application or type of problem. FORTH is 
also highly transportable from one microcomputer to another, more so than Microsoft 
BASIC and most other languages. FORTH tends to run fast and closer to machine 
code than to higher-level languages like Microsoft BASIC. FORTH may be somewhat 
harder to master than Microsoft BASIC, but it offers many advantages. FORTH is 
available for the Macintosh from Creative Solutions, Inc. 

FORTH Development System• See MacForth. 

FORTRAN FORmula TRANslator. One of the first high-level languages, still widely 
used, especially by scientists and engineers. Microsoft BASIC is largely based on 
FORTRAN, using statement numbers and a similar set of commands. The differences 
are slight, mostly dealing with 1/0 statements. FORTRAN includes the FORMAT 
statement for formatting printed output. It is rich in mathematical functions and 
supports an extended precision calculations mode for scentific problems. 

FORTRAN is a compiled language, not interpeted like Microsoft BASIC. A pro
gram is edited in a file, then submitted to a compiler for translation into executable 
object code. FORTRAN and Microsoft BASIC are so similar that Microsoft BASIC 
could be called an interpeted dialect of FORTRAN. Here is a sample FORTRAN 
program to sum the first 100 integers: 
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20 FOR I = 1 TO 100 
30 J = J + I 
40 NEXT I 
50 END 

Forward Reference Electronic spreadsheet programs can calculate all of the formulas 
contained in the cells of the spreadsheet by reading the cells across the horizontal 
rows, one row at a time, starting at the top of the worksheet, or they can calculate 
the contents of the worksheet by reading the columns down each vertical column, 
one column at a time, starting at the leftmost column. If a particular cell is 
encountered that contains a formula or expression that refers to another cell located 
in an area of the spreadsheet that has not yet been read, the cell is said to contain a 
forward reference. Thus if the worksheet is being calculated in row order and 
calculated through the fifth row from the top and the cell that is currently being 
calculated contains a reference to a cell in the twenty-third row from the top, this 
reference is a "forward reference." 

Forward references usually cause an error message to appear in the cell that 
contains them, which may be overcome by causing the entire worksheet to be 
recalculated two or three more times. This manual recalculation is accomplished by 
using the Calculate Now option from the Calculate menu on the menu bar or by 
pressing the Command key and the equal sign key at the same time. See Calculate 
Menu, Calculate Now Option, Cell, Spreadsheet, Worksheet. 

Fragmentation A situation in which mass memory (disk, hard disk, etc.) has been 
allocated in such a way that it has many unallocated areas (fragments) that are too 
small to be useful or to allow optimum performance. The remedy for fragmentation 
is compacting all of the allocated areas into a single area to make the space 
occupied by fragments available in one large block. See Memory Manager. 

FRE A Microsoft BASIC function which will return the number of bytes in memory 
not being used by Microsoft BASIC. This number does not include the size of the 
reserved portion of the interpreter work area, which is normally 2.5K to 4K bytes. The 
format is: 
<variable> = FRE(<X>) 
<variable> = FRE(<x$>) 

<X> and <x$> are dummy arguments. 
Since strings in Microsoft BASIC can have variable lengths, strings are manipulated 

dynamically. Each time you do an assignment to a string, its length may change. For 
this reason, string space may become fragmented. 

FRE with any string value will cause a housecleaning before returning the number 
of free bytes. This means that Microsoft BASIC is collecting all of its useful data and 
freeing up unused areas of memory that were once used for strings. The data is 
compressed so you can continue until you actually do run out of space. 

Microsoft BASIC will automatically do housecleaning when it is running out of 
usable work area. You could even use FRE(' ''')occasionally to get shorter delays for 
each housecleaning routine. 

CLEAR,(n) sets the maximum number of bytes for the Microsoft BASIC workspace. 
FRE returns the amount of free storage in the Microsoft BASIC workspace. Refer also 
to CLEAR. 

Freeze (Or Hold) Screen Display To freeze the screen briefly while the operator 
using your program reads a message, just write a delay loop after you print the 
message: 



1000 FOR Y = 1 TO 2000 
1010 NEXT Y 
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To freeze the screen until the operator is done with it, put in a dummy input 
statement and instruct the operator to press Return to proceed. The input variable 
(A$) need not be used in your program: 

1000 INPUT" Press Return to continue" ;A$ 

Frequency The number of cycles per second. F = 1/T where T is the period in 
seconds over which cycles are counted. 

Friday• An electronic, menu-driven file-handling system which prompts the user 
where decisions are required. It will work with dBase II and the Lotus Macintosh 
Product. It can find filed information quickly, and perform mathematical functions 
such as totals, subtotals, commissions and others. A variety of reports are available 
and easily structured. Ashton-Tate. 

Front Panel A panel with lights and switches to display information and allow direct 
control or access to memory or registers. A front panel requires a specific interface 
and a monitor program. Many microcomputers have no front panel and all access is 
then performed from a keyboard and screen. 

Frozen Keyboard, How to Restart If the Macintosh fails to respond to the keyboard 
or to the mouse during the use of a program or application. it can be shut off by 
turning off the power switch and then turned back on by turning the power switch on 
again. If a disk is in the disk drive, the disk will be rebooted. If the problem arises as 
the disk is booted, you will want to eject the disk. This can be done by pressing the 
mouse button and holding it down while you turn the Macintosh power switch off 
and then on again very quickly. The last resort (if you do not like the approaches 
discussed above) has the same result as turning the computer on and then off: press 
the Reset button that was installed on the lower left-hand side of the case by you or 
the dealer when you bought the Macintosh. It will not eject the disk, but it will 
restart the system if the keyboard freezes. See Reset, Mouse Button, Eject Disk. 

Full Duplex A communication technique which allows data to be transmitted and 
received simultaneously. This technique is accomplished by each computer using a 
different frequency of transmission. 

Full Justification The ruler on the MacWrite screen display contains four boxes in 
the lower right-hand portion of the ruler. Each of these boxes is used to select the 
manner in which text will be justified in a MacWrite document. The box on the 
extreme right is called the "Full Justification box." When this box is clicked, the 
margins on the right-hand side of the document and the left-hand side of the 
document wi II be aligned. This justification is called "full justification." It provides a 
straight margin on both sides of the document. This justification will be used unless 
it is changed in the ruler or until another ruler containing another justification is 
inserted below the ruler that contains the acivated Full Justification box. 

Full Screen Editor Edit means to change the contents of a file, including both 
program and data files. Several different editors are used with the Macintosh: 

(1) the Microsoft BASIC editor; 
(2) other editing programs such as a word processing program, other languages 

with built-in editors, or other software packages that have built-in editing capabilities 
(Multiplan, some database systems, etc.). 
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Editors are considered line-oriented if they work on one line at a time and deal 
with text by line number. 

Full screen editors, by contrast, allow you to change any data currently displayed 
on the screen. Most treat paragraphs or even entire documents as a unit, allowing 
reformatting, change of margins with justification, block moves, etc. Most word 
processing programs are full screen editors. 

The Microsoft BASIC editor lies between these two categories. It allows you to 
change any Microsoft BASIC line on the screen, but still treats the data as a 
collection of lines. You must press Return while the cursor is on a line you have 
changed with the Microsoft BASIC editor, or the changes are not effective. 

Editing of program lines in Microsoft BASIC for the Macintosh is accomplished by 
listing the program in the List window on the screen, pointing at the line number of 
the line to be edited, clicking the mouse button to move the line from the List 
window to the Command window, pointing at the position in the line that requires 
the insertion or deletion of characters, clicking the mouse button again to display 
the vertical bar cursor at the insertion point and then adding or deleting the 
characters required to make the program line correct. See Edit, List Window, 
Command Window, Insertion Point, Mouse Button, Vertical Bar Cursor, Delete 
Character. 

Full Screen Editor, Cursor The cursor is the symbol which appears on the screen to 
let you know where an action (such as typing in a character, deleting, inserting, etc.) 
will take place. The cursor moves to the right as you type, and backs up to the left 
when you press Backspace or cursor left f- key. Backspace usually erases the 
characters from the screen as the cursor moves left, while cursor left f- usually 
does not. The fundamental way of moving the cursor around the screen is by rolling 
the mouse across the Desktop. 

Functions From the Menu A menu is a screen display which lists a number of 
possible options and asks the user to select one. When a selection is made by keying 
in an identifying number or letter (or by positioning the cursor beside the desired 
item, using a light pen, etc.) the function is performed. This may require either a 
branch or subroutine call to the code for the selection. or may require that a program 
be loaded into memory and run. 
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Games See Cyborg, Deadline, Enchanter, Infidel, Mac Puzzle, Mac-Slots, Millionnaire, 
Mind Over Mac, Murder By The Dozen, Pensate, Planetfall, Run For The Money, 
Seastalker, Sargon Ill, Sorcerer, Starcross, Suspended, The Coveted Mirror, The 
Quest, Transylvania, Wizardry, Xyphus, Zork (1, II, & Ill). 

Gap The space between two records or two blocks of information on a magnetic 
medium, usually set to a predetermined value, such as all1's. It allows blocks to be 
rewritten in a slightly expanded or reduced format, due to speed variations of the 
drive. 

Garbage Collection A technique for collecting unavailable, unused space in a mass 
memory and making it available for reuse by any of several schemes. 

Gate A single logic function. The NAND, NOR, AND, OR, XOR and NOT functions 
are examples of gates. 

Generate Line Numbers Automatically (Microsoft BASIC) See AUTO. 

GET Files A Microsoft BASIC statement which reads a record from a random file 
into a random buffer. The format is: 

GET [ # ]<filenum>(,<number>] 

<filenum> is the number under which the file was opened. 
<number> is the number of the record which is to be read. It is in the range 1 to 

16,777,212. When <number> is left out, the next record (after the last GET statement) 
is read into the buffer. 

Following a GET statement, INPUT #, LINE INPUT # or references to variables 
defined in the FIELD statement may be used to read characters from the random file 
buffer. 

Since Microsoft BASIC blocks as many records as possible in 512-byte sectors, the 
GET statement does not necessarily perform a physical read from the disk. 

GET (Graphics) A Microsoft BASIC statement which reads poi.nts from an area of 
the screen. The format is: 

GET (<x1, y1>)-(<x2, y2>),<arrayname> 

<x1,y1>-<x2,y2> refers to the coordinates in either absolute or relative form. 
The specified rectangle has points <x1,y1> and <x2,y2> as opposite corners. 
GET and PUT can be used for high-speed object motion in graphics mode. You 

could think of GET and PUT as "bit pump" operations which move bits onto the 
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screen (PUT) and off of the screen (GET). Remember that PUT and GET are also used 
for random access files, but in a different syntax. 

The<arrayname> is used as a place to hold the image. It must be numeric, but may 
be any precision. The required size of the array, in bytes, is: 

4+ INT((<x>*bitsperpixel + 7)/8)*<y> 

where <X> and <Y> are the lengths of the horizontal and vertical sides of the 
rectangle, respectively. The value of (bitsperpixel) is 2 in medium resolution, and 1 
in high resolution. 

Get Info Option A command option available from the File menu on the menu bar 
displayed by the Finder. When a file is selected from the Desktop, by pointing to the 
file icon or the file name and clicking the mouse button once to highlight the file, 
the pointer may be moved to the pull-down File menu and then dragged down to the 
Get Info command. When this command is highlighted, the mouse button should be 
released. A window then displays the file name, type, size, date last modified, the 
location (internal disk drive, external disk drive, hard disk), the date the file was 
created, a button for locking and unlocking files and any comments that you may 
wish to add about the fi I e. The Get Info option works the same way for disk icons as it 
does for files. 

Ulew Special 

MS-BRSIC ~ 
~ Close 

Close All 
Print bytes, accounts for 51 K on disk 

......................................................... o~1r•ue, HppleBus 

t , January 1, 1904 at 3:01 PM 
Modified: Friday, January 1, 1904 at 5:21 PM 

D Locked 

MS-BHSIC IS R UERSION Of MICROSOFT BASIC THAT HAS 
BEEN WRITTEN FOR USE ON THE MACINTOSH. THIS UERSION 
OF THE LANGUAGE IS LORDED INTO RAM AND USED. 

Fig. G1 Get Info window display. 

Glitch A pulse or burst of noise. A small pulse of noise is called a "snivitz." Glitch is 
usually reserved for the more dangerous noise pulses which cause crashes and 
failures. 
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Global Search and Replace This is a common feature of word processors, allowing 
all occurrences of a word or phrase identified to the program by the user to be 
changed to another word or phrase supplied by the user. This feature is available in 
MacWrite from the Search menu's Change option. To use this feature, the Change 
All button must be clicked in the Change window. See Search Menu, Change. 

Global Variable A variable whose name and value are accessible throughout the 
program or application system. A local variable is accessible only within the block 
where it is defined. 

Goodies Menu The Goodies menu is a pull-down menu that is available in Mac Paint. 
This menu contains eight command options. These options are Grid, FatBits, Show 
Page, Edit Pattern, Brush Shape, Brush Mirrors, Introduction and Short Cuts. Introduction 
is an explanation of each of the icons on the drawing tool palette and the pattern 
palette. It also describes the lines and borders that are available in MacPaint. Short 
Cuts describes the short cuts that are available to the user by double-clicking various 
icons and by using the Command key, Shift key and Option key in conjunction with 
clicking certain icons. It also illustrates which keys are reused to copy, constrain, 
stretch, undo and clear images. Brush Mirrors is used to set up the ability to draw 
mirror images with the paint brush. Brush Shapes is used to select a particular brush 
shape and size. Edit Pattern is used to alter the patterns in the pattern palette at the 
bottom of the MacPaint screen display. Show Page displays an entire 8-1/2 by 11 
page with the current display window shown as a rectangle drawn with broken lines. 
FatBits blows up a portion of the screen to show the individual dots that make up a 
drawing. Each dot may be turned on or off by clicking it with the mouse button. Grid 
ensures that shapes are moved up or down along straight lines. 

GOSUB and RETURN These are Microsoft BASIC statements used together and 
function to branch to and return from subroutines. The format is: 

GOSUB <line> 

. <line>- begin subroutine 

RETURN !<line>] 

<line> is the line number of the first line of the subroutine or the line number for the 
RETURN. 

You can call a subroutine using COSUB any number of times in a program and a 
subroutine may be called from within another subroutine. 

The RETURN statement causes Microsoft BASIC to branch back to the statement 
following the GOSUB statement from where it exited. A subroutine may contain 
more than one RETURN statement (if you want to return from different points in the 
subroutine). You may place subroutines anywhere in a program. 

In order to keep your program from returning a subroutine that should not be 
executed, it may be necessary to use a STOP, END or GOTO statement to direct 
program control around it. Refer also to ON GOSUB and ON GOTO. 

GOTO A Microsoft BASIC statement used to exit from the normal program se
quence to a specified line number. The format is: 

GOTO <line> 

<line> is the line number in the program you want to execute next. 
The <line> specified after GOTO will be executed if it is an executable statement. If 
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<line> is a nonexecutable statement. such as OAT A or REM, the program will continue 
until it finds the first executable line after that. 

In debugging, the GOTO statement can be used in direct mode to re-return a 
program at a desired point. Refer also to ON GOSUB and ON GOTO. 

Grabber Used by many people at Apple computer to describe the "hand'' icon from 
the drawing tools on the left-hand side of the MacPaint screen display to move the 
View window around the page. 

Graphic Magician, The* A program that allows the user to generate detailed graphics 
pictures and integrate them into other applications such as text games. Penguin 
Software. In UK: Softsel. 

Graphics See PUT. 

Graphics Software See Clip 1, Clip Art, Cut 'N Paste, DaVinci, Graphics Magician, 
GraphPian, Images, MacAnimation, MacDraw, MacPaint, MacPuzzle, Mac the 
Knife, McPic, Microsoft Chart, Picture Disk, PaintMover, PFS Graph, Shapes 'N 
Shots. 

GraphPian• A program that integrates spreadsheets with business graphics. It has 
many built-in formulas and statistical commands, as well as graphics, sorting and 
ranking features. legends are generated automatically. X-axis andY-axis labels, tic 
marks, and numeric, time date, and logarithmic labels are generated automatically 
as required. The program can generate explodable pie charts, horizontal and vertical 
line charts and bar charts. Chang labs. In UK: Softsel. 
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H Hexadecimal. Used as a prefix or suffix to denote hexadecimal numbers in Intel 
format. Also, High, the most significant half of a register or a pointer. 

Habadex• A desktop convenience program that puts a telephone directory, a 
telephone dialer, an appointment calendar, a letter writer, a list generator, a form 
generator, a label printer and a mailing list generator at the user's fingertips on the 
Macintosh. Preset forms are used to enter names, addresses, phone numbers, zip 
codes, company names, titles and other pertinent information into a database with 
this program. The program will search its records to find a specific entry which can 
be used to dial a phone number through a modem or special adaptor box. The 
calendar is selected by clicking on a particular month. The schedule for a particular 
day is obtained by zooming that day's number on the calendar. Zoom features are 
also available on name listings. A Quick Dial list may be set up for important friends 
and clients. A Things To Do list may also be set up and updated. Material can be 
merged from Habadex to MacWrite. Haba Systems, Inc. 
In UK: P+ P micro distributors. 

Half-duplex A mode of communication in which data may be transmitted in only 
one direction at a time between two devices such as computers. MacTerm allows 
the selection of half-duplex vs. full-duplex to ensure that the Macintosh can 
communicate with any device that requires the half-duplex protocol. 

Halt System Operation The system operation of the Macintosh may be halted at the 
end of a session by turning off the main power switch on the back panel of the 
computer. The system may be "warm-booted" or "warm-started" (fooled into thinking 
it was turned off although it was not) by pressing the Reset button that you or your 
dealer have installed in the vents on the lower left-hand side of the computer case. 
Both of these methods cause any data that was left in RAM to be lost. If a disk is left 
in a disk drive, this disk will be booted when either method is used. If no disk is left in 
the disk drive when either procedure is followed, the disk request icon will be 
displayed on the screen (flashing disk icon with a question mark inside the image of 
the disk). See Disk Icon, Back Panel. Warm Boot, Interrupt Reset Switch, Reset, 
RAM. 

Handler A program used to control or communicate with an external device such as 
a disk drive. 

Hard Copy Computer output printed on paper. 

Hard Disk A disk composed of a magnetic coating applied to a rigid substrate, such 
as aluminum or ceramic. The term is generally used to contrast with soft (floppy) 
disks, which are flexible. Floppy disks are slower and have less storage capacity. 
Some hard disks are permanently fixed within the hard disk drive that is used to read 
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from them and write to them. Others are designed as cartridges that may be removed 
and replaced as needed. 

Hard Disk Drives Devices capable of reading information from hard disks and 
writing information to hard disks. The disks used by these devices have a larger 
capacity than 3-1/2-inch, 5-1/4-inch and 8-inch disks, and spin the hard disk much 
faster than a normal disk drive. The read/write heads on these devices can track 
better than the heads of a normal disk drive. 

Hard disk drives are available for disks with a 5-megabyte up to 32-megabyte 
capacity. Some of these disk drives have the hard disk fixed permanently in the disk 
drive. Others use a cartridge that may be removed from the hard disk drive as 
required. Tecmar is producing a hard disk drive called the "Mac Drive."Oneof these 
systems is a 5-megabyte cartridge system. The other is a 10-megabyte fixed disk 
system. Davong Systems, Inc. is also producing a hard disk system for the Macintosh 
called the "Mac Disk." This system offers from 5 to 32 megabytes of hard disk 
storage. Micro-Design offers the PRO Series 5, 10 and 20 megabyte drives. See Mac 
Drive, Mac Disk, PRO Series. 

Hard-sectored Describes a disk in which the recording surface has been divided into 
sectors using nonalterable methods, such as a ring of holes in the disk itself. In 
contrast soft- sectoring is done by software control. Hard-sectored disks require 
more hardware but can also store more information. The 3-1/2-inch disks used by 
the Macintosh disk drives are soft- sectored. See Sector, Disk. 

Hardware The boards, chips, wires, etc., of a system, as opposed to software 
(programs). Hardware also refers to expansion devices. For Macintosh expansion 
hardware, see Accessories, Digitizers, Hard Disks, Interfaces, Modems, Monitor 
Adaptors, Printers, Printer Buffers. 

Hardware vs. Software Computer programs of all kinds are called software. Software 
is contrasted to hardware, the actual chips, wires, boards, etc., which make up the 
computer. A special case is Read-Only Memory (ROM) (q.v.), which is hardware that 
contains a permanent copy of software. These terms can create confusion. For 
instance, which term applies to the User Interface Toolbox, which means a ROM 
(hardware) containing a copy of machine language routines and subroutines (software)? 
Such ROMs are often called "firmware" to distinguish them from nonprogram 
hardware and from software in changeable media (RAM, disk, cassette, etc.). 

Header Header is used to describe information placed in the top margin of each 
page of a document, such as a letter, a report or a book, and might consist of a 
company logo, the subject of a report and the author's name, the current date or the 
page number of the document. This information might appear on only one page or 
on each page of the document. Many word processing programs such as MacWrite 
allow the user to define and generate headers. 

Header Window Headers are created with MacWrite by selecting the Show Header 
option from the Format menu. When this option is selected, a Header window is 
displayed on the screen with six lines to be set aside for placing information in 
headers. This window allows tabs and line spacing to be set, text justification, the 
inclusion of consecutive page numbers, the inclusion of the current date and the 
current time, along with such text as may be entered by the user. 

Pictures generated by MacPaint or similar programs may be transferred into the 
header from the Clipboard by using the Cut or Copy options from the Edit menu to 
move the picture from Mac Paint to the Clipboard, exiting Mac Paint, loading Mac Write 
and pasting the picture into the header. This feature could be used to include logos 
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generated in MacPaint on letters and other documents generated by MacWrite. See 
Window, Format Menu, Clipboard, Cut Option, Copy Option, Paste Option, Edit 
Menu. 

Heap The heap in the Macintosh is the general RAM memory area that may be 
allocated for use by data and programs on demand. Its use is controlled by the 
Memory Manager which makes more efficient use of the memory space than the 
last-In First-Out systems used by most other computers. See Memory Manager, 
RAM. In UK: Softsel. 

Helix• Helix is an interactive information system for the Macintosh. It is a very 
powerful database management program. Input forms are created easily. Free-form 
reports are generated easily. Tables of calculated numbers may be generated from 
data. Pictures may be drawn on MacPaint and employed in Helix. Windows, 
pull-down menus and the mouse are used by this program. Calculations may be 
diagrammed visually. Icons are created by the program and associated with the 
information that is entered into Helix. Form letters may be generated by Helix. 
Complex search sequences may be used to collect data from the database. Data may 
be cut and pasted between forms. Files may contain numbers, text or pictures. 
Odesta Corporation. In UK: Softsel. 

Help Button Microsoft Multiplan uses a unique approach to providing the user with 
information about the program and how to use it. This information is obtained by 
selecting "About Multiplan" from the Apple menu on the Finder display or on the 
menu bar in the application. When selected, a dialog box is displayed containing 
information about Multiplan and a button marked "Help." If this button is clicked, a 
series of help screens that describe the features and commands of Multiplan are 
displayed. See Button, Dialog Box. 

HEX$ A Microsoft BASIC function which returns a string representing the hexadecimal 
value of the decimal argument. The format is: 

<stringvariable> = HEX$(<m) 

<n> is a numeric expression in the range -32768 to + 32767. 
When <n> is negative, HEX$<-m is the same as HEX$<32767-m (two's complement 

form). 

Hexadecimal to Decimal Conversion See HEX$. 

Hide Clipboard Option Once the Clipboard has been opened by selecting the Show 
Clipboard option from the Edit menu in MacWrite, it may be closed either by 
clicking the Close button in the upper left-hand corner of the Clipboard, or by 
selecting the Hide Clipboard option from the Edit menu. See Edit Menu, Show 
Clipboard Option, Close Box. 

Hide Footer Option After a footer has been created in MacWrite, the Footer 
Window may be closed by clicking the close box in the upper left-hand corner of the 
window, or by selecting the Hide Footer option from the Format Menu on the menu 
bar. See Menu Bar, Format Menu, Window, Close Box. 

Hide Rulers Option Rulers are used in MacWrite to indicate the position of margins. 
indentation, tabs. line spacing, text justification and cursor position. A ruler is 
displayed at the top of the screen when MacWrite is booted. Additional rulers may 
be added to the document in positions where the user wishes to change justification, 
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indentation, tabs, and spacing within the document. which are inserted by using the 
Insert Ruler option from the Format menu on the menu bar. Rulers may be hidden 
from the document's screen display by using the Hide Rulers option from the same 
menu. When this option is selected. all of the rulers on the screen display are hidden. 
See Ruler, Menu Bar, Format Menu. 

Highlight The highlight is a device used in the Macintosh Desktop, the Desktop 
directory, in pull-down menus and in most applications to indicate which icons. 
documents, applications, files, portions of text or portions of a spreadsheet have 
been selected for action by a command. All of these things are selected and 
highlighted by clicking them with the mouse pointer. Multiple items may be 
selected by dragging the mouse pointer over each of the items or by holding down 
the Shift key and clicking each item to be selected individually. The Shift key is held 
down continuously with this method until the last item has been selected by clicking 
the mouse button. 

Highlighted Command All commands available from the menus on the menu bar of 
the Finder and the menu bar of an application are displayed when the mouse pointer 
is placed on top of the menu's name and clicked. As the pointer is dragged down the 
list of options on the menu, each option passesd over is highlighted and appears as a 
black background with white letters. If the mouse button is released while an option 
is highlighted in this fashion, the option will be selected and executed by the Finder 
or by the application. See Menu Bar, Pointer, Finder. 

Highlighted Icon When the pointer on the Desktop is placed on a file or a disk icon 
and the mouse button is clicked, the icon is darkened and called a "highlighted 
icon.'' Once highlighted, it may be acted upon by the File menu. See File Icon, Icon, 
Mouse Button, Desktop, File Menu. 

Hold/Freeze Screen Display, How to To freeze the screen briefly while the operator 
using your program reads a message, write a delay loop after you print the message: 

1000 FOR Y = 1 TO 2000 
1010 NEXT Y 

To freeze the screen until the operator is done with it, put in a dummy input 
statement and instruct the operator to press Return to proceed. The input variable 
(A$) need not be used in your program: 

1000 INPUT" Press return to continue" ;A$ 

Holding Register A register that holds data temporarily to bridge a speed or timing 
gap between two devices. 

Hollow Shapes Five shape icons that appear on the drawing tool menu on the 
left-hand side of the MacPaint screen display are called "hollow shapes." They 
consist of a hollow rectangle, a hollow rounded square, a hollow oval, a hollow 
polygon and a hollow free-form sbape. When one of these icons is selected as a 
drawing tool, the shape that it generates is not filled by the pattern currently active 
from the pattern menu on the bottom of the screen display. See Drawing Tools. 

Home Accountant• A personal financial management program, allowing the user 
to define specific account types and tie them to sources of income and checking. 
accounts. It can be used for tax planning, tracking checkbook transactions, budget 
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preparation, tracking actual costs against budget and for investment calculations. It 
has limited graphing ability. Continental Software. In UK: Softsel. 

Home Software See Educational Software, Games, Personal Management. 

How to Use Your Macintosh• An on-disk training program that introduces the full 
power of the Macintosh to the new user. It presents a step by step introduction to the 
computer. American Training International. In UK: Softsel. 

Human Engineering Designing hardware or software that is easy for people to use. 
In terms of hardware, it refers to designing equipment that will be comfortable for a 
person to use physically and easy on the eyes, and eliminating any other unnecessary 
fatigue or difficulties of use. For software, human engineering refers to ease of use 
and ease of learning, and has become a synonym for user friendly. 

Several guidelines exist for writing user friendly programs. If a complex series of 
data items has been typed in and some entries turn out to be invalid, the user should 
be able to reenter the bad items without redoing everything. Error messages should 
indicate not only that an entry is invalid, but also just how it is invalid and, if 
possible, hints on correcting it. 
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1-beam A pointer used by MacPaint, in the Text mode. A lso used by MacWrite and 
by Microsoft BASIC, when program lines are being edited in the Command window. 
This pointer is displayed in the screen dump below, and appears between the words 
" by" and " Megahaus" in the first line of the letter. It is used to position the vertical 
bar cursor in the proper position on the screen to input or delete characters. The 
verti cal bar cursor is displayed at the 1-beam's location at the time that the mouse 
button is cl icked. See Vertical Bar Cursor, Clicking, Command Window, Pointer. 

a File Edit Search Format Font Style 
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Fig. 11 A M acWrite screen dump that illustrates the 1-beam. This pointer is located between 
the words " by" and " M egahaus" on the first line of the letter. 

IC Integrated Circuit. 

Icon A picture used to identify a function, a fi le type, a di sk drive type or a drawing 
tool. The Macintosh lends itself to the use of icons because it supports the mouse as 
a selection and input device. The combination of the icons and the mouse provide 
the user wi th a convenient and easy to understand method of selecting functions. 
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selecting commands, manipulating files and otherwise dealing with the computer 
and its operating system. Icons are used by the Finder in the Desktop display and by 
many of the application programs that run on the Macintosh. See the frontispiece 
for a visual guide to icons. 

IF A Microsoft BASIC statement which makes a decision regarding program flow 
based on the result of an expression. The formats are: 

IF <expression> THEN <clause> I ELSE <clause>) 
IF <expression> GOTO <line> I ELSE <clause>)$FL 

<expression> may be any numeric or string expression. 
<clause> may be a Microsoft BASIC statement. a sequence of statements separated 

by colons or the number of a line to branch to. 
<line> is the line number of a line that exists in the program. 
If the value of the numeric expression is not zero (true), the THEN or GOTO clause 

is executed. THEN may be followed by a line number for branching or one or more 
statements to be executed. GOTO is always followed by a line number. 

If the value of the numeric expression is zero (false), the THEN or GOTO clause is 
ignored and the ELSE clause, if any, is executed. Execution continues with the next 
executable statement. 

When you enter an IF ... THEN statement in direct mode, and it directs control to a 
line number, an "Undefined line number" error message is displayed if you have not 
already entered a line with the specified number. 

When using IF to test equality for a value that is the result of a single- or 
double-precision computation, remember that the internal representation of the 
value may not be exact. Single-and double-precision numbers are stored internally 
in floating point binary format, so the test should be against the range over which 
the accuracy of the value may vary. 

IF ... THEN ... ELSE statements may be nested. You are restricted only by the length 
of the line entered. Each statement must contain the same number of ELSE and 
THEN clauses; otherwise, each ELSE is matched with the closest unmatched THEN. 

Images• A disk that contains more than 150 images that may be used in MacPaint, 
MacWrite, and other applications which allows the use of the clipboard for graph
ics. Matrix Advocates Company. In UK: P+ P micro distributors. 

lmageWriter A specially modified printer built by C. ltoh for Apple Computer. It is a 
dot-matrix printer capable of producing high-quality text and graphics output to 
form feed or friction feed paper. The lmageWriter produces characters in a matrix 
that is seven dots wide and eight dots high with a separation of one dot between all 
dots that are printed. At ten characters per inch, the lmageWriter prints up to 120 
characters per second or 72lines per minute. Its standard character set consists of 96 
ASCII alpha and numeric symbols and 25 European language characters. Vertical 
dot spacing is 1/72 of an inch. It can produce from 4.5 to 17 characters per inch and 
from 72 to 136 characters per line of print. 

Paper feeds both forward and reverse. This allows the convenient generation of 
subscripts and superscripts. Line spacing varies from 1/144 to 99/144 of an inch and 
can be controlled by commands received from the computer. The maximum line 
feed rate is ten lines per second at a setting of six lines per inch. Paper width may 
vary from three to ten inches. Three inches is the normal label stock and ten inches is 
greater than the normal width of pin-feed stock that produces 81/2- by 11- inches 
pages. The lmageWriter is an 8-bit serial interface device. It supports proportional 
spacing if the fonts in use are proportional. It can produce high-quality pictures, 
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charts and other graphics output. See Control Characters for Printer, and various 
entries under Print, Printer and Printing. Apple Computer, Inc. 

Immediate Response to One-character Answers (without using Enter key). To pro
vide immediate response to a one-character response (Y or N, drive letter, etc.), use 
INKEY$ to input the reply. The program can then proceed and process the request 
without the user having to press Enter after the response. Examples: 

10 PRINT "Make another copy Y/N?" 
20 ANS$=1NKEY$:1F INKEY$ =""THEN GOTO 20 
30 IF ANS$ = "Y" OR ANS$ = "y" then GOTO 1000 
40 IF ANS$ = "N" OR ANS$ = "n" THEN GOTO 2000 
50 GOTO 10 

This technique can be used with a numeric response by applying the VAL 
function: 

20 ANS$ = INKEY$: IF INKEY$ = "" THEN GOTO 20 
30 NUMBER= VAL(ANS$) 

Inactive Window Any window on the screen display (Desktop, Microsoft BASIC, 
Microsoft Chart) that contains dimmed icons or is not on top of a stack of windows. 
A window becomes active when the pointer is placed inside the window and the 
mouse button is clicked. If windows are stacked one on top of the other, an inactive 
window is moved to the top of the stack when it is clicked. It then becomes 
an active window. 

Index Disk Directory On each disk Macintosh maintains an index or Directory of all 
files, which is loaded into memory by the Finder when the disk is inserted in a 
Macintosh disk drive. The Directory is displayed in a window by the Finder when a 
disk icon on the Desktop is double-clicked. This window will be displayed for all of 
the disk icons on the Desktop although some of these disks may have been ejected. 
As long as the disk icon remains on the screen, although the disk has been ejected, 
the disk's Directory will be displayed and files may be selected from it. If a file has 
been selected for opening from an ejected disk, the current disk will be ejected and 
the ejected disk will be requested by the Finder. The icons for files and the disk icons 
for ejected disks appear somewhat hollow or ghostly on the screen display. See 
Finder, Directory, Desktop, Double-clicking. 

Infidel• A text adventure game which is a treasure hunt with several good puzzles to 
solve. lnfocom. In UK: Softsel. 

Information Window The window that is displayed when the Get Info command 
option is selected from the File Menu in the Finder. See Get Info Option. 

Initialize a Disk See Disk. Initialize. 

INKEY$ A Microsoft BASIC variable which reads a single character from the key
board. The format is: 

(stringvariable) = INKEY$ 

INKEY$ will read only one character, regardless of how many characters are 
waiting in the keyboard buffer. The returned value is a zero- or one-character string. 

zero length- indicates that no character is pending at the keyboard. 
one-character- contains the actual character read from the keyboard. 
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The result of INKEY$ must be assigned to a string variable before using the 
character with any Microsoft BASIC statement or function. When IN KEY$ is in use, 
no characters are displayed on the screen. All characters are passed through to the 
program except for Command-C, which terminates the program. 

If you press Enter in response to INKEY$, the carriage return character passes 
through to the program. 

INPUT A Microsoft BASIC statement which receives input from the keyboard 
during program execut.ion. The format is: 

IN PUT[;)[<'' prompt''>; ]<variable>[ ,<variable> ... ] 

<''prompt''> is a string constant which will be used to prompt for the desired input. 
<variable> is the name of the numeric or string variable or array element which will 

receive the input. 
When the program encounters an INPUT statement, it pauses and displays a 

question mark (?) on the screen to indicate that data is to be typed in. When a 
"prompt" is included, this string is displayed before the question mark. When you 
use a comma(,) instead of a semicolon after the <"prompt"> string, the question 
mark is not displayed. 

The data entered is stored in the variable or variables declared in the variable list. 
Each data item typed in must be separated by commas, and the number of data 
items must match the number of variables in the list. The type of each data item 
entered must also agree with the type specified by the variable name (string or 
numeric). Strings entered in response to an INPUT statement do not need to be 
surrounded by quotation marks unless they contain commas or significant leading 
or trailing blanks. 

If you respond to INPUT with too many or too few items, or with the wrong type of 
value (string data instead of numeric data), Microsoft BASIC will display a "?Redo 
from start" error message. If a single variable is requested and you do not want to 
en~r any value, press Enter to indicate the default values of 0 for numeric input or 
null for string input. If more than one variable is requested, pressing Enter will cause 
a "?Redo from start" error message to be displayed (too few items were entered). No 
input values will be assigned to any variables until an acceptable response is given. 

If INPUT is immediately followed by a semicolon, pressing Return to input data 
does not produce a carriage return/line feed sequence on the screen. The cursor 
remains on the same line as your response. 

Input READ data into memory. Memory is any device which can store information 
and allow it to be retrieved when needed. The Macintosh relies primarily on Random 
Access Memory (RAM), Read- Only Memory (ROM). disks and hard disks. ROM and 
RAM together make up the internal or main memory of the Macintosh or any other 
computer. Data may be read into memory from any of these devices. It may also be 
read into memory from another computer via a direct connection or a modem. 

INPUT# A Microsoft BASIC statement which reads data items from a sequential 
device or file and assigns them to program variables. The format is: 

INPUT #<fi lenum>,<variable>[ ,<variable> ... ] 

<filenum> is the number used when the file was opened for input. 
<variable> is the name of a variable that will have an item in the file assigned to it. It 

can be a string or numeric variable, or an array element. 
The sequential file may be located on disk, it may be a sequential data stream 

from a communications adapter or it may be the keyboard (KYBD:). The type of data 
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in the file must agree with the type specified by the variable name. No question mark 
is displayed with INPUT# (unlike INPUT statement). 

The data items in the file must appear just as if the data were being typed in as 
responses to an INPUT statement. For numeric values, leading spaces, carriage 
returns and line feeds are ignored. The first character encountered (not a space, 
carriage return or line feed) is assumed to be the start of the number. The number 
ends with a space, carriage return, line feed or comma. 

If Microsoft BASIC is scanning the data for a string item, the leading spaces, 
carriage returns and line feeds are also ignored. The first character found (not a 
space, carriage return or line feed) is assumed to be the start of the string item. If this 
first character is a quotation mark (" ), the string item will consist of all characters 
read between the first and next quotation mark. If the first character of the string is 
not a quotation mark, the string is an unquoted string; it will end with a comma, 
carriage return or line feed, or after 255 characters have been read. If end of file is 
reached when a numeric or string item is being input, the item is cancelled. 

INPUT# can also be used with random file processing. 

INPUT$ A Microsoft BASIC function which returns a string of (n) characters, read 
from the keyboard or from a file number. The format is: 

<stringvariable> = I NPUT$(<m(,l # ]<filenum>]) 

<m is the number of characters that are to be read from the file. 
<filenum> is the file number used on the OPEN statement. If <filenum> is left out, the 

keyboard is read. 
When the keyboard is used for input, no characters will be shown on the screen. 

All characters (including control characters) are sent through, except Command-C. 
which is used to interrupt the execution in the INPUT$ function. When responding 
to INPUT$ from the keyboard, you do not have to press Enter. 

The INPUT$ function allows you to read characters from the keyboard which are 
significant to the Microsoft BASIC program editor. If you want to read these special 
characters, you should use INPUT$ or INKEY$ (not INPUT or LINE INPUT). 

For communication files, the INPUT$ function is preferred over the INPUT# and 
LINE INPUT# statements, since all ASCII characters may be significant in commun
ications. 

Input/Output Ports Sockets on the back or front panel of the computer that allow 
the internal circuits of the computer to be connected to devices that input to or 
accept data from the computer. 1/0 ports may handle data in a serial fashion (one 
bit after another over a single wire) or a parallel fashion (one bit after another over 
several wires). 

The Macintosh back panel has five ports. Facing the back panel, the first port on 
the left is the mouse port, an input port. It accepts signals and data from the mouse 
or from other devices such as graphics tablets, digitizer pads and joysticks that are 
designed to emulate a mouse. The second port from the left is the disk drive port, an 
input/output port. Data may be carried to or from the computer's circuits by this 
port. It may handle a single external disk drive and transfers data at a rate of 62.5 kb 
per second. The third port from the left is a serial 1/0 port designed to use both the 
RS-232C and the RS-422 communications hookups and protocols. This particular 
port is designated as the modem port. Tecmar uses this port to connect the 
Mac Drive hard disk system. The fourth port from the left is also a serial I/O port with 
the same characteristics as the third port from the left. This is designated as the 
printer port. The lmageWriter and other serial printers would be connected via this 
port. The last port on the back panel is the Audio Output port, used to connect the 
Macintosh to an external sound system or an external speaker. The computer may be 
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connected to a high- fidelity amplifier via its AUX connection if you wish to amplify 
the sound generated by the Macintosh. This port is an output-only port. 

There is one port on the front panel of the Macintosh. It is an 1/0 port located in 
the lower right-hand corner and is used to connect the Macintosh's keyboard to the 
computer. This port is also used to connect the optional numeric keypad to the 
Macintosh. When this keypad is connected to the computer, the keyboard is 
disconnected from this port and connected to a port on the keypad. See Serial, 
Parallel, Protocol, RS-232C, RS-422, lmageWriter, Numeric Keypad. 

Input Statement, Dummy To hold or freeze the screen briefly while the operator 
using your program reads a message, just write a delay loop after you print the 
message: 

1000 FOR Y = 1 TO 2000 
1010 NEXT Y 

To freeze the screen until the operator is finished, put in a dummy input statement 
and instruct the operator to press Enter to proceed. The input variable (A$) need not 
be used in your program: 

1000 INPUT" Press Enter to continue" ;A$ 

Input/Output See Input, Output. 

Insert Characters To place characters between those already on a line. This could 
be an omitted letter in a word or an omitted word in a line. This process is described 
in Edit. 

Insert Line To place a line between two existing lines in a file (or in internal 
memory). The inserted line could also go at the very top or bottom of the file. In 
some cases the very first line to go into a file is also considered an inserted line. 

Insert Page Break Option Word processing programs such as MacWrite allow the 
user to force a page break at any point required in the text. When the computer 
encounters a page break command or marker, it causes the printer to break off 
printing on the current page and to advance the paper to the top of the next page. 
MacWrite allows the user to insert page breaks via the Insert Page Break option that 
may be selected from the Format menu. This selection may be made anywhere in a 
document as many times as required. When this option is selected, a rectangle fills 
the screen in the area between the end of the text where the page break was inserted 
and the top of the next page. This rectangle expands and contracts as characters are 
added or deleted before the point where the page break was inserted. See Format 
Menu, Document. 

Insert Ruler Option MacWrite uses rulers to set tabs, indentation, line spacing, text 
justification and to provide a reference for cursor location. When MacWrite is 
booted, a ruler is displayed at the top of the screen display. Additional rulers may be 
added anywhere in a document as many times as required, and would be inserted in 
situations where the user needs to set up special tabbing for outlines or tables. They 
would also be inserted in situations where text justification must be different from 
the justification elsewhere in the document. Once the ruler has been inserted and 
the required settings are made, it may be displayed continuously on the screen with 
all other rulers, or may hide all of the rulers. Rulers are inserted by selecting the 
Insert Ruler command option from the Format menu on the menu bar, or hidden by 
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selecting the Hide Rulers command option. See Menu Bar, Selecting, Justify, Line 
Spacing, Tab, Document. 

Inserting a Disk Disks are inserted in the Macintosh's internal disk drive or its 
external disk drive by holding the disk label up, and with the sliding door that 
protects the read/write slot facing the disk drive slot. Disks should be inserted gently 
but firmly. When inserted properly, it will drop slightly in the slot and will be locked 
in by the disk drive mechanism. See Disk Drive, Read/Write Slot, Disk. 

Inserting Text Text may be inserted in documents created by MacWrite by placing 
the 1-beam pointer at the location in the document where text is to be added, and the 
mouse button clicked. This causes a vertical bar cursor to be displayed at the 
insertion point. If the text is to be entered from the keyboard, it should be typed in 
until the new text is completely entered for that insertion point. When the insertion 
is completed, the 1- beam should be moved to the next location where text will be 
added. When all required text has been inserted, the document should be saved. If 
the insertion is to be made from the Clipboard, the insertion point would be selected 
in the fashion described for inserting text from the keyboard. Once the vertical bar 
cursor is being displayed, the Paste option may be selected from the Edit menu on 
the menu bar. This will cause the contents of the Clipboard to be inserted, starting at 
the location of the vertical bar cursor. See 1-beam, Menu Bar, Edit Menu, Insertion 
Point, Clipboard. 

Insertion Point The insertion point for text in Mac Write is where additional text is to 
be added to the document. The user determines this point in the text and marks it by 
moving the mouse pointer (an 1-beam) to the location and then clicking the mouse 
button. Then a vertical bar cursor replaces the 1-beam at the selected point. New text 
may be added at the location of the vertical bar cursor by typing in the characters 
and words to be inserted in the text. See 1-beam, Vertical Bar Cursor, Document. 

Inside the Macintosh• By Thorn Hogan, delves into the Macintosh and its 
operation. It deals with the hardware that makes the Macintosh the computer 
that it is. It also discusses the MC68000 microprocessor in depth. The Macintosh 
disks, ROM and other aspects of the computer are discussed completely. Brady. 

INSTR A Microsoft BASIC function which searches for the first occurrence of string 
(y$) in (x$) and returns the position at which the match is found. The optional offset 
(n) sets the position for starting the search in (x$). The format is: 

<variable>= INSTR([<n>,]<x$,y$>) 

<n> is a numeric expression in the range 1 to 255. 
<~$,y$> This may be any string variable, string expression or string constant. 
If <n> is greater than LEN<x$> or <X$> is null, or if <y$> cannot be found, I NSTR returns 0 

(zero). If <y$> is null, INSTR returns <n> or 1, if <n> is not specified. If <n> is out of range, 
an "Illegal function call" error is displayed. 

Instructions A statement that causes a computer to carry out a specific action. 
Commands differ from instructions in several ways. A command is a complete 
specification of an action, while instructions must be combined in dozens or 
hundreds to make a useful program. Commands are acted upon immediately by the 
computer, while instructions are saved for later execution in a program. Commands 
are acted on by the basic operating system of the computer, while instructions must 
first be processed by a particular program, such as the Microsoft BASIC interpreter, a 
FORTRAN or Pascal Compiler, etc. 
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INT A Microsoft BASIC function which returns the largest integer that is less than or 
equal to (x). The format is: 

<variable> = INT(<X>) 

<X> is any numeric expression. 

For example: 

PRINT INT(57.97) returns 57. 
PRINT INT(-4.53) returns -5. 

See FIX, CINT. 

Integer, Convert To (by Rounding) See CINT. 

Integer Variable (Numeric) Integer (numeric) variables for whole numbers from 
-32768 to +32767 end in % or start with a series of letters specified in a DEFINT 
statement. 

Integer numeric variable names must start with a letter, can have up to 40 
characters, must not be any reserved words (IF, ON, THEN, GOTO, etc.} or a 
reserved word followed by a type declaration character ($,%,!, # ). See Reserved 
Words for complete list. See Variable Names. 

Integrated Circuit A complete electronic circuit with multiple components (transistors, 
diodes, resistors, capacitors, etc.) all constructed on a single, small silicon chip. 

Integrated Software The trend in software is toward multifuntion systems, which 
integrate several of the major applications: spreadsheets, databases, word processors, 
communications and graphics. Integration implies the ability to move freely from 
one application to another and move blocks of data. See Jack 2, Lotus Macintosh 
Product. 

Integrity of Data Ensuring that data (or programs) cannot be altered improperly. For 
example, in a payroll system, steps must be taken to ensure that employees cannot 
alter their pay rates or hours worked. Data security consists of guaranteeing both 
data integrity and data secrecy or privacy. 

Interface The point at which two systems make contact. Most microcomputers 
have multiple interfaces or "ports," such as a serial port to connect serial devices, a 
parallel port and possibly TV or monitor ports, power port, joystick ports, etc. 
Interface is also used to refer to the type of interconnection, with respect to its size 
or shape (subminiature 25-pin D connector), its mode of function (serial, parallel, 
etc.) or its electrical characteristics (RS-232, IEEE, RS-422, etc.). For additional 
interfaces available for the Macintosh, see Candy Apple IEEE-488, Appleline, Monitor 
Adaptors. 

Internal Memory See Memory. 

Interpreter A language translation program. Any programs that run directly on the 
Macintosh are machine language programs in the actual numeric instruction code 
of the Macintosh's MC68000 microcomputer chip. Most were originally written by a 
programmer as text (source) files. The source program contains relatively readable 
statements in a language such as FORTRAN, COBOL or Microsoft BASIC. These 
were then translated by a compiler program, producing an object program. 
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The object program contains the machine language instructions for the Macintosh's 
MC68000 which correspond to the instructions of the original source program. 
Microsoft BASIC programs work in this way with a Microsoft BASIC Compiler. 

Regular Microsoft BASIC works in a slightly different way. It is a program (in 
machine language) which uses your Microsoft BASIC program as a guide to tell the 
computer what to do. It is therefore an interpreter, processing each line of the 
source program and interpreting what should be done. Since it must reinterpret your 
source program each time you run it, interpreted Microsoft BASIC can be as much as 
100 times slower than compiled Microsoft BASIC. 

When you write a Microsoft BASIC program, you have produced a source program 
in text form. The Microsoft BASIC interpreter, itself a machine language program, 
uses your source program as a data source of instructions or commands to control its 
execution. 

To speed up a Microsoft BASIC source program by compiling it into a faster 
machine language program, you will need a Microsoft BASIC Compiler (not supplied 
with the Macintosh) soon to be available from software houses. To run your 
Microsoft BASIC Compiler, input the source program you wrote. The Microsoft 
BASIC Compiler will translate your source program into an executable machine 
language program. 

Interrupt A signal to an MPU that an event has occurred requiring attention. The 
MPU will save enough information to resume the task it is currentlyworkingon, then 
execute a code from an interrupt servicing program. There may be multiple interrupt 
lines or other ways of distinguishing interrupts, in which case the MPU can tell from 
which interrupt signal it receives, which event has occurred (vectored interrupts). 
The MC68000 provides eight types of interrupt. Interrupts are a more efficient way of 
managing external events (such as a key press at a keyboard) than continL:Jally 
checking to see if any event has occured (polling). 

Interrupt Reset Switch When you unpack your Macintosh, you will find a plastic 
switch marked Interrupt Reset in one of the boxes. This is called the "Programmer's 
switch" in the Macintosh manual. It is not installed at the factory, under the theory 
that no one but a programmer will find it useful or will know how to use the switch. 
The manual warns that when this switch is used, you could lose information stored 
in the computer's memory. This switch can be useful to the non programmer as well 
as the programmer. First, it must be installed properly. This is done by turning off the 
Macintosh, disconnecting all of the cords attached to the back panel, turning the 
Macintosh so you have a clear view of the left side of the computer, finding the 
ventilation slots on the lower portion of the left side, locating the rear portion of the 
lower three slots (the correct location in these slots is toward the rear of the 
computer and has no vertical braces within the vent), turning the Macintosh on its 
side, grasping the switch firmly between your thumb and forefinger with the words 
"Interrupt Reset" on top and inserting the two flat fingerlike tabs into the second slot 
from the bottom at the rear of the left side of the computer. 

Once the switch has been inserted, press it down firmly with both thumbs. You 
may have to rock it gently toward the back of the computer then toward the front of 
the computer to make it lock in place. Once in place, the flat fingerlike projections 
will contact the Interrupt Reset switch located inside the computer case. Once 
installed, the computer should be set upright, and the power cord and other cords 
should be reconnected. The Macintosh can then be turned on again, and the switch 
can be tested. 

The Interrupt switch is used to break the flow of a program and to return the user 
to the next highest control level. Thus, if you are running a BASIC program and press 
this switch, the program will stop its operation and will return to the command level 
of BASIC. The program will still be present in memory. The Reset switch is used to 
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stop the operation of the program and the computer. Then it returns the user to a 
power-on state but everything that was in the computer's memory is lost. You may 
find a use for either of these switches if a program hangs up and locks you out of the 
keyboard. You may find the Interrupt switch useful to stop a program and rewrite a 
line or two. 

Introducing Ths Apple Macintosh* A book written by Edward S. Connolly and 
Phillip Lieberman, providing a general introduction to the use of the Macintosh. 
Howard W. Sams Co., Inc. 

Inverse The normal Macintosh screen display in MacWrite, MacPaint, Microsoft 
Multiplan and many other applications is a white background with black letters. 
When certain portions of a document, worksheet, a pull-down menu or an icon are 
highlighted, the background be~omes black and the characters become white. This 
type of display called "inverse." 

1/0 Input/Output. This abbreviation is used to describe devices, connections or 
circuits that can accept data from a source external to the computer and send it to an 
external device from the computer. Input devices provide data to a computer, 
output devices accept data from a computer and do something with it such as 
display or print it. 



J 
J ASCII 74, HEX 4A. j ASCII106, HEX 6A. 

Jack 2• An integrated software package for the Macintosh, offering word process
ing, database management, business graphics and a spreadsheet. Business Solu
tions, Inc. In UK: P+ P micro distributors. 

Justify To make the edges of a text file line up. Left justification is almost universal 
in English text. Right justification is usually present in text that has been typeset or 
processed by a word processor or special typewriter which inserts a variable amount 
of space between words or letters (proportional spacing). 
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K ASCII 75, HEX 48. k ASCII107, HEX 68. 

K Measurement of bytes. Storage in computer memory. Byte is a label for storage to 
to hold one character (letter, digit, etc.) in computer memory, internal or external. 
Byte is abbreviated B, or in thousands KB, or simply K. Actually, 1 K = 1024 because 
this number is an even power of 2. Macintosh has 128K (or 128KB) of internal 
memory, or 128,000 bytes (to be precise, 128K = 128 x 1024 =131,072 bytes). The 
Macintosh also has 64K or internal memory space devoted to ROM and to the User 
Interface Toolbox. 

KB A Kilo-Byte. Measurement of bytes in thousands. SeeK. 

Kearsarge SX-70 Switcher/Spooler• A multichannel switcher/spooler that can serve 
up to four computers and two printers at once. Switching is software controlled and 
a buffer is included. Its memory capacity may be 8K, 32K, 64K, 128K or 384K. An 
expansion board may be installed to expand buffer memory to 512K. Kearsarge 
Industries. 

Keyboard The computer keyboard is either a built-in or detached set of typewriter
like keys connected to the computer by a connector cord. The keyboard is an input 
device that allows the user to communicate commands or responses to the com
puter. The Macintosh keyboard is a detached keyboard connected to the front panel 
of the computer via a plug similar to the plug that connects your telephone to the 
wall. It is a sturdy, full-travel keyboard with raised keys including character keys 
(letters, numbers and special characters) and special keys (Shift, Caps Lock, Option, 
Command, Enter, Return, Backspace and Tab). 

Keyboard (ECHO Function). ECHO means to send characters keyed on the keyboard 
to the screen for a visual confirmation of what has been typed. Since there is no 
hardwired connection between the keyboard and the screen, the keyboard simply 
enters characters into memory, then the ROM copies the characters from memory to 
the screen, creating a duplication or "echo" of what was keyed. 

Keyboard, Read Data from See INKEY$, INPUT, LINE INPUT. 

Key Caps Key Caps is one of the Macintosh desk accessories available from the 
Apple menu in the upper left-hand corner of the screen display. It is selected by 
placing the pointer on the Apple, pressing the mouse button, dragging the highlight 
to the words "Key Caps" on the pull-down menu and releasing the mouse button. A 
window displays the keyboard and a data entry rectangle appears on the screen. This 
display is intended to show the user the effect of using the Shift key, the Option key 
and the Caps Lock key. Characters are entered in the rectangle at the top of the 
display by pointing at the character on the keyboard and clicking the mouse button 
or by typing the character from the keyboard. Once an entry has been made in the 
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rectangle, it may be cut or copied to the Clipboard and pasted into another 
document or application. 

Fig. K1 The Key Caps display with the Shift key pressed. 

Keys (Rate of Repetition) The Macintosh Control Panel available from the Apple 
menu allows the user to adjust the rate at which a key repeats when the key is held 
down. The repeat speed is adjusted by selecting a number from the upper panel of 
numbers next to the keyboard icon on the Control Panel. There is a turtle on the left 
and a rabbit on the right. If a lower number is selected, the repeat key is slow; if a 
higher number is selected, it is faster. See Control Panel, Icon, Clicking. 

Keystroke Data Base• A database management program for the Mainctosh. Brock 
Software Products. In UK: P+ P micro distributors. 

Keystroke Report Base• A database report generator for the Macintosh. Brock 
Software Products. In UK: P+P micro distributors. 

Keyword A word with special significance to a program. It must not be misspelled or 
used for other purposes, or erroneous results may occur. 

KILL A Microsoft BASIC command used to delete a file from a disk. The format is: 

KILL <filespeC> 

<filespeC> is a valid file specification. The device must be a disk drive. If the device 
name is left out, the internal drive is used. 

You can use KILL for all types of disk files. The name must include the extension, if 
one exists. For example, you may save a Microsoft BASIC program using the 
command: 

SAVE II SAMPLE" 

If a KILL statement is given for a file that is already open, a "File already open" 
error occurs. For example: 

100 KILL II SAMPLE" 
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will delete the file named "SAMPLE" on the disk. 

Kilobyte One thousand bytes (technically, 1024 bytes). Kilobyte is abreviated K or 
k. The Macintosh has 128k or 128 kilobytes of internal RAM storage. 

Kleen Line Conditioners• Portable power regulators and air filters used with the 
Macintosh. They are designed to handle 250-, 500-, 1000- and 2000-watt loads. They 
provide voltage spike suppression, transformer surge suppression, wide band prefiltering 
and isolated winding line noise suppression. Electronic Specialists, Inc. 

KYBD An abbreviation used as the device name for the console. Example: 

10 OPEN" KYBD:" FOR INPUT AS #1 



L 
l ASCII 76, HEX 4C. I ASCII 108, HEX 6C. 

largest line Number In Microsoft BASIC, the largest possible line number for a 
program is 65529. 

lasso The lasso is the upper left-hand icon on the drawing tool palette running 
along the left-hand side of the MacPaint screen display. When selected, the lasso 
can be used to draw a dotted line around any figure or shape on the screen. As soon 
as the image or object has been completely surrounded, its border will begin to 
flash. This means that the object can be cut, copied, pasted, moved about the 
screen, erased and copied to another place on the screen. Once an object has been 
lassoed, it can be dealt with by using the Edit menu on the menu bar to Cut the 
object to the Clipboard, to Copy the object to the Clipboard, to Clear this object 
from the screen display and to Paste this object into another document. When the 
lasso is used, just the object surrounded by the dotted line will be affected by any 
action taken. However, when the dotted rectangle is used, everything within the 
rectangle including any background will be affected. 

A lassoed object may be manipulated with a number of keys from the keyboard. It 
may be moved to another point on the screen by placing the pointer inside the 
object, pressing the mouse button, dragging it to a new location and releasing the 
mouse button. A copy may be made of the object by placing the pointer inside the 
object and pressing the Option key while the object is dragged to a new location on 
the screen. Repeating copies may be made by placing the pointer inside the object 
and pressing the Command key and the Option key while the object is dragged 
around the screen. When one image or object is placed on top of another after the 
lasso has been used, the background object will show through any spaces in the 
lassoed object. See Edit Menu, Menu Bar, Option Key, Command Key. 

lCOPY A Microsoft BASIC statement that dumps the screen image to the Macintosh 
printer. The format is: 

LCOPY 

The printer must be on-line for this statement to work. 

left Alignment Most word processors allow text to be aligned or justified in a 
variety of ways. One option is left justification (alignment). This option justifies all 
text on the left margin while text along the right margin remains ragged. This option 
is exercised in MacWrite by placing the mouse pointer inside the left alignment box 
in the ruler at the top of a MacWrite screen when the ruler is being displayed and 
then clicking the mouse button. It may also be used to justify the text under extra 
rulers that are added from time to time to change the nature of the display or the 
output in sections of a document. See Ruler, Document. 
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Shortly, Macintosh users will have a variety of database management 
programs to use with information management tasks for home and 
business. Each of the database management programs will be slightly 
different from the others. Some will use the mouse to design input froms 
and output reports. Others will use the keyboard instead of the mouse. 
MegaFinder by Megahaus is an example or a database management program 
for the Macintosh.! 

~ 
Fig. L 1 A MacWrite screen display wi th the left alignment box within the ruler highlighted . 

Left Alignment Box The Left A lignment box is one of four boxes in the lower right 
port ion o f the ruler in M acWrite. Each of these four boxes is used to justi fy text in a 
part icular fashion wi thin a MacWrite document. The lef tmost of t hese boxes is 
called the " Left A lignment box. " W hen this box is cl icked, the left-hand margin of 
the document is straight and the right margin is ragged. This justifica tion is retained 
unless it is changed by clicking another alignment box or until another ruler is 
inserted and another alignment box is clicked in the new ruler. See Ruler. 

left, Justify See Left A lignment, Justify. 

left, Justify a String See LSET. 

left Margin Marker M ost word processing programs that display a "what you see is 
what you get" format, or nearl y that format. also display the location of the right and 
left margins. MacWrite uses a ruler ac ross the top o f the screen display. A small, 
black triangle with a small black arrow immediately under it marks a marg in in 
MacWri te. The margin may be changed by placing the pointer on the double 
triangle symbol and dragging it to a new location w ith the mouse. 

LEFT$ A Microsoft BASIC function which returns the leftmost <n> characters of <x$>. 
The format is: 

<Stringvariable> = LEFT$(<x$>,<n>) 

<x$> may be any string expression. 
<n> is a numeric expression w hich must be in the range 0 to 255. It specifies the 



Length of String • 169 

number of characters you want in the result. 
If <n> is larger than LEN( <X$>), the entire string <x$> is returned . IF <n>=O a string of 

zero length is returned . 
See also LEN, M ID$, RIGHT$ . 
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Fig. L2 The MacWrite ruler with the leit margin marker al the poinler. 

LEN A Microsoft BASIC function which returns the number of characters in <x$>. The 
format is: 

<variable> = LEN(<x$>) 

<x$> may be any string expression. 
The count returned includes blanks and unprintable characters. 

Length of File See LOC, LOF 

Length of Line To set to 80 characters per line (for example), return Microsoft BASIC 
statement: 

WIDTH II LPT1 :",80 

This command sets the output of a printer at 80 characters per line. It may also be 
used to set the line width on screen displays and on communications devices by 
substituting SCRN or COM1 for LPT1. Notice that this is a deferred command. It 
affects the next OPEN statement, not any file that is currently open. See WIDTH. 

Length of String See LEN, Variable. 
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LET A Microsoft BASIC statement which assigns the value of an expression to a 
variable. The format is: 

[LET] <variable>=<expressiom 

<variable> is the name of the variable or array element which is to receive a value. It 
may be a string or numeric variable or array element. 

<expression> This is the expression whose value will be assigned to <variable>. The 
type of expression (string or numeric) must match the type of the variable, or a "Type 
mismatch" error will be displayed. 

LET is not necessary in Microsoft BASIC programs when assigning values to 
variables. You may simply use the format: 

<variable> = <expression> 

LINE A Microsoft BASIC statement used to draw a line or number of lines on the 
screen. It is used in the graphics mode only. The format is: 

LINE [ (<x1, y1>)]-(<x2, y2>)[,[<color>][,B[ F ]] I 

<x1 ,y1>,<x2,y2> are the starting and ending coordinates in either absolute or relative 
form. 

<color> is the number of the color in which the line should be drawn. If h = 30, the 
line color will be white. If it is any other number, the color will be black. 

LINE ~x2,y2> 

will draw a line from the last point referenced to the point <x2.y2> in the foreground 
color. 

Line, Blank An LPRINT statement with no other specifications will print a blank line 
(that is, feed the paper up one line and return to left margin). 

Line Editor A line editor is a program or text editor that deals with one line at a time. 
Line editors are not usually as powerful as full screen editors. Edit means to change 
the contents of a file, including both program and data files. 

Line, End Current While a program is being entered, pressing Enter or Return ends 
the current line, sends the line to the requesting program and puts the cursor at the 
start of the next line. While lines of text are being entered on the screen in a word 
processor, a line is ended and the cursor is moved to the left-hand side of the screen 
by pressing the Return key only at logical break points in the text. Otherwise, the word 
wrap feature automatically moves the cursor to the left margin at the end of a word. 

Line Feed To advance one line on the printer (space up) without carriage return, 
enter Microsoft BASIC statement: LPRINT CHR$(10) or use the "line feed" button 
(LF) on printer. 

Entering just LPRINT gives a line feed, both a space up one line (line feed) and a 
Return to left margin (carriage return). 

Line Icon One of the options available to the Mac Paint user is the ability to anchor 
one end of a line on the screen and to draw the line to another point on the screen. 
This option is selected by clicking the line icon on the drawing tool palette on the 
left-hand side of the MacPaint screen. When clicked. a single line is drawn by 
placing the pointer at the origin point of the line, clicking the mouse button, 
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dragging the pointer to the termination point of the line and releasing the mouse 
button. See Drawing Tools, Dragging. 

LINE INPUT A Microsoft BASIC statement which reads an entire line of up to 254 
characters from the keyboard into a string variable, ignoring delimiters. The format 
is: 

LINE INPUT[;! [<"prompt">; I <stringvariable> 

<"prompt"> is a string constant displayed on the screen before input is accepted. 
A question mark is not printed unless you include it with the prompt string. 

<stringvariable> is the name of the string variable or array element to which the line 
will be assigned. All input from the end of the prompt to the Enter is assigned to 
<stringvariable> and trailing blanks are ignored. 

If LINE INPUT is immediately followed by a semicolon, pressing return to end the 
input line will not produce a carriage return/line feed sequence on the screen. The 
cursor will remain on the same line as your response. 

Pressing Command-C allows you to exit from LINE INPUT and Microsoft BASIC 
returns you to command level. You may then enter CONT to continue execution at 
the LINE INPUT. 

LINE INPUT# A Microsoft BASIC statement which reads an entire line from a 
sequential file into a string variable, ignoring delimiters. The format is: 

Ll N E INPUT #<filenum>,<stri ngvariable> 

<filenum> is the number under which the file was opened. 
<stringvariable> is the name of a string variable or array element to which the line 

wi II be assigned. 
LINE INPUT# will read all characters in the sequential file up to a carriage return. 

The carriage return/line feed sequence is skipped over and the next LINE INPUT# 
will read all characters up to the next carriage return. The line feed/carriage return 
characters are returned as part of the string. 

LINE INPUT# can be useful if each line of a file has been separated into fields, or if 
a Microsoft BASIC program saved in ASCII mode is being read as data by another 
program. LINE INPUT# can also be used for random files. 

Line Length To set to 80 characters per line (for example), enter Microsoft BASIC 
statement: 

WIDTH "LPT1 :" ,80 

Line Number The largest possible line number for a Microsoft BASIC program is 
65529. 

Line Number Where Error Occurred See ERL. 

Line Numbers Generated Automatically in Microsoft BASIC See AUTO. 

Line Numbers Renumber See RENUM. 

Line Spacing line spacing is adjustable in most word processing programs. Some 
require the selection of line spacing from a special print menu. Others require that 
the line spacing be set to single, double or triple spacing by setting up a special 
command line at the beginning of each document. MacWrite allows the adjustment 
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of line spacing within a document each time a rul er is added by the user. It may also 
be set on the first ruler in the document. Line spacing is set in single space, 1-1/ 2 
space and double space in MacWrite by cl icking one of the three line spacing icons 
on the lower line of the ruler. See Ruler, Document. 
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Fig. L3 The MacWrite ruler with the single space line spacing icon indicated by the pointer. 

lines Use LIST to display all program lines on the screen. The format is : 

LIST 

To display program lines from start up to line 100 enter: 

LIST -100 

To display program lines from line 100 to end enter: 

LIST 100-

To display program lines from line 100 to line 200 enter: 

LIST 100-200 

To display program line 100 only enter: 

LI ST 100 

• All program and line lists are displayed in the Li st window. The user may scrol l 
through the list by using the scroll bars on the right-hand side of the List window. See 
List for a d iscuss ion of the List w indow. 
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Lines Per Inch (8) To set the lmageWriter for this line spacing, enter Microsoft 
BASIC statement: 

LPRINT CHR$(27);" B" 
See Control Characters for Printer. 

Lines Per Inch (6) To set the lmageWriter for this line spacing, enter Microsoft 
BASIC statement: 

LPRINT CHR$(27);" A" 

See Control Characters for Printer. 

Lines, Program To start a new program, type: 

NEW 

This completely erases all lines now in Microsoft BASIC's memory. If it is something 
you want to keep and have not already got on disk, SAVE it first. If you do not erase 
the program in memory before starting on another, you wi II usually wind up with an 
unusable combination of lines from your old and new programs. 

Link Command One helpful characteristic of Microsoft Multiplan is the ability of 
the program to link portions of one worksheet to another. For the Macintosh, 
portions of one or more worksheets may be named and then linked to one or more 
other worksheets. Each of the links is accomplished by first naming the portion of 
the worksheet to be saved, saving the same portion to the Clipboard, saving the 
origin worksheet, loading the worksheet to which the portion of the origin worksheet 
is to be linked and using the Name command from the Edit menu to signify the 
named portion to be linked from the origin sheet, highlighting the area of the 
destination worksheet to signify where the new information will be placed and then 
using the Paste and link command from the Edit menu to affect the link. See Name 
Command, Paste And Link Option, Worksheet, Clipboard. 

Link Module• A program that links MicroPian to mainframes, on-line databases, 
timesharing services and files from other applications programs. It will also allow 
MicroPian files to be used by the applications programs to which it is linked. Chang 
Labs. 

Link Time The point in the processing of a program with a language translator 
(Compiler or Assembler) when the program is tailored for a specific memory 
location. This occurs after compiling (compile time) but before execution (execution 
time). Some small systems do not require linking. 

Lisa• The computer that preceded the Macintosh in the Apple 32-bit computer 
family, which introduced the desktop display, pull-down menus and mouse operations. 
Many of the applications programs available for the Macintosh were first available 
for the lisa in versions similar to those that operate on the Macintosh. The lisa 
provides an environment for Macintosh software to be developed. Most of the tools 
available from Apple Computer Inc. for developing Macintosh software will only 
operate on the Lisa. Three versions of the lisa combine Macintosh and Lisa features: 
the Lisa 2 that uses the Sony 3-1/2-inch microfloppy disk drive that is used by the 
Macintosh; the lisa 2 has a minimum of 512K of RAM installed, which may be 
expanded considerably; the Lisa 2/5 uses the same disk drive, has more memory 



Apple Computer's new Lisa 2 (left) and Macintosh are part of an expanded fami ly of compatible products cal led the 
Apple 32 Supermicro System. Products in the family incorporate Lisa Technology, 32-bit microprocessors, high resolution 
bit-mapped graphics and mouse poin ting devices, and all run Macintosh software. 

..... 
'I ... 
• 
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than the Macintosh and also has a five megabyte hard disk drive. The Lisa 2/10 is 
similar to the Lisa 2 and Lisa 2/5 except it has a ten megabyte hard disk system 
installed. MacWorks allows these Lisas to run Macintosh software. Apple Computer, 
Inc. 

LISP A programming language oriented toward symbols in the way that other 
languages are oriented toward numbers. The type of object it handles best is 
information whose structure cannot be completely specified in advance. LISP 
permits the building of intermediate structures and the discarding of them without 
causing the user any worries about how to find and later reuse the space necessary 
for their storage. The syntax of LISP is simple and elegantly defined. The natural 
method of building programs in LISP by function composition encourages good 
programming style and facilitates modular programming. 

LIST A Microsoft BASIC command which displays the program currently in com
puter memory, on the screen or other specified device. The format is: 

LIST [ <line1> ][-[<line2> ]]t<filespeo 

<line1>-<line2> are valid line numbers in the range 0 to 65529. <line1> is the first line 
to be listed and <line2> is the last. A period(.) in place of either line number indicates 
the current line number. 

<filespec> is a string expression naming the output file. If <filespeC> is omitted, the 
specified lines are listed on the screen. 

You may use Command-. to interrupt any listing to the printer. You can list an 
entire program simply by entering LIST. The program will be displayed in sections in 
the List window. The contents of this window not currently visible may be viewed by 
using the scroll bars on the right-hand side or on the bottom of the window. Up to 
three List windows may be displayed at the same time. 

Three options are available when using the dash(-): 
1. If you declare only 

<line1>-
that line and all higher-numbered lines will be listed. 
2. If you declare only 

- dine2> 
all lines from the beginning of the program through (line2) are listed. 
3. If you declare both line numbers 

<line1>- <line2> 
all lines from <line1> through <line2>, inclusive, are listed. 
For example: 

LIST 100," SCRN :" 
will list line 100 on the screen. 

LIST 200-300," LPT1 :" 
will list lines 100 through 200, inclusive, on the printer. 
Press Command-. to freeze the list for reading while it is being displayed. 
When you list to a file on a disk, the specified part of the program is saved in ASCII 

format. This file may later be used with MERGE. 

List All Files on A Disk See File. 

List Window When the LIST command is used in Microsoft BASIC, the program 
lines are displayed inside of a special window called the //List window." It is similar 
to the Directory window as it has a title bar used to move the window around the 
screen display, a close box in the upper left-hand corner, scroll bars on the right-
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hand side and on the bottom and a size box in the lower right-hand corner. When the 
List window is displayed in Microsoft BASIC, a Command window is also displayed 
along the bottom of the screen. The List window will display a listing of the program 
currently in the computer's memory. It can be invoked by typing LIST in the 
Command window followed by pressing the Return key, or by using the list command 
from the Control menu on the menu bar. See Title Bar, Menu Bar, Close Box, Scroll 
Bar, Command Window. 

LUST A Microsoft BASIC command which displays all specified parts of the pro
gram currently in computer memory on the printer (LPT1 :). This format is: 

LUST (line1)(-line2) 

(line1)(-line2) refers to the range of line numbers to be listed. 

Microsoft BASIC will always return to command level after LUST is executed. 

LOAD A Microsoft BASIC command which takes a program from the specified 
device and places it into computer memory. It can also run the program automatically. 
The format is: 

LOAD [<filespeoJ[,R) 

<filespeC> is a string expression for naming the file. 
R specifies that the program is to be run automatically, after it has been loaded. 
The LOAD command must be typed into the Command window at the bottom of 

the Microsoft BASIC screen display. 
LOAD removes all variables and program lines currently in computer memory and 

closes all open files. If (,R) is omitted, Microsoft BASIC returns to direct mode after 
the program has been loaded. If the R option is implemented with LOAD, the 
program is run after it is loaded. In this case all open data files are kept open. In this 
way LOAD with the R option may be used to chain several programs or segments of 
the same program. Information may be passed between the programs using data 
files. 

LOAD filespec,R is the same as RUN filespec,R 

A program may also be loaded by clicking the program's icon in the Directory 
window and using the Open command from the menu bar of the Finder. This causes 
the program to Load and Run. The Open command from the File menu on the menu 
bar of Microsoft BASIC may also be used but a dialog box will request the name of 
the program to be loaded. When this method or the method outlined above using 
the Command window is used, the program is loaded into the computer's memory, 
but it is not automatically RUN. To RUN it. you must type RUN followed by Return 
in the Command window or use the Run command from the Control menu on the 
menu bar. See Directory Window, Menu Bar, Finder, Dialog Box, Run. 

Load Module A file containing an object code ready to load into memory. 

Load Time The point in the processing of a program when all translation and linking 
are completed and the program is loaded from disk or tape into memory for 
execution. 

LOC Microsoft BASIC function which returns the current position in the file. The 
format is: 
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<variable> = LOC(<filenum>) 

<filenum> is the file number used when the file was opened. 
When processing random files, LOC returns the record number of the last record 

read or written to a random file. 
When processing sequential files, LOC returns the number of records read from or 

written to the file since it was opened. A record is a 128-byte block of data. When a 
file is opened for sequential input, Microsoft BASIC reads the first sector of the file, 
so LOC will return a 1 even before any input from the file. 

For a communications file, LOC will return the number of characters in the input 
buffer waiting to be read. The default size for the input buffer is 256 characters, but 
you can change this with the /C: option on the Microsoft BASIC command. If there 
are more than 255 characters in the buffer, LOC returns 255. Since a string is limited 
to 255 characters, this practical limit alleviates the need to test for string size before 
reading data into it. If fewer than 255 characters remain in the buffer, LOC returns 
the actual count. For example: 

400 IF LOC(1 )>100 THEN STOP 

stops the program if you have gone past the 100th record in the file. 

Location of Cursor See POS. 

Locked-up Keyboard A situation where the computer does not respond to key 
presses. There are three methods of recovering from a locked-up keyboard on the 
Macintosh. One method is to turn off the computer with the power switch and then 
turn it on again. This method will cause the data in memory to be lost and will 
not eject a disk that is still in a disk drive. It you wish to eject a disk and recover 
at the same time, you would press the mouse button, turn the power off and 
on again. This will clear the memory and eject the disk. The final method of 
restarting from a locked keyboard is to press the RESET switch you installed on the 
lower rear portion of the left-hand side of the computer case. See Mouse Button, 
Reset. 

Locking a Disk A disk is "locked" when it has been write-protected. This measure 
ensures that the contents of a disk are preserved from being written over by other 
data from a computer. Macintosh disks are locked by sliding a tab (located in the 
upper right-hand corner of a disk) toward the centerline of the disk. When moved in 
this fashion, a hole is revealed in the corner of the disk. The computer senses the 
hole and will not write data to such a disk. See Disk, Write-protect. 

Locking a File Files or documents on a disk may be locked. When a file is locked, it 
may not be erased or renamed until it is unlocked. Files are locked and unlocked by 
first selecting the file or document from the Directory display, by placing the pointer 
on the file icon or the file name and clicking the mouse button once. Next, the Get 
Info command option must be selected from the File menu on the menu bar, causing 
a window to be displayed on the screen that contains information about the file. The 
lower portion of this window contains a data entry rectangle. just above this 
rectangle is a box marked "Locked." If there is an "X" in this box, the file is locked. If 
there is no "X," it is unlocked. A file may be locked or unlocked by placing the mouse 
pointer on the box and clicking the mouse button. See Directory, File Icon, Get Info 
Option, Menu Bar. 

LOF A Microsoft BASIC function which returns the number of bytes made avai I able 
to a file. The format is: 
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<variable> = LOF(<filenum>) 

<filenum> is the file number used when the fi.le was opened. 
LOF will return a multiple of 128 for disk files created by Microsoft BASIC. For 

example, if the actual data in the file is 129 bytes, the number 256 will be returned. 
For disk files created outside Microsoft BASIC (for example, using EDLIN), LOF 
returns the actual number of bytes allocated to the file. 

For communications, LOF will return the amount of free space in the input buffer, 
which is (size)-LOC(filenum), where (size) is the size of the communications buffer 
(which defaults to 256 but may be changed with the /C: option on the Microsoft 
BASIC command). LOF may be used to determine when the input buffer is getting 
full. 

LOG A Microsoft BASIC function which returns the natural logarithm of <X> (log to 
the base (e)). The format is: 

<variable> = LOG(<x>) 

<X> must be a numeric expression which is greater than zero. 

Log of Screen Displays on Printer Pressing Shift-Command-4 with the Caps Lock key 
in the down position and the printer on will print whatever is displayed on the 
screen. This creates an ongoing printed log of everything you do on the Macintosh. 

Logo See Macintosh Logo. 

Loop Part of a program that is executed many times. See FOR ... NEXT, Delay Loop. 

Loop-back Loop-back (ECHO) is used to test the circuits of an input/output device 
by "looping" whatever is sent out back into the computer as if it were input. In this 
way the circuits inside the computer are tested in isolation from the circuits in the 
external device (and vice-versa) to help isolate a fault. 

Lotus Macintosh Product• A step above the original Lotus 1- 2-3 which combined an 
electronic spreadsheet, a database manager and a business graphics program into an 
integrated software package. The Lotus Macintosh Product integrates word process
ing, electronic spreadsheet, information management, graphics and telecommuni
cations. Lotus Development Corporation. 

LPOS A Microsoft BASIC function which will return the current position of the print 
head within the printer buffer for LPT1 :. The format is: 

<variable> = LPOS(<n>) 

<n> is a numeric expression which indicates which printer is being tested. 
The LPOS function does not necessarily give the physical position of the print 

head on the printer. 

LPRINT To advance one line on the printer (space up) without carriage return, enter 
Microsoft BASIC statement: 

LPRINT CHR$(27);CHR$(102) 

or use "line feed" button (LF) on printer. 
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Entering just LPRINT gives a line feed, both a space up one line (line feed) and a 
Return to left margin (carriage return). 

LPRINT and.LPRINT USING Microsoft BASIC statements used to format and print 
data. The formats are: 

LPRINT !<list of expressions>] 
LPRINT USING <stringvariable>;<list of expressions> 

<list of expressions> is a list of the numeric and/or string expressions to be printed. 
The expressions have to be separated by commas or semicolons. 

<stringvariable> is a string constant or variable which defines the format to be used 
for printing. Refer to PRINT USING. 

LPRINT and LPRINT USING are similar to PRINT and PRINT USING, except the 
output goes to the printer. 

LPRINT (Double Comma(,) Space in Print Line.) To leave space on the print line 
between items, put an extra comma (,} in the print list. Enter Microsoft BASIC 
statement: 

LPRINT A,B 

This would print A in print zone 1, nothing in print zone 2 and put Bin print zone 
3. Print zones may be defined with the WIDTH statement. See also Print Zones. Also 
see Print Line (Spacing). 

LPRINT (Normal Size Print) To return to normal ten character per inch print size, 
turn off all nonstandard print options. See Control Characters for Printer for complete 
instructions and examples. 

LPRINT (Page Length) To set page length (for example) to 55 lines per page, enter 
Microsoft BASIC statement: 

LPRINT CHR$(27);" C" ;"55" 

LPRINT (Print Zone) Each group of fourteen spaces across the print line, as defined 
by the WIDTH statement, is called a "print zone." A comma(,) in an LPRINT list of 
items to be printed means "start printing the following item at the start of the next 
print zone." Contrast this with the semicolon (;), which means the next item is to 
print immediately after this one, without even a single space between them. See also 
Print Line {Spacing). 

LPRINT (Set Line Length with WIDTH Command) To set the line length on the 
printer to 80 characters per line (for example) enter Microsoft BASIC statement: 
WIDTH II LPT1 :" ,80 

LPRINT (Spacing) To get one or more spaces between fields printed by your 
Microsoft BASIC programs, use a literal of spaces like: " ". To get several spaces 
between the printed values of A$ and B$ use: 

LPRINT A$;" II ;B$ 

See also Print Zones. 
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LPRINT (To Get a Blank Line on Printer) An LPRINT statement with no other 
specifications will print a blank line (feed the paper up one line and return to left 
margin). 

LPRINT (6 Lines Per Inch) To set for this line spacing on the printer, enter Microsoft 
BASIC statement: 

LPRINT CHR$(27);" A" 

See Control Characters for Printer for more information and examples. 

LPRINT (8 Lines Per Inch) To set for this line spacing on the printer, enter Microsoft 
BASIC statement: 

LPRINT CHR$(27);" B" 

See Control Characters for Printer for more information and examples. 

LPT1: Stands for printer used for output. 

LRC Longitudinal Redundancy Check. See CRC. 

LSB Least Significant Bit. 

LSET and RSET Microsoft BASIC statements which will move data into a random file 
buffer (in preparation for a PUT (file) statement). The format is: 

LSET <stringvariable> = <X$> 
RSET <stringvariable> = <X$> 

<stringvariable> is the name of a variable that was defined in a FIELD statement. 
<x$> is a string expression for the information to be placed into the field identified 

by (stringvariable). 
If <x$> requires fewer bytes than were specified for <stringvariable> in the FIELD 

statement, LSET left-justifies the string in the field, and RSET right-justifies the string. 
Spaces are placed in the extra positions. If <X$> is longer than <stringvariable>, 
characters are stripped from the right. 

Numeric values must be converted to strings before they are LSET or RSET. Refer 
also to MKI$, MKS$, MKD$. 

LSET or RSET may be used with a string variable not defined in a FIELD statement 
to left-justify or right-justify a string in a given field. For example: 

100 Q$=SPACE$(15) 
110 RSET Q$= J$ 

right-justifies the string J$ in a 15-character field. You could make use of this in 
formatting printed output. 
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MacAnimation• A utility program that assists the user in the animation of Microsoft 
BASIC programs. The package is inexpensive. It contains a disk and an instruction 
book. Microsoft BASIC is required to use this program. Integrated Systems. 
In UK: P+ P micro distributors. 

MacBag• A bag designed to carry a Macintosh, the keyboard, the mouse, paper, 
manuals and accessories. There is room for an external disk drive and a modem. It 
can be carried with a shoulder sling, or like a suitcase. It uses masonite for its 
strength and structure and high-density foam to absorb shocks. MacPacks. 
In UK: P+ P micro distributors. 

MacBASIC Programmer's Reference Manual* A book written by Scott Kamins 
that provides a detailed reference to Macintosh BASIC (MacBASIC). It discusses 
each keyword and command set in the language and contains many examples of 
working MacBASIC programs. Hayden Book Company. 

MacBASIC: Programming Powe~ A book by Scott Kamins that deals with writing 
programs for the Macintosh in Macintosh BASIC (MacBASIC). Mr. Kamins leads 
the reader through setting up and using data files, generating reports, creating 
windows and a variety of other Macintosh uses. It also provides a great deal of 
information about accessing the User Interface Toolbox. Hayden Book Company. 

MacBASIC (Macintosh BASIC)* The name given to the version of BASIC that is 
being released for the Macintosh by Apple Computer, Inc. This version of BASIC 
does not require line numbers. Instead, parts of the program are identified and acted 
upon as distinctive labels. It is semicompiled. This means that each program line is 
passed to a B-code generator that compiles the line. It accepts entry and displays 
listings in both upper case and lower case characters. It does, however, treat both 
character cases as upper case. More than one program can be run at a time by using 
Output windows to display each program that is being run. Program listings are also 
displayed in windows that look very much like the List window in Microsoft BASIC. 

Macintosh BASIC relies upon the tools that are available in the User Interface 
Toolbox. It also makes use of the Clipboard, a full screen editor, and the desk 
accessories. The menu bar for Macintosh BASIC contains menus called Edit, Search, 
Program and Operate. It also contains the Apple menu. Macintosh BASIC programs 
can be saved as source code (ASCII text version) or as compiled B-code versions. 
Programs saved as B-code may only be executed. They cannot be listed. Source code 
programs can be listed, edited and executed. Files that are generated by Macintosh 
BASIC will either be sequential files, stream files or relative files. A sequential file is 
one where data is accessed one character at a time starting at the beginning of the 
file and ending at the end of the file. A stream file is a sequential file for binary 
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format data. A relative file is a random access file that looks for records instead of 
characters. See List Window, Output Window, Menu Bar. Apple Computer, Inc. 

MAC Book: Using Your Macintosh Computer, The* By William 0. Jones, Jr. 
A user-friendly book, which is attractively presented. It explains computer concepts 
and terminology, and discusses programming in BASIC and Pascal. CBS Computer 
Books. 

MACC and MACC-4* Power panels that may be used with the Macintosh and other 
computers. These devices provide additional sockets to plug in power cords from 
computers and their accessories. They also provide surge protection which insulates 
a computer and its accessories from rapid rises and drops in electrical power. The 
MACC can be used to plug in eight devices. The MACC-4 can be used for four 
devices. Both units are attractive enough to sit on the top of a desk or a computer 
table. They provide a convenient means of getting electrical power to a computer 
and its peripherals. Alpha Delta Communications, Inc. 

Maccessories• "Maccessories" is the name given to a collection of products sold by 
Kensington Microware for use with the Macintosh. The products released in this line 
will consist of a dust cover, a swivel, a surge suppressor, a portable modem, a disk 
case, a disk pocket, a printer buffer, a printer stand, a cleaning kit and a control 
center. Kensington Microware. 

Maccessories Disk Case• An attractive plastic case that will hold 36 Macintosh 
disks. Five dividers are used to separate and classify disks. Kensington Microware. 
In UK: P+ P micro distributors. 

Maccessories Printer Buffer• A memory buffer that may be connected between the 
Macintosh and the lmageWriter. Kensington Microware. 
In UK: P+ P micro distributors. 

Maccessories Printer Stand• A collapsible stand for the lmagewriter. The printer is 
placed on top of the stand and paper is stacked underneath to be fed to the printer. 
Kensington Microware. In UK: P+ P micro distributors. 

MacCover• MacCover is a vinyl, cloth-lined dust cover for a Macintosh, the keyboard, 
the mouse and an lmageWriter printer. MacPacks. 
In UK: P+ P micro distributors. 

Mac Disk• A hard disk data storage system for the Macintosh computer. It can 
provide from 5 megabytes to 40 megabytes of data storage. Each unit is supplied 
with connecting cables, adaptors and software required to operate the system. 
Davong Systems. In UK: P+ P micro distributors. 

MacDraw• A drawing program designed for artists, architects, engineers, draftsmen 
and similar professionals in the graphic arts. The program is similar to Mac Paint, but 
may display rulers, measure the length of lines and display object dimensions, 
smooth curves, display grid lines that are independent of the objects drawn and 
provide the serious draftsman with other more powerful tools than those provided 
by MacPaint. This program allows 90-degree rotation of an object or an image. It 
uses a vertical pattern menu instead of the horizontal pattern menu used by 
MacPaint. This menu is only displayed when it is required by the user, is more 
efficient for the mouse user and provides more space for screen display. Apple 
Computer, Inc. Apple (UK) Ltd. 
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* File Edit Type Font l Fill lines Pen 

Fig. Ml The MacDraw screen display. 

Mac Drive• Mac Drive is the name given to a 5-megabyte capacity hard disk drive 
that is sold by Tecmar, Inc. This hard disk system plugs into the modem port on the 
back panel of the Macintosh. The hard disk plugs into a wall socket and the 
Macintosh power cord is then plugged into a socket on the back panel of the hard 
disk drive. The unit itself is about as wide and deep as a Macintosh, and a little less 
than half as high. It matches the color of the Macintosh case. The media used in this 
system is a 5-megabyte capacity cartridge that may be removed when the Mac Drive 
has been ejected and the power has been turned off. 

The system includes a system disk with a special system folder and f inder, a power 
cord, a connector cable, the hard disk drive and a 5-megabyte cartridge. Another 
modem port is provided on the back panel of the hard disk drive to ensure that the 
user has the capabil ity of using a modem without disconnecting the printer or the 
hard disk drive from the Macintosh. The Mac Drive is easy to install and use. As the 
directory for the Mac Drive fills up with programs, documents and applications, the 
Finder's directory which is in RAM also fills up. As the memory set aside by the 
Finder for disk icons and directories fills up, the Finder is limited to the number of 
disk icons that can be displayed on the Desktop at the same time. This situation 
might be improved by organizing the files, programs and documents in the Mac 
Drive Desktop into file folders. This practice is also recommended as the Mac Drive 
Desktop fills up. The same situation exists with other hard disk systems. 

Hard disk systems such as the Mac Drive have a particular value to users who use 
programs that are interactive with disk to write to, and read from, files. Such systems 
are also valuable to anyone with a large collection of programs, files, documents 
and applications. Speed of access and capacity are the most important features of 
hard disk systems. Tecmar Inc. In UK: P+ P micro distributors. 
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~acEdge• An educational package to improve children's reading and mathematical 
skills. It teaches concepts and leads children through a subject, step-by-step. Sound, 
graphics and game formats are used to make learning an appealing process. The 
mouse is used extensively in vocabulary programs. Think Educational Software. 
In UK: Softsel. 

~acforth• An interactive development system for Macintosh programs. This 
development system uses powerful trace and debug functions to assist the developer. 
It can access most of the Macintosh User Interface Toolbox. The system includes the 
disk tutorial Going Forth as a tutorial to get the user started with Forth. Users may 
easily define functions and error-handling routines. The system makes use of QuickDraw 
and is a powerful graphics tool for the Macintosh. Three levels are available to the 
developer. The first level comes with a CPU and a single license. The second level 
comes with the CPU, the license, an assembler and advanced graphics tools. The 
third level comes with a complete developer's kit, trace capabilities, debug capabilities 
and snapshot capabilities. It also comes with a broader licensing arrangement than 
level1 or level 2. Creative Solutions. In UK: P+ P micro distributors .. 

~acFreighte ... A heavy duty cargo case for a Macintosh system. It resembles a 
footlocker, is lined internally with shipping foam and can be carried like a suitcase. 
This case can accommodate a Macintosh, the keyboard, the mouse, an external disk 
drive and a modem. MacPacks. 

Mac Graphics• By Tony Fabbri. A guide to the use of MacPaint and Macintosh 
graphics. It teaches animation and how to create graphic adventures. Tab Books, 
Inc. 

MacGraphics• By Cordon Mann. A complete guide to graphics on the Macintosh 
and in the use of MacPaint. It deals with the creation of a variety of graphs, 
freehand sketches and animation. Plume Computers. 

MacGuide• By Leslie Smith. A primer for the Macintosh user. It is equally useful 
to the novice and the advanced user. It delves into the operation of this powerful 
computer and provides the user with a wealth of tips. Plume Computers. 

~achine Language Program See Program, Source or Object. 

~achine Language Program (Subroutine) See CALL. 

~ach 1• A 23 inch video monitor that may be connected to the Macintosh via a 
manufacturer-installed adapter. The user's Macintosh must be shipped to the manu
facturer for this installation. This monitor is available in green phosphor or in 
black/white. The system consists of the video interface, cable and the monitor. 
Professional Data Systems. 

~ach 2• Mach 2 is a projection system that may be used with the Macintosh. Your 
Macintosh must be shipped to the manufacturer for installation of a special interface. 
Projection may be onto a flat or curved screen up to 25 feet in width. The system 
includes the video interface, the projector, a six foot screen and all necessary cables. 
Professional Data Systems. 

~acintosh Assembler/Debugge... A program written to assist the serious programmer. 
It has a full screen editor, a macro assembler for the 68000 chip and a symbolic 
debugger. The edit or and the debugger are mouse-d riven. This debugger wi II require 
a second Macintosh to operate if the user's Macintosh has only 128K of RAM. The 
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macroassembler allows assembly language programs to be written and edited easily. 
Assembly language programs use mnemonics to give instructions and information 
to the computer, rather than long reserved words such as those used in BASIC. These 
mnemonics are three-letter abbreviations for instructions. See Assembly, Debugger. 
Apple Computer, Inc. Apple (UK) Ltd. 

Macintosh Assembly Language• By Leo j. Scanlan. A beginning and experi
enced programmers guide to Macintosh assembly language programming. It intro
duces the MC68000 microprocessor and explains how to write assembly language 
programs and routines for use by this chip. The entire MC68000 instruction set is 
presented and explained. Brady. 

Macintosh BASIC See MacBASIC. 

Macintosh/ Complete• A book written by Doug Clapp that describes the creation 
and use of the Macintosh computer. This book provides a sound background in 
the use of the Macintosh, the selection of hardware and software that may be 
used with the Macintosh and a good technical description of the Macintosh and 
the systems that make it work. The book is easy to read and should be a standard 
work about the Macintosh. Softalk Books. In UK: Softsel. 

Macintosh Computer Graphics• By john P. Grillo and j. Douglas Robertson. 
This book tells the reader how to use the graphics features of the Macintosh. 
CBS Computer Books. 

Macintosh Connection, The* By John Campbell. This book explains the instal
lation of application tools, use of the Profile hard disk system and the system 
operations behind the applications used on the Macintosh. This is a complete 
hardware description of the Macintosh. Reston. 

Macintosh Cover* A cover for your Macintosh computer, to protect against dust 
and other contamination. Computer Cover Co. 

Macintosh Data Files• By David Miller. This book explains, in depth, the creation 
and manipulation of data files on the Macintosh. This book is useful to the novice 
and the advanced programmer who wishes to learn about the Macintosh and 
how it deals with data files. Reston. 

Macintosh Expansion Guide, The• By Gary Phillips and Donald J. Scellato. This 
book describes the hardware products that may be purchased to expand the 
Macintosh computer system. Selection criteria, product descriptions, product com
parisons and vendor listings are presented to assist the Macintosh user. Tips for 
using various types of products are also included. Tab Books, Inc. 

Macintosh for Co/legs Students• By Bryan Pfaffenberger. The power of the 
Macintosh, for college students, is introduced in this book. It deals with reports, 
term papers and exam preparation. It also deals with mathematics and notetaking 
on the Macintosh. Sybex. 

Macintosh Logo• The implementation of the Logo interactive programming lan
guage for the Macintosh. It is a graphics language that uses an on-screen pen called a 
"turtle," whose movement is controlled by the user through a series of very simple 
commands. It is easily grasped by children and is commonly used to teach programming 
techniques and logical thinking to children. Apple Computer, Inc. 
In UK: Apple (UK) Ltd. 
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Macintosh Pascal* By Jerry Brecher and George Cherry. This book presents 
Macintosh Pascal to the reader. It book teaches the programmer the best ways 
to use Pascal on the Macintosh without getting into trouble. Reston. 

Macintosh Pascal• An interpreted version of the Pascal language, popular for 
business and graphics applications. It has been used to write a variety of database 
management programs for the Apple II family of computers. It is also the language 
that was chosen for "Wizardry," one of the more popular games for the Apple II 
family. Macintosh Pascal uses all of the features of the User Interface Toolbox to 
allow the user to communicate with the computer and the programs that are written 
in Pascal. It uses labels for program sections rather than line numbers, and a number 
of keywords such as PROGRAM, VAR, BEGIN, END and others that are presented to 
the user in boldface type on the screen when used in a program. Programs may be 
edited as they are running on the Macintosh with Macintosh Pascal. The structure 
and keywords used by this programming language are very similar to those used by 
UCSD Pascal, one of the more popular implementations of this language. The user 
interface presented by the Macintosh really sets this implementation of Pascal apart 
from other implementations. Developed by Think Technologies, Inc. as "MacPascal." 
Apple Computer, Inc. In UK: Apple Computer (UK) Ltd. 

Macintosh Programmer's Handboo~ By Gary Phillips and Donald j. Scellato. 
A book that introduces the novice programmer to the basic principles of pro
gramming in Microsoft BASIC, MacBASIC, and Macintosh Pascal. Programming 
rules and terms are discussed in depth, as are reserved words, commands and 
functions. Brady. 

Macintosh: The Appliance of the Future• A book about the Macintosh and 
how to use it by Gerard Lewis. It is spiral-bound and has 288 pages. Banbury 
Books, Inc. 

Mac the Knife• A collection of Clipboard art for the Macintosh including borders, 
maps and useful illustrations. Each file has a unique feel and texture to it. Miles 
Computing, Inc. In UK: Softsel. 

MacManager• A simulation that provides a method to learn management skills, 
management decision making and financial management skills. It uses a hypothetical 
company to present the simulation and such variables as plant capacity, pricing 
strategy and inventory to teach the principles of business management. Harvard 
Associates. In UK: Softsel. 

MacMath• A collection of mathematics drills on disk for use with the Macintosh. It 
uses animations to reward the child for successfully completing drills. Microsoft 
BASIC is required to run these programs. Integrated Systems. 
In UK: P+ P micro distributors. 

Mac Multiplan• A book written by Ramsey and LaSelle that deals entirely with 
using Multiplan and all of its features on the Macintosh. A number of useful 
applications are presented in this book along with complete discussions of the 
command functions and features of Mulitplan. Hayden Book Company. 

MacPaint• An excellent drawing program that uses a mouse to draw lines and 
shapes on the screen, select patterns, edit drawings, erase lines, shade drawings, 
manipulate images, stretch shapes and a variety of other graphics functions. This 
program displays a portion of a page within a drawing window. It provides a variety 
of tools from a drawing tool palette that runs along the left-hand side of the screen 
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display. It also provides a va riety of fill patterns in a pa lette that runs along the 
bottom of the screen display for backgrounds and for fi ll ing shapes. Text may be 
entered in the grahics display easily by choosi ng the text icon f rom the drawing 
tools. It may be displayed in a variety of fonts, font styles and font sizes. Images may 
easi ly be copied to other parts of the screen display or to other MacPaint or 
MacWrite documents via the Clipboard . A pple Computer, Inc. 
Apple Computer (UK) Ltd. 
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MacPak• A carrying pack for a Macintosh system. This pack is shockproof and 
weatherproof. It uses masonite for its strength and high-densi ty foam to insulate the 
system from shocks. There are pockets for accessories, paper and manuals and room 
in the pack for a M acintosh, the keyboard, the mouse, an external disk drive and a 
modem. It may be carried as a sui tcase, a backpack or a hand bag. MacPacks. 

MacPascal• See Macintosh Pascal. 

MscPsscsr A book written by Chernicoff about how to program in Macintosh 
Pascal (MacPascal ). It covers program construction in Pascal, program testing and 
debugging as well as describing the keywords and commands used by Pascal. 
Hayden Book Company. 

MacProject• A program written to perform scheduling tasks for those pro fessionals 
who use PERT charts and Critical Path Methods of scheduling and controll ing large 
projects. It al lows the tasks involved in a project to be displayed graphically in a 
chart that resembles a programmer's flow chart. This chart is more oriented toward 
the passage of time and the expenditure of funds, rather than to program flow. Task 
charts may also be generated . These charts list each task in the order in which it w il l 
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be executed. They also provide key information regarding each task. Resources may 
be identified and listed. Cash f low may be projected, recorded and reported. A 
Project Table that lists the key information about each task in a project may also be 
created. This program can meet the needs of planners, engineers, project managers 
and others who wish to plan and contro l intricate activities. It may also be used to 
measure the time requ ired to execute a program if the components are entered as if 
they are parts of a project. Apple Computer. Inc. 
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Fig. M3 The MacProject Pert Chart. 

MacPuzzle• MacPuzzle uses a MacPaint document to create a jigsaw puzz le that 
can be reassembled ndustrial Computations. 

Mac Revealed: Programming with the Mac Toolbox- A book by Chernicoff 
that explains the use of the Macintosh User Interface Toolbox in programs. It is a 
readable book in plain English that explains the intricacies of the user interface. 
Hayden Book Company. 

Mac Sac• A padded, water-resistant carrying case to hold the system unit, keyboard, 
mouse and keypad. Comes with a shoulder strap and an antistatic lining. R. ). Gear. 

MacSak• A small, light carryi ng bag for the Macintosh. It is foam and masonite 
lined. M acPacks. 

Mac-Slots• A game package with two games for the Macintosh on the same disk. 
One of these games emulates a coin-operated slot machine l ike those used in Las 
Vegas. The other game is Keno, a very popular game at all casi nos. Both games are 
mouse contro lled. The odds used in the games are the same as those used against the 
gambler in Las Vegas. A number of graphics displays are used to present such 
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situations as hitting a jackpot, going to the restroom and buying a drink at the bar. 
The p layers bankroll is displayed as stacks of ch ips in a window on the right-hand 
side of the screen display. Soft-Li fe. In UK: Softsel. 
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Fig. M4 The MacProject Project Table. 

MacSpell• A collection of spelling drills for use wi th the Macintosh. The user may 
add his own words to the f iles. Microsoft BASIC is required to run these programs. 
Integrated Systems. 

MscTe/ecommunicstions• By Jonathon Erickson and Robert) . Sayre. A complete 
guide to putt ing your Macintosh to work with a modem and telecommunications 
software. It also presents information on banking, e lectronic mail and database 
networks such as Compuserve and The Source. Osborne/McGraw-Hill. 

Mac Terminal• A communications contro l program written for use by the Macintosh. 
It allows the user to defi ne the manner in which communications w ill be carried with 
other computers and commu nica tions devices, such as teletypes. MacTerminal can 
also emulate the VT100 or an IBM 3270 computer terminal. This program may be 
used with the Macintosh and a modem for a variety of telecommunications applications. 
It is easy for the user to master and to use. Apple Computer, Inc. 
In UK: Apple Computer (UK) Ltd. 

MacTote• A carrying case for the Macintosh system that may be used as a tote bag 
or a shoulder bag. It has pockets for the keyboard, mouse, disks and manuals. 
Optimum Computer Luggage. 

Mac.Transfer• A program that allows data to be exchanged by the Macintosh and 
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Apple II computers. Two disks are included in the package. One disk is for the 
Macintosh and the other is for the Apple II. Apple Writer files may be converted to 
MacWrite files and vice-versa. Applesoft programs may be converted to Microsoft 
BASIC for the Macintosh and vice-versa. Data files may be exchanged in either 
direction by these computers. Southeastern Software. 
In UK: P+ P micro distributors. 

MACTUTOR, The• A software tutorial for the Macintosh. It uses a screen window to 
teach the user about his Macintosh. This program uses all of the features of the 
Macintosh to teach the user about the computer. Harper & Row Electronic and 
Technical Publishing. 

MacWorks• A software package that brings to the Lisa computer the ability to run 
Macintosh software. It may be used to run MacPaint, MacWrite, Multiplan and 
many other Macintosh applications on the Lisa. The Macintosh image, in most 
applications, is smaller than the Lisa's screen size. Most of the applications use the 
Macintosh screen size for their display. The Lisa 2, Lisa 2/5 and Lisa 2/10 are 
equipped with 3-1/2 inch disk drives, which will run MacWorks. Apple Computer, 
Inc. In UK: Apple Computer (UK) ltd. 

MacWrite• A word processor written for the Macintosh. It allows a document of 
twelve pages to be generated, formatted, edited and printed, when a microfloppy 
disk drive is used. More pages may be generated, formatted, edited and printed 
when a hard disk is used. MacWrite uses the mouse to select a variety of functions 
such as tabs, line spacing, justification, fonts, font sizes and font styles. It also uses 
the mouse to select text insertion and deletion points. Documents and images that 
are generated by MacPaint and similar programs that use the Clipboard may be 
included in a MacWrite document. Headers and footers may be created. Fonts, 
spacing, justification and other functions may be changed within a document to suit 
the needs of the user. Apple Computer, Inc. 
In UK: Apple Computer (UK) ltd. 

Magazines, Computer-oriented A number of popular magazines contain useful 
information concerning the Macintosh and available hardware and software for it. 
Most computer stores and larger bookstores carry a good assortment of these 
magazines. BYTE is an excellent source for general information on microcomputers, 
although information specifically relevant to the Macintosh is buried amid voluminous 
ads and articles on other machines and general topics. 

Magazines devoted to the Macintosh and its compatibles include MacWorld and 
St. Mac. Magazines which specialize in the Macintosh and one or more other 
microcomputers include Creative Computing and Personal Computing. Magazines 
that specialize in the Apple computer family including the Macintosh are A+, 
Apple Orchard, Nibble and lnCider. lnfoworld is a weekly magazine for micro
computers including the Macintosh. It is interesting if you want to keep up with 
the new developments on a week-by-week basis. 

If you want to subscribe or write for information, here are the addresses: 

A+ 
P.O. Box 2964 
Boulder, Co 80321 

Apple Orchard 
P.O. Box 6502 
Cupertino, Ca 95015 Apple User (UK). 
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BYTE 
Subscription Dept. 
P.O. Box 590 
Martinsville, NJ 08836 
U.S. = 1 year $19 12 issues 

Creative Computing 
P.O.Box 789-M 
Morristown, NJ 07960 
U.S. = 1 year $20 12 issues 

In Cider 
Wayne Green Inc. 
Circulation Dept. 
POB 911 
Farmingdale, NY 11737 

Info World 
Circulation Dept. 
Box 837 
Framingham, MA 91701 
U.S. = 1 year $25 52 issues 

MACWORLD 
Subscription Department 
P.O. Box 20300 
Bergenfield, New Jersey 07621 

Nibble 
PO Box 325 
Dalton, Ma 01227-9938 
Personal Computer World (UK). 

Personal Computing 
PO Box 2941 
Boulder, Co 80321 

MAGICphone• MAG ICphone is a telephone that may either be used as a stand
alone telephone or mounted on the side on the Macintosh case. The Macintosh may 
be used to dial this telephone. Software is provided to manage lists of phone 
numbers and to access these lists to dial numbers. Time that the phone is used is 
logged, as are the numbers that are called. This system is useful to those who wish to 
track phone use for billing purposes. The system does not include a modem for data 
communications. It only provides voice communications. Artsci. 

Mail List Software See Megamerge, Habadex. 

Main Memory See Memory. 
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Main Street Filer• Main Street Filer is a database management program for the 
Macintosh. It combines the features of a filing system and a report generator. It 
handles up to 65,000 records, and up to six distinct fields within a file. Up to four of 
the six fields can be indexed to supply sorted reports. The report generator can 
provide columnar reports, mailing lists, mailing labels, envelopes and rolodex cards. 
File design, record access and retrieval and report selection are mouse-driven. Data 
entry is accomplished from the keyboard. The user can design file formats and data 
entry screens or can use a name/address format that is supplied with the program. 
Main Street Software. In UK: Softsel. 

Maintenance (Disk) See Disk Maintenance. 

Maintenance of the Macintosh The Macintosh is sold to the user in a sealed case. It 
is not expandable internally by the user. Any maintenance required on the Macintosh, 
its keyboard, the mouse and its disk drives should be carried out by an authorized 
dealer or maintenance facility. If the Macintosh case is opened by the user, the 
computer's warranty is void. You may find the address of the nearest authorized 
maintenance facility by consulting the dealer who sold you the Macintosh by 
consulting a local user's group or by watching your local newspaper for advertisements. 

Management Edge, The• An interactive program that provides a management 
strategy for the user. The user enters information about himself and about the 
management situation he anticipates. A strategy is suggested after the information 
is analyzed by the prografll. The Management Edge is also a useful training tool. 
Human Edge Software Corporation. In UK: Softsel. 

Management of Files File management or disk maintenance describe keeping track 
of files on disks. See Disk Maintenance. 

Manual A process done by hand, not automated or programmed. Also, a reference 
book, booklet or other document. 

Manual Calculation Electronic spreadsheet programs such as Microsoft Multiplan 
offer two modes of calculation to the user, Automatic Calculation and Manual 
Calculation. The Automatic Calculation mode performs a calculation each time a 
value is entered in a a spreadsheet. The Manual Calculation mode turns off Automatic 
Calculation until a Calculate Now instruction is given or until Automatic Calculation 
is selected. Manual Calculation is a command option that is available from the 
Calculate menu on the menu bar of the Microsoft Multiplan screen display. See 
Calculate Menu, Menu Bar, Automatic Calculation Option. 

Margin Markers Many word processing programs show where margins and tabs 
have been set. The device used to show this information is often called a "ruler." 
This might resemble a real ruler, like the ruler displayed by Mac Write, or it might be 
a series of dashes marked with exclamation points or similar vertical symbols. 
MacWrite uses distinctive markers under the ruler to indicate the location of the 
right and left margins of a document. These are black triangles with the point of the 
triangle marking the location of the margin on the ruler. The location of a margin 
marker may be changed by placing the mouse pointer on the marker and dragging it 
to the desired location on the ruler. See Ruler, Dragging, Document. 

Master Menu A menu is a screen display which lists a number of possible options 
and asks the user to select one. When a selection is made by keying in an identifying 
number or letter (or positioning the cursor beside the desired item, using a light pen, 
mouse click or mouse-driven highlight, etc.), the selected function is performed. 



194 • MAX 

This may require ei ther a branch or subroutine call to the code for the function, or 
the program to carry out this function. Master menus may be loaded into memory 
and executed in a program written by the user or in a commercial program. 

M any application packages use a system of multiple menus. A Master menu lists 
the major functions al lowed. Selection of an option on the Master menu causes 
another menu to display, indicating more detailed options for the selected function. 
This can be followed by even more detailed menus, and so on. Completion of a 
function will often cause redisplay of the Master menu. Such a system is called 
" menu-driven." A Master menu and a Main menu are the same thing. 

The Macintosh Finder is similar to a M ain menu or Master menu. See Finder, 
M enu, Menu Bar. 
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Fig. M S A Ma<;Write ruler with the left margin marker next to the mouse pointer. 

MAX A common function ava ilable on an electronic spreadsheet such as Microsoft 
Mulitplan. This function is used to instruct the program to read a specfic range of 
cells within a column or row and return the maximum value within the specified 
range. Thus, if you inserted the formula = MAX(R2CS :R2C12) in a cell, the program 
would return the largest number within that range of cel ls. 

MBIS Microbuffer• A serial interface buffer for the Macintosh. It may be connected 
between the Macintosh and serial inter face devices like printers and modems. It 
uses RS-232 conventions and wi II accept data at baud rates ranging from 75 to 19,200 
baud . The buffer may be purchased with 32K, 64K, 128K or 256K of memory. This 
device is extremely useful when long documents are being transmitted or printed as 
it holds the information whi le the M acintosh is freed to do other things. Practical 
Peripherals. In UK: P+P micro distributors. 

MC Machine Code. Acutal machine language instructions, whether written directly 
in MC or resu lting from translation of a source program. 



Memory • 195 

McPic• A collection of 130 pictures on a disk. They may be used with Mac Paint and 
MacWrite to illustrate documents. They may be customized by the user with FatBits 
and other tools. Magnum Software. In UK: Softsel. 

Media Data storage devices for personal computers record information such as 
programs or data files. The physical substances on which the data is recorded are 
called "media," and includes cassettes, diskettes, cassettes for hard disks, RAM, 
ROM and a few other types of devices. Fixed media are permanently lodged in the 
device that uses it. Removable media, such as most diskette drives, can be removed 
from the drive and replaced by another one. Removable media have the advantage 
that large amounts of data can be stored on the media on a shelf and manually 
placed into the device that reads it. An example of this are diskettes stored in a box 
and placed one at a time as needed into the diskette drive. A example of fixed media 
would be most hard disk drives. Here the disk is permanently mounted in the drive 
and cannot be removed. The amount of storage possible with such a device is 
limited to what can be placed on one medium. There are, of course, hard disk drives 
with removable media which have the large storage capacity of fixed drives along 
with the ability to store additional disk cartridges with data and place them into the 
disk drive as needed. 

Media Accessories See Micro-disk Minder. 

Megafinder• MegaFinder is a database management program that allows form and 
report design. Forms can be designed for home use and small business use. There are 
output forms for Checks, Home Inventory and Mailing Lists included with this 
software. The program will also allow the user to save report formats he has designed 
and use them with associated files. Megahaus. In UK: Softsel. 

MegaMerge• A mail merge program for the Macintosh. It uses address files generated 
by MacWrite to create form letters by merging name and address information into 
letters that were written on MacWrite. It also can generate mailing labels and 
mailing lists from the name and address files. One particularly useful additional 
feature is that this program merges a number of Mac Write documents into a single 
long document. Megahaus. In UK: Softsel. 

Memory Any device which can store information and allow it to be retrieved when 
needed. The Macintosh relies primarily on Random Access Memory (RAM), Read
Only Memory (ROM). disks, and hard disks. Memory, by itself, is t~sually a reference 
to RAM. This is the general purpose, erasable and reusable memory located inside 
the Macintosh. 

ROM (read-only) memory contains fixed data. usually programs such as the 
Macintosh's screen programs. The ROM contains the fundamental machine lan
guage programs to run the various devices attached to the Macintosh, such as 
monitor, printer, disks, etc. ROM and RAM together make up the internal memory or 
main memory of the Macintosh, or any other computer. 

Contrast this with external memory, such as disk and hard disk. which involves 
mechanical motion to retrieve data and is thus hundreds or thousands of times 
slower than internal memory. Data in internal memory is immediately available to 
programs for processing. Data in external memory must be copied into internal 
memory (READ or INPUT), processed, then copied back out to external memory 
(WRITE or OUTPUT). 

If data has been created, it can be written out to external memory without a READ 
first. And, if data read in from external memory has not been modified, there is no 
need to write. it back out since the original copy is still there. 

While external memory is very slow relative to internal memory, it also has 
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advantages. It is much cheaper per character of data stored on-line (available for 
processing without manual intervention). In addition, the ability to store external 
memory data off-line (such as disks in a box) allows essentially unlimited storage of 
data. This, of course, requires a manual step of inserting the disk before the data can 
be loaded into the internal memory for processing. See also Virtual Memory, RAM 
Disk, Spool, Bank Switching, Memory Map, Memory Address, Memory Segment, 
Bubble Memory, RAM, Disk. 

Memory Address A number or variable designating a location in memory. See 
Address, PEEK, POKE. 

Memory, Amount of Free See FRE. 

Memory, Enter Values to Equal See POKE. 

Memory Manager The Memory Manager is a set of routines in the Macintosh ROM 
that is part of the computer's operating system. Its purpose is the management of the 
use of zones within the computer's memory circuits and chips. The Memory Manager 
scans the blocks of memory within the computer's circuits, recognizes how the are 
being used, whether or not they are in use and only allows unused blocks to be 
written to. If certain sections of memory are used in a fashion that their contents 
may be relocated to another address, the Memory Manager keeps track of the 
location of such data. 

The memory of the Macintosh may be set up in nonrelocatable or relocatable 
blocks by the Memory Manager. Nonrelocatable blocks are somewhat inefficient as 
they tend to fragment the memory space. Relocatable blocks may be moved around 
to consolidate data or to make room for additional data. The Memory Manager 
defines nonrelocatable blocks in terms of absolute memory addresses. It defines 
relocatable blocks by using pointers stored within a portion of memory called the 
"master pointer" that is used by the Memory Manager to keep track of relocatable 
memory locations. See Operating System, Memory, Block. 

Memory Map A memory map is a simplified diagram of the manner in which the 
Random Access Memory and Read-Only Memory of a computer are used. The 
memory map resembles a rectangle broken into several sections with symbols 
representing memory addresses next to the beginning and end of each section of the 
rectangle. Descriptive comments are usually shown inside each section of the 
rectangle. These comments describe the use of each section of the memory. The 
addresses are usually provided in hexadecimal format. 

Memory, Review Values of See PEEK. 

Memory Segment A continuous block of memory addresses, such as 0 to 16K. 

Memory (Storage in Bytes) Byte is a label for storage to hold one character (letter, 
digit, etc.) in computer memory, internal or external. Abbreviated Borin thousands, 
KB or simply K. (Actually, 1 K = 1024 bytes, because this number is an even power of 
2). Macintosh is currently provided with 128K of RAM memory and 64K of ROM 
memory. To be precise, the RAM is not really 128,000 bytes of memory. It is 131,072 
bytes. The ROM is really 65,536 bytes. 

Menu A screen display which lists a number of possible options and asks the 
user to select one. A few Macintosh applications use menus of a conventional form 
that are carryovers from non-Macintosh programs. These are lists of options displayed 
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on the screen and require that the user enter a letter or number that designates the 
action to be taken by the computer, and then press the Return key. Most Macintosh 
applications rely on pull- down menus displayed by placing the mouse pointer on a 
menu name on the menu bar displayed across the top of a Macintosh application's 
screen display. Pull-down menus give the user access to a variety of commands or 
options related to the menu name on the menu bar. Once a pull-down menu has 
been selected in the fashion described above, the options ava ilable are selected by 
dragging the pointer down the list of options until the correct option is highlighted. 
Then the mouse button, which was held down whi le the pointer was dragged down 
the menu, is released. Then the highlighted option is executed by the computer. 

Many application packages use a system of multiple menus. A Master menu lists 
the major functions allowed. Selection of an option on the Master menu causes 
another menu to display, indicating more detailed options for the selected function. 
This can be followed by even more detailed menus, and so on. Completion of a 
function wi ll often cause redisplay of the Master menu. Such a system is called 
" menu-driven." 

Menu Bar The line of menu names that runs across a Macintosh screen display is 
called the " menu bar." It is used to select a pull-down menu appropriate to the needs 
of the user. Once a pull-down menu is displayed, any option that is listed may be 
selected by the user, unless a menu selection is dimmed . Dimmed selections are not 
currently avai lable to the user due to the user's current position in a program. See 
Pull-down Menu, Dimmed Commands, Menu. 
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Fig. M6 An illustration of the menu bar from the MacPaint screen display with the pointer 
resting on the Edit menu designator. 

Menu-driven See M en u. 
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Menu Manager The Menu Manager is a collection of 33 subroutines in the Macintosh 
User Interface Toolbox. This collection of subroutines is responsible for the creation 
and the manipulation of the menu bar in an application. It sets up and executes 
user-defined pull-down menus. This collection of subroutines is available to the 
serious programmer. It is one of the features that allows a variety of applications 
written for the Macintosh to present options to the user, and to execute these 
options in the same fashion as all other applications that access the Menu Manager. 
See Menu Bar, User Interface Toolbox. 

MERGE A Microsoft BASIC command used to add lines from an ASCII program file 
into the program currently in computer memory. The format is: 

MERGE <filespeC> 

<filespec> is a string expression naming the file. 
The device is searched for the named file. If the file is found, the program lines in 

the device file are merged with the lines in memory. If any lines in the file being 
merged have the same line number as a line in the program in memory, the lines 
from the file will replace the corresponding lines in memory. Following the MERGE 
command, the merged program is in memory and Microsoft BASIC returns to 
command level. 

If the program being merged was not saved in ASCII format (using the A option on 
the SAVE command}, an error message will be displayed, and the program in 
memory will remain intact. This error message will read "Bad file mode." 

Message A statement or code printed out or displayed on the screen by a program to 
let you know what is happening. Examples include prompts, when the program 
expects you to input something, error messages, which tell you something about 
what went wrong, and informational messages, such as "Copy Complete." Many 
such messages are displayed in alert boxes by Macintosh applications. 

Micro-disk Minder• A rectangular molded plastic case holding thirty-six 3-1/2-inch 
microfloppy disks. It has a hinged lid and comes with plastic dividers. International 
Datawares, Inc. In UK: P+P micro distributors. 

MicroPian• MicroPian is a financial modelling program. It uses built-in formulas 
and a statistical package to assist the user. Its built-in formulas include loan 
amortization, standard deviation and tax rate schedules. It consists of a spreadsheet 
made up of 200 rows and 60 columns. A separate report generator is used to format 
printed output. Chang Labs. In UK: Softsel. 

Microsoft BASIC* The first version of BASIC made available for the Macintosh was 
Microsoft BASIC. This version of BASIC is very close to the Microsoft BASIC written 
for the IBM PC. It uses a variety of new commands that allow the user to access 
informationlbox for file selection, editing and program control. Microsoft BASIC 
uses three types of windows on the screen: the Output window, the List window and 
the Command window. The Output window displays any text or graphics generated 
by a program written in Microsoft BASIC. The List window is displayed any time that 
the LIST command is used in the Command window or List is selected from the 
Control menu on the menu bar. Up to three List windows may be opened at the same 
time. The Command window is used to input program lines and to give direct 
commands to the computer in Microsoft BASIC. 

Microsoft BASIC requires that each line of a program have a line number. It uses 
Reserved Words to interpret the user's instructions and pass them to the computer. 
Microsoft BASIC is loaded into the Macintosh's memory from disk when it is used. 



Microsoft File • 199 

When loaded, it leaves about 30K of memory space available for program lines and 
variables. The mouse is used to perform many functions in this version of Microsoft 
BASIC. It is used to select program lines that are displayed in the List window for 
editing in the Command window. It is used to mark the insertion or deletion point of 
characters to be added to or taken out of a program line being edited . It is also used 
to select commands from the menus on the menu bar. This programming language is 
recommended for those who al ready have experience with Microsoft BASIC on 
other computers. See Command Wi ndow, List Window, Output Window, Menu Bar. 
M icrosoft Corporation. In UK: Microsoft (UK) Ltd. 

100 DEFINT A-Z 
110 DIM A( 1025) 
120 GOSUB 220 
30 GET(O,O)- ( 127, 127),A 

140 X:O: V:O 
150 IF MOUSE(O):O THEN 150 
160 IF ABS(X-MOUSE( 1)) > 2 GOTO 180 
170 IF ABS(V-MOUSE(2)) < 3 THEN 150 
180 PUT(X,V),A 
190 X:MOUSE( 1 ): V:MOUSE(2) 

1----------4=1?'00 PUT(X, V),A 
'--------...1.=:.~? 10 GOTO 150 

Fig. M7 The Microsoft BASIC screen display illustrating the List window, the Command 
window and the O utput window. 

Microsoft Chart• A business graphics program. It makes extensive use of the menu 
bar and pull-down menus to present options to the user. Seven menus are ava ilable 
on the menu bar: the Apple menu, the File menu, the Edit menu, the Data menu, 
the Gallery menu. the Chart menu and the Format menu. The Apple menu provides 
access to the Desktop accessories. The File menu is used for file handling and 
printing. The Edit menu is used to access the Clipboard. The Data menu is used 
to define the data format to be used by a chart. It is also used to instruct the program 
to sort, analyze or l ist data that has been entered into a data series. The Gallery 
menu is used to present chart formats to the user. It gives the user the choice 
of Area charts, Bar charts (horizontal bars), Column charts (vertical bars), Line 
charts, Pie charts, Scatter charts and Combination charts that use combinations of 
all of the formats that are available. Microsoft Chart can accept data input from 
the keyboard or from disk. It can also accept data from M ultiplan via the Clipboard. 
See Clipboard, Menu Bar. Microsoft Corporation. In UK: M icrosoft (UK) Ltd. 

Microsoft File• A database management program for managing personal f iles. It is 
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billed by Microsoft as a personal filing system, but might meet the needs of a small 
business. Microsoft File includes a number of predefined input formats, such as a 
name and address format that may be selected to enter data to the program. The 
program includes a report generator that produces columnar reports, labels, lists 
and sorted reports. It can perform basic mathematical functions, such as sums, 
averages, counts and logical operations and can accept data from other applications. 
Microsoft Corporation. In UK: Microsoft (UK) Ltd. 

Microsoft Multiplan• An electronic spreadsheet program that brings to the Macintosh 
most of the features it had in versions marketed for other computers. It is much 
easier to use on the Macintosh than it is on conventional computers. This spreadsheet 
can have up to 63 columns and 255 rows. Text, values, formulas and references are 
entered into cells (the spaces where columns and rows cross each other). The mouse 
is used to select active cells for data entry, formatting, text entry, value entry and 
editing. Portions of rows and columns or blocks of cells may be selected in the same 
fashion. A portion of the worksheet is made active by dragging the mouse pointer 
over the cell or cells that are going to be acted upon. The menu bar in Microsoft 
Multiplan has the Apple menu, the File menu, the Edit menu, the Select menu, the 
Format menu, the Options menu and the Calculate menu. The mouse is used in the 
conventional fashion to select options from each of these menus. It is also used to 
position the pointer to insert a vertical bar cursor for character entry or deletion in 
any cell that is being edited. Microsoft Multiplan can sort data and it can perfrom 
iteration. Worksheets may be linked together and data can be moved between 
worksheets via the Clipboard. The contents of cells, including formulas, may be 
moved around the worksheet and copied to new locations on the same worksheet. 
See Mouse Pointer, Menu Bar, Cell, Spreadsheet. Microsoft Corporation. 
In UK: Microsoft (UK) Ltd. 

Microsoft Word• A powerful word processor for the Macintosh. It makes full use of 
the features of the User Interface Toolbox. It has automatic word wrap, and uses the 
Clipboard to pass data to and from other applications such as MacPaint and 
MacWrite. The menu bar in Microsoft Word contains the Apple menu, the File 
menu, the Search menu, the Character menu, the Paragraph menu and the Docu
ment menu. The File menu is similar to the File menu in MacPaint except for an 
additional command called "Print Merge." The Save As ... command allows a backup 
copy of a file to be saved. The Page Setup option allows gutters (extra margin space 
on left-hand pages) to be set up. 

The Edit menu has three additional features: Show Glossary, Hide Paragraph and 
Preferences. The Preferences command option allows fine settings to be made to 
character pitch and line spacing. The Show Glossary option allows a glossary of 
abbreviations to be set up and used while a document is being written. The Search 
menu contains an extra command called "Go To." The Paragraph menu is used to 
format the centering and spacing of paragraphs. It is also used to format paragraphs 
and to set tabs. The Character menu is used to select the type format and the font to 
be used. The Document menu allows the entire document to be formatted. Docu
ments that are generated by Microsoft Word may be a~ large as the user requires. If 
they exceed the RAM capacity of the Macintosh, they are automatically written to 
disk. Microsoft Word will automatically number footnotes. Up to four different 
documents may be displayed at the same time with Microsoft Word. Data can be 
merged into a document automatically by using the Print Merge option mentioned 
above. This is an extremely powerful word processor for the Macintosh. Microsoft 
Corporation. In UK: Microsoft (UK) Ltd. 
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Microsoft Word Made Easy- Macintosh Edition• By Paul Hoffman. A complete 
description of the use of Microsoft Word on the Macintosh. The book treats this 
word processor in great detail. Osborne/McGraw-Hill. 

MID A function available in some electronic spreadsheet programs, and included 
in Microsoft Multiplan. The function is used to return text characters from a 
specified cell to the cell that contains the function. The function will also return text 
characters from a list of characters supplied within the formula for the function. The 
format is: 

=MID(" charstring" ,s,n) 

(s) stands for the starting character location in the string from which the text 
characters are to start. 

(n) stands for the number of characters to use. Both numbers must be integers. 

MID$ A Microsoft BASIC function and statement. When used as a function, returns 
the requested part of a given string. The format is: 

Ml D$( <Stringvariable> ,<n>[ ,<m>]) 
<stringvariable> may be any string expression. 
<n> is an integer expression in the range 1 to 255. It represents the character number 

in the string that is the starting place for using characters from within the string. 
<m> is an integer expression in the range 0 to 255. It represents the number of 

characters from the stringvariable that are to be used from the starting point <n>. 
The MID$ function returns a string of length <m> characters from <stringvariable> 

starting with the <mth character. If you leave out <m> or if there are fewer than <m> 
characters to the right of the <mth character, all rightmost characters beginning with 
the <n>th character are returned. If <m> is equal to zero, or if <n> is greater than 
LEN(<stringvariable>), then MID$ returns a null string. 

When used as a statement, MID$ replaces a portion of one string with another 
string. The format is: 

MID$(<stringvariable>,<n>[,<m>] = <y$>) 

<stringvariable> is a string variable or array element that will have its characters 
replaced. 

<n> is an integer expression in the range 1 to 255. 
<m> is an integer expression in the range 0 to 255. 
<y$> is any string expression. 
The characters in <stringvariable>, starting at the <n>th position, are replaced by the 

characters in <y$>. The <m> is optional and refers to the number of characters from <y$> 
that will be used in the replacement. If <m> is left out, all of <y$> is used. 

Regardless of whether <m> is omitted or included, the length of <stringvariable> 
remains the same, as determined by the value given to <n>, the starting character. For 
example, if <Stringvariable> is six characters long and <y$> is seven characters long, 
then after the replacement <stri ngvariable> wi II contain only the first six characters of 
<y$>. 

See also LEFT$, RIGHT$. 

Millionaire• An investment simulation game for the Macintosh. The player starts 
the game with $10,000 and invests it in the stock market. Time is measured in weeks. 
The player may buy or sell the stocks he desires. Information is provided about each 
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investment that he selects. His buy and sell decisions are based on this information. 
Up to fifteen stocks are graphed for the player with complete company profiles and 
regular announcements about each company. This is an extremely realistic simulation 
of stock market action. Blue Chip Software. In UK: Softsel. 

Mind over Mac• A collection of five games. MasterCode requires the player to 
break a complicated secret code. Destroyer requires the player to find and destroy 
the computer's ships on a grid. Third Dimension is 3-D Tic, Tac, Toe. On the Contrary 
is a memory game. Trivial Intrigue is a trivia game. Think Educational Software. 

Mixed Program Lines To start a new program, select New from the Edit menu on the 
menu bar or type NEW in the Command window. 

This completely erases all lines now in Microsoft BASIC's memory so if it is 
something you want to keep and have not already stored on disk, SAVE it first. If you 
do not erase the program in memory before starting on another, you will usually 
wind up with the unusable combination of mixed lines from your old and new 
programs. 

MKI$, MKS$, MKD$ Microsoft BASIC functions which convert numeric-type values 
to string-type values. The formats are: 

<stringvariable> = MKI$(<integer expression>) 
<stringvariable> = MKS$(<single-precision expression>) 
<stringvariable> = MKD$(<double-precision expression>) 

When a numeric value is placed in a random file buffer with an LSET or RSET 
statement, it must be converted to a string. MKI$ changes an integer to a 2-byte 
string. MKS$ changes a single- precision number to a 4-byte string. MKD$ changes a 
double- precision number to an 8-byte string. 

See also STR$, CVI, CVS, CVD. 

Mnemonic A name or abbreviation intended to remind you of what it stands for, 
such as LAX for Load Accumulator into X register. 

MOD A function available in a number of electronic spreadsheet programs such as 
Microsoft Multiplan. This function is used in a cell to instruct the program to display 
the remainder of a division operation of two numbers shown in parentheses after the 
function. The format of this command is: 

MOD(n1,n2) 

(n1) is the number to be divided. 
(n2) is the number to divide into the first number. 

Modal Dialog Box The Macintosh User Interface Toolbox is used by programmers to 
provide a uniform method of supplying and obtaining information to carry on with 
the sequence of the program or a command given to the computer. Dialog boxes are 
used to supply information to the user and to obtain further instructions from the 
user. A Dialog box that requires a response from the user prior to going forward with 
the next step of a command is called a "modal dialog box" in the Macintosh 
technical manuals. Such dialog boxes generally contain rectangles for inputting 
information or lists of selections that must be used. They also contain buttons for 
indicating the next action to be taken. Such an action might be to cancel the 
command just given, or to accept the information just supplied. See Dialog Box, 
BASIC Statements Cross Referenced by Function, Button. 
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Fig. M8 An example of a modal dialog box. 
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OK 

(Cancel ) 

Modeless Dialog Box Two types of dialog boxes are presented to the Macintosh user 
in situations that require the user be informed about the state of a program or require 
the user to supply additional information or instructions by those applications that 
use the Macintosh User Interface Toolbox. The modeless dialog box is one that 
supplies information and requires only a recognition of a situation but no further 
information to proceed. See Dialog Box, Modal Dialog Box, User Interface Toolbox. 

Type mismatch ( OK J 

Fig. M9 An example of a modeless dialog box. 

Modem MOdulator DEModulator. A device to convert the digital voltage level 
signals of the computer to modulated (frequency or tone) signals for transmission 
over phone lines. Required at both ends of a phone line for telecommunications. 
Modems are connected to the Macintosh via one of the serial ports on the back 
panel of the computer. Under normal circumstances, the last multipin port on the 
right as you face the back panel would be used. This port is connected to an 
RS-232/RS-422 circuit within the computer. It is marked with a telephone icon. See 
Apple Modem 300, Apple Modem 1200, Portable Modem, Promodem 1200, 
Volksmodem. 

Modula-2• A programming language integrated with the Macintosh Operating 
System. It converts text files to code files which may be executed by the Macintosh. 
This system employs a compiler, a module library and a library manager. The library 
modules are extensive and include directories for disks, number format conversions, 
string management, scheduling of tasks and many other useful features. forty 
tutorial source programs are included with the system. Volition Systems. 
In UK: P+ P micro distributors. 
Monitor The software which is in the Macintosh with a program to be tested, which 
may determine your ability to detect and interpret errors, is the test environment. 

Similar features are included in Microsoft BASIC, via TRON, TROFF, and the 
ability to stop the program at any time and examine the contents of variables with 
PRINT. This TRACE feature is a fundamental way of following the sequence of 
instructions executed in a program to ensure that the program's logic is correct. 

Monitor A CRT or TV-type screen display for presenting computer output. The 
Macintosh has a built-in monitor. See also CineMac, Mach 1 Projection System, 
Mach 2 Projection System. 
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Motherboard The main part of a circuit board in an electronic device. It is usually 
the largest board. The important characteristic of this board is that it contains the 
main memory chips and circuits of the computer. 

Mouse The mouse is a rectangular hand-held pointing device connected to the 
Macintosh by a flexible electrical cable. It converts motion across a Desktop, table 
top or any flat surface into motion of a pointer on the Macintosh screen display. It 
has a single button on top and cavity on the bottom that holds a hard rubber ball. 
The rubber ball is locked into the black circular disk cavity. The motion of the ball is 
translated into pointer motion. The mouse is used as a tool to convey the user's 
needs and requirements to the computer. It is used to select a particular disk icon 
from the Desktop and to open the icon. Selection is accomplished by clicking the 
mouse button once. Opening an icon is accomplished by clicking the mouse button 
twice. Menus are selected by moving the pointer to the name of the desired menu on 
the line at the top of the screen display and pressing the mouse button. This action 
causes the entire menu to be displayed with the topmost entry highlighted. A 
command can be selected from the menu by dragging the mouse down the Desktop 
with the button still depressed. This drags the highlight down the list of options. 
When the desired option is highlighted the mouse button is released and the 
command is executed if it is not a dimmed command (dimmed commands are not 
currently available). 

Insertion and deletion points are selected in text and program lines by moving an 
1-beam pointer to the point and clicking the mouse button once. This action causes a 
vertical bar cursor to be displayed at the selected point. Icons may be dragged from 
one point on the Desktop or from one disk icon or disk directory to another by 
placing the pointer on the file icon, pressing the mouse button, dragging the icon to 
the new location and then releasing the mouse button. See Mouse Button, Menu 
Bar, Clicking, Dragging, Desktop, Icon, Directory, Dimmed Commands. 

MOUSE A Microsoft BASIC function used in programs in seven different ways. The 
syntax for this function is: 

MOUSE(<n>) 

<n> represents one of seven integers between 0 and 6 that interpret mouse location 
or mouse motion and then act upon this information. A table of mouse functions is 
presented below: 

MOUSE FUNCTION 

MOUSE (0) 

MOUSE (0), 0 

MOUSE (0), 1 

MOUSE (0), 2 

MOUSE (0), 3 

USE/MEANING 

This function returns a value lying + 3 and -3 that informs 
the program of the status of the mouse button. This function 
also remembers the values returned to the program by 
MOUSE functions (1) through (6). Each status is listed below: 

Mouse button is not down and has not been down since last 
action taken. 

Mouse button is not down, but last selection was a first 
level selection. 

Mouse button is not down, but last selection was a second 
level selection. 

Mouse button is not down, but last selection was a third 
level selection. 



MOUSE (0), -1 

MOUSE (0), -2 

MOUSE (0), -3 

MOUSE (1) 

MOUSE (2) 

MOUSE (3) 

MOUSE (4) 

MOUSE (5) 

MOUSE (6) 
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Mouse button is down for a first level selection and has not 
been released during dragging. 

Mouse button is down for a second level selection and has 
not been released during dragging. 

Mouse button is down for a third level selection and has 
not been releas~d during dragging. 

This function returns the horizontal (x) coordinate of the 
mouse pointer at the time that the last MOUSE (0) function 
was invoked whether the mouse button was up or down. 

This function returns the vertical (y) coordinate of the mouse 
pointer at the time that the last MOUSE (0) function was 
invoked whether the mouse button was up or down. 

This function returns the (x) horizontal coordinate of the 
mouse pointer the last time the mouse button was pressed 
down. This is normally the starting point of dragging. 

This function returns the vertical {y) coordinate of the mouse 
pointer the last time the mouse button was pressed down. 
This is normally the starting point of dragging. 

This function returns the horizontal (x) coordinate of the 
mouse pointer the last time that the mouse button was 
released. This is normally the ending point of dragging. 

This function returns the vertical (y) coordinate of the mouse 
pointer the last time that the mouse button was released. 
This is normally the ending point of dragging. 

Mouse Button The mouse button is the button at the top center of the Macintosh 
mouse. This button is pressed and held down to drag an icon from one place to 
another or to drag a pointer over several selections on the screen. It is pressed once 
and released (clicked) to highlight a selection or several selections. It is pressed 
twice quickly (double-clicked) to open a selection. This mouse button is a key 
element in the interaction between the Macintosh and its user. 

Mouse Pointer The mouse pointer is a distinctive symbol similar to a cursor that 
represents the physical location of the mouse on the Desktop. As the mouse is 
moved over the Desktop, the pointer moves in the same direction. In the Desktop 
display for most applications, the mouse pointer is an arrowhead. When the Control 
Panel, one of the desk accessories from the Apple menu, it changes to a crosshair. In 
applications where text is being inserted or deleted, it is an 1-beam. The mouse 
pointer is used to select, highlight and execute. 

Mouse Port The mouse port is on the back panel of the Macintosh to which the end 
of the mouse cable with the plug is connected. This port is the first port on the left as 
you face the back panel, and is identified by- a mouse icon located above the port. 
See Back Panel, Icon. 

MOVE A common command in electronic spreadsheet programs, used to move a 
row, a column or a block of cells from one place on the spreadsheet to another. This 
command is not available as a command in Microsoft Multiplan. Instead, portions 
of rows, portions of columns, or blocks of cells are moved from one place to another 
on a worksheet by highlighting the cells to be moved, using the Cut option from the 
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Edit menu, placing the pointer in the upper left-hand corner of the new location, 
pressing the mouse button to highlight this cell and using the Paste option from the 
Edit Menu. See Edit Menu, Cut Option, Paste Option, Highlight. 

Moving Applications Applications may be moved from one position on the Desktop 
display to another by placing the mouse pointer on the application's icon and 
dragging the icon to the new location. An application is a program that makes use of 
the Macintosh computer to satisfy the need of a computer user. It could be a word 
processor, a text editor, an electronic spreadsheet, a graphics tool or any similar 
useful program. Applications may be moved from one disk to another by opening 
the disk icon from which the application is to be copied, ejecting the disk if you only 
have the internal disk drive, inserting the disk to which the application is to be 
copied, opening the icon of the second disk and dragging the application's icon 
from the source disk directory display to the destination disk directory display on 
the Desktop. The system will then prompt you to swap disks back and forth until the 
application has been copied. When an application is moved from one disk to 
another with this method, a copy of the application is still present on the source 
disk. If space is required on this disk and you no longer wish to maintain a copy of 
the application on the disk, the icon must be moved to the Trash Can and the Trash 
must be emptied by using the Empty Trash command from the Special menu or by 
ejecting the disk. See Copying an Application, Eject Disk, Application Software. 

Moving Cells (Multiplan) See MOVE. 

Moving Documents Documents can be moved from one location to another on the 
Desktop by placing the mouse pointer on the icon of the document to be moved and 
dragging the icon to its new location. Documents are files that are generated by an 
application. A document could be a picture that was drawn on MacPaint, a letter 
that was written on MacWrite, or any other file generated by an application 
program. If an icon is moved onto the icon of another disk displayed on the Desktop, 
the document will be copied to that disk. The system will instruct the user when 
disks are to be swapped. See Desktop, Icon, Mouse Pointer, Dragging, Moving 
Applications. 

Moving Folders When documents are moved into a folder, they are removed from 
the Desktop display. A folder is the device used to arrange a number of documents 
into a particular directory. The document names and icons are no longer displayed 
on the Desktop unless the folder is opened by double-clicking its icon. Folders may 
be moved around the Desktop in the same fashion as other icons. The pointer must 
be placed on the folder's icon and the icon must be dragged to the new location by 
pressing the mouse button, holding it down while the icon is dragged to its new 
location and releasing the mouse button. Folders may be copied from one disk to 
another by dragging the folder's icon onto the disk's icon on the screen display. It 
may also be copied by dragging the icon from one directory display to another on 
the Desktop. See Icon, Desktop, Dragging, Moving Applications. 

Moving Text Text may be moved from one place to another in a text file, in the Note 
Pad or in an application by dragging the mouse pointer over the text to be moved 
(this action highlights the text), selecting Cut from the Edit menu (this erases the text 
from its current location), moving the pointer to the new location for the text and 
clicking the mouse button (this indicates the insertion point to the computer and the 
program) and selecting Paste from the Edit Menu (this inserts the text at its new 
location). See Edit Menu, Cut Option, Paste Option, Note Pad. 
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Moving the Cursor Cursors are symbols that mark the location on the screen where 
the next action will occur, which could be supplying input to a computer program, 
entering the next portion of a program line, entering text in a word processor 
document or deleting characters or text. In many Macintosh screen displays, pointers 
rather than cursors are used to initiate and locate action. This is the case with the 
Finder when pointers and highlights are used instead of cursors to indicate to th~ 
user what is happening and where it is happening on the screen. Cursors are used in 
many situations in Macintosh applications. A pointer is used to position a cursor in 
the correct location on the screen. Pointers are moved from one place to another 
with the mouse; cursors are moved with key strokes. As a letter or number is typed, 
the cursor moves across the screen one space at a time to the next space where a 
character may be entered. The same thing happens in the opposite direction when a 
character is deleted. When the Return key is pressed, the cursor is moved down one 
line and moved all the way to the left-hand side of the screen. In such cases, the 
cursor appears as a flashing vertical bar. It may be returned to the upper left-hand 
corner of the screen or to any other location on the screen by moving the pointer to a 
new location and clicking the mouse button once. In those applications where the 
Tab key is used, the cursor can be moved to the next tab position on a line by 
pressing the Tab key. MacWrite and Microsoft Word use this feature. The Tab key is 
used in some database management programs to move the cursor from one entry 
field to another. See Clicking, Vertical Bar Cursor, Pointer. 

Moving Windows Windows are used in many Macintosh applications, as well as by 
the Desktop accessories, to allow more than one thing to be shown on the screen at a 
time. When a Desktop accessory is opened, it is displayed in a window that overlays 
the current screen display. Windows may be moved from one place to another on 
the screen by placing the mouse pointer on the window's title bar, pressing the 
mouse button, dragging the window to its new location and releasing the mouse 
button. See Mouse Button, Dragging, Title Bar, Desktop Accessories, Window. 

MPU MicroProcessor Unit. The actual chip containing the processor. 

MSB Most Significant Bit. 

Multiplan• An electronic spreadsheet program first released for microcomputers in 
1982. It was a major improvement on earlier spreadsheet releases such as VisiCalc 
(the first commercially successful electronic spreadsheet program for microcomputers) 
and SuperCalc (a VisiCalc clone). Multiplan has concentrated on simplifying the 
user interface (the screen as the user sees it) to make the spreadsheet easier to use 
and more understandable. 

Multiplan divides the computer screen into a grid of rectangular cells like most 
spreadsheets, with a row of numbers stretching across the top and another down the 
side of the screen to give the coordinates for each cell. Unlike VisiCalc, which uses 
letters of the alphabet across the top of the screen, Multiplan uses numbers for both 
row and column coordinates. Thus, the first cell in the upper left-corner is referenced 
as "R1C1," for Row 1 Column 1. Multiplan's numbering scheme simplifies moving 
about the spreadsheet by using coordinates that are easy to remember. 

Multiplan, as implemented for the Macintosh, uses the mouse, the mouse pointer, 
highlighting, a menu bar and many other features of the Macintosh User Interface 
Toolbox. 

Creating a spreadsheet involves placing numeric values in the different cells and 
then relating them to other cells, using mathematical formulas. For example, the 
cells R1C1, R1C2 and R1C3 each represent a value and might be added together in 
the formula R1C1 +R1C2+R1C3; the total of this formula appears in a fourth cell 
somewhere on the spreadsheet. 
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Creating a formu la by adding three cells together may seem simple, but in more 
complicated arithmetic, t ryi ng to keep cel l coordinates straight can be awkward. 
One of the outstanding features of Mul tiplan is its abi lity to give individual cells 
meaningful names. For example, the value in R1C1 can be given the name SALES if 
the value the cell holds is a sales statistic. The value in another cell can be named 
COSTS. Multiplan enables you to use the names of cells in your math to create a 
formula of SALES-COSTS with the new value appearing in a cell named PROFITS. 
This ability to name cells and use them in spreadsheet mathematics simplifies the 
logic requ ired to create complicated spreadsheets. This feature alone represents a 
significant enhancement in the user interface over Multiplan's predecessors. See 
Microsoft Multip lan, Spreadsheet Menu Bar, User Interface Toolbox. M icrosoft 
Corporation. 

j File Edit Control 

Command 

Fig. M10 The Control Panel w indow displayed on a Multiplan screen display with the mouse 
pointer on the title bar. This window may be dragged to a new location by pressing the 
mouse button, holding it down and moving the mouse until the window is where you want it. 
Then the mouse button is released . 

Multiplan Made Easy- Macintosh Edition• By Walter A. Ettlin. This book 
helps you get the most out of Multiplan on the Macintosh. It deals with basic 
commands, building worksheets, data entry, advanced mathematica l operations 
and using BASIC to deal with worksheets. Osborne/ McGraw-Hi l l. 

Multiple Microsoft BASIC Statements on One line You can put a colon (:)at the 
end of one statement and continue entering another statement on the same line, 
without giving a new line number. The line number at the left refers to all statements 
on the l ine. An apostrophe (') allows a comment or remark to be added after a 
statement, with or without a separating colon. 
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Multiplex Use the same component for several distinct functions, either sequentially 
or simultaneously. For example, the address lines of an MPU are often used as the 
data lines at another point in time. 

Multitasking Running two or more tasks concurrently on a single computer. The 
MPU actually works on only one task at a time, but it switches back and forth so 
rapidly it creates the impression that all tasks are being processed concurrently. 

Murder by the Dozen• presents twelve murder cases for the players to solve. A 
crime computer plays a large part in the game, supplying information about the 
victim and analyzing physical evidence. Up to four people can play at the same 
time. Two reference manuals are supplied with the game and worksheets are 
provided to assist in solving the mystery. CBS Software. In UK: Softsel. 

Music Software See Professional Composer. 
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NAME (Microsoft BASIC) Used to change the name of a file on a disk. It is used in 
the Command window by typing: 

NAME <oldname> AS <newname> 

<oldname> is the name of an existing file on a disk. 
<newname> is the new name this file is to be given. 
When this direct command is used, the designated disk drive will rewrite the name 

of the file in its directory. Only an existing file on an active volume (disk drive) can 
be renamed in this fashion. The file that is renamed may be any file or document on 
the disk. 

Name Command (Microsoft Multiplan) One of the features of Microsoft Multiplan 
is the program's acceptance of names for designated cells, designated portions of 
rows, designated portions of columns and designated blocks of cells. Names can be 
used in formulas instead of cell references. Thus, if you named the contents of a cell 
SALES, representing the total sales done by a company in a month, this name could 
be used in a formula elsewhere on the spreadsheet. This cell could contain a formula 
that totalled the contents of ten cells above the cell. These cells could contain the 
sales results of ten different salesmen. Another cell could be named COSTS, representing 
the total of a number of cells above it containing product and production costs for 
the month. A third cell could be named GROSS PROF IT, and could contain the 
formula = SALES - COSTS. 

A cell or range of cells is named in Multiplan by highlighting the cell or cells 
(holding down the mouse button) while the plus sign pointer is dragged across the 
cell or cells. When the cell or cells have been highlighted, the Define Name 
command option must be selected from the Select menu on the menu bar. This will 
cause a dialog box to be displayed requesting the name. The name is then typed into 
the Name: rectangle on the bottom of the dialog box and the OK button is clicked to 
supply the name to the program. See Mouse Button, Dialog Box, Button. 

Names In Microsoft BASIC. See BASIC, Variable Names. 

Naming Disks When a Macintosh disk is initialized, the Operating System asks the 
user to name the disk. This request appears on the screen in the form of a window 
called a dialog box. The name of the disk is entered in a rectangle within that dialog 
box directly under the words "Please name this disk." Once the name has been 
entered, the OK button may be clicked or the Return key pressed. Disk names may 
be up to 27 characters in length. A disk name may not contain a colon and may not 
start with a period. All other characters from the keyboard may be used within a 
name or to start a name. See Dialog Box, Button, Disk, Initialize a Disk. 
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Define Name 

~ ( OK ) 

~ 
( Con eel ) 

Name: IF I RST TEN I 
Fig. N1 A Microsoft Multiplan screen display while the name command is in use. Note the 
dialog box and the Name rectangle. 

Please name this disk: 

( OK ) 

Fig. N2 The dialog box that is presented when a disk has been initialized and must be named. 

Naming Documents Documents are files generated by an applications program 
such as Mac Paint, MacWrite and Microsoft Multiplan. Documents are named when 
the Save or Save As ... command is selected from the File menu on the menu bar. 
When the command is selected, a dialog box is displayed on the screen requesting 
the name of the document be typed into the input rectangle located under the words 
"Save current document as" or "Save document as." Once the name has been 
entered in the rectangle, the Save button may be clicked or the Return key may be 
pressed. Document names may be up to 63 characters in length and may not contain 
a colon or start with a period. Any other keyboard characters may be used in 
document names. See Button, Document, Dialog Box. 

Naming Folders Special directory files used to organize files on a disk are called 
"folders" and are created by selecting the Empty Folder icon from the Desktop and 
using the Duplicate command option from the File menu on the menu bar. This 
process creates a second empty folder named Copy of Empty Folder. This copy may 
be given any name the user desires by moving the pointer to the extreme right-hand 
side of the words "Copy of Empty Folder." As the pointer nears the words, it changes 
from an arrow head pointer to an 1-beam pointer. Make sure that it looks like the 
1-beam when it rests on the extreme right-hand side of the words, and then click the 
mouse button. This will change the 1-beam to a vertical bar cursor. Backspace this 
cursor over all of the letters until just the cursor remains on the line of words. Then 
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type in the name you wish to give the folder. Move the pointer to anyplace on the 
Desktop and click the mouse button. The new name wi ll then be recorded for the 
fo lder. See Mouse Button, Menu Bar, 1-beam. 

Saue document as: MacDrlue 
jFHC~ 

Eject 

Saue Cancel Driue 

Fig. N3 A MacPaint screen display illustrat ing the dialog box used when the Save as command 
option is selected from the File menu on the menu bar. 

NAND NOT-AN D Logical. See AND. 

Negotiation Edge, The• A program that analyzes a negotiation situat ion based on 
data about the parties involved. It then suggests a strategy to fo llow as the negotiations 
proceed. This program is also useful as a training aid and in evaluat ing employee 
performance in negotiations. Human Edge Software Corporation. 

Nested Subroutine A subroutine within another subroutine. The nested subroutine 
is compl eted f irst, and the outer subroutine is completed after the nested subroutine 
has fi nished. 

Network An interconnected system of computers. Appleline and the AppleBus 
may be used in the networking process with the M acintosh. See Appleline, AppleBus. 

NEW A M icrosoft BASIC command which deletes the program currently in com
puter memory and clears all variables. The format is: 

NEW 

NEW is generally used to clear all memory before entering a new program. 
Microsoft BASIC will always return to command level after NEW is executed. NEW 
causes all fil es to be closed and turns TRACE o ff, if i t was on. See also TROFF / TRON. 
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NEW is not implemented in Compiler Microsoft BASIC. 
The NEW command may be used in Microsoft BASIC on the Macintosh in two 

different ways: typed in the Command window when Microsoft BASIC is being used 
or selected from the file menu on the menu bar at the top of the screen display. See 
Menu Bar, file Menu. 

New York New York is one of the fonts available to the user of MacPaint and 
MacWrite. This font is selected by using the pull-down font menu on the menu bar. 
A sample is presented below. See Menu Bar, fonts, Pull-down Menu. 

Tbia Ia ao example or New Yort 9 point plain text. 
This is an example of New York 10 poiJlt plain te1t. 
This is an example of New York 12 point plain text. 
This is an eza•ple of New Yort 12 point bold. 
This Is an eDmple of New York 14 point bold. 
mbftm ftm IR \Tmaik nl [i)mftmtt mmttnft.a 
ID.lJII II ~4 fil(l)lm& llhfBiiiJ\\9' .. 
Fig. N4 A sample of the text generated by the New York font from MacWrite. 

NEXT In Microsoft BASIC the end of the FOR ... NEXT loop. This statement tells the 
program to perform a series of instructions a specific number of times. It is used with 
the FOR statement in a combination of statements called a FOR ... NEXT loop. See 
FOR ... NEXT. 

Nibble Half a byte or 4 bits. 

No Decimal Command Allows whole numbers to be displayed. Electronic spreadsheet 
programs allow the user to format numbers in a variety of ways. Most provide 
various decimal and currency options. Some provide commas at the '000 points in 
numbers. All have an integer or "no decimal" format. Microsoft Multiplan uses the 
No Decimal command option on the format menu to set this format, which may be 
used on any cell, range of cells or block of cells that has been highlighted with the 
mouse pointer prior to exercising the command. See Mouse Pointer, Format Menu. 

Noise Interference on a system communications line; random unknown signals. 

Nondestructive Readout This occurs when the memory contents are not erased or 
displaced when other data is read. 

Nonstartup Disk A startup disk loads the Disk Operating System into RAM when the 
disk is booted. The System folder must be present on a Macintosh disk for the disk to 
be considered a startup disk. A nonstartup disk may be used to store files but 
requires a startup disk be booted prior to using the nonstartup disk. See RAM, 
Startup Disk, System Folder, Disk Operating System. 

Nontext File Editors A text editor is an editor program specialized for text files and 
manipulates ASCII characters such as letters, punctuation marks, etc. EDLIN (the 
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Microsoft BASIC ed itor for versions of Microsoft BASIC for computers other than the 
Macintosh) and word processing programs arc text ed itors. Their basic function. is to 
create and change text data such as a letter, report, program or book. 

Nontext editors usually display and modify a byte of storage as either two 
hexadecimal digits or a three-digit numeric ASCII value. See Editor, Edit. 

NOT Negative operation which changes every 1 in a byte to 0 and every 0 in a byte 
to 1. Also used as a logica l operator to reverse the outcome of a conditional test in 
many languages ( If x NOT= 1). 

Note Pad The Note Pad is one of the M ac intosh desk accessories available from the 
Apple menu on the menu bar. It can be used to keep notes while you are working on 
a document. Text can be moved into the Note Pad by using the Cut option or the 
Copy option from the Ed it menu whi le the document is being displayed and then the 
Paste option from the Edit menu while the Note Pad is being displayed. Once text 
has been moved to the Note Pad, it ca n be edited and returned to the document by 
cutting it or copying it from the Note Pad and pasting it into the document. The Note 
Pad has eight pages that may be turned by placing the mouse pointer on the 
turned-back corner at the lower left-hand side of the Note Pad and cl icking the 
mouse button. Notes may be removed from the Note Pad by cutting them. This 
involves highlighting them and using the Cut option from the Edit menu. If notes are 
left on the Note Pad when you close an applica tion and eject a disk. these notes are 
saved in the Note Pad file in the System Folder of a startup disk. When the 
applica tion is used again , the notes are moved back into the Note Pad . See Desk 
Accessories. Menu Bar, Apple Menu. Edit Menu, Cut Option. Copy Option. Paste 
Option. 
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18, 1984j 

Fig. NS The Mac Paint Note Pad. 
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Note Pad File Any time that notes are left on the Note Pad in a Macintosh 
application which is closed, these notes are saved in a Note Pad file that is reloaded 
into memory when the application is rebooted from the same disk. See Note Pad. 

NPL Information Management System• This a database manager and a report 
generator, that uses simple English language sentences to request data input from 
the user, to allow the user to make queries and to generate reports. Records may be 
merged, sorted, selected and printed. Each record may consist of 4000 bytes in 100 
fields. Desktop Software Corporation. 

NSEC NanoSECond. One nanoSECond is equal to one-billionth of a second. 

Null String or File A string or file with no contents at present. 

Number, Convert from String See CVI, CVS, CVD. 

Number, Convert to String See MKI$, MKS$, MKD$. 

Number Crunching The performance of complex arithmetic operations and 
computations. 

Number, Largest Line In Microsoft BASIC, the largest possible line number is 65529. 
Each program line can contain up to 255 characters. 

Number of Decimals Command If an electronic spreadsheet program allows the 
user to fix the number of decimals in the numeric format of a cell, range of cells or 
block of cells, there is a method available on one of the menus of the program to set 
the number of decimal spaces. Microsoft Multiplan uses a Number of Decimals 
option from the Format menu. This option is exercised after the Decimal option on 
the same menu. It is still available if the Commas option is used. When this option is 
selected, a dialog box is displayed requesting that the number of decimals number 
from 1 to 15 be entered in the Input rectangle in the dialog box. See Dialog Box, 
Format Menu, Decimal Command. 

Number of Files on Disk See Disk Capacity. 

Numbering Pages Word processors usually paginate documents automatically for 
the user. MacWrite will automatically number pages in a Header or in a footer as 
directed by the user. Both the header window and the footer window contain a small 
icon with a number sign on it. This icon is in the upper left-hand corner of the 
window. When this icon is dragged to a location in the Footer window or Header 
window, the page number is printed in this location on each page. The starting page 
number for a document is provided by using the Set Page# option from the Format 
menu. 

Numeric Keypad An accessory is available for the Macintosh upon which numeric 
operations and data can be entered. The numeric keypad connects to the Macintosh 
via the keyboard socket on the lower right-hand side of the front of the Macintosh. 
The keyboard is then connected to a similar socket on the back of the keypad. For 
the person who has been using a calculator or adding machine, the numeric keypad 
is much easier than using the numbers that run across the top of the Macintosh 
keyboard. There are keys for each of the numerals between 0 and 9, a Clear key, an 
Enter key, a decimal or period key, a minus sign key and four keys that use the shift 
key. One of these keys has a left arrow and a plus sign. Another has a right arrow and 
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the multiplication sign (*).Another has the up arrow and the division sign (/).The 
last has a down arrow and decimal point. The keypad has its own microprocessor 
and can be used alone with the Macintosh or hooked up with the keyboard. Apple 
Computer, Inc. 

Numeric Precision on Microsoft BASIC Conversions Microsoft BASIC can be used 
to convert constants from one numeric format to another. If a numeric constant of 
one type is set to equal a different type of numeric variable, the constant will be 
stored in memory as the type of variable to which it was set. Variable types are 
integers, single-precision and double-precision. Each type is declared by using a 
special character after the variable name. The percent sign (%) or the DEFINT 
expression is used to declare an integer variable type. The exclamation point(!) or 
the DEFSNG expression is used to declare a single-precision variable. The number/pound 
sign (#) or the DEFDBL expression is used to declare a double-precision variable. 
Thus if the following program was entered using Microsoft BASIC, it would produce 
these conversions: 

10 REM THIS SECTION CONVERTS A VARIABLE TO AN INTEGER 
20 A% = 19.999 
30 PRINT A% 
40 REM THIS SECTION CONVERTS A VARIABLE TO A 
41 SINGLE-PRECISION VARIABLE 
50 A! = 10/3 
60 PRINT A! 
70 REM THIS SECTION CONVERTS A VARIABLE TO A 
71 DOUBLE-PRECISION NUMBER 
80 A#= 10/3 
90 PRINT A# 
95 END 

If this program was run, it would produce the following output: 

20 
33.33 
33.33333333333333 

Numeric Value of String See VAL 

Numeric Variable (Double-precision Floating Point) In Microsoft BASIC, numeric 
double-precision floating point variable names (numbers with decimal fraction up 
to sixteen digits) end in # or start with a series of letters specified in a DEFDBL 
statement, and are the default for all variables not otherwise specified. 

Numeric variables must start with a letter, can have up to 40 characters, must not 
be any reserved words (If, ON, THEN, GOTO, etc.) or a reserved word followed by a 
type declaration character($,%.!,#). See Reserved Words for complete list. See also 
Variable Names. 

Numeric Variable (Integer) In Microsoft BASIC, numeric whole numbers (integers) 
from -32768 to+ 32767 end in% or start with a series of letters specified in a DEF INT 
statement. 

Integer numeric variable names must start with a letter, can have up to 40 
characters, and must not be any reserved words, such as (IF, ON, THEN, GOTO, etc.) 
or a reserved word followed by a type declaration character($,%,!,#). See Reserved 
Words for complete list. See Variable Names. 
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Numeric Variable (Single-precision Floating Point) In Microsoft BASIC, numeric 
single-precision floating point variable names (numbers with decimal fraction up to 
six digits) end in # or start with a series of letters specified in a DEFSNG statement. 

Single-precision floating point numeric variable names must start with a letter, 
can have up to 40 characters, and must not be any reserved words (IF, ON, THEN, 
GOTO, etc.), or a reserved word followed by a type declaration character($,%,!,#). 
See Reserved Words for complete list. See Variable Names. 
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Object Code The code produced by a compiler or assembler program. The object 
code is either directly executed by the computer or needs further translation 
through a linkage before it can be executed. 

Object File A file containing the MC68000 machine language version of a program. 
In most cases the object file is a translation of a source program stored in a text file. 

Object Program Machine language program resulting from translation of a source 
program. See Programs, Source and Object. 

OCT$ A Microsoft BASIC function which returns a string representing the octal 
value of the decimal argument. The format is: 

<Stringvariable> = OCT$(<n>) 

<n> is a numeric expression in the range -32768 to 65535. 
If <n> is negative, OCT$<-n> equals OCT$(65536-<m) (two's complement form). See 

HEX$ 

Octal String See OCT$. 

Odd Parity A byte is said to have odd parity when an odd number of bits are set to 1. 

Off-line When a device or medium is outside of, or disconnected from, the com
puter system, in contrast with on-line, which means that a device or medium is 
inside, or connected. 

A disk is off-line when it is in a box, and on-line when it is in a working disk drive. A 
printer is on-line if it is attached, powered on and ready to print and off-line if it is 
disconnected, powered off or switched to its "off-line" state by an on- line/off-line 
switch. See Memory, Input, Output. 

Offset Address The smaller part of a base register/offset pair. The data to be 
processed is located at: 

<effective address>=<contents of base register>+<offset>. 

OK Button Dialog boxes are presented by the Macintosh User Interface Toolbox to 
notify the user of a condition that exists with the computer or with the program in 
use. They are also used to obtain further information from the user prior to proceeding 
further with a program or a command. Many dialog boxes display an OK button, 
resembling a rectangle with rounded corners with "OK" inside. This button is used 
by moving the mouse pointer inside the rectangle and clicking the mouse button. 
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This action OK's whatever action is recommended in the dialog box. See Dialog Box, 
Button, Mouse Button, Mouse Pointer, User Interface Toolbox. 

Omnis 1-The File Manager• An entry-level database manager for the Macintosh. It 
allows 120 fields per record and up to 3000 characters per record. One file may be 
open at a time. It has mailmerge and letter-writing capabilities, and also contains a 
comprehensive report generator and full calculation capability. Organizational 
Software Corporation. In UK: Blythe Computers 

Omnis 2-The Information Manager• A sophisicated database manager with all of 
the capabilities of Omnis 1, plus multiple update capability, multiple delete capabi I ity 
and advanced error checking features. See Omnis 1. Organizational Software Cor
poration. In UK: Blythe Computers 

Omnis 3-The Database Manager• A complete database management system. Up to 
12 files may be open at one time. It supports both hierarchical and relational data 
structures. The user may write custom messages and can generate complete turnkey 
systems. Organizational Software Corporation. In UK: Blythe Computers 

One Line, Advancing on the Printer To advance one line on the printer (space up) 
without carriage return, enter: 

LPRINT CHR$(10) 

or use the "line feed" button (LF) on the printer. 
Entering just LPRINT gives both a space up one line (line feed) and a return to left 

margin (carriage return). 

ON ERROR GOTO In Microsoft BASIC this statement allows the user to set up error 
handling routines within a program. The syntax of this statement is: 

ON ERROR GOTO <linenumber> 

<linenumber> is the line in the program that starts error handling activity. The 
RESUME statement is required after the end of the error-handling routine to enable 
the program to continue its execution. 

If the program line states ON ERROR GOTO 0, the computer will print an error 
message for the first error encountered indicating BREAK IN LINE---. 

ON GOSUB and ON GOTO These are Microsoft BASIC statements that tell the 
program to branch to a specified line number depending upon the value of an 
expression. The formats are: 

ON <n> GOTO <line>[,<line> ... ] 
ON <n> GOSUB <line>[,<line> ... ] 

<n> is a numeric expression which is rounded to an integer, if necessary, and must 
be in the range 0 to 255, or an "Illegal function call" error is displayed. 

<line> is the line number you wish to branch to. 
The value of <n> determines which line number in the list will be used for 

branching. If the value is 4, the fourth line number in the list will be the destination 
of the branch. 

In the ON ... GOSUB statement, each line number in the list must be the first line 
number of a subroutine. This means that it will be necessary to have a RETURN 
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statement to bring you back to the line following the ON ... GOSUB. 
If the value of <n> is zero or greater than the number of items in the list (but less 

than or equal to 255), Microsoft BASIC will continue with the next executable 
statement. 

On-line This means that a device or media is inside or connected, opposed to 
off-line, which means that a device or medium is outside of or disconnected from 
the computer system. 

A disk is off-line when it is in a box, and on-line when it is in a working disk drive. A 
printer is on-line if it is attached, powered on and ready to print. The printer is 
off-line if it is disconnected, powered off or switched to its "off-line" state by an 
on-line/off-line switch. See Memory, Input, Output. 

OPEN A Microsoft BASIC statement which allows 1/0 to a file or device. The 
formats are: 

OPEN <filespeo[FOR <mode1>) AS [#]<filenum> [LEN=<recb] 
OPEN <mode>,[# ]<fi lenum>,<fi lespec>[,<rech] 

<mode1> in the first form may be one of the following: 
OUTPUT, which specifies sequential output mode. 
INPUT, which specifies sequential input mode. 
APPEND, which specifies sequential output mode where the file pointer is positioned 

to the end of data on the file when it is opened. 
<mode1> must be a string expression not enclosed in quotations marks. If mode is 

left out, random access is assumed. 
<mode2> in the second form is a string expression whose first character is one of the 

following: 

0, which specifies sequential output mode. 
I, which specifies sequential input mode. 
R, which specifies random input/output mode. 
A, which specifies sequential output mode and places the file pointer at the end of 
the file. 

The following are true for both formats: 

<filenum> is an integer expression whose value is between one and the maximum 
number of files allowed. The default maximum in Microsoft BASIC is three, but you 
can change this with the /F: option on the Microsoft BASIC command. 

<filespeC> is a string expression for naming the file. 
<reel> is an integer expression. If it is included, it sets the record length for random 

files. It may be in the the range 1 to 32767. <reel> is not valid for sequential files. The 
default record length is 128 bytes. <reel> cannot exceed the value set by the /S: option 
on the Microsoft BASIC command. 

OPEN makes a buffer (for 1/0) available to the file or device and determines the 
mode of access used with the buffer. <filenum> is the number that is associated with 
the file for as long as it is open and is used by other 1/0 statements to refer to the file 
or device. 

An OPEN must be executed before any 1/0 may be done to a device or file by any 
statement or function requiring a file number, including the following: 



PRINT# 
PRINT# USING 
WRITE# 
INPUT$ 
$$$FL 

INPUT# 
LINE INPUT# 
GET 
PUT$FL 
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GET and PUT can be used for random files or communication files. A disk file may 
be either random or sequential, and a printer may be opened in either random or 
sequential mode. All other devices may be opened only for sequential operations. 

Microsoft BASIC normally adds a line feed after each carriage return (CHR$(13)) 
sent to a printer. However, if you open a printer (LPT1 :, LPT2: or LPT3:) as a random 
file with width 255, this line feed is suppressed. 

APPEND can only be used for disk files. The file pointer is initially set to the end of 
the file and the record number is set to the last record of the file. PRINT# or WRITE# 
will extend the file. 

You can have a particular file open, at any one time, under different file numbers. 
Different modes can then be used for different purposes. You may also use different 
file numbers for different access. Be careful when writing or using one file number 
and when reading using another file number (each file has a different buffer). A file 
cannot be opened for sequential output or appended if the file is already open. 

Three files is the default maximum for Microsoft BASIC. You can override this 
value by using the /F: option on the Microsoft BASIC command. 

A nonexistent file opened for input will cause a "File not found" error to be 
displayed. If a file does not exist, and is opened for output, append or random 
access, a file is created. 

Attempting to enter parameters outside the given range will cause an "Illegal 
function call" error to be displayed, and the file will not be opened. 

Open In order for a program to be run, the files with necessary data must first be 
opened so that the data contained is available to the running program. A file, 
document or application may be opened by typing Open in the Command window 
followed by the name of the file, document or application, or by selecting Open 
from the File menu on the menu bar. See Menu Bar, File Menu. 

Opening a Document Documents may be opened directly from the Desktop or 
from within an application. Using the Desktop, you would move the mouse pointer 
onto the document icon and click the mouse button twice. This action causes the 
application on which the document was written to be opened first if that application 
is also on the same disk. If it is not on the disk, an alarm box indicating that there is 
no application available to use will be displayed. If you wish to open a document 
from within an application, use the Open command option from the File menu. 
When this command is selected, a dialog box listing all of the documents on the disk 
is displayed. To open one of these documents, press the mouse button, move the 
highlight down the list until the desired document is highlighted and release the 
mouse button. See Menu Bar, File Menu, Desktop, Icon, Dialog Box. 

Opening an Application To open an application such as MacWrite, first open the 
disk icon for the disk that contained the application, by making sure the disk is in the 
disk drive, and then by moving the mouse pointer onto the disk icon and clicking the 
mouse button twice. Then the directory window for that disk is opened and displayed 
on the screen. Next, the pointer is moved onto the MacWrite icon and the mouse 
button is double-clicked. This causes the application to be opened. The same 

I 



222 • Opening an Icon 

process can be accomplished by highlighting the MacWrite icon by placing the 
mouse pointer on the icon and clicking the mouse button once. The application can 
then be opened by using the Open command option from the menu bar. See Mouse 
Button, Disk Icon, Icon, Directory. 

Opening an Icon Icons represent disks, folders, applications, documents, BASIC 
programs and other files in the Desktop display on the Macintosh. Any of these icons 
and the thing they represent may be opened in two ways from the Desktop. First, an 
icon may be double-clicked. This means that the mouse pointer must rest on top of 
the icon to be opened and the mouse button must be clicked twice. The second 
method requires the use of the Open command option from the File menu. Place the 
mouse pointer on the icon to be opened, click the mouse button once to highlight 
the icon, move the mouse pointer to the File menu, press the mouse button, drag the 
highlight on the pull-down menu to the word Open and release the mouse button. 
See File Menu, Icon, Menu Bar, Mouse Button, Mouse Pointer. 

Opening a Window Windows are used to represent a number of the features of the 
Macintosh, including the directory of files on a disk. They are also used to display 
the Desktop accessories accessed from the Apple menu. Windows are usually 
opened from the menu bar. The List window in Microsoft BASIC is opened by 
selecting List from the Control menu. It may also be opened by entering LIST in the 
Command window at the bottom of the screen. Folders are diplayed as windows 
when they are opened by double- clicking them. Disk icons are displayed as 
Directory windows when they are opened by double-clicking the disk icon. Windows 
overlay the rest of the screen display. They may be moved around the screen by 
placing the mouse pointer on the title bar and dragging them to a new location. 
Window sizes may be altered by contracting or stretching the window with the size 
box in the lower right-hand corner of the window. The contents of a window may be 
scrolled by using the scroll bars on the right-hand side of the window and along the 
bottom of the window. See Mouse Button, Menu Bar, Scroll Bar, Size Box, Title Bar, 
Directory Window, Disk Icon. 

Operand Operations are performed upon entities called the operands. For example, 
LET A=B+C specifies that addition be performed on the operands Band C. 

Operating System The software which manages the hardware and the logical reasoning 
of the computer. The Macintosh Operating System is located in Read-Only Memory, 
the permanent memory that is not lost when the computer is turned off. It consists of 
machine language routines that handle interrupts, manage memory use, manage 
interpretation of events from the mouse and the keyboard, manage Input and 
Output functions, manage files, manage interaction with external devices, provide 
for sound generation and manage interfacing with serial devices. 

Operation Action of a program resulting in a defined instruction being executed 
and carried out. 

Operator Person using the program (user). For programs you write, the operator will 
often be you. But if others will ever use your program, you need to give some 
thought to giving clear prompts for every item of input data, freezing the screen long 
enough for them to read or act on the information displayed, providing clear error 
messages if anything is entered incorrectly or error situations arise, etc. This is often 
referred to as "human engineering," making the program easy to use as well as 
technically correct. Another term for this side of programming is making the 
program "user friendly." 
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Several other guidelines exist for writing user-friendly programs. If a complex 
series of data items has been typed in but some entries turn out to be invalid, the user 
should be able to reenter only the bad items. Error messages should indicate not only 
that an entry is invalid, but also in just what way it is invalid and, if at all possible, 
some hints as to how to correct it (such as a list of possible correct values). 

Operators Symbols within a program, such as * for multiply, - to subtract or + to 
add, which specify what operation is to be performed. 

Optimization Changing either the software or the hardware of a computer system 
so that it operates faster or more efficiently. 

OPTION BASE A Microsoft BASIC statement that declares the minimum value for 
subscripts for an array. Subscripts are integer values that indicate the minimum 
number of items that will be used in an array. The minimum value is the lowest value 
that a subscript may have. The most common minimum values are 0 and 1. OPTION 
BASE sets this value. If OPTION BASE 0 is declared, the lowest possible value of the 
subscript is 0 and either positive or negative numbers may be used in the array. If no 
value is given to OPTION BASE, the default value is 0. If OPTION BASE 1 is declared, 
the lowest possible value of the subscript would be 1. The syntax for this statement 
is: 

OPTION BASE <m 

<n> is the integer used to declare the minimum value for the array subscript. 
The OPTION BASE must be declared before any arrays are defined and used in a 

program. See DIM. 

Option Key The Option keys are in the lower left-hand and right-hand corners of 
the Macintosh keyboard. This key is generally used to supply optional character sets 
to the user. The Option key supplies the following accent marks: 

Option ' provides a grave accent ('). 
Option e provides an acute accent ( '). 
Option i provides a circumflex(). 
Option u provides an umlaut("). 
Option n provides a tilde(). 
The Option key is used with the key combinations listed above by typing the 

Option key and the other key together followed by the key that wi II need the accent 
mark. If the accent mark is needed alone, the Option key combination is pressed 
twice in succession. 

The Option Key is also used in MacPaint to make copies of shapes and images, 
which must first be selected with the dotted rectangle tool or the lasso. Then the 
pointer is moved onto the shape and the Option key and mouse button are pressed 
and held down while a copy of the shape or image within the rectangle or lasso is 
moved off of the original. The Option key and mouse button are held down until the 
copy has been moved to the location where it belongs. Then they are released. If the 
Option key and Command key are held down together, repeating copies are made of 
the selected image or object. See Mouse Button, Command Key, lasso. 

Options from Menu A menu is a screen display which lists a number of possible 
options and asks the user to select one. When a selection is made by positioning the 
highlight on the menu by dragging the mouse pointer down the list and releasing the 
mouse button at the desired option, the highlighted function is performed. This may 
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require either a branch or subroutine call to the code for the function, or the 
program to carry out this function may be loaded into memory and executed. If 
further information or instruction is required by the program, a dialog box will be 
displayed. 

Options Menu The Options menu in Multiplan contains ten command options. 
These options are Freeze Titles, Unfreeze Titles, Set Page Break, Remove Page 
Break, Show Formulas, Show Values, Protect Document, Unprotect Document, 
Remove Cell Protection and Restore Cell Protection. Freeze Titles is used to lock 
titles (labels) in place vertically and horizontally to assist in reading and entering 
data into the spreadsheet by allowing cells below or beside locked titles to be 
scrolled under the titles rather than over them. Unfreeze Titles reverses the Freeze 
Titles command. Set Page Break forces a page break at a point on the worksheet 
selected by the user. When a page preak is encountered, the printer advances the 
paper to the top of the next page before continuing to print. Remove Page Break 
reverses Set Page Break. Show Formulas is an option that tells Multiplan to display 
the formulas within each cell rather than displaying numbers. The Show Values 
option tells Multiplan to display the values in each cell containing a formula rather 
than displaying the formulas. Protect Document prevents data from being written to 
a document and prevents a document (worksheet) from being altered. Unprotect 
Document reverses Protect Document. Remove Cell Protection is used to allow 
protected cells to be written to or altered. Restore Cell Protection reverses Remove 
Cell Protection. 

Options, Program or Device Values which determine the functioning of a device or 
program. For example, the screen can be set to 40 columns wide or 80 columns wide, 
the screen-width option. 

OR (Logical Operator) One of the six logical operators available to the user of 
Microsoft BASIC. If either of two conditions separated by OR is true, the complex 
condition is true. If both conditions are false the complex condition is false. In 
tabular form: 

A B AORB 

T T T 
T F T 
F T T 
F F F 

OS Operating System. 

Output Information coming out of a program, going to a screen, printer, disk, 
speaker, etc. 

Output WRITE data from memory. Memory is any device which can store information 
and allow it to be retrieved when needed. The Macintosh relies primarily on Random 
Access Memory (RAM), Read-Only Memory {ROM), disks and hard disks. ROM and 
RAM together make up the internal memory or main memory of the Macintosh, or 
any other computer. 

Contrast this with external memory such as disk and hard disk, which involve 
mechanical motion to retrieve data and are hundreds or thousands of times slower 
than internal memory. Data in internal memory is immediately available to pro
grams for processing. Data in external memory must be copied into internal memory 
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(READ or INPUT), processed, then copied back out to external memory (WRITE or 
OUTPUT). 

If data has been created, it can be written out to external memory without a READ 
first. If data read in from external memory has not been modified, there is no need to 
write it back out since the original copy is still there. 

Output Window Microsoft BASIC employs three windows. These windows are the 
Command window, the List window and the Output Window. The Output Window 
is used to display output from a program. This includes menus, mathematical 
results, graphics, and whatever other material is generated by a Microsoft BASIC 
porgram. 

OV OVerflow occurs when the number of digits that result from a mathematical 
operation exceeds the amount of storage available to hold the result. The response 
depends on the language in which the program was written. 

Overlay Different routines within a program which occupy the same memory 
location. They are loaded as needed during the operation of a program. Conflict can 
occur if two routines with different overlays try to use the same location at the same 
time. 

Overstriking The printer returns to a position where a previous character was struck 
and strikes a new character on top of it producing a combination character. Also 
called "boldfacing." 

Overvoltage Protection The computer's circuitry is protected from undesirable 
increases in the AC power line voltage. 
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P Parity. See Parity. 

Package, Software A group of computer programs, possibly including data files and 
documentation, used to perform a function or group of related functions on the 
computer. Applications software are devoted to an end-user task. Examples would 
be a word processing package, an accounting package, etc. Systems software 
packages facilitate the use of the machinery, such as a database management 
package, a disk operating system or a program development package. 

Packet A short set of data with the length of the data stored in the first few bytes. 
The set is then transferred in a network of devices. 

Pad The rectangular base where the wire of a computer chip is connected. Also, to 
fill a data field with blanks. 

Page Break Word processors are capable of inserting page breaks where required, 
using special command sequences to instruct the program to insert page breaks. To 
insert a page break at a particular point in a MacWrite document, you would move 
the 1-Beam pointer to the line where you wish a page break and click the mouse 
button once. Then, move the mouse pointer to the Format menu on the menu bar 
and press the mouse button. This displays the Format menu. Then drag the pointer 
and the highlight down the menu until Set Page Break is highlighted. Release the 
mouse button. This will force a page break at the insertion point. 

Page Length on Printer To set page length (for example) to 55 lines per page, enter 
Microsoft BASIC statement: 

LPRINT CHR$(27);"C" ;"55" 

See Control Characters for Printer. 

Page Numbering Word processors are capable of numbering successive pages 
automatically by selecting the top or bottom of the page and the line in the header 
or footer where the page number will appear. MacWrite will automatically number 
pages starting with a designated page number using the Show Header or Show 
Footer option from the Format command menu on the menu bar. If you want the 
page number at the top of the page, use the header, or at the bottom of the page use 
the footer. Once the header or footer is being displayed, the page number icon 
should be dragged from the header or footer ruler to the location in the header or 
footer where you want the page number to be printed. Once the page number icon 
has been placed, the Set Page# command option may be selected from the Form~t 
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menu to specify the page number from which all numbering starts. See Menu Bar, 
Header, Footer, Format Menu, Show Header Option, Show Footer Option, Icon. 
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Fig. P1 The Footer window wi th the page number icon in place to number pages. The 
mouse pointer is just below th is icon. 

Page Setup Most Macintosh applications allow the printed page to be set up by the 
user from the File menu on the menu bar. W hen this command option is selected, a 
dialog box is presented that allows paper size and page orientation to be specified. 
The choices for page size are US Letter (s tandard 8-1 / 2 by 11 inches), US Legal 
(standard 8-1/ 4 by 14 inches), A4 Letter (standard European 8-1/ 4 by 11-2/3 inches), 
and A4 Fanfold (standard International 8-1 / 4 by 12 inches). The choices for page 
orientation are Tall (text upright on page with fi rst line at top of the page), Tall 
Adjust (sa me as Tal l but pictures are printed proportionately) and Wide ( text printed 
sideways on page with top line running down the right-hand side of page). Selections 
are made by placing the mouse pointer on the circle to the left of the desired choice 
and clicki ng the mouse button. See File Menu, Dialog Box. 

Paper: ® US Letter 

OUS Legol 

Orientation: ®Tall 

0 R4 Letter 

0 International Fanfold 

0 Tall Rdjusted 0 Wide 

Fig. P2 The page setup dialog hox. 

OK 

(Cancel ) 

Paging To switch from one full screen of information to another, especially in a 
word processing program, you can page either backwards or forwards. 
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Paging is accomplished on the Macintosh by using the scroll bar on the right-ha nd 
side of a window, which contai ns a scrol l arrow and a scroll box. The scrol l box is 
sometimes called an "elevator." Text may be scro lled up or down by placing the 
mouse pointer on the arrow. on the scroll box, just above the scroll box or below the 
scroll box. Cli ck ing the scroll arrow at the top of the scroll bar moves the text in the 
document down one line. The arrow on the bottom of the scroll bar is used to move 
the text up one line. If the pointer is placed in the gray area above the scroll box, the 
text is scrol led down one fu ll window height. If it is placed in the gray area below the 
scroll box, it is scrolled up one full wi ndow height. The scroll box itself is used to 
scroll to any place in the document. This is accomplished by placing the pointl:!r on 
the scrol l box and dragging it up or down the scroll bar until the desired portion of 
the text is displayed in the window. 

In memory, a page is a logical set of storage used for the management of memory ; 
in a paging system, the memory location is designated by a page number or address 
and an address within the page. See Mouse Pointer. Dragging, Window. Scroll Bar. 
Scrol l Box, Scroll Arrows, Document. 

Paintbrush One of the tools available from the drawing tool palette of MacPaint. 
This tool provides the user with a variety of brush shapes and access to the brush 
mirrors. It is used to draw a line the shape and thickness of the brush shape selected 
from the Goodies menu on the menu bar. The paint brush is selected by moving the 
mouse pointer onto the paintbrush icon on the drawing tool palette and clicking the 
mouse button once. Brush shapes are selected by using the Brush Shape command 
option from the Goodies menu. Brush mirrors are selected from the same menu. See 
Goodies Menu, Menu Bar, Drawing Tool Palette, Brush Shape, Brush Mirrors . 
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Fig. P3 The brush shape window from the Goodies menu. 

Paint Can A tool available f rom the drawing tool palette on the left-hand side of the 
MacPaint screen display, which is used to fill shapes in the drawing w indow with the 
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active pattern from the pattern palette located on the bottom of the MacPaint 
screen display. This tool is selected by placing the mouse pointer on the paint can 
icon and clicking the mouse button once. It is used by moving the paint can over the 
screen display until the bottom of the paint that is being poured is inside the 
boundaries of the shape to be filled. The pattern palette on the bottom of the screen 
should be checked to ensure that the desired pattern is in the leftmost box of the 
palette. If not, the desired pattern may be selected by plac ing the mouse pointer on 
the pattern and clicking the mouse button once. Once the paint can is in the proper 
posi tion and the desired pattern selected, the area or shape may be filled by clicking 
the mouse button once. This action can be undone by using the the Undo command 
option from the Edit menu on the menu bar at the top of the screen display. If the 
mouse button has been clicked at any time after the shape has been f illed and the 
Undo option is selected, the action cannot be undone. See M ouse Button, M enu 
Bar, Drawing Tool Palette, Pattern Palette. 
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Fig. P4 Usi ng the paint can to fi ll a shape drawn on MacPaint . 

Paintmover• An inexpensive program for the Macintosh that converts MacPaint 
f iles into a format acceptable to Microsoft BASIC. This program may be used to 
create action games, menus and forms. M acinsoft. In UK: Softsel. 

Panes The M acintosh User Interface Toolbox produces windows that divide into 
two windows called " panes." The contents of one pane may be scrolled independently 
of the contents of the o ther pane. Mic rosoft Multiplan uses this feature when the 
Freeze Tit les command is selected from the Options menu on the menu bar. This 
feature locks a portion o f the screen into an upper and lower window. It allows the 
upper window to scroll horizontally with the lower portion of the screen, but does 
not allow vertica l scrolling of the upper w indow. See Options M enu. 
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Parallel Simultaneous handling of processes, transmissions or storage of data. In 
most microcomputers, parallel 1/0 connections have eight wires to carry eight bits 
of a byte simultaneously (or in parallel). Contrast this with a Serial interface, where 
only one data wire is available. The eight bits of a byte are transmitted one after 
another (or serially). The 1/0 device must collect all eight bits and reconstruct them 
into one eight-bit byte. 

'Parameter Another name for a definable variable in a program or system which can 
be used to send information to and from a subroutine or procedure. A parameter 
may take on various values which are used in subsequent processing by a program. 

Parity An error detection technique that uses a one-bit indicator at the end of a 
word. Odd parity sets the parity bit to make the total number of 1 bits odd. Even 
parity sets the parity bit to make an even number of 1 bits. 

Pascal A structured computer language, descended from ALGOL 60, a computer 
language created when FORTRAN became too cumbersome. ALGOL is an excellent 
language for defining algorithms, but it is very complex and hard to learn. Pascal was 
created by Niklaus Wirth from ALGOL and PL/1 and is a language that is easy to use 
and learn. It is useful for defining algorithms and data structures. Pascal is an 
extremely compact, compiled langauge. Its compiler occupies only a small amount 
of memory space. It is suitable for a wide variety of chores, from systems to 
application programming, and is both explicit and verbose, making it easy for 
relatively naive readers and those other than the original programmer to understand. 

It is structured, and all structured languages represent a major improvement for 
programmers who want to predict the behavior of a program. It is much easier to 
understand the function of an IF ... THEN ... ELSE structure than to trace GOTOs and 
statement labels to remote, unpredictable places in a program. Pascal has most of 
the structures necessary to write a completely structured program (without GOTOs). 
Some of the dialects of Pascal implement all the necessary structures. In any case, it 
allows for more complete structuring than even FORTRAN 77 or the semistructured 
dialects of COBOL. 

Pascal is strongly typed. The "type" (floating point, integer, set, record) of a 
variable is traced even through procedure calls, where a language like FORTRAN 
only checks the type through the current local routine. This helps to point out a 
major class of programming errors. Pascal, like other recent languages, requires the 
explicit definition of all variables as a guard against introducing a misspelled 
variable, otherwise difficult to spot. 

The Pascal standard includes an input/output package. This is important for a 
language intended to be used in textbooks, but fixes the style of 1/0 that can be done 
from Pascal. 

Pointers and records give the high-level language programmer access to powerful 
techniques formerly only available to assembly language programmers for handling 
complicated data structures like linked lists and trees. You can handle these structures 
explicitly in Pascal. In a language like FORTRAN these structures would have to be 
"simulated" inside an array with the structure diagrammed only in documentation 
or the inside of the programmer's head. 

Currently, there are many implementations of Pascal. There are several stand
alone compilers that run under various operating systems. There is also an operating 
system written primarily in Pascal, called the P-System, available on a wide range of 
computers, contributing to the portability of programs written in Pascal. See UCSD 
P-System, Macintosh Pascal, MacPascal. 

Pass To make information from one process or program available to another 
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process or program, similar to a football pass, except that one or more bytes of data 
replaces the football (and the receiver is a program). The sender may be a program or 
a person typing the data onto a command line to he "passed" to a program. The most 
common example would be a Microsoft BASIC program passing variables to a 
subroutine. 

Password Used for identification and security purposes on a computer system. Each 
user is assigned a specific set of alphanumeric characters to gain entrance to the 
entire computer system or to parts of the system. Microsoft Multiplan asks for a 
password when a worksheet is protected by using the Protect Document command 
option from the Options menu on the menu bar. This password is requested when 
the protection is removed. If the user forgets the password, the protection will not be 
removed from the document and the user will be unable to write data to the 
document. See Menu Bar, Options Menu. 

Paste and Link Option Microsoft Multiplan is one of a very few spreadsheet pro
grams that allows portions of one worksheet to be permanently linked and copied to 
another worksheet. To use this command, the portion of the worksheet to be linked 
must first be highlighted by dragging the mouse pointer over the cells to be linked, 
and held down until all of the desired cells are highlighted. Then this highlighted 
area must be copied to the Clipboard. After this has been done, the source worksheet 
may be saved, and the worksheet to which the information is to be linked may be 
opened. Place the pointer in the upper left-hand corner of the cells that will use the 
linked information and drag it down over the entire range of cells that will accept the 
linked information. If a single cell is being linked, then the pointer must be placed in 
the cell to use the linked information and the mouse button clicked to highlight the 
cell. Then the Paste and Link command must be selected from the Edit menu to 
paste the contents of the Clipboard into the worksheet at the insertion point and link 
the destination worksheet to the origin worksheet until an Unlink command is used. 
See Clipboard, Insertion Point, Edit Menu. 

Paste Name Option A number of electronic spreadsheet programs such as Multiplan 
allow the contents of a cell to be given a specific name to be used in formulas. In 
Multiplan, the Paste Name command from the Edit menu is used to insert the 
contents of a named cell into a formula. 

Paste Option Available from the Edit menu on most Macintosh applications, and 
used to copy the contents of the Clipboard to a designated insertion point in a 
document. A picture from a MacPaint document can be inserted into a MacWrite 
document, or part of a spreadsheet can be inserted in a MacWrite document from 
Multiplan by using this command. Text from the Note Pad can be cut or copied to 
the Clipboard and pasted into a document. The result of a calculation done on the 
Calculator can be cut or copied to the Clipboard and pasted into another document. 
Text and pictures can be pasted into the Scrapbook from the Clipboard by cutting or 
copying them. They can be transferred to the Clipboard and into another document 
in the same fashion. See Clipboard, Cut Option, Copy Option, Paste Option, Edit 
Menu, Scrapbook, Document. 

Patch For debugging or alteration of a software program, a section of code, a patch, 
is inserted into the program which changes the control functions of the program. 

Pattern Palette The two rows of blocks containing patterns that run along the 
bottom of the MacPaint screen display are called the pattern palette. This palette 
contains a variety of different patterns that can be used to fill shapes with the paint 
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can drawing tool, to shade pictures wi th the spray can drawing tool, and to draw 
lines of different textures with the paintbrush drawing tool. These patterns are also 
used with the fi lied shape icons to fill the shapes that are drawn when these icons are 
selected. The leftmost box on the palette is the current active pattern. This pattern 
may be changed by placing the mouse pointer on the block containing another 
pattern and clicking the mouse button. These patterns may be edi ted by using the 
Edit Pattern command option from the Goodies menu on the menu bar at the top of 
the screen display. See Menu Bar, Goodies Menu, Edit Pat tern, Mouse Button, 
Drawing Tools. 
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MocPaint Pattern Palette 

Fig. PS The pattern palette from MacPaint with the mouse pointer on the current pattern box. 

Pause To pause and freeze the screen briefly while the operator using your program 
reads a message, just w rite a delay loop after you print the message: 

1000 FOR Y = 1 TO 2000 
1010 NEXT Y 

To freeze the screen until the operator is done wi th it, enter a dummy input 
statement and instruct the operator to press Return to proceed. The input variable 
need not be used in your program: 

1000 INPUT " Press Return to continue" ;A$ 

PC Program Counter, Prin ted Circuit or Personal Computer. 

PC-BASIC Developer's Compiler• This converts IBM PC programs written in BASIC 
for transfer by cable to a Macintosh or Lisa and then recompiles these programs to 
allow them to run on these computers. This Compiler is called PC-BASIC and 
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includes a communications package and an RS-232 cable. It is packaged as a 
developer's compiler which allows sale of the code generated by the compiler, as a 
user's compiler for use with a single machine, and a PC to Lisa/Mac communications 
package. Pterodactyl Software. In UK: P+ P micro distributors. 

PEEK A Microsoft BASIC function which returns the byte read from the indicated 
memory position. The format is: 

<variable> = PEEK(<m) 

<m is an integer in the range 0 to 16777215. The variable that is returned will fall in 
the range from 0 to 255. See POKE. 

Pensate• A game that closely resembles chess. The computer pits ten types of 
pieces against the player's single piece. Penguin Software. 

Period(.) A file extension delimiter. In a file name, the. (period) is used to specify 
an extension to a file name. An example is EDIT.BAS. This indicates a program called 
EDIT written in BASIC. 

Peripheral Any external device connected to a computer and controlled by it. 

Personal Computer Generally, an inexpensive, single-user computer system which 
fits on a desktop. 

Personal Management Software See Calender, Dollars and Sense, Home Account
ant, Personal Tax Planner. 

Personal Tax Planner• A program used to predict federal income tax liability for the 
individual, and used to compute short-term or long-term capital gains and losses. It 
automatically calculates the individual's tax liability, his capital gain deduction, any 
capital losses, income averaging and alternative minimum tax, if they apply. 
Aardvark/McGraw-Hill. 

PFS File• A database management program that allows the user to design input 
screens to suit his needs. This program can be used to store data, update data and 
sort data. Entry and sort procedures are simplified. This program can be used to 
generate invoices, mailing lists, inventories, bibliographies and similar applications. 
The program uses the mouse, the menu bar and pull-down menus. Software 
Publishing Company. In UK: Softsel. 

PFS Graph• A business graphics program. It accepts data from the keyboard or from 
other programs, such as PFS File, and plots the information in a variety of graph 
formats for the user. Ease of use and learning are characteristic of this program. The 
graphics quality is quite good. Software Publishing Company. In UK: Softsel. 

PFS Report• A companion program for PFS File, which generates tabular reports 
from data stored using PFS File. It can sort data both alphabetically and numerically, 
and be used to calculate averages, counts, and totals in the reports generated. This 
program uses the mouse, menu bars and pull-down menus. Software Publishing 
Company. In UK: Softsel. 

PFS Write• A word processor and applications integrator for the PFS series of 
programs. It allows the combination of graphics and database information to be 
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used in the word processor. This program is easy to use and learn. Software 
Publishing Company. In UK: Softsel. 

Picture Disk, The• An inexpensive disk containing more than 200 pictures for 
viewing and using on the Macintosh. These pictures include cartoons, digitized 
photographs, drawings and seasonal figures. The manufacturer can also reproduce 
onto a Macintosh disk any photograph sent to them. Digi-Graphics. 
In UK: Softsel. 

Pin-compatible A computer system whose circuits have leads or pins with identical 
functions. 

Pixel The smallest addressable unit in a video graphics display. 

Planetfall• Planetfall is a text adventure game that is science-fiction oriented. One 
of its central characters is a robot. lnfocom. In UK: Softsel. 

Plotter A computer-controlled mechanical device which draws images upon a 
screen or a piece of paper with pens. instead of with a daisy-wheel or dot-matrix print 
head. 

Plug-compatible Devices or components which use the same plugs and, therefore, 
can be used interchangeably without modification within the computer system. 

Plus Sign Pointer Microsoft Multiplan employs a large plus sign as a pointer on a 
worksheet. This pointer is used to select cells or groups of cells for taking an action 
such as copying, cutting, pasting or whatever. When this pointer is placed on a cell 
and clicked, the cell is highlighted. When it is dragged over a number of cells with 
the mouse button held down, those cells are highlighted. It is also used to select the 
next cell for data entry or formula entry. 

POINT A Microsoft BASIC function which returns the color of the specified point 
on the screen. The format is: 

<variable>= POINT(<x,y>) 

<x,y> are the coordinates of the point to be used and must be in absolute form. 
If the point given is out of the range, -1 is returned. The horizontal elements on the 

Macintosh screen are numbered from 0 to 511. The vertical elements are numbered 
from 0 to 341. 

Pointer A data item. Its contents is the address of another data item. 
Also describes a variety of Maintosh tools (pointers) associated with the location 

and movement of the mouse on a physical Desktop. The most common pointer is an 
arrowhead, used in the Desktop to highlight, drag and click icons. When the 
arrowhead is placed on a disk, folder or icon name, it changes to an 1-beam. The 
1-beam is the pointer used in text applications and in editing. When this pointer is 
placed within text on the screen and the mouse button is clicked, it changes to a 
vertical bar cursor. The location of the vertical bar cursor is the insertion point. 
Microsoft Multiplan uses a plus sign as a pointer to highlight or activate cells on a 
worksheet. When the pointer is used on the Control Panel it changes to a crosshair. 
See 1-beam, Vertical Bar Cursor. 

POKE A Microsoft BASIC statement which allows the user to enter specific values or 
data into a particular memory location. POKE places a byte into a memorv location. 
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The format is: 

POKE <n>,<m> 

<n> must be in the range 0 to 16777215. It indicates the address of the memory 
location where the data is to be written. 

<m> is the data to be written to the specified location. It must be in the range 0 to 
255. 

The complementary function to POKE is PEEK. POKE and PEEK are useful for 
efficiently storing data, loading machine language programs and passing arguments 
and results to and from machine language subroutines. Microsoft BASIC does no 
address checking, so use caution when assigning address locations. You do not want 
to POKE data in Microsoft BASIC's stack, its variable area or your Microsoft BASIC 
program. 

Polling A technique inquiring into the status of each device according to a schedule. 

Port A physical 1/0 connection and an address providing a connection between 
the computer's internal processor and an external device. Ports are used to attach 
input and output devices. Some devices require several ports to function. The 
Macintosh is equipped with six ports. These are the mouse port, the disk drive port, 
two serial interface ports (one for a printer and the other for a modem), an 
audio-output port and a keyboard port. The mouse port may be used to attach the 
mouse or other pointing devices that operate in a fashion similar to the mouse. The 
disk drive port is an input/output port which can handle data at a rate of 62,500 baud 
per second and is designed to support an external disk drive. The serial ports are 
designed to handle the RS-422 protocol which defines the manner in which 
communications are carried out to and from an attached device. Although these 
ports are designed for RS-422 protocol, most RS-232C devices can operate through 
these ports. These ports handle both input and output. The keyboard port is located 
on the lower right-hand side in the front of the Macintosh and resembles a telephone 
connection. It is an input/output port that can handle up to eight devices such as the 
keyboard, the numeric keypad, musical keyboards and similar devices that transmit 
and receive data slowly. The audio-output port allows the user to connect his 
Macintosh to an external amplifier or a tape recorder. 

Portable Modem (Maccessories)• A product sold for use with the Macintosh Com
puter. This is a compact, battery-powered modem. It has a baud rate of 300 baud. It 
is equipped with a carrying case and will connect directly with the Macintosh 
RS-422/RS-232 modem port on the back panel. Keningston Microware Ltd. 

POS A Microsoft BASIC function which returns the current cursor column position. 
The format is: 

<variable> = POS(<n>) 

<n> is a dummy argument. 
The current horizontal (column) position of the cursor is returned. See LPOS. 

Position of Printer Carriage See LPOS. 

Postfix A notation system where the operator follows the manipulation symbols 
used in the program. 
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Power Down The steps a computer may take to preserve the state of the processor 
and to prevent damage to it or to connected peripherals when the power fails or is 
shut off. 

Power On Turn the power switch to the ON position or otherwise supply electric 
current to a device. 

Power Supplies/Protectors See Datasaver, Kleen-Line Conditioners, MACC, MACC-4, 
Maccessories Surge Protector. 

Power Supply The unit that converts the voltage from the electrical supply to the 
voltages which the computer elements use. 

Power Up The steps taken by a computer processor when the power is turned on, or 
restored after a power failure. The processor and peripherals are initialized so that 
program execution may be started. 

Preprocessor A program or mechanical device which prepares data for further 
processing. 

Presentation Graphics on the Apple Macintosh• A book by Steve Lambert 
that teaches the use of Microsoft Chart on the Macintosh. This book deals with 
the intricacies of this very powerful business graphics program. Microsoft Press. 

Presenting the Macintosh• A brief book that introduces the Macintosh and its 
use. It was written by Merl K. Miller and Mary A. Myers. dilithium Press. 

PRESET See PSET. 

Prevent Accidental Loss of Programs or Data A disk is write-protected if the 
write-protect square is open. The lock square could be missing altogether (as on 
some original software disk) or present, but in the open or locked position. See 
Write-protect. 

PRINT A Microsoft BASIC statement which displays data on the screen. The format 
is: PRINT (<list of expressions>](;] or ? [<list of expressions> I[;] 

<list of expressions> is a list of numeric and/or string expressions, separated by 
commas, blanks, or semicolons. Any string constants in the list must be enclosed in 
quotation marks. 

A PRINT statement alone will display a blank line. The question mark(?) may be 
used for PRINT only when you are entering Microsoft BASIC program lines in the 
Command window. 

The punctuation in the <list of expressions> determines the spacing of the printed 
items. Microsoft BASIC divides the screen line into zones with as many spaces each 
as has been set by the WIDTH statement. In the <list of expressions>, a comma will 
cause the next item to be printed starting in the first space of the next zone. A 
semicolon{;) causes the next value to be printed immediately after the last value. 
Placing one or more spaces between expressions is the same as typing a semicolon 
between them. 

If a comma or semicolon ends the <list of expressions>, the following PRINT 
statement begins printing on the same line, spacing accordingly. If the <list of 
expressions> ends without a comma or semicolon, a carriage return is performed at 
the end of the line and the cursor is moved to the beginning of the next line. 
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If the length of the value to be printed is more than the number of character 
positions remaining on the current line, then the value will be printed at the 
beginning of the next line. If the value to be printed is longer than the defined 
WIDTH, Microsoft BASIC prints as much as possible on the current line and 
continues to print the remaining values on the next physical line. 

Printed numbers are followed by a space, positive numbers have a space in front 
of them and negative numbers have a minus sign in front of them. Single-precision 
numbers that can be represented with seven or fewer digits in fixed-point format (no 
less accurately than they can be represented in the floating- point format) are output 
using fixed point or integer format. For example, 10A(-7) is output as .0000001 and 

'1 OA( -8) is output as 1 E-8. 
LPRINT statement uses the same format techniques but displays the values on the 

printer. See LPRINT. 

Print a Blank Line on Printer An LPRINT statement with no other specifications will 
print a blank line (that is, feed the paper up one line and return to left margin) so you 
can space your printout format neatly. 

Print Current Screen on Line Printer Press Command-Shift-4 together with the caps 
lock down to print the current contents of the screen on line printer 1. This is 
valid in any program and all applications at any time. See Control Key. 

Print Lines, Spacing In Microsoft BASIC, to get one or more spaces between fields 
printed in your programs, use a literal of spaces:" ".To get several spaces between 
the printed values of A$ and B$ use Microsoft BASIC statement: 

LPRINT A$;" ";B$ 

See also Print Zones. 

Print Microsoft BASIC Program Line on Printer See LUST. 

Print on Printer from Microsoft BASIC See LPRINT. 

Print Pak• A carrying case specifically designed for the lmageWriter printer. It can 
be carried by a shoulder sling, as a suitcase or as a backpack. Macpacks. 

PRINT USING A Microsoft BASIC statement that is used to print strings or numbers 
in a specific format. The syntax of this statement is: 

PRINT USING <string exp>;<expression list> 
<string exp> is a string variable made up of formatting characters which define the 

field and the format of the strings and numbers to be printed. 
<expression list> is made up of the strings or numbers that are to be printed. 
Three formatting characters are used for string fields: the exclamation point ( !), 

the ampersand(&) and two backslashes with spaces in between them ( n spes). The 
exclamation point is used to instruct the computer to print just the first character of 
each string. The ampersand specifies a variable field length for strings allowing the 
entire string to be printed. The backslashes with spaces between them are used to 
print a number of characters equal to two characters, plus a character for each space 
between the backslashes. 

Numeric fields are defined by using the number sign(#). One number sign is used 
to specify each number's position. Each number position is filled even if there are 
not enough digits to fill the amount of number signs used. A decimal point may be 
used in any position in the field defined by the number signs. The number signs must 
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be enclosed in quotation marks. If a plus sign is used before a format string the sign 
of the number (plus or minus) will be printed before the string. If the plus sign 
follows the string, the plus or minus sign will follow the string. If a minus sign is 
placed at the end of a format field, all negative numbers will be printed with a 
trailing minus sign. If a double asterisk (**) is used before the format string, all 
spaces that precede numbers in the string will be filled with asterisks. If two dollar 
signs ($$) are used before a string format, all numbers that are printed will be 
preceded by a dollar sign. If two asterisks and a dollar sign (**$)are used before a 
format string, a dollar sign will precede each number and all spaces before the dollar 
sign will be filled with asterisks. If a comma is used before the decimal point in a 
numeric string, a comma is printed automatically before each third digit that 
precedes the decimal point. If four carets (""""') are placed after the last number 
position in the string format, space is allowed in the output for E+nn to be 
printed where nn equals the number of characters to follow the E symbol. If an 
underscore(_) is inserted before any character in the string format, the character 
after the underscore is treated as a literal character and is printed. Thus, 
"###.##-?"; 99.99 would print as 99.99?. If the percent sign(%) is used prior to 
the first number sign in the format string, any number that is larger than that 
allowed by the format string will be printed with a percent sign preceding the 
number of digits allowed by the format string. 

Print Zone, To Skip Over To leave space on the print line between items, put an 
extra comma (,) in the print listing. Enter Microsoft BASIC statement: 

LPRINT A,B 

This would print A in print zone 1, nothing in print zone 2, and put Bin print zone 
3. 

See also Print lines (Spacing). 

Print Zones, On Printer Line (LPRINT) Each group of spaces as set by the WIDTH 
statement across the print line is called a print zone. A comma(,) in an LPRINT list of 
items to be printed means "start printing the following item at the start of the next 
print zone." Contrast this with the semicolon (;),which means the next item is to 
print immediately after this one, without even a single space between. The print 
zones begin in columns as determined by the WIDTH statement. See also Print line 
(Spacing), WIDTH. 

PRINT# and PRINT# USING Microsoft BASIC statements. PRINT# is used to write 
data sequentially to a file. PRINT # USING is also used to write to a file, but the 
USING option allows control of the format of the file. The format is: 

PRINT# <filenum>,[USING <v$>;]dist of expressions> 

<filenum> is the number used when the file was opened for output. 
<V$> is a string expression made up of formatting characters. 
<list of expressions> is a list of the numeric and/or string expressions that will be 

copied to the file. 
PRINT # writes data to the file just as it would appear on the screen with no 

compression. For this reason, your data should be edited carefully for file input, 
exactly the way it should appear on the screen. Numeric expressions should be 
delimited by semicolons. If commas are used as delimiters, the extra blanks inserted 
between print fields are also written to the file. String expressions must be separated 
by semicolons in the list. To format the string expressions correctly on the file, use 
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explicit delimiters in the <list of expressions>. 
See PRINT USING, WRITE #. 

Printer, Advancing One Line To advance or space up one I i neon the printer without 
a carriage return, enter Microsoft BASIC statement: 

LPRINT CHR$(10) 

Or use the line feed button (LF) on printer. 
Entering just LPRINT gives a line feed, both a space up one line (line feed) and a 

return to left margin (carriage return). 

Printer, Blank Line An LPRINT statement with no other specifications will print a 
blank line (that is, feed the paper up one line and return to left margin). 

Printer Buffer An external accessory to most computer systems. A printer accepts 
data more slowly than a computer can send the data to the printer. This means that 
the memory of the computer is occupied with the data being sent to the printer and 
is not available to the user unless a spooler program is employed. This is a printer 
with a large built-in buffer or a printer buffer. Printer buffers are really extra external 
memory devices that generally make 2K, 8K, 16K, 32K, 48K, 96K and 128K available 
to the user. They are connected to the computer via the printer port on the back 
panel and then connected to the printer. 

Most buffers require external electrical power and can accept data as quickly as 
the computer can send it. They then hold the data and transmit it to the printer in the 
same fashion that a computer sends the data. As soon as the data has been 
transferred to the buffer, the computer's memory is available to the user for other 
purposes. The buffer continues to send data to the printer, independently of the 
computer, until all of the data stored in the buffer has been printed. Anyone who 
prints long documents or is involved in large writing projects, mass mailings, mass 
label printing projects and the like, would find a printer buffer well worth the 
financial investment. In considering a printer buffer for the Macintosh, make sure it 
is plug-compatible and is capable of handling serial data instead of parallel data. See 
Kearsarge SX-70 Switcher/Spooler, Maccessories Printer Buffer, MBIS Microbuffer, 
Printer Optimizer. 

Printer Buffer, Maccessories• A printer buffer designed for the Macintosh. Kensington 
Microware Ltd. In UK: P+ P micro distributors. 

Printer, Carriage Position See LPOS. 

Printer Driver A printer driver is a utility program that is used to move data from a 
computer's memory to a printer. It would contain all of the routines required to 
access the printer. It could also contain control codes to set print size, margins, etc. 
on the printer. 

Printer, Line Length To set to 80 characters per line (for example), enter Microsoft 
BASIC statement: 

WIDTH "LPT1 :" ,80 

Printer Optimizer, The• A printer controller that is both Macintosh and Lisa compatible. 
It will allow the Macintosh to operate a letter quality printer. It can handle up to 
three printers at once and can make multiple copies of documents. Applied Creative 
Technologies. In UK: P+ P micro distributors. 
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Printers Printers are devices used by computers to produce hard copy of output 
from the computer or from an application used on the computer. Printers may be 
thermal devices that use heat- sensitive paper to produce output. They may be 
dot-matrix if small needles are used to strike a ribbon to form letters on paper. They 
may be daisy-wheel devices if a f lower-like wheel is used to produce characters by 
striking a ribbon before striking the paper. Printers may be serial interface or para llel 
interface devices. If they are serial interface like the lmageWriter, data is transmit
ted to them in a stream over a single wire one bit at a time. If they are paral lel 
devices. data is transmitted to them over eight paral lel wires at the sa me time. See 
lmageWriter. 

Printer Stand A small stand built to hold a printer on its top shelf. It general ly has 
legs on either side and places the printer high enough that paper can be stacked 
underneath the stand and fed directly to the printer. A printer stand is an easy 
project for a handyman. Many are made from plastic or various types of wood. 

Printer Stand, Maccessories• A printer stand avai lable commercially for the Macintosh, 
it is set up to hold the lmageWriter printer or other printers of a simi lar size and 
allows the stacking of paper under the stand. Kensington Microware Ltd. 

Printer, Top of Page To form feed or advance to the top of the page enter Microsoft 
BASIC statement: 

LPRINT CHR$(12) 

Or use the top of form or form feed manual control button (FF) on the printer. You 
may need to adjust the paper in the printer so it actually is at the top of a page as 
defined by the perforations. In a program, you may want to provide instructions to 
the operator and a pause to allow for adjustment of the paper. 

Printing a Document A document may be printed from the Desktop directory 
display by placing the mouse pointer on the document's icon and click ing the 
mouse button once to select the document. The document will then be printed 
when you select the Print command option from the File menu on the menu bar. See 
Menu Bar, Mouse Button, Document Icon. 

• File Edit Uiew Speciol 

MocDrlue 
39 items 2068K in disk 2959K ~v~ibb .. 

Q ~ til Q 
EDIT .BAS Scretn MS-BASIC MACTEP++ MacPaint 

Fig. P6 The Macintosh Desktop display with the mouse pointer beside a selected icon. 
This icon appears in inverse shading to the rest of the documents on the display. 
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Printing a Group of Documents If you have several documents on a single disk that 
you wish to print, you may select all of these documents at once by holding down 
the mouse button and dragging the pointer over each of the icons for the documents 
to be printed. They will all be highlighted when you release the mouse button. After 
highlighting, the Print command option is selected from the File menu on the menu 
bar. An application such as Mac Paint or MacWrite must be present on the same disk 
to enable the documents to be printed, they are Mac Paint or MacWrite documents. 
See Menu Bar, File Menu, Icon. 

a File Edit Uiew Special 

39 items 

• 
MacDriue 

2068K in disk 

~ 
~ 

MS-BASIC 

2959K availab-.. 

MACTEP++ MacPaint 

Fig. P7 A group of highlighted documents from the Desktop directory display. 

Printing the Active Window If a number of windows are being displayed on the 
Macintosh screen, the last window clicked is the frontmost or top window, called 
the "active window." To print this window on the lmageWriter printer first make 
sure the Caps Lock key is in the up position, then hold down the Command key, the 
Shift key and the 4 key together. 

Printing the Entire Screen Display The entire screen display of the Macintosh may 
be printed at any time by first ensuring that the Caps Lock key is in the down 
position, then pressing the Command key, Shift key and 4 key together. 

Procedure A separate function of the program which could be incorporated into a 
subroutine and which helps the program's structure, readability or reliability. 

Processor-bound When the speed of the processor limits the processing speed of 
the program. 

Professional Composer• A program for the Macintosh that lets the user compose 
and create music, score music, edit music and print it. The mouse is used with this 
program to enter clefs, notes, rests, time signatures, chords, ties, beams, slurs and 
note ornaments. Virtually all of the tools are needed to write sheet music are 
available. As music is being composed, it can be played or when a compositon is 
complete, it can be played and printed out using the lmageWriter. Mark Of The 
Unicorn. In UK: P+ P micro distributors. 

Program A sequence of instructions which specifies a process for manipulating 
data. Programs can be written in many languages of different "levels." The level 
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reflects how much additional work the processor must do before the program can be 
executed. BASIC is a high-level language which requires that all programs be run 
through a compiler or interpreter. A midrange language is assembler or assembly 
language which is closer to the binary code of the computer, but still needs some 
processing through an assembler before executing. 

The lowest level are programs written in binary or hexadecimal code, directly 
executable by the microprocessor. Before assembler language programs were developed, 
all programs were written in binary code--a tedious, time-consuming task. For 
listings of programs available for the Macintosh, see Software. 

Program Disk A disk which is primarily used to store programs used to process data. 
Likewise, data disks are used primarily to store data rather than programs. To save 
space a data disk will not usually contain most or all of the system files. A system 
start-up disk is one used to principally store system files and related utility-type 
programs. Often a disk will contain both data and the programs needed to process 
the data. 

Program File A file containing some type of program instructions specifying how 
data is to be processed. If you write a Microsoft BASIC program called SAMPLE. BAS, 
it is a source program. If you submit it to the compiler to produce a fast- object 
program, the compiler will treat SAMPLE.BAS as its input data rather than as a 
program to be executed. The Microsoft BASIC Compiler will produce an object file 
which contains a translation of your source program into the MC68000 machine 
language. 

Program Generators See RGS Softmaker II. 

Program, How to Start In Microsoft BASIC, if the desired program is in memory, use 
RUN to execute the program. If the program is on a disk, use LOAD file name,R or 
RUN file name,R in the Command window. If a program is already in memory, it can 
be started by selecting RUN from the Control menu. 

Program Integrity Ensuring that programs (or data) cannot be altered improperly. 
For example, in a payroll system, steps must be taken to ensure that employees 
cannot improperly alter their pay rates or hours worked. Data security consists of 
guaranteeing both data integrity and data secrecy or privacy. 

Program Line A program line is a unit of instruction given to a computer from within 
a program. It could be a sequentially numbered line as is used by Microsoft BASIC. It 
could be an unnumbered line of instruction if the language in which the program 
was written does not require numbering. 

Program Lines, Deletion See DELETE. 

Program Lines, List See LIST. 

Program Lines, New In Microsoft BASIC programs to start a new program type: 

NEW 

Program, LOAD Use LOAD to load a Microsoft BASIC program that was SAVEd on 
disk back into the Macintosh's memory. For a program named "SAMPLE," on the 
default disk, enter: 
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LOAD ''SAMPLE'' 

If SAMPLE is on the disk in the external drive, enter: 

LOAD "SAMPLE" 

All LOAD instructions erase any program lines you have in memory before the 
LOAD. If you want to combine a SAVEd program with the one you are writing, see 
MERGE. 

To run the program, use LOAD SAMPLE,R or its synonym, RUN SAMPLE,R. If you 
use ,R any files that are open stay open for the next program. Unless this is 
specifically needed, it is safer to use RUN SAMPLE, which first closes any files now 
open, then loads SAMPLE into memory and runs it. See also SAVE, RUN. 

Program, Object The machine language instructions which result from the translation 
of a source program by a compiler or assembler. See Program. Source or Object. 

Program or Data Concatenation Adding one item on at the end of the others to 
produce one longer data or program item. 

Program, Run or Execute See RUN, LOAD. 

Program, SAVE To SAVE a Microsoft BASIC program named "SAMPLE": 

On disk (the default drive) the format is: 

SAVE "SAMPLE" 

On disk (external drive) the format is: 

SAVE '' d iskname: SAMPLE'' 

The SAVE command must be used in the Command window to accomplish these 
things. The Save command option may also be selected from the File menu to save a 
program from memory to disk. A dialog box that requests the name of the program 
and the disk to which the program is to be saved will be displayed when this option is 
used. 

To run the program at a later time, use the LOAD command to copy it from the 
disk you saved it on, back into the Macintosh's memory. See LOAD. If you want to 
save the program in ASCII format, which allows you to MERGE two programs 
together, put ,A after the close quote of the program name: 

SAVE II SAMPLE" ,A 

See MERGE. 
To SAVE the program as a protected file in encoded binary form use .P instead of 

,A. Then it cannot be listed, saved, edited (or unprotected). While a clever programmer 
can get around this, it will at least prevent a quick and casual or accidental 
modification to your program. 

The SAVE instruction does not alter your program in memory. It is important to 
remember that if you write a Microsoft BASIC program, it will be lost (erased) unless 
you SAVE it before you 1) turn off the Macintosh; 2) go to the Desktop (System 
Command); or 3) use the NEW command. See also EDIT. 
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Program, Source or Object All programs that run directly on the Macintosh are 
machine language programs in the actual numeric instruction code of the Macintosh's 
MC68000 microcomputer chip. Most were orginally written by a programmer as text 
files known as source programs, which contained relatively readable statements in a 
language such as FORTRAN, COBOL or Microsoft BASIC. These were then translated 
by a compiler program, producing an object program. 

The object program contains the machine language instructions for the Macintosh's 
MC68000 which corresponds to the instructions of the original source program. 
Microsoft BASIC programs work in this way with a Microsoft BASIC Compiler. 

Regular Microsoft BASIC works in a slightly different way. It is a program (in 
machine language) which uses your Microsoft BASIC program as a guide to what it 
should do. It is therefore an interpreter, processing each line of your source program 
and interpreting what should be done. Since it must reinterpret your source program 
each time you run it, interpreted Microsoft BASIC can be as much as 100 times 
slower than compiled Microsoft BASIC. 

When you write a Microsoft BASIC program, you have produced a source program 
in text form. The Microsoft BASIC interpreter, itself a machine language program, 
uses your source program as data, a source of instructions or commands to control 
its execution. 

To speed up a Microsoft BASIC source program by compiling it into a faster 
machine language program, you will need a Microsoft BASIC Compiler, a program 
not supplied with the Macintosh, but available from other software houses. Run 
your Microsoft BASIC Compiler, using as input the source program that you wrote. 
The Microsoft BASIC Compiler will translate your source program into an executable 
machine language program. 

Program, Version or Release Programs and software packages are changed from 
time to time to correct errors or add new capabilities. To keep programs from 
being in a constant state of flux, and to simplify distributing modified programs 
to users, a number of changes are made, tested and packaged as a new version or 
release of the program. 

Versions or releases are typically numbered: 1.0 for the first version, 1.1 for the 
first minor revision, 1.2 for the second minor revision, etc. When a major change or 
large number of minor changes have been made, a new number may be assigned, as 
Version 2.0. Version numbers help programmers support a program by advising 
them on which version the user has encountered problems. Numbering also helps 
users know which changes are effective in the version they possess. 

Programmer's Switch See Interrupt Reset Switch. 

Programming Language A language that can be translated into machine language 
to direct the computer to carry out functions. 

Programming Languages See ADA, BASIC, C for the Macintosh, MacBASIC, MacForth, 
Macintosh Assembler/Debugger, Macintosh BASIC, Macintosh Logo, Macintosh 
Pascal, Microsoft BASIC, MacPascal, Modula-2, Pascal, PC BASIC Compiler, Utilities. 

Programming the MC6BOOO• By Steve Williams. A guide to assembly language 
programming for the MC68000 programmer. It explains microprocessor operation, 
writing programs and 1/0 programming. This book is useful to both Macintosh and 
Lisa programmers. Sybex. 

Programming Utilities See Uti I ities. 

Project Management Software See MacProject. 
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PROM Programmable Read-Only Memory. A ROM which can be modified by the 
user. 

Promodem 1200• This 1200 baud modem may be connected to the Macintosh via 
the modem port on the back panel. Its features include autoanswer, autodial, tone 
dialing, pulse dialing, an RS- 232 interface, intelligent dialing, an internal power 
supply and a built-in speaker with volume control. Prometheus Products. 

PROM Programmer An external device or module used to write user-modified 
ROMs. The programmer may input data through a hex keyboard, binary paper tape 
or directly through the microprocessing unit. 

Prompt A visual signal from a program to "prompt" the operator to do something 
and hopefully, gives some clue as to what the program requires (or allows) the 
operator to do in response to the prompt. 

Propagate To go from one component in the computer system to another. 

Propagation Delay The time the processor takes to pass a signal through one device 
on the system to another. 

Proportional Spacing Where the printer allocates horizontal space according to a 
character's width, rather than having standard width space for all characters. 
Proportional spacing is more readable than fixed-width type and resembles typeset. 

PRO Series Hard Disk Drives• Micro-Design offers two hard disk drives for the 
Macintosh. One has 10 megabyte capacity and the other has 20 megabyte capacity. 
Both have automatic locking heads and an internal power supply. Micro-Design. 

Protected Field Reserved areas that cannot be modified by the user with keyboard 
entry. 

Protected Format To SAVE a Microsoft BASIC program named "SAMPLE" as a 
protected file in encoded binary form use ,P instead of ,A. Then it cannot be listed, 
saved, edited (or unprotected). While a clever programmer can get around this, it 
will at least prevent a quick and casual or accidental modification to your program. 
See SAVE. 

Protocol The rules governing the exchange of information between two computer 
systems. 

PSET and PRESET PSET and PRESET are Microsoft BASIC statements used to draw a 
point at a specified position on the screen. The formats are: 

PSET (<X, y>[ ,<color>]) 
PRESET [STEP]<x,y>[,<coloo] 

<X,Y>are the coordinates of the point to be set. They may be in absolute or relative 
form. 

<color> specifies the color to be used. White has a value of 30. All other values 
produce black. 

STEP is an option that allows the user to specify that all x andy coordinates used 
for plotting are relative coordinates rather than absolute coordinates. The syntax for 
the STEP option is: 
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PSET STEP (<xoffset>, <yoffset>) 

The <xoffset> refers to the value of x in relation to the current x position. The 
<yoffset> refers to the value of they coordinate relative to the current y position. 

PRESET differs from PSET only in that if no <color> is specified in PRESET, the 
foreground color becomes the default color. If <color> is included, PRESET is identical 
to PSET. An out-of-range coordinate in PSET or PRESET will give no error message 
and no action will be taken. 

The Macintosh screen is divided into 512 vertical columns of pixels that are 
numbered from 0 to 511. It is also divided into 342 rows of horizontal pixels that are 
numbered from 0 to 341. Coordinate values may exceed these values in Microsoft 
BASIC. If, however, these values are outside the allowable range of integer numbers 
(-32768 to 32767), an "Overflow" error message will be displayed. 

PSW Program Status Word. Contains the zero flag, carry flag and other information 
relevant to the processor. 

PTAB A Microsoft BASIC statement that moves the print position on the screen to 
pixel <X>. The syntax for this statement is: 

PTAB(<x>) 

<x> is the designated pixel. If the present print position is more than x, then the print 
position is moved to x on the same line. Pixel 0 is the leftmost pixel on a line. PTAB 
may only be used in PRINT statements. See PRINT. 

Publications See Books, Magazines. 

Public Domain A term that describes products that has been released to the public 
by the author without a copyright notice. The author is usually recognized somewhere 
in the program listing. Many times these are prototypes of commercial products. 
They often lack detailed documentation or any documentation that has been 
provided is included in the program. Public domain software is available from user 
groups and from a number of commercial outlets that call themselves clubs. This 
software ranges from good and useful to terrible and useless. It can be copied and 
distributed freely. It can also be modified as required by the user. 

Pull-down Menu Command options available on the Desktop or in applications 
from the menu bar are accessed from pull-down menus, displayed when the mouse 
pointer is positioned on the menu name on the menu bar and the mouse button is 
pressed. Selections may be made by holding down the mouse button, dragging the 
pointer and the highlight that accompanies the pointer down the menu until the 
desired selection is highlighted and releasing the mouse button. See Menu Bar, 
Mouse Pointer, Mouse Button. 

PUT (File) A Microsoft BASIC statement which allows you to write a record from a 
random buffer to a random file. The format is: 

PUT ( # ]<filenum>[,<numbeo] 

<filenum> is the number under which the file was opened. 
<number> is the record number for the record to be written, in the range 1 to 

16777215. 
If <number> is left out, the record has the next available record number (after the 

last PUT statement). 



PUT (Graphics) • 247 

PRINT II , PRINT II USING, WRITE II , LSETand RSET may be used to put characters 
in the random file buifer before a PUT statement. In the WRITE # statement, 
M icrosoft BASIC pads the buffer with spaces up to the carriage return . If you try to 
read or write past the end of the buffer, a " Field overflow" error w ill occur. 

Style 

Open Header 
Open Footer 
Display Headers 
Remoue Footers 
Set Page# ... 
Insert Page Break 
Title 

Fig. PS A typical pull-down menu. 

PUT (Graphics) A Microsoft BASIC statement used to draw a graphics image on the 
screen. This form of PUT is used in graphics mode only. The format is : 

PUT (<x1, y1>)]-(<x2, y2>) ],<array>] ,<actioml 

<X1 ,y1> are the coordinates of the top left corner of the image to be transferred. 
<x2, y2> are the coordinates of the lower right hand corner of the image to be 

transferred . 
<array> is graphics information contained in a numeric array to be transferred. This 

array ho lds the graph ics image that is to be transferred. 
<actiom is one of the following: 

PSET 
PRESET 
XOR 
OR 
AND 

The default is XOR. 
PUT is different f rom GET in that it takes data out of the array and d isplays it onto 

the screen. See GET. It also provides the option of interacting with data already on 
the screen by use of <ac tiom. 
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PSET stores the data from the array onto the screen (just the opposite of GET). 
PRESET is identical to PSET except it produces a negative image, black on white. 
Using AND you can transfer an image. It must exist under the transferred image. 

You may superimpose an image onto an existing image using OR. 
XOR is a mode that may be used for animation which causes the points on the 

screen to be inverted where a point exists in the array image. When an image is PUT 
against a complex background twice, the background is restored unchanged. This 
allows you to move an object around without erasing the background. 

AND 

array value 

screen 0 1 2 3 

0 0 0 0 0 
1 0 1 0 1 
2 0 0 2 2 
3 0 1 2 3 

OR 

array value 

screen 0 1 2 3 

0 0 1 2 3 
1 1 1 3 3 
2 2 3 2 3 
3 3 3 3 3 

XOR 

array value 

screen 0 2 3 

0 0 1 2 3 
1 1 0 3 2 
2 2 3 0 1 
3 3 2 1 0 

Animation of an object can be done as follows: 

1. PUT the object on the screen with the XOR option. 
2. Recalculate the new position of the object. 
3. PUT the object on the screen, using XOR, again at the old location to remove the 
old image. 
4. Co to step 1, this time putting the object at the new location. 

Movement done this way leaves the background unchanged. Flickering can be 
reduced by minimizing time between steps 4 and 1, and making sure there is enough 
time delay between steps 1 and 3. If more than one object is being animated, every 
object should be processed at once, one step at a time. 

If it is not important to save the background, animation can be performed using 
the PSET action verb, but you should remember to have an image area that will 
contain the before and after images of the object. This way the extra area will 
effectively erase the old image. This is faster than the method using XOR described 
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above, since only one PUT is needed to move an object. You must, however, PUT a 
larger image. 

If the image to be transferred is too large to fit on the screen, an " Illegal function 
call" error occurs. 

Puzzle One of the Macintosh desk accessories which can be used to learn how to 
use the mouse or just as re lief from too much work wi th the computer. The puzzle is 
the same as the old d ime store puzzle with numbered squares in a case. The numbers 
must be arranged in the proper order from a random distribution to solve the puzzle. 
The puu le may be selected from the Apple menu in the upper left-hand corner of 
the screen display. See Apple Menu, Desktop Accessories. 

a File Edit Uiew Special 

Fig. P9 The puzzle from the Desktop accessories. 



Q 
Q ASCII 81, HEX 51. q ASCII113, HEX 71. 

Quad Involving four entities, or a multiple of four. 

Quad Density Disk Format Specifies storage density of a disk medium. Quad 
density stores four times the amount of information per disk as single density. 

Quadruple Density Disk format. See Quad Density Disk Format. 

Quest, The• The Quest is an adventure game that combines text, graphics and 
animation on the Macintosh. The ultimate mission of the game is dragon-slaying. 
Penguin Software. 

Queue A data structure which contains data or tasks waiting to be processed. 

Quickdraw A set of graphics procedures, functions and data types in the Macintosh 
ROM that draws complex graphics images on the computer's screen display. This 
routine is in the User Interface Toolbox and performs all of the on-screen graphics 
operations on the Macintosh. These procedures are accessed by Pascal or assembly 
language calls. Quickdraw is a programmer's tool, not a user's tool. It allows the 
programmer to generate the rapid, high-quality graphics that appear on the Macintosh 
screen display. See User Interface Toolbox, Pascal, Assembly. 

Quit Option The Quit command option is available from the File menu on the menu 
bar and is used to quit the use of a particular application such as MacPaint or 
MacWrite. When this command is selected, the current document is saved, the 
application is closed and the user is returned to the Desktop directory display. If 
changes have been made to the current document, a dialog box asks the user if the 
changes should be saved. The user instructs the computer to save the changes by 
clicking the OK button in the dialog box. See Dialog Box, OK Button, Menu Bar, File 
Menu. 

QWERTY The traditional typewriter keyboard layout, named after the first six 
letters in the top letter row. This is the most common keyboard layout for com
puters, and is the standard keyboard for the Macintosh. 
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R ASCII 82, HEX 52. r ASCI1114, HEX 72. 

R Reset, Register, Request, Ring Indicator. 

RAM Random Access Memory. Memory is any device which can store information 
and allow it to be retrieved when needed. The Macintosh relies primarily on Random 
Access Memory (RAM), Read- Only Memory (ROM), disks and hard disks. Memory, 
which by itself is usually a reference to RAM, is the general purpose, erasable and 
reusable memory located inside the Macintosh. RAM is the memory to which 
external programs and data are loaded. The Macintosh RAM is controlled by the 
Memory Manager which is a part of the Macintosh operating system. The Macintosh 
RAM can hold 128K bytes of data and programs. This memory capacity is actually 
131,072 bytes as 1K = 1024 bytes. 

RAM Disk A block of RAM memory used by a program to simulate a disk drive. The 
program must modify or intercept all I/O to the fictitious drive and redirect it to the 
RAM memory. The RAM disk will have its own drive designator (a letter, number or 
name) and appear in every way like a real disk, except it is much faster. 

Random Access An access method where each data item can be retrieved directly 
by an address computed from the data. 

Random Number See RND. 

RANDOMIZE A Microsoft BASIC statement used to reseed the random number 
generator. The format is: 

RANDOMIZE [<expo] 

<expo is an optional expression consisting of an integer number between -32768 
and 32767. It may also be the word TIMER which inserts the number of seconds that 
have passed since midnight. If no expression is provided, the program stops and 
requests that a number be provided by the user to reseed the random number 
generator. 

If the random number generator is not reseeded by the program or by the user, it 
repeats the same sequence of numbers every time the program is run. See RND. 

Raster Scan (CRT Display) The most common technique of TV display: an image is 
created from groups of dots of varying brightness. Contrast this with Vector graphics. 

R:base 2000* R:base 2000 is a database management program that may be used on 
the Macintosh. It includes search, sort and computation abilities. The user designs 
his own databases by building input screens. The program prompts the user as 
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screens are designed. Customized reports may also be designed by the user. Microrim, 
Inc. 

READ A Microsoft BASIC statement which reads values from a DATA statement and 
assigns them to variables. The format is: 

READ <variable>[,<Variable> ... ] 

<variable> is a numeric or string variable or an array element which is to receive the 
value read from the DATA table. 

A READ statement must always be used in conjunction with a DATA statement. 
The READ statement will take values read from the data statement and assign them 
to READ variables on a one-to-one basis. The variable types must agree with the data 
being stored in them or a "Syntax error" will occur. 

One READ statement may access several data statements or several read statements 
may access the same data statement. If the amount of data available is less than the 
number of variables allocated for the data, an "Out of data" error occurs. If the 
number of variables in the READ statements is less than the amount of data items, 
subsequent READ statements may be used and reading will begin at the first unread 
element. If there are no subsequent READ statements, the extra data is ignored. Data 
can be reread using the RESTORE statement. See RESTORE. 

READ (Input Data into Memory) Data in internal RAM is immediately available to 
programs for processing. Data in external memory must be copied into internal 
memory (READ or INPUT), processed, then copied back out to external memory 
(WRITE or OUTPUT). 

If data has been created, it can be written out to external memory without a READ 
first. And, if data read in from external memory has not been modified, there is no 
need to write it back out since the original copy is still there. 

Read Character from Keyboard See INKEY$, INPUT. 

Read Data from File See GET Files. 

Read-Only Memory (ROM) Storage which can be written only once. The Macintosh 
relies primarily on Random Access Memory (RAM), Read-Only Memory (ROM}, 
disks and hard disks. Memory, by itself, is usually a reference to RAM, the general 
purpose, erasable and reuseable memory located inside the Macintosh. 

ROM (Read-Only Memory) contains fixed data, usually programs such as the 
Macintosh's screen programs. The ROM also contains the fundamental machine 
language programs to run the various devices attached to the Macintosh such as 
monitor, printer, disks, etc., as well as the routines for interpreting keyboard and 
mouse input. Thus, the Macintosh ROM contains the computer's Operating System, 
Quickdraw and the User Interface Toolbox~ ROM and RAM together make up the 
internal memory or main memory of the Macintosh, or any other computer. See 
Memory, ROM, User Interface Toolbox, Quickdraw. 

Read/Write Describes the nature of an operation, i.e., the direction of data flow. If 
a device is a Read Only device, it may only pass data to the computer. It will not 
accept data from the computer. If it is Write Only, it will only accept data from the 
computer but will pass signals indicating that it is ready to receive or has received 
data. A Read/Write device such as the Read/Write head in a disk drive can both 
receive and send data to the computer as well as read and write data to the device 
itself. 
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Read/Write Head Disk drives and hard disk drive are equipped with read/write 
heads. These heads read data from a disk and record data on a disk. They are very 
much like the record and play heads on a tape recorder. A single-sided disk drive 
uses a single read/write head. A double-sided disk drive has read/write heads on 
both sides of the plane through which the rotating disk passes. 

Read/Write Slot Floppy disks, minifloppy disks, and microfloppy disks are protected 
with a sheath or casing. A slot is cut in this sheath or casing to allow the disk drive to 
write data to a disk and to read data from the disk. This slot is called the "read/write 
slot." This slot is protected on Macintosh 3-1/2 inch disks by a sliding cover. 

Real-time An action, or system capable of action, at a speed that keeps pace with 
the occurrence of an actual proces·s. 

Reboot the System The process of turning the computer off and then back on again. 
When this is done, everything in RAM is lost. The Macintosh system may be 
rebooted by turning the power switch off then on again. It may also be done by 
pressing the RESET switch which is the forwardmost switch of the two switches on 
the Macintosh programmer's switch (Interrupt Reset Switch). This switch is either 
installed by the user in the fashion described in the entry called Interrupt Reset 
Switch or is installed by the dealer when you purchase your Macintosh. The switch is 
located in the lower rear portion of the left-hand side of the computer case. The first 
method is called a "cold boot" as the computer is actually started from the off-line 
state. The second method is called a "warm boot" as the computer is only fooled 
into thinking it was turned off. Instead, power was left on. See Interrupt Reset 
Switch, Programmer's Switch, Reset, Interrupt. 

Recalculation There are two methods of calculation available on electronic spreadsheet 
programs such as Microsoft Multiplan: automatic or manual. Electronic spreadsheet 
programs such as Microsoft Multiplan will recalculate the results of all of the entries 
made in a worksheet automatically unless the recalculation method is set on 
manual. The automatic method should only be used after all data has been entered 
on a worksheet for calculation. If it is left on automatic, each time a number or label 
is entered on the worksheet, the entire worksheet will be recalculated. This is a very 
time-consuming process on large worksheets. 

Record A unit of information, either read, written or stored, such as a punched card, 
a disk sector or a line of characters. 

Recovering Disk Files Disk files may occasionally be lost to the user when a Finder is 
damaged or if the directory file in the Finder is damaged. These files cannot be 
recovered by conventional file-handling methods available from the Macintosh 
Finder. Instead, a variety of utility programs that can read the contents of each disk 
sector and write to each sector may be required. Anyone who uses these utilities 
must have a thorough understanding of disk files and ASCII code. If this occurs, ask 
your software dealer if he has any programs available that are easy to understand 
and use. If not, seek assistance from your local user's group or computer club as 
there is generally someone in the membership who is capable of dealing with these 
problems. 

Recovering Removed Items Items such as file folders, document files and even 
applications may be removed from the Desktop and thrown away (erased) by 
dragging the item's icon into the Trash Can on the Desktop. These items will remain 
in the Trash Can and may be recovered as long as the Empty Trash command option 
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has not been selected from the Special menu, and as long as the disk has not been 
ejected prior to emptying the trash. To recover an item, click the Trash Can icon 
twice. This will display a window showing the contents of the Trash Can. Then drag 
the icon of the item to be recovered from the Trash Can window to the Desktop or to 
the Directory window on the Desktop. See Trash Can, Icon, Dragging, Window, 
Special Menu. 

Recursive Refers to a function, routine or procedure which calls itself. 

Redo Option The Edit menu on the menu bar in MacWrite contains an option called 
"Undo Typing." When this option is selected from the menu, all information, 
including backspacing since the last time the mouse button was clicked, is erased 
from the screen. As soon as the Undo Typing option is used, it is replaced on the 
menu with a Redo Typing option, which allows the user to recover from an Undo 
Typing command. See Edit Menu, Undo Option. 

Redundancy The use of more than one of the same item to increase reliability or 
performance. 

Register One word of memory, usually implemented in fast flip-flops, directly 
accessible to a processor. Most CPUs include a set of internal registers which can be 
accessed much faster than the main memory. The Macintosh's MC68000 has sixteen 
general registers that are each 32-bits wide. These registers are divided into eight 
data registers and eight address registers. See R F. 

Relative Reference Electronic spreadsheet programs use references to specific cells 
within formulas to make the results of calculations in one cell dependent upon data 
entered in other cells. If a formula depends upon the contents of a specific cell, 
regardless of the location of the cell containing the formula that references the other 
cell, the reference is an absolute reference. If the formula refers to a cell or range of 
cells in the same relative position to the cell containing the formula, regardless of 
the location of this cell on the worksheet, the reference is a relative reference. 

Release An edition of a software package. Programs and software packages are 
changed from time to time to correct errors or add new capabilities. To keep 
programs from being in a constant state of flux and to simplify distributing modified 
programs to users, a number of changes are made, tested and packaged as a new 
version or release of the program. 

Versions or releases are typically numbered: 1.0 for the first version, 1.1 for the 
first minor revision, 1.2 for the second minor revision, etc. When a major change or 
large number of minor changes have been made, a new number may be assigned 
e.g., Version 2.0. 

Version numbers help programmers support a program by letting them know the 
version with which the user has encountered problems. Numbering also helps users 
know which changes are effective in the version they possess. 

Relocatable Describes the load module or object form of a program (or routine) 
which does not contain fixed addresses or which is structured so that it can be 
executed anywhere in the memory. 

REM REMarks or explanatory comments in a Microsoft BASIC program. The apostrophe 
(') may be used as a synonym for REM. The apostrophe can be used without a colon 
to indicate that the rest of the line is a remark. Examples: 



20 REM Just a comment 
30' Just a comment 
40 LET X= 1: REM Just a comment 
50 LET X = 1: 'Just a comment 
60 LET X = 1' Just a comment 
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The colon (:)allows multiple Microsoft BASIC statements on one line. The format 
is: 

REM remark 

(remark) can be any string of characters. 
REM statements are nonexecutable but are output exactly as entered when the 

program is listed. However, they do take up extra memory space and slow execution 
time. REM statements may be branched into by using GOTO or GOSUB statements. 
Execution continues with the first executable statement after the REM statement. 

Remarks may also be added to the end of a line by preceding the remark with a 
single quotation mark instead of :REM. The remark, if placed at the end of a 
statement, must be the last entry on that line. 

Removable Media Diskettes, hard disk cartridges or cassettes which can be removed 
from the device which reads or writes data to them. See Media. 

Renaming Disks, folders, applications and documents may be renamed on the 
Macintosh as long as the icon for the item to be renamed is visible on the Desktop 
display. The disk that contains the item must also be in a Macintosh disk drive. The 
item's icon must first be selected by placing the mouse pointer on the icon and 
clicking the mouse button once. This will highlight the icon. Then, move the pointer 
to the right-hand side of the icon's name, or to the insertion point within the name, 
and click the mouse button once again. As the pointer nears the icon's name, it will 
change from an arrow to an 1-beam. When the mouse button is clicked, a vertical bar 
cursor will appear at the insertion point you selected. The Backspace key may be 
used to erase any unwanted characters. New characters may be inserted by typing 
them from the keyboard. When the item has been renamed, the Return key may be 
pressed or the pointer can be moved to any blank space on the Desktop and clicked. 
Document names can be 63 characters long. Disk names can be 27 characters long. 
Neither name may contain a colon(:). Any other keyboard characters are allowed. 
See Clicking, Icon, Document, Folder. 

RENUM A Microsoft BASIC command which renumbers lines in a program and 
changes all line number references following GOTO, GOSUB, THEN, ELSE, ON 
GOTO, ON GOSUB, RESTORE, RESUME and ERL test statements to point to the new 
line number. The format is: 

RENUM [[<newnumbeo][,[<oldnumbeo][,<increment>])] 

<newnumbeo is the first line number to be used in the new sequence. The default is 
10. 

<oldnumbeo is the line in the current program where renumbering is to begin. The 
default is the first program line. 

<increment> is the increment to be used in the new sequence. The default is 10. 
If a nonexistent line number appears in one of the branching statements to be 

renumbered, the error message "Undefined line number xxxxx in yyyyy" is printed 
where xxxxx is the referenced line number and yyyyy is the line where the error 
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occurred. The referenced line, xxxxx, will not be changed, butthe line of occurrence, 
yyyyy, may be renumbered. 

RENUM cannot be used to change the order of program lines or to create line 
numbers greater than 65529. 

Repair of the Macintosh The Macintosh may only be repaired at an authorized 
repair facility. If it is opened by any other person, facility or individual, the 
computer's warranty is void. Your dealer may be an authorized repair center. If not, 
he can tell you where the nearest such center is located. 

Repeat a Character (n) Times See STRING$. 

Repeat Program Lines See FOR and NEXT. 

Reserved Word or Name A specific value which serves a special purpose and may 
therefore not be used for other purposes. In Microsoft BASIC, for example, TRON is 
a reserved word because it is reserved to turn the TRace function ON. See Reserved 
Words, Uses and Restrictions. 

Reserved Words, Uses and Restrictions See BASIC, Reserved Words. 

RESET A Microsoft BASIC statement used to close all open files on all active 
volumes. The syntax for this statement is: 

RESET 

This must be typed in the Command window and must be followed by pressing the 
Return key. The command closes all open files and updates volume directories. 

Reset To return to zero, or to some arbitrarily selected beginning point. Reset by 
turning on the Macintosh or pressing the Reset key on the Interrupt Reset Switch on 
the left-hand side of the Maicntosh. 

Reside Be recorded in. A program may reside on a disk, or in memory (RAM or 
ROM). 

Resident Software A program which resides in the main memory of the system. 

Resizing a Picture A picture that has been transferred from MacPaint to MacWrite 
may be resized within MacWrite, by placing the mouse pointer anywhere on the 
picture and clicking the mouse button once. This will cause a black border to be 
displayed around the picture. There are three black boxes along the bottom edge of 
the border. The middle box is used to stretch the picture vertically. Place the mouse 
pointer on the middle box, press the mouse button and drag the box down or up 
vertically until the picture is the correct vertical size. The left-hand box is used to 
stretch the left-hand side of the picture. The right-hand box is used for the right side 
of the picture. If you wish to move the picture horizontally, you would place the 
mouse pointer along the right- or left-side border, press the mouse button and drag 
the picture to its new location. See Mouse Button, Clicking. 

Resource Files Files created by Macintosh programmers to hold special fonts or 
special alert messages. These files are used by the Resource Manager. 

Resource Manager One of the parts of the User Interface Toolbox on the Macintosh. 
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It is a collection of about 34 routines that make use of data structures stored in 
resource fi les. It searches for and prints the proper messages fo r alert boxes and 
dialog boxes. See User Interface Toolbox. 

Restart a Program after a Pause Press any character key on the keyboard to continue 
a paused program. Press Command-S to pause in any program at any time. 
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Fig. R1 The MacWritc display with a picture enc losed inside the black border used for 
resizing pictures. 

RESTORE A Microsoft BASIC statement w hich lets you reread OAT A statements 
from spec ified lines. The format is: 

RESTORE (<line>] 

<line> is the line number of a OAT A statement in the program. 
Following the execution of the RESTORE statement, the next READ statement 

reads the first item in the f irst DATA statement in the program. If dine> is specified, 
the READ statement will read the first item in the DATA statement line specified . 

RESUME A Microsoft BAS IC statement which will continue program execution 
after an error recovery procedure has been performed. The format is: 

RESUM E 
RESUME(O) 
RESUME NEXT 
RESUME (line) 

The format used depends upon where execution is to resume. 
RESUME or RESUME 0 Execution resumes at the statement causing the error. 
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Attempting to renumber a program containing a RESUME 0 statement will cause an 
"Undefined line number" error to occur. 

RESUME NEXT Execution resumes at the statement immediately after the one 
causing the error. 

RESUME (line) The line number specified indicates where execution is to resume. 
A RESUME statement that is not in an error trap routine will cause a "RESUME 

without error" message to occur. 

Resume a Program after a Pause Press any character key on the keyboard to 
continue a paused program. Press Command-( to pause in any program at any time. 

RETURN A Microsoft BASIC statement which will bring you back from a subroutine. 
It is used in conjunction with the GOSUB statement. See GOSUB and RETURN. The 
formats are: 

RETURN 
or 

RETURN <line> 

<line> is the line number of the program line to which you want to return. 
RETURN (line) allows non local returns from the event-trapping routines to a fixed 

line number while still eliminating the GOSUB entry the trap created. Be careful 
when using this nonlocal RETURN since any other GOSUBs, WHILEs or FORs that 
were active at the time of the trap will still be active. 

Return Key The Return key is the key on the extreme right- hand side of the middle 
row of keys on the Macintosh keyboard. This key is used in programming and in text 
entry to move the cursor down one line and return it to the left-hand margin. It is also 
used to send an entry to the computer or to confirm a command. 

Return to Finder The Macintosh user can return to the Finder (Macintosh Desktop 
directory display) at any time by selecting the Save option or the Quit option from 
the File menu on the menu bar. See File Menu, Menu Bar. 

Reverse Video The ability of some CRT terminals to display dark characters on a 
light background as opposed to the standard light on dark. Also called Inverse 
Video. 

RGS Softmaker 11• A database and report generator that requires Microsoft BASIC 
to run. It can calculate up to fourteen digits of precision and can sort and search 
files. The maximum record length in this program is 32,767 characters. Rio Grande 
Software. 

RIGHT$ A Microsoft BASIC function which returns the rightmost <n> characters of 
string x$. The format is: 

stringvariable = RIGHT$(<x$>,<n>) 

<x$> may be any string expression. 
<n> is an integer expression specifying the number of characters to appear in the 

result. 
lf<n> is greater than or equal to LEN(<x$>), then <X$> is returned. If <n> is zero, the null 

string (length zero) is returned. <n> may have a value from 0 to 32767. 
Refer also to MID$, LEFT$ 
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Right Alignment Box The Right Alignment box is one of the four text-justification 
boxes in the lower right portion of a MacWrite ruler. It is the second box from the 
right. When this box is clicked, the right margin of the text below the ruler is aligned 
and the left margin is ragged. This justification is maintained unless it is changed by 
clicking another justification box or until another ruler with another justification 
box is inserted into the MacWrite document. 

Right Justify See Justify. 

Right Justify String See RSET, LSET. 

RND A Microsoft BASIC function which returns a random number between 0 and 1. 
The format is: 

variable = RN D[ (<X>) I 

<X> is a numeric expression which affects the returned value as follows: 
The same sequence of random numbers is generated each time the program is run 

unless the random number generator is reseeded. You can reseed by using the 
RANDOMIZE statement (see RANDOMIZE). You may also perform reseeding by 
calling the RND function using <X> where <X> is negative. This always generates the 
particular sequence for the given <X>. This sequence is not affected by RANDOMIZE, 
so if you want to generate a different sequence each time you run the program, you 
must use a different value for <X> each time. 

lf<x> is positive or not included, RND(<X>) generates the next random number in the 
sequence. RND(O) repeats the last number generated. 

To generate random numbers in the range zero through n, use the formula: 

INT(RND * (n+1)) 

ROM Read-Only Memory. Memory is any device which can store information and 
allow it to be retrieved when needed. The Macintosh relies primarily on Random 
Access Memory (RAM), Read- Only Memory (ROM), disks and hard disks. Memory, 
by itself, is usually a reference to RAM, the general purpose, erasable and reusable 
memory located inside the Macintosh. 

ROM (Read-Only Memory) contains fixed data, usually programs such as the 
Macintosh's screen programs. The ROM contains the fundamental machine lan
guage programs to run the various devices attached to the Macintosh such as 
monitor, printer, disks, etc. The Macintosh ROM also contains the routines for 
interpreting keyboard and mouse input. Thus, the Macintosh ROM contains the 
computer's Operatiing System, Quickdraw and the User Interface Toolbox. ROM 
and RAM together make up the internal memory or main memory of the Macintosh, 
or any other computer. See Memory, ROM, User Interface ToolBox, Quickdraw. 

Rotate Option A command option available from the Edit menu on the menu bar of 
MacPaint. This command turns an image 90 degrees if that image was selected by 
using the dotted rectangle. See Drawing Tools, Menu Bar, Edit Menu. 

Routine A section of code written to perform an action, such as an input character 
routine or a disk write routine. 

RSET See LSET. 

RS-232( The widely used standard for connecting computer system components, 
especially for serial communication of control and data between computers and 
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serial input/output peripheral devices. Standard for connecting data terminal equip
ment, such as modems or network data concentrators. It allows for substantial 
variation as to what signals are passed. RS-232 connections will usually handle only 
19,200 characters per second. The Macintosh has two serial ports on the back panel, 
designed to handle both RS-232 and R5-422 communications protocols and maximum 
baud rates. See EIA RS-232C. 

RS-422 A set of protocols and standards for data communications that is an 
improvement over the RS-232C standard. This standard can handle up to 920,000 
characters per second. It can generally transmit and receive data over longer cables 
than the RS-232C standard. 

Ruler MacWrite uses a ruler which runs along the top of the MacWrite screen 
display to indicate the location of the cursor, the paragraph indentation tab, the 
right margin and left margin, the justification of the text between the ruler being 
displayed and the next ruler. and the line spacing of the text between rulers. 
Additional rulers may be inserted in a MacWrite document to vary line spacing or 
justification. The ruler is a formatting device in MacWrite. All of the rulers in a 
document may be hidden from the screen display by selecting Hide Rulers Option 
from the Format menu. This command changes to Show Rulers after a Hide Rulers 
command has been given. 

RUN A Microsoft BASIC command which causes a program to begin execution. The 
formats are: 

RUN (<line>] 
RUN <filespee>(,R] 

<line> is the line number of the program in memory where you wish execution to 
begin. 

<filespeC> is a string expression used to name the file. 
RUN executes the program currently in memory at the lowest line number. 
RUN <line> will begin to execute the program at the specified line number. 
RUN <filespeC> loads a file from disk into memory and runs it. It closes all open files 

and erases from memory any contents before loading the designated program. 
However, with the R option, all data files remain open. 

Executing a RUN command will turn off the sound that is running and reset to 
Music Foreground. PEN and STRIG will be RESET to OFF. 

The RUN statement must be entered in the Command window on the Macintosh's 
Microsoft BASIC screen display, or may be selected from the Control menu on the 
menu bar. 

RUN To cause a program or batch file to start functioning or to execute. In 
Microsoft BASIC, entering RUN will cause any program in memory to execute. If the 
program is on a disk, use: 

LOAD file name,R or 
RUN file name,R. 

These command sequences must be typed in the Command window in the 
Microsoft BASIC screen display. The RUN command is also available from the 
Control menu on the menu bar of the Microsoft BASIC screen display. 
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Run for the Money• Run for the Money is an educational game for the Macintosh. 
Players are left on a strange planet with little money. The object of the game is for 
the player to start a business and to make enough money to repair a damaged 
spaceship. Scarborough Systems. 

R/W Read/Write. 



s 
S ASCII 83, HEX 53. s ASCII115, HEX 73. 

Sales Edge, The• A training tool and a sales strategy tool. This interactive program 
asks for data about the salesman and the client, and uses this information to supply a 
strategy for the salesman. Human Edge Software Corporation. In UK: Softsel. 

San Francisco One of the fonts introduced with the Macintosh on the earlier 
versions of MacWrite and MacPaint. This was moved to the font file in later releases 
of these two programs to make space for new fonts and to create more space for 
documents and files on the MacWrite/MacPaint disk. This font may be moved back 
into Mac Paint and MacWrite by us.ing the font mover from the Finder on the System 
disk. Once it has been restored to the applications, it may be selected from the Font 
menu on the menu bar. See Finder, Font Mover. 
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Fig. 51 A sample of the San Francisco font from MacWrite. 

Sargon 111• An interactive chess game for the Macintosh. The player challenges the 
computer in this game. His pieces are moved around the board with the mouse. 
Pull-down menus are used to select various features of the game. There are nine 
levels of difficulty to this game. Games can be saved to disk and the screen display 
can be printed. The board is displyed on one side of the screen display and a list of 
moves is displayed on the other side. The user can also examine 100 great games of 
chess or 45 great chess problems in detail. Hayden Software. In UK: Softsel. 

SAVE a Program on Disk To SAVE a Microsoft BASIC program named "SAMPLE" on 
disk (the default drive) enter: 
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SAVE ''SAMPLE'' 

On disk (external drive) enter: 

SAVE "diskname:SAMPLE" 

To RUN the program at a later time, use the LOAD command to copy it from the 
disk you saved it on back into the Macintosh's memory. See LOAD. If you want to 
save the program in ASCII format, which allows you to MERGE two programs 
together, put ,A after the close quote of the program name thus: 

SAVE ''SAMPLE'' ,A 

See MERGE. 
To SAVE the program as a protected file in encoded binary form, use ,P instead of 

,A so it cannot be listed, saved, edited (or unprotected). While a clever programmer 
could probably get around this, it will at least prevent a quick and casual or 
accidental modification to your program. 

The SAVE instruction does not alter your program in memory. It is important to 
remember that if you write a Microsoft BASIC program, it will be lost (erased) unless 
you SAVE it before you either: turn off the Macintosh; go to the Desktop (System 
Command); or use the NEW command. When the SAVE command is used in this 
manner, it must be entered in the Command window on the Microsoft BASIC screen 
display. It is followed by pressing the Return key. 

The Save command may also be exercised from the File menu on the menu bar. It 
is selected by placing the mouse pointer on the word File on the menu bar, pressing 
the mouse button to reveal the pull-down menu, dragging the pointer and highlight 
down this menu until Save is highlighted, and releasing the mouse button. This will 
cause the program currently in memory to be saved onto the default disk drive. See 
SAVE. 

Save As ... Option Available from the File menu on the menu bar in Macintosh 
applications. This command is used to save a changed document, file or program 
while the original document, file or program remains unchanged on disk. When the 
Save As ... Command is selected from the File menu, a dialog box is displayed 
requesting the name to be given to the changed version. It also selects the disk drive 
to which the document is to be saved. This is done by clicking the Drive button in the 
dialog box. Each time the Drive button is clicked, another of the disk drives 
connected to the Macintosh is displayed. See Drive Button, Dialog Box, Menu Bar, 
File Menu. 

Saue document as: MacDriue 
lsauE R~ ( Eject ) 

( Saue ) ( Cancel ) ( Driue ) 

Fig. 52 The dialog box displayed with the Save As ... option. 
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Save Button Whenever the Save option or the Save As option is selected from the 
file Menu in an application, a button called "Save" is displayed in the dialog box 
asking for the name of the file, document or program to be saved. This button is 
clicked or the Return key is be pressed, after the name of the item has been entered 
and the drive has been selected, to save the desired item. See Button. 

Save Option One of the command options available from the File menu on the 
menu bar of a Macintosh application. This command saves the current version of 
the file, document or program currently in memory to disk. If the file, document or 
program has not been named yet, a dialog box is displayed to request the name of 
the document and the disk drive to which it is to be saved. The Save button is 
dimmed until a name is entered in the Save As ... box in the dialog box. See Dialog 
Box, File Menu, Menu Bar, Button, Save Button. 

Saue current document as WRITE/PR .•. 

[ Eject ] 

( Cancel ) 

® Entire Document QTeHt Only 

Fig. 53 The dialog box that is displayed with the Save command. 

Saving Documents, files and programs currently in the Macintosh's memory may be 
saved to mass storage devices, such as disk drives and hard disk systems, by using the 
Save command or the Save As ... command from the File menu on the menu bar of 
the application. The Save command writes the item in its current state over any 
earlier version of the item that was stored. It is also used to save an item for the first 
time. The Save As command is used to save an altered version of an item while the 
original is still stored in an unchanged form. This command gives the user the 
opportunity to change the name of the item, thereby preserving the original item. 
See SAVE, Save As ... Option, File Menu, Menu Bar. 

Saving, Problems with There will be occasions when the Macintosh user will be 
unable to save a document, file or program to disk from an application. These 
occasions will arise when a disk is too full to accept more data, when the disk to 
which the data is to be saved is not initialized, when the disk is write-protected, 
when the disk is damaged, when the Finder on the disk is damaged or when the disk 
drive is not working properly. If any of these conditions is encountered when data is 
being saved, an alert box will be displayed. If the disk is too full, the user will be 
given an opportunity to eject that disk and replace it with another disk that is not 
full. The SAVE can then be retried. If the disk has not been initialized, the user will be 
given the opportunity to initialize the disk. The save operation can then be tried 
again. If the disk is write-protected, it must be ejected and unlocked before reinsert
ing it into the disk drive and trying again. If the disk or its Finder have been damaged, 
the disk should be ejected if possible and replaced with an undamaged disk. If the 
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disk drive is working improperly, all cables and connections should be checked on 
external drives that are malfunctioning. This requires that the entire computer be 
taken to an authorized service center for repair. In the latter case, the file, program 
or document will he lost. 

Scheduling Allocating a nonshareable resource such as CPU time or an 1/0 device 
to a particular task for a period of time. 

Scottie Mac Case, The• A carrying case, that holds the Macintosh, the keyboard, 
the numeric keypad, an external disk drive, two boxes of disks and the power cord. It 
is foam insulated to protect the system. The Casemaker. 

Scrap Another term used in Macintosh technical manuals for the contents of the 
Clipboard, a portion of the Macintosh RAM used to store text, program lines, 
numbers from a spreadsheet program or graphics images until they can be pasted 
into a document from the same application or from another application. The 
Clipboard's contents remain there until something new is cut or copied from a 
document and thereby is transferred to the Clipboard. See Clipboard, Document, 
Cut Option, Copy Option, Paste Option. 

Scrapbook One of the Desktop accessories available to the Macintosh user from the 
Apple menu on the menu bar. It makes five pages available to the user for storing 
text or graphics cut or copied from a document to the Clipboard and from the 
Clipboard to the scrapbook. Any text or graphics in the Scrapbook may be cut or 
copied to the Clipboard and from the Clipboard to a document by using the Cut and 
Copy commands from the Edit menu. The Scrapbook is opened by selecting Scrap
book from the Apple menu. Its pages are turned by using the scroll bar at the bottom 
of the scrapbook window. It is closed by placing the mouse pointer on the close box 
in the upper left-hand corner of the window. Text or graphics may be removed from 
the Scrapbook by cutting the page that contains them onto the Clipboard and then 
placing something else on the Clipboard or quitting the application. Either step will 
clear the Clipboard. New material may be saved into the scrapbook as long as there 
is a page available. Just cut or copy whatever is on the Clipboard into any page of the 
Scrapbook. It will fit the material into the available page. The contents of the 
Scrapbook are saved onto disk in a file called the Scrapbook file. They are not lost 
like the contents of the Clipboard when the application is no longer in use. See 
Clipboard, Cut Option, Copy Option, Paste Option. Edit Menu, Apple Menu. 

Scratchpad A group of general purpose registers without specific function that 
serve as a high-speed workspace for some operations. Usually, it is an internal RAM 
faster than the main system RAM. 

Screen The surface of a monitor or TV set on which characters are displayed. 

Screen (Current) Printed Press Command-Shift-4 together with the Caps Lock key in 
the down position to print the current contents of the screen on the lmageWriter. 
This is valid in any program and all applications at any time. 

Screen Dump A program or routine that allows thf' user to print the current contE>nts 
of any screen to a printer. SPe Screen (Current) Printed. 

Screen, ECHO Function on Sends characters from the keyboard to the screen for 
visual confirmation of what has been typed. There is no hard-wired connection 
between the keyboard and the screPn. The keyboard simply enters characters into 
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memory. The ROM programs of the Macintosh then copy the characters from 
memory to the screen. creating a duplication or "echo" of what was keyed. 

Scrapbook 

2/5 PICT 

Fig. 54 The Scrapbook window with a graphics page. 

Screen Generator A program which helps define CRT screen forms. consisting of 
text and symbols on the CRT data entry and display. Screen forms are often 
displayed in protected fields and consist of prompts to guide the data entry oper
ator. 

Screen Size A measure of the amount of information that a CRT screen can display. 
Screens may be measured diagonally, as TV sets, or by the number of vertical and 
horizontal dot or character positions. 

Scroll Arrows The windows used on Macintosh displays have a scroll bar on the 
right-hand side to allow the contents of the window to be scrolled up or down. They 
also have a scroll bar along the bottom of the window to allow the contents of the 
window to be scrolled from right to left or left to right. There is an arrow at the top 
and bottom of the right-hand scroll bar, and an arrow at the right and left ends of the 
bottom scroll bar. These arrows are called "scroll arrows." When a scroll arrow is 
clicked, the contents of the window are scrolled line by line. See Scroll Bar, 
Window. 

Scroll Bar The windows used on Macintosh displays have a scroll bar on the 
right-hand side to allow the contents of the window to be scrolled up or down. They 
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also have a scroll bar along the bottom of the window to allow the contents of the 
window to be scrolled from right to left or left to right. There are arrows at each end 
of each scroll bar, called "scroll arrows" used to scroll the contents of the window 
line by line. There are boxes in each scroll bar called "scroll boxes" used to signify 
the relative position of the current contents of a window in relation to the entire 
window. They may also be dragged from one position to another in the scroll bar to 
move rapidly from one part of a window to another. If the mouse pointer is placed 
within the limits of a scroll bar above the scroll box and clicked, the contents of the 
window are scrolled down one screen. If it is clicked below the scroll box, the 
contents are scrolled up one screen. See Scroll Box, Window. Scroll Arrows. 

List 
CLS 
REM Home Budget1ng/Cashflow Analysis 
DEFDBL A-V:DEFINT Z 
DIM D( 12) I 10(3,2) I C0(313) I c 1 (515) I c 1 $(5) I E0(2512) 
PU$:'"$$•••• 111111 ••" 

REM DO --Day Offset Factors 
REM 100 --Salaried Income 
REM C 10 --Credit Instruments 

100 REM EO() --Expenses 
110 REM C 1$0 --Descriptions of credit cards 
120 REM coo --F1xed-Term Loans 
130 DATA ''Mortgage","Car Loan"I"Other Loan" 
140 REM expenses 

Fig. 55 A Macintosh window display with the scroll bars on the right-hand side and bottom, 
the scroll arrows at both ends of each scroll bar and the scroll box in each scroll bar. 

Scroll Box The square shapes within the scroll bars on a Macintosh window display. 
One scroll bar runs down the right-hand side of the window, and another runs along 
the bottom of the window. The scroll boxes are used to denote the position of the 
current window display in relation to the entire contents of the window. They are 
also used to scroll the contents of the window one screen at a time by clicking in the 
scroll bar above or below the scroll box. They may also be used to move quickly from 
one part of the window to another by placing the mouse pointer on the scroll box 
and dragging it up or down the scroll bar until the proper portion of the window is 
being displayed. See Scroll Bar, Window, Mouse Pointer, Dragging. 

Scrolling Moving the contents of the CRT screen or window up or down by one or 
more lines. Some applications such as electronic spreadsheets and word processors 
allow scrolling a screen at a time as well as a line at a time. Smaller movements, 
performed one dot at a time, are called "microscrolling." 

• SEACAS• An automated auditing tool, which helps save time during the progress of_ 
an audit. It also documents audits completely. Peat, Marwick, Mitchell, & Co. 

Search Menu Word processors and database managers often allow the user to 
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search for a particular word or phrase. This is usually accomplished by invoking a 
Search Command and instructing the program as to the word or phrase to be found. 
MacWrite uses the Find command from the Search menu to find a particular word or 
phrase in text in a document. This menu also has a Change command used to replace 
occurrences of a particular word or phrase with another word or phrase. The Search 
menu is located on the menu bar at the top of the MacWrite screen display. See 
Change, Find Command, Menu Bar. 

Seastalker• An interactive adventure game that combines text and graphics in an 
undersea adventure game. lnfocom, Inc. In UK: Softsel. 

Second Disk Drive The Macintosh is equipped with an internal disk drive to allow 
the loading and saving of data onto 3-1/2-inch microfloppy disks. A second disk 
drive, an external disk drive, may be connected to the Macintosh via the disk drive 
port located on the back panel of the computer. The disk drive socket is a 19-pin 
socket and is the second port from the left facing the back of the Macintosh. When 
saving and loading programs in Microsoft BASIC. the internal disk drive is assumed 
to be the default drive unless it was not the last drive used. To be sure of accessing 
the proper drive use the name of the disk in the drive, a colon and the file or program 
name after the command SAVE or LOAD. See SAVE, LOAD. 

Sector A contiguous section of a disk track. A block of data on a disk is addressed by 
its track and sector numbers. Typical disk sector sizes are 128, 256 or 512 bytes of 
data. Consecutively numbered sectors may or may not be physically adjacent within 
a track. The Macintosh Disk Operating System uses 512-byte sectors to store 
information on disk. Each disk is divided into 80 tracks numbered from 0 to 79 from 
the outermost track to the innermost track. The outermost set of sixteen tracks are 
divided into twelve 512-byte sectors. The second set of sixteen tracks are divided 
into eleven sectors. The third set of sixteen tracks has ten sectors per track. The 
fourth set of sixteen tracks has nine sectors per track. The fifth and final set of sixtePn 
tracks has eight sectors per track. There are a total of BOO sectors on a Macintosh 
disk initialized by the Macintosh Operating System. 

Sector, Bad Refers to a sector on the disk which will not read/write data correctly, 
usually due to a minor physical flaw in the disk. One or two bad sectors will not 
seriously affect the disk's use. Macintosh will mark them as bad and avoid using 
them. More than a few bad sectors indicates the disk should be trashed after all of 
the files that can be recovered are copied from the bad disk to a good disk. 

Security Accessory Kit* Since the Macintosh is an extremely compact and portable 
computer, Apple Computer. Inc. decided to offer a special security kit to Macintosh 
buyers. Security eyelets are provided as a part of this kit. One eyelet locks into place 
on the back of the Macintosh on the left-hand side. The second locks into the back 
of the keyboard. Once these eyelets are in place. they cannot be removed. The 
security kit also includes a cable that may be wrapped around some permanent 
object, threaded through the eyelets and secured with a cowling ring and a lock. 
Apple Computer, Inc. In UK: Apple Computer (UK) Ltd. 

Security Kits See Anchor Pad, Security Accessory Kit. 

Seek Time The time needed to position the read/write head in a drive over the 
specified track of the disk. 

Segment A continuous block of memory addresses, such as 0 to 64k. 
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Select All Option Available from the Edit menu, it selects all of the icons in the 
current window for some subsequent action such as duplicating, getting info or 
whatever. Each of the icons in the window is highlighted as if it had been clicked. If 
the Get Info option is selected from the Edit Menu on the menu bar all of the icons 
on the screen will be opened. The Finder can only handle seven items at a time in 
this situation, so no more than seven info windows will be opened. The items can be 
unselected by placing the mouse pointer anywhere on the Desktop and clicking the 
mouse button. See Edit Menu, Menu Bar, Clicking, Finder. 

Selecting Disk icons, folder icons, applications icons, document icons, blocks of 
text in Macwrite, pictures in Macpaint and cells in Microsoft Multiplan are all 
selected for some subsequent action by placing the mouse pointer on the item to be 
selected and clicking the mouse button one time. This causes the selected item to be 
highlighted by displaying it in inverse and on the screen. Groups of items may be 
selected by dragging the mouse pointer over all of the items to be selected and 
releasing the mouse button when all of the desired items are highlighted. When this 
is done in the Finder's Directory window, a dotted rectangle appears. This rectangle 
should include all of the desired items if you wish to select more than one item. 

You may have to move icons around inside the window by dragging them from 
place to place to get the icons of all of the desired items to a location where they can 
fit within the rectangle. When a picture is selected on the Mac Paint screen display, it 
briefly shows in inverse then it is surrounded by a black rectangular border with 
three small squares on the bottom line. The selection process can be extended in a 
different fashion by holding down the Shift key while the mouse button is held down 
to make the first selection. A second selection can be made from a location some 
distance away on the display by releasing the mouse button and continuing to hold 
down the shift key, moving the pointer to the next selection, and pressing the mouse 
button again. This process is called "shift-clicking." See Icon, Mouse Button, Window, 
Finder, Directory. 

Select Menu The Select menu is one of the pull-down menus that is available in 
Microsoft Multiplan. The options in this menu are All Cells, last Cell, Name, link, 
Show Active Cell, Define Name and Delete Name. This menu is used to select either 
all cells in a spreadsheet or just the last cell for a command or action. It is also used 
to name a cell, a range of cells or a block of cells. It is used to link a portion of one 
spreadsheet to another. The Show Active Cell option is used to return the screen 
display to the last active cell when the user has scrolled the screen display to another 
portion of the spreadsheet. The Define Name command is used to name a cell, range 
of cells or block of cells. The Delete Name command is used to remove a name from 
a cell, range of cells or block of cells. The Name command is used to scroll the 
worksheet display to a point where the named cell is displayed on the screen. 

Semicolon(;) For use in LPRINT on printer line. Each group of spaces as set by the 
WIDTH statement across the print line is called a "print zone." A comma(,) in an 
LPRINT list of items to be printed means "start printing the following item at the start 
of the next print zone." Contrast this with the semicolon(;), which means the next 
item is to print immediately after this one, without even a single space between. See 
also Print line (Spacing). 

Send a Line to Requesting Program Pressing the Enter key sends the displayed line 
to the requesting program for processing. 

Sensor A device which translates a physical stimulus into an electronic signal which 
may, for example, be input into a computer. 
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Sequential Access An access method in which items may be accessed in' a fixed 
order only. The standard example of a sequentially accessed medium is magnetic 
tape. Here, in order to access a particular record, all records before it must 
be scanned first. 

Sequential File A file whose elements may only be accessed in ascending order. In 
order to read an element of a sequential file, all of the preceding elements must be 
accessed. 

Serial Simultaneous handling of processes, transmissions or storage of data. In most 
microcomputers, parallel 1/0 connections have eight wires to carry eight bits of a 
byte simultaneously (or in parallel). Contrast this with a serial interface. where only 
one data wire is available. The eight bits of a byte are transmitted one after another 
(or serially). The 1/0 device must collect all eight bits through time back into one 
eight-bit byte. 

Serial Data Data transmitted sequentially, one bit at a time. 

Serial Port An 1/0 port through which data is transmitted and received serially. 
Serial ports are often used for communicating with terminals or other computers. 

Servomechanism A device which can respond to an electrical (or other) signal by 
producing a physical change, such as moving a part. rather than producing another 
electrical signal. Servomechanisms range from a simple relay to robots. Examples of 
servomechanisms are disk drives, printers and automated TV antennas. In each case 
the device responds to certain electrical signals by moving a part such as the disk 
read/write head, the paper feed of the printer or the antenna. 

Set Date The current date in the Macintosh clock can be set by selecting the Control 
Panel from the Apple menu. Once displayed, the month, day and year may be 
changed by placing the crosshair pointer on the portion of the date to be changed 
and clicking the mouse button. This will cause an up arrow and a down arrow to be 
displayed between the date and the time fields. The up arrow advances the selected 
portion of the date. The down arrow decrements the selected portion of the date. 
Once the date has been set properly, the crosshair pointer can be moved elsewhere 
in the Control Panel or the Control Panel may be closed by placing the mouse 
pointer on the close box of the Control Panel window and clicking the mouse 
button. See Control Panel, Mouse Pointer. Clicking. 

Set Page# Option One of the command options available from the Format menu 
on the menu bar in MacWrite. This command is used to set the number for the 
current page. This will set up the numbering for subsequent pages. This command 
causes a dialog box that requests the OK of the currently displayed page number or 
allows the page number to be changed by moving the mouse pointer into the New 
page number? box. This causes a vertical bar cursor to be displayed in this box. The 
current number can be deleted with the Backspace key and the new page number 
may be entered. Once this has been done, the OK button should be clicked. See 
Format Menu, Menu Bar, Clicking. 

Set the Time The time on the Macintosh's internal clock may be set in in the same 
manner as the date. First, the Control Panel is selected from the Apple menu. Then 
the crosshair pointer is moved onto the hours, minutes or seconds on the time 
display and the mouse button is clicked. This causes the selected time setting to be 
highlighted. An up arrow and a down arrow are displayed between the time setting 
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and the date setting. The selected time sett ing is advanced by cl icking the up arrow 
and retarded by clicking the down arrow. See Contro l Panel, Mouse Pointer, Cl icking. 

t
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Control Panel 

Fig. 56 The Contro l Panel with the day set section highlighted. 

SGN A Microsoft BASIC function which gives the sign, positive or negative, of <X>. 
The format is: 

variable = SGN(<x>) 

<X> may be any numeric expression. 
If <X> is positive, SGN(<X>) wil l return 1. 
If <X> is zero, SGN (<x>) wi ll return 0. 
If <X> is negative, SGN(<x>) wil l return -1 . 

Shapes 'N Shots• A graphics uti li ty program and graphics tutor. Versions are avail
able in Microsoft BASIC, MacBASIC and Macintosh Pasca l. Shapes works much like 
fat bits in MacPaint, allowing the user to build graphic images on disk files. Shots 
al lows the user to animate images. These programs are useful to game players, 
programmers and educators. Macro Micro Software. 

Shift-clicking The process of holding down the Shi ft key whi le click ing the mouse 
button. This allows the selection process to be extended to allow the user to select 
more than one item regardless of how far apart they are on the Directory window in 
the case of making a selection from a directory. Therefore the fi rst item can be 
selected and the mouse button ca n be released as long as the Shift key is held down. 
The pointer can be moved elsewhere on the Desktop to make a second selection and 
the mouse button clicked again. The sa me process can be used in Mac Write to select 
different portions of text in e1 document for changing to a particular fon t style. font 
size or font. 

Shift Key The Shi ft key on the Macintosh keyboard gives the user upper case in text 
applications. It may also be used in combination with the CommCind key and o ther 
keys to carry out tasks such as printing the entire scret>n or the active w indow. The 
Shi ft key is used along w ith the mouse button to extend thf' process of making 
selections in what is cal led " shift- clicking." See Command K<•y. Activf' Window. 
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Shok Stop• A foam-lined. polyethylene carrying case. This case is designed for 
long-distance transportation of the Macintosh system. Thermodyne International. 

Shortcuts A quicker way of getting things done on the Macintosh with a Macintosh 
application. Shortcuts which are available on the Finder are double-clicking, which 
opens the item double-clicked; shift-clicking, which extends the selection process; 
pressing the Return key or the Enter key while a dialog box is being displayed, which 
confirms the command in the outlined button in the dialog box: pressing the Tab key 
while a dialog box is being displayed, which causes the next logical place for 
information entry in a dialog box to be selected; and using the Command key in 
conjunction with other keys, which causes selected actions to take place. See 
Command key for these shortcuts. There are a number of shortcuts available in 
MacPaint, which also involve the use of double-clicking and special keys. 

Show Clipboard Option The contents of the Clipboard may be displayed in a 
window at any time while using an application or from the Finder by selecting the 
Show Clipboard command option from the Edit menu on the menu bar. See Clip
board, Edit Menu, Menu Bar, Window. 

Show Footer Option Once a footer has been opened in MacWrite with the Open 
Footer command option from the Format menu on the menu bar, the footer will be 
shown on each page on the screen display of a MacWrite document. Footers may be 
hidden by using the Hide Footer option on the same menu. This option replaces the 
Show Footer option at any time that footers are being displayed. See Footer, Format 
Menu, Menu Bar. 

Show Header Option When a header has been opened in MacWrite with the Open 
Header command option from the Format menu on the menu bar, then the Show 
Header command option replaces the Open Header option on the menu. As long as 
this option is active, the header is shown on the screen display at the top of each 
page. Headers may also be hidden by choosing the Hide Header option which 
replaces the Show Header option when headers are being displayed. See Format 
Menu, Menu Bar. 

Show Page Option An option available in Mac Paint from the Goodies menu on the 
menu bar. This option causes a reduced version of an 8-1/2 by 11 page to be 
displayed on the screen. This gives the user a chance to see a MacPaint document 
before it is printed. While the page is being displayed, the screen window, which is 
represented within a dotted rectangle, can be dragged to another part of the page to 
be displayed when Show Page is deselected by clicking the OK button. See Goodies 
Menu. 

Show Rulers Option Rulers are used in MacWrite to format all or part of a docu
ment. All of the rulers used in a document will be displayed on the MacWrite screen 
display of the document as long as the Show Rulers option has been selected from 
the Format menu on the menu bar. Rulers will be hidden if the Hide Rulers option is 
selected. This option replaces the Show Rulers option as long as rulers are being 
displayed in a document. See Ruler, Hide Rulers Option, Format Menu. 

Silicon Valley The area around Sunnyvale, in the Santa Clara Valley south of San 
Francisco, California, where many semiconductor manufacturers are located. More 
generally, it contains the greatest concentration of electronics industries in the U.S. 
When you refer to this geographical area, please do not call it Silicone Valley. 
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Fig. 57 A screen dump of the Mac Paint Show Page option. 
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Simulator A program which models a device by having the same input/output 
behavior as the device simulated. A CPU is easily si mulated but 1/ 0 cannot be 
precisel y simulated beca use of timing considerations, so onl y the logic of a program 
can be tested with a simulator. 

SIN A Microsoft BASIC function which calculates and returns the trigonometric 
sine fu nction. The forma t is : 

variable = SIN(<x>) 

<X> is the angle in radians. 
To convert degrees to radians, mu ltip ly by Pl/180; Pl = 3.141593. SIN(<X>) is 

calculated in single precision . 

Single-precision Arithmetic Regular arithmetic, e.g .. arithmetic on single-word integers, 
by contrast to double or multiprecision arithmetic. 

Single-precision Floating Point Variables Single-precision floa ting point numbers 
(numbers wi th decimal f ractions with up to six digits) can be declared by ending 
their variable names with an exclamation point ( !). DEFSNG sign ifies that all 
fo llowing variables which start with the specified letters are single- precision floa ting 
point numbers. See also Va riable Names, DEFSNG. 

Single-sided A method of disk storage using onl y one side of the disk as used in the 
Macintosh 400K dri ve. 
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Size Box The size of windows displayed on the Macintosh screen may be adjusted 
by using the size box located in the lower right-hand corner of each window. A 
window may be made smaller by dragging the size box diagonally toward the upper 
left-hand corner of the window, or larger by dragging the size box away from the 
upper right-left corner of the window. See Window, Dragging. 

Skip Over Print Zones To leave space on the print line between items, put an extra 
comma(,) in the print list. Enter Microsoft BASIC statement: 

LPRINT A,B 

This would print A in print zone 1, nothing in print zone 2, and put Bin print zone 
3. 

See Print Zones, Print (Line Spacing). 

Skip to Top of Page Enter Microsoft BASIC statement: 

LPRINT CHR$(140) 

Or use the top of form or form feed manual control button (FF) on the printer. 
You may then need to adjust the paper in the printer so it actually is at the top of a 

page as defined by the perforations. 
In a program, you may want to provide instructions to the operator and a pause to 

allow for adjustment of the paper. 

Smalltalk A language and software system developed by the Learning Research 
Group at the Xerox Palo Alto Research Center (PARC) during the years 1971-1980. It 
was released in 1981. Smalltalk is organized around two fundamental concepts: 
objects and messages. Smalltalk systems are characterized by a high degree of 
pictorial interaction. 

Snapshot of a Screen display Any Macintosh screen display can be converted to a 
MacPaint snapshot by pressing the Command key, the Shift key, and the 3 key 
together. The Caps Lock key should be in the up position when this is being done. Up 
to ten snapshots can be taken and each one will be numbered consecutively from 0 
to 9. Each one is named Screen 0, etc. when it is saved to disk. Mac Paint can be used 
to print and edit each of these snapshots. See Command Key, Shift Key. 

Soft-sectored A disk format where the beginning of every sector is detected by 
reading magnetic marks on the disk (used by the Macintosh). This is in contrast to 
hard-sectored, where each sector's origin is marked by a physical hole. 

Software Computer programs of all kinds. Usually software is contrasted to hard
ware, the actual chips, wires, boards, etc. which make up the computer. A special 
case is Read-Only Memory (ROM), which is hardware containing a permanent copy 
of software. Shorthand terminology here could be confusing. A Microsoft BASIC 
ROM, means a ROM (hardware) containing a copy of a Microsoft BASIC interpreter 
program (software). Such ROMs are often called "firmware" to distinguish them 
from nonprogram hardware and from software in changeable media (RAM, disk, 
etc.). For software available for the Macintosh, see Agriculture, Business Software, 
Communications, Databases, Educational Software, Games, Graphics Software, 
Integrated Software, Music Software, Personal Management Software, Programming 
Languages, Spreadsheets, Utility Programs. Word Processors. 
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Software, Applications A group of computer programs, possibly including data files 
and documentation, which performs a function or group of related functions on the 
computer. Applications software are devoted to an end-user task (e.g., a word 
processing package, an accounting package, etc.). Systems software packages 
facilitate the use of the machinery (e.g, a database management package, a disk 
operating system or a program development package). 

Software Package A prewritten group of commercially available programs designed 
to serve a specific need, such as word processing, inventory control, database 
management, etc. 

Software-compatible Describes CPUs which execute the same instructions (i.e., 
have the same machine language). 

Sorcerer• An interactive text adventure game that takes the user into realms of 
magic. lnfocom, Inc. 

Sort To arrange items according to defined criteria, such as in alphabetical or 
numerical order. 

Source The emitter of a transistor. 

Source Code A synonym for source program. 

Source Drive The disk drive from which information/data comes. Target drive is the 
disk drive to which information/data goes. 

Source Language The original language used by the programmer, on which a 
translator program operates to produce a version in machine language. 

Source Program A file which contains data to be processed by a language processor 
or interpreter. For example, a Microsoft BASIC program called SAMPLE.BAS is a 
source program. If you submit it to the Microsoft BASIC Compiler to produce a fast
object program, the Microsoft BASIC Compiler will treat SAMPLE.BAS as its input 
data rather than as a program to be executed. The Microsoft BASIC Compiler will 
produce an object file with extension .OBI which contains a translation of your 
source program into the MC68000 machine language. See Programs, Source or 
Object. 

SP Stack Pointer. 

SPACE$ A Microsoft BASIC function which returns a string containing <n> spaces. 
The format is: 

stringvariable = SPACE$(<n>) 

<n> is in the range 0 to 255. 
See SPC. 

Space Binary 0 (zero). ASCII 32. In the RS-232C standard, negative voltage; in a 
current loop, no circuit flow; and in modems, the lower frequency of the pair. Also 
commonly used as a synonym for the blank character. 

Space Bar The space bar on a computer keyboard serves much the same function as 
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a space bar on a typewriter. It is used to insert a space or a null string into text, 
numbers or program lines. The space bar generates an ASCII 32 character for the 
computer. The space bar is located in the center of the bottom row of keys on the 
Macintosh keyboard. It is the longest key on the keyboard. 

Space, How to An LPRINT statement with no other specifications will print a blank 
line (feed the paper up one line and return to left margin) so you can format your 
printout neatly. 

Space on Print Line To leave space on the print line between items, put an extra 
comma(,) in the print list. Enter Microsoft BASIC statement: 

LPRINT A,B 

This would print A in print zone 1, nothing in print zone 2, and put Bin print zone 
3. 

See also Print Zones, Print Line (Spacing). 

Space Up One Line To advance one line on the printer (space up) without carriage 
return, enter Microsoft BASIC statement: 

LPRINT CHR$(10) 

or use the line feed button (LF) on printer. 
Entering just LPRINT gives a line feed, both a space up one line (line feed) and a 

return to left margin (carriage return). 

Spaces in PRINT or LPRINT See SPC. 

Spacing in Microsoft BASIC Print Lines To get one or more spaces between fields 
printed by your Microsoft BASIC programs, use a I iteral of spaces: 11 11

• To get several 
spaces between the printed values of A$ and B$, enter Microsoft BASIC statement: 

LPRINT A$;" II ;B$ 

See also Print Zones. 

SPC A Microsoft BASIC function which causes <m spaces to be skipped in a PRINT 
statement. The format is: 

PRINT SPC(<m) 

<n> must be in the range 0 to 255. 
If you make <n> greater than the width of the device, The value used is <n>MOD(width ). 

SPC is restricted to use with PRINT, LPRINT and PRINT # statements. If the SPC 
function is placed at the end of the list of data items, Microsoft BASIC will not add a 
carriage return as though the SPC function had an implied semicolon after it. See 
SPACE$. 

Speaker Volume Setting The volume of the Macintosh speaker may be set from the 
Control Panel, accessed by selecting it from the Apple menu on the menu bar. Once 
the Control Panel window is being displayed. the sound may be adjusted by dragging 
the volume control lever on the left-hand side of the window up for louder volume, 
or down for lower volume. See Apple Menu, Dragging. 
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Control Panel 

Fig. 58 The Control Panel with the volume control setting on the left-hand side. 

Special Characters Mean ings of in BASIC. See BASCI, Special Characters. 

Special Keys There are three special keys on the Macintosh keyboa rd : the Tab key, 
the Return key and the Enter key. The Ta b key is used to move the cursor from one 
insertion point to the next and to move this po int from one tab setting to the next in a 
word processor. The Enter key is interpreted as an instruct ion to move down one line 
and continue printing. The Return key is interpreted as an instruction to move down 
one line, move the cursor to the extreme left-hand end o f the line and continue 
printing. Both the Enter key and the Return key are recogni zed as Do it instructions 
by t he computer. 

Special Menu One o f the menus on the menu bar of the M acintosh Desktop d isplay. 
which allows the user to Clea n Up the Desktop. Erase Disk and Empty Trash. The 
Clean Up command rearranges the icons on the Desktop and in the Directory 
w indow so they are a ll in neat columns and rows. The Erase D isk command is 
sel f-explanatory. The Empty Trash command is used to erase from the disk any f iles. 
programs or documents no t wanted. Such files must have been placed in the Trash 
prior to using this command. 

Spikes Sharp, temporary increases in a signal or vo ltage. 

Split Bar Split bars may appear at the top o f verti ca l scroll bars and on the left-hand 
side o f the scro ll bars located on the bo ttom o f a w indow. and mean that the window 
may be spli t vertica ll y or horizontally into two pil ncs . The contents of each pa ne 
may be scro lled independently o f the contents o f the other pane. Split hars are no t 
found frequently in M acintosh app lica tions. Sec Scro ll Bar. Window, Panes. 
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Split Screen Division of a CRT screen into two or more separate areas, or windows, 
in which distinct information is displayed. 

Spool Simultaneous Peripheral Operating On-line. A method of increasing the 
efficiency of the system throughput by allowing programs using slow output devices 
to complete execution rapidly. Program output data is placed in queues on high
speed mass storage devices or a part of main memory dedicated to spooling for 
low-speed transmission concurrent with normal system operation. 

Spray Paint The spray paint icon is a symbol on the Mac Paint drawing tool palette. 
When this icon is clicked. the spray paint may be used to shade an area of a drawing 
with the current pattern shown on the left-hand side of the pattern palette. See 
Drawing Tools. 

Spreadsheet A spreadsheet or electronic spreadsheet program is a program that 
uses the conventions of an accountant's ledger sheet to deal with numbers and 
formulas. An accountant's ledger sheet is made up of rows and columns. Labels and 
numbers are inserted as required in the cells that are located at the junction point of 
a row and a column. Parts of rows or whole rows of numbers may be added across. 
Parts of columns or whole columns may be added down. The contents of one or 
more cells may be added to, subtracted from, divided by or multiplied by the 
contents of another cell or cells. Constants may be introduced and used. 

One particularly frustrating aspect of an accountant's ledger sheet is that as the 
entries become more complex, as one number is changed, many more numbers that 
are related to the changed number must be erased and changed. All of these 
oprations are carried out electronically by the computer in a spreadsheet format 
when a spreadsheet program or electronic spreadsheet is used. 

Spreadsheet programs have a number of common characteristics. They are divided 
into rows and columns in terms of screen display and hard copy output. They have a 
number of built-in commands to format individual cells or portions of a worksheet 
generated by the program. They have a number of built-in file handling commands 
that allow a worksheet to be saved to disk. loaded from disk or printed. They have a 
number of built-in functions that allow mathematical and analytical operations to 
be carried out. The Lotus Macintosh Product offers a spreadsheet as one of its 
integrated applications. MicroPian and Microsoft Multiplan are examples of spreadsheet 
programs that are available for the Macintosh. Spreadsheet programs are easy to 
learn and easy to use. They are a necessity for a business and are extremely useful in 
the home. They are extremely verstile and flexible. See lack 2, MicroPian, Lotus 
Macintosh Product, Microsoft Multiplan. 

SQ 5 See PRO Series. 

SQR A Microsoft BASIC statement, which returns the square root of <X>. The format 
is: 

<X> must be greater than 0. 

Square Root See SQR(x). 

Stand-alone A device which will operate by itself, requiring no other equipment. 

Starcross• An interactive text adventure game which takes place in outer space. 
lnfocom. Inc. 
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Start or Execute To cause a program or batch file to start functioning or to Run. 

Start-bit A bit indicating the beginning of asynchronous serial transmission. See 
Stop-bit. 

Starting a New Program To start a new program type: 

NEW 

This completely erases all lines now in Microsoft BASIC's memory. If it is something 
you want to keep and have not already stored on disk. SAVE it first. If you do not 
erase the program in memory before starting on another, you will usually wind up 
with an unusable combination of lines from your old and new programs. 

Starting a Program after a Pause Pauses may be delays written into a program. They 
may also be caused by using a key combination such as Command-( to interrupt a 
program's execution, or by pressing the Interrupt key on the lower left-hand side of 
the Macintosh. If a program has been interrupted in any of these fashions, it may be 
restarted by using the Continue command option from the Control menu on the 
menu bar. Another method is to enter CONT in the Command window followed by 
pressing the Return key. 

Startup Disk A disk that contains the information required to start the computer 
system. The first disk inserted into a Macintosh disk drive should be a startup disk, 
which may also contain one or more applications and a number of files. A startup 
disk always contains all of the system files originally in the the System Folder. The 
documents included in this folder should be System, Finder, lmageWriter and 
Printer. At times there will be other files in a System Folder, including Scrapbook 
file, Clipboard file, Note Pad file, Fonts and possibly other files. When a startup disk 
is booted, the System and the Finder are copied into the computer's memory. About 
half of the space on a 400K disk is taken up by System files. See Finder, System 
Folder. 

Statement A string of characters which is a syntactically complete instruction with 
respect to a high-level language translator, such as BASIC. 

Static Memory MOS memory which uses a flip-flop as a storage element. It does not 
need to be refreshed, does not require a clock, and does not lose its contents as long 
as power is applied. 

Static RAM RAM memory circuits which retain their contents as long as power is 
applied. 

Statistical Software See Telofacts 2. 

Status The present condition of a device, usually indicated by flag flip-flops in 
special registers. See Flag. 

Stepper Motor A mechanical device which rotates by a fixed amount each time it is 
pulsed. Often used in disk drives. 

Stock Market Software Dow Jones Market Manager, Dow Jones Spreadsheet Link. 
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STOP A Microsoft BASIC statement which terminates program execution and 
returns to command level. The format is: 

STOP 

You may use STOP statements anywhere in a program to stop execution. When 
Microsoft BASIC sees a STOP statement, it displays the message: 

Break in <Xxxxx> 

where <xxxxx> is the line number where the STOP occurred. 
STOP statements do not close files, as do END statements. Microsoft BASIC will 

always return you to command level following execution of a STOP statement. By 
using the CONT command you can resume execution of the program. See CONT. 

The Stop command may also be exercised from the Control menu on the menu bar 
of the Microsoft BASIC screen display. 

Stop a Microsoft BASIC Program See STOP, END. 

Stop and Terminate Current Function To end, terminate or break current function 
in any program at any time, press the Command key and the C key together. 
Another option is to press the Reset button on the programmer's switch. 

Stop-bit A bit indicating the end of asynchronous serial transmission. 

Stopping System Operation System operation can be interrupted by pressing the 
Interrupt key on the left-hand side of the Macintosh. It can be restarted by using the 
RUN or CONT commands. System operation can also be stopped by pressing the 
Reset key on the lower left-hand side of the Macintosh, which clears everything out 
of memory and restarts the system as if it had been turned off. Both the Interrupt key 
and the Reset key are on the Programmer's Switch that may be installed by the user 
in the vent slots on the lower rear of the left-hand side of the computer. See 
Programmer's Switch, Interrupt Reset Switch. 

Storage A synonym for memory. 

STR$ A Microsoft BASIC function which returns a string representation of the 
numeric value in <X>. The format is: 

stringvariable = STR$(<x>) 

<X> is any numeric expression. 
When <X> is positive, the string returned by STR$ contains a leading blank (the 

space reserved for the plus sign). 

STRING$ A Microsoft BASIC function which gives a string of length <n> whose 
characters all have ASCII code <m> or the first character of <X$>. The formats are: 

stringvariable = STRING$(<n,m>) 
stringvariable = STRING$(<n>,<x$>) 

m,m> must be in the range 0 to 25.5. 
<x$> can be any string expression. 
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String An ordered sequence of data items, such as characters. For example, the 
word "string" is a string of six characters. See Character String. 

String, Convert from Number See MKI$, MKSS, MKD$. 

String, Convert to Number See CVI, CVS, CVD. 

String Handling The ability of a programming language to operate on strings of 
characters. 

String, Left Justify See LSET. 

String, Length of See LEN. 

String, Numeric Value of See VAL. 

String, Right Justify See RSET. 

String Variable In Microsoft BASIC string variables must end in $ or start with a 
series of letters specified in a DEFSTR statement. String variable names (for characters) 
must start with a letter, can have up to 32,767 characters, and must not use reserved 
words (IF, ON, THEN, COlO, etc.) or a reserved word followed by a type declaration 
character ($,%,?,!,#). String variables can hold 0 to 255 alphabetic, numeric or 
special characters. See Reserved Words for complete list. See also Variable Names, 
DEFSTR. 

Structured Language A computer language designed to aid or enforce structured 
programming. Control structures such as IF ... THEN, ELSE, DO, WHILE, CASE and 
REPEAT, UNTIL, together with provisions for declaring logically separate program 
modules such as procedures, and limiting the scope of variables all lend a modular 
structure to programs. Unconditional control transfer statements (GOTOS) are 
often left unimplemented. Popular structured languages are Pascal, ALGOL and C. 

Structured Programming A set of techniques designed to increase the reliability and 
comprehensibility of programs by increasing programmer discipline. Structured 
programming involves precise problem specification, top-down or stepwise pro
gram design and block-structured or modular programs. 

Style Menu MacWrite uses a pull-down menu on the menu bar called the "Style 
menu" to select the style of text to be printed in a MacWrite document. The text 
styles available are Plain Text, Bold, Italic, Underline, Outline, Shadow, Superscript 
and Subscript. These options may either be selected from the Style menu or by 
pressing the Command key in conjunction with another key. Both the menu and the 
Command key sequences for MacWrite are illustrated below. MacPaint also has a 
Style menu, which serves the same purpose except that there are fewer choices in 
the Mac Paint menu. The Mac Paint Style menu does not include the Superscript and 
Subscript options. See Menu Bar, Pull-down Menu. 

Subdirectory A file that lists the names of other files, and is displayed in a disk 
directory rather than the name of each file. This system allows files to be classified 
together to save space in a disk directory. The Empty Folder on the Macintosh 
Finder's Directory window is the same thing as a subdirectory when the icons of a 
number of files have been dragged into the Folder and irectory window is the same 
thing as a subdirectory when the icons of a number of files have been dragged into 
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the Folder and irectory window is the same thing as a subdirectory when the icons of 
a number of files have been dragged into the Folder and the Folder has been given a 
name. See Directory, Folder, Finder. 

Fig. 59 The Style Menu from MacWrite. 
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Subroutine A program segment identified by name and often bracketed by a 
subroutine and a Return statement. Execution is transferred to a subroutine when a 
subroutine ca ll occurs. Subroutines improve program modularity and save memory 
space at a minimal cost in the overhead required to process the call/return se
quence. See GOSUB and RETURN, CALL. 

Subroutine, Passing Variables to a Passing parameters (also called arguments or 
data) makes information from one process or program available to another process 
or program. Sim ilar to a football pass where one or more bytes of data replaces the 
football , and the receiver is a program. The sender may be a program or a person 
typing the data onto a command line to be passed to a program. The most common 
example would be a Microsoft BASIC program passing variables to a subroutine. 

Supplies See Accessories. 

Support Chips All the components beyond the main device requi red for complete 
system operation. 

Suspend Suspend is a command that is used to interrupt a program that is running in 
Microsoft BASIC. This command is selected from the Contro l menu. A program that 
has been suspended may be restarted usi ng the Continue command from the 
Control menu or by pressi ng any key on the keyboard. 
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Suspended• An interactive text adventure game that pits the player against the 
program in the computer, involving a cryogenic nightmare. lnfocom, Inc. 

SWAP A Microsoft BASIC statement which exchanges· the values of two variables. 
The format is: 

SWAP <variable1 >,<variable2> 

<variable1> and <variable2> are the names of two variables or array elements. 
Any type variable may be exchanged (integer, single-precision, string), but the 

two variables must agree with the variable type defined or a "Type mismatch'' error 
will result. 

Symbol Table A table constructed by an assembler or compiler to associate symbolic 
names with actual addresses or values. 

Symbolic Describes the use of characters or character strings in a defined syntax to 
stand for machine-related entities such as instructions or data. 

Synchronous System A system in which all events are synchronized with a common 
clock pulse. 

Syntax The rules governing proper construction of statements in a language. For 
programs, the rules include spelling and placement of keywords and data names, 
and number, type and order of arguments. Punctuation rules are also usually part of 
syntax. 

Syntax Check A check, performed by a program or person, to ensure that one or 
more statements in a programming language complies with all syntax rules of the 
language. A program may pass all syntax checks and still give an error message or 
erroneous results due to logic, data or program-flow problems. 

System Any aggregate of two or more interconnected electronic components. See 
Computer System. System can also refer to a group of programs which accomplish 
some function (database management system), a group of interconnected devices 
(turn the system off) or both taken together (a total accounting system). 

SYSTEM To return to the Desktop from Microsoft BASIC enter: 

SYSTEM 

System Clock An internal clock built into a computer sytsem, used to log access 
time to programs and to control activities within the computer. The Macintosh has a 
battery- operated clock/calendar. The time and date are read into the Macintosh 
RAM, and may be displayed on the screen by accessing Alarm Clock from the Apple 
menu. The date will not be visible until the switch on the right-hand side of the date 
is clicked. See Alarm Clock, Apple Menu. 

System Crashes A system crash occurs when a program freezes up or the system 
Jocks up and leaves no way out for the user except Resetting the system or turning 
the computer off and back on again. On the Macintosh, an alert box might be 
displayed, informing the user that a fatal error has occurred and offering the option 
of restarting the system from the alert box or shutting down. System crashes are 
generally caused by software or Finder problems. See Alert Box, Reset, System 
Reset. 



284 • System Date 

System Date See System Clock, Alarm Clock. 

System Disk Used to contain system files and other system software or utility-type 
programs. See Data Disk. A Macintosh System disk contains at least Finder, System, 
lmageWriter and Printer. See Startup Disk. 

System File A system file is a file that normally is included in the System Folder on 
the Macintosh. System files are necessary to allow the Macintosh to use disk drives, 
printers and other peripherals. For a further discussion of system files, see System 
Folder. 

System Folder The System Folder is a folder that must be present on a Macintosh 
startup disk. This folder must contain at least the Finder and the System. It usually 
contains a number of other System files. The System files that are usually included in 
a System Folder are Fonts, lmageWriter, Clipboard file, Note Pad file, and Scrapbook 
file. The System file contains all of the subroutines that are loaded into memory or 
that are kept on disk for reference in making the Macintosh system work. The Finder 
is the program that presents and manages the Desktop display. It is the Macintosh 
file handling and disk handling program. The lmageWriter file is the printer driver 
for the lmageWriter printer. It may be replaced by another driver for another printer 
as these printers become available for use with the Macintosh. The Clipboard file 
contains information that has been stored in the Clipboard by the user if there is 
enough room on the disk to save this file. If there is not enough room, the file is not 
saved. The Note Pad file contains any information saved in the Note Pad by the user. 
The Scrapbook file contains any data stored in the Scrapbook by the user. Pictures, 
text and numbers may be moved to the Clipboard and Scrapbook by using the Cut 
command or Copy command from the Edit menu. They may be moved from the 
Scrapbook or Clipboard by using the Paste command. 

System Font The font displayed in the title bar Finder's Directory window when this 
window is displayed on the Desktop. This font is identified as Font number 0 on a 
font list. See Fonts, Font Manager. 

System Reset A system reset occurs when a computer is fooled into thinking that it 
was turned off and turned on again. This is accomplished by pressing the Reset key 
on the Macintosh. See Reset. 

System Time See Set the Time. 

Systems Software System programs (system software) perform functions necessary 
to the use of the computer yet not directly relevant to solving a particular applications 
problem. An example of this would be the disk operating system used by the 
computer, various utilities such as sort, copy or programs which facilitate the use of 
the program and may be used by application software, but do not directly produce 
useful results (keeping track of your bank balance, allowing you to play a game, 
produce a letter. etc.). Computer programs (software) are divided into two major 
categories·. Application software consists of programs that actually perform some 
useful function directly related to what he wants done. Examples are word process
ing programs that produce letters, reports, etc., database programs that allow the 
user to manage his inventory, appointments and various other items of data. 
accounting programs, educational programs and even games, etc. 
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TAB A Microsoft BASIC function which tabulates to position <m. The format is: 

PRINT T AB(<m) 

<n> must be in the range 1 to 255. 
If the current print position is already past space <n>, then TAB goes to position <m 

on the next line. Space 1 is the leftmost position. The rightmost position is the 
defined WIDTH. You are restricted to using TAB with PRINT. LPRINT and PRINT# 
statements. 

If the TAB function is at the end of the list of data items, Microsoft BASIC does not 
add a carriage return, as though the TAB function had an implied semicolon after it. 

Tab Key The leftmost key on the second row from the top on the Macintosh 
keyboard. This key is used when text is being entered to move the insertion point to 
the next tab stop. It is particularly useful in word processors such as MacWrite to 
carry out columnar functions. It is also used in dialog boxes with several buttons or 
input rectangles to move from one response item to the next. See Insertion Point, 
Dialog Box. 

Tab Markers Tab markers are used in the MacWrite rulers to indicate the current 
position of each tab in use. There are two types of tab markers in MacWrite. The first 
is the conventional tab marker, used to mark the starting point of text entry in a 
document. The second type is a decimal tab marker, which sets up columns of 
numbers to align the decimal point of the column on this tab. Tabs are set by 
dragging a tab icon or a decimal tab icon from its tab well in the lower left section of 
a ruler and placing the tab at the desired position on the ruler line. Once the tab 
marker is in its proper position, the mouse button may be released. 

Tab Wells Tab wells, located on the ruler in MacWrite, are for the decimal tab 
marker and the regular tab marker, which must be dragged from the wells to the 
desired position on the ruler line. See Ruler. 

Table Look-up Method of converting one variable to a corresponding value or 
verifying its accuracy by searching a list or table of entries for the known keyword or 
value. The corresponding values may then be extracted from corresponding posi
tions in the table, similar to looking up a name in the phone book to find the 
corresponding number. 

Tables Tables can be composed easily in MacWrite by setting a tab marker at the 
beginning of each column of the table, in the case of text, and at the decimal 
location of a column of numbers, in the case of numeric tables. As each subsequent 
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tabular entry is made, a press of the Tab key places the insertion point at the next 
entry position . See Tab Key, Tab Markers. 
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Fig. T1 A MacWrite ruler w ith a decimal tao and a regular tab on thf' ruler line. The mouse 
pointer lies between the dec imal tao well and the regular tab well . 

TAN A Microsoft BAS IC function which gives the trigonometric tangent of <X>. The 
format is : 

variable= TAN(<x>) 

<X> is the angle in radians. Mult iply by Pl/180 to convert degrees to raciians. PI = 
3.141593. TAN is calculated in single precision. 

Tape, Magnetic An inexpensive mass storage medium with the disadvantage o f 
requiring sequential access. It is convenient for large f iles or archival storage, it is 
often the only external sto rage on very low-priced systems and is used as a backup 
for disk on larger systems. 

Target Drive The disk drive to wh ich information/ data goes. Source cirivP is the disk 
drive from whi ch info rmation/ data comes. 

Tax Packages See Personal Tax Planner. 

Telephone Directory Software See Habadex, MAGICphone. 

Telofacts 2• A program used to gather and analyze informat ion. It may be used to 
design questionnaires that gather information to input into a database and to 



The Quest • 287 

analyze it for marketing information, opinion polls and similar information. dilithium 
Software. 

Template Disk No.1 For Multiplan• Four worksheets for use by Multiplan, a family 
budget template and a check book register are included. rds labs. 

Terminal Emulators See MacTerminal. 

Terminal Mode A mode of operation for a general purpose computer so that its CRT 
and/or printer can be used as a terminal for another computer. Also called terminal 
emulation. 

Terminate Current Function The current function in a Microsoft BASIC program 
can be terminated by selecting Stop from the Control menu on the menu bar, or by 
pressing Command-C. or as a last resort, by pressing the Reset button on the side of 
the computer. See Reset, Menu Bar, Control Menu. 

Test Data, Running A programmer must ensure that a program will correctly pro
cess all of the types of data it is intended for. Samples of the data are prepared (test 
data) and the program is executed using this data (a test run). The program's outputs 
(reports, screen displays, files, etc.) are then verified to be as specified. An error in 
the processing logic of a program is called a "bug," hence the terms "debug" and 
"bug- free." 

Test Sites, Alpha and Beta See Alpha Test Site vs Beta Test Site. 

Text Editor An editor program specialized for text files, it manipulates ASCII characters 
such as letters, punctuation marks, etc. The Microsoft BASIC editor and word 
processing programs are text editors. Their basic function is to create and change 
text data such as a letter, report, program or book. Microsoft BASIC is edited on the 
Macintosh by listing the program, selecting lines from the List window and editing 
the lines in the Command window. 

Nontext editors usually display and modify a byte of storage as either two 
hexadecimal digits or a three-digit numeric ASCII value. See Editor, Edit. 

TextEdit A program residing in the Macintosh ROM, it is a basic text entry and 
editing program. TextEdit is one of the User Interface Toolbox programs. See User 
Interface Toolbox, ROM. 

Text File A file containing character data, letters, numbers or special characters. 
Most data and programs that you write will be in text files. See Data File. 

Text Mode Most graphics programs not only allow images, shapes, and pictures to 
be drawn by the user. they also allow text to be used along with graphics. In most 
such programs, the user must switch from the routines that generate graphics to the 
routines that generate text. When the latter routines are being used, the program is 
said to be in the Text mode. The Text mode is accessed in MacPaint by clicking the 
large letter A on the drawing tool palette on the left-hand side of the MacPaint 
screen display. 

The Coveted Mirror* The Coveted Mirror is a fantasy adventure game that combines 
graphics, animation and text. Penguin Software. In UK: Softsel. 

The Quest• See Quest. 
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Thimble Printer Prints fully formed characters with a thimble, which is like a 
daisy-wheel element with the type petals bPnt up 90 degrees to form a cup or 
thimble shape. 

ThinkTank 128* A tool for producing outlines which is particularly suited to putting 
complex thoughts and plans into outline form and then rearranging them as required. 
Thoughts and ideas may be classified under headers. Parts of an outline may be 
hidden or revealed by the user. Outlines may be added to or easily edited. Various 
levels of each outline may be displayed as required rather than using all levels or 
rewriting an outline several times to present each level. The cut and paste capabilities 
ot the Macintosh are fully utilized by this program. It is also heavily mouse
dependent. Living Videotext, Inc. In UK: Rapid Recall Ltd. 

Time See Set the Time. 

TIME$ In Microsoft BASIC TIME$ is both a function and a command statement. The 
syntax of the function is: 

variable = TIME$ 

This function returns the current time from the Macintosh's clock/calendar in an 
eight-character string in the hh-mm·ss format. hh (hours) is expressed in digits from 
00 to 23. mm (minutes) is expressed in digits from 00 to 59. ss (seconds) is expressed 
in digits from 00 to 59. The TIME$ command statement is used to set the current time 
on the Macintosh's internal clock/calendar. Its syntax is: 

TIME$ = <string-exp> 

<string-exp> must be in one of the following formats: 

hh 

hh-mm 

hh-mm-ss 

in two digits from 00 to23, sets the hour while it defaults the 
minutes and seconds to zero. 

sets the hours with two digits between 00 and 23. It sets the minutes 
with two digits from 00 to 59. It leaves seconds at a default 
value of zero. 

sets the hours, minutes and seconds. The hours and minutes are 
set as outlined above. The seconds are set with two digits from 00 
to 59 

TIMER A Microsoft BASIC function that retrieves the number of seconds that have 
elapsed since midnight. This function is used frequently to generate random numbers 
in the RANDOMIZE statement. The syntax for this function is: 

variable = TIMER 

It must be included in a program line. 

Title Bar The top section of a window, which includes the window's title and usually 
a close box. A window may be dragged from one place to another on the screen 
display by placing the mouse pointer on the title bar, holding down the mouse 
button, dragging the window to a new location and releasing the mouse button. See 
Window, Close Box, Mouse Button, Dragging. 
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Title Page Option One of the options on thP MacWrite Format menu. When 
selected, the user may choose whether or not to show the st;mdard header on the 
front page of the MacWrite document. 

Toolbox Support Microsoft BASIC makes use of support from the Macintosh User 
Interface Toolbox. A Microsoft BASIC programmer may access Macintosh ROM 
routines by calling them by name from a program line. For instance, CALL lnitCursor 
would access Quickdraw and set the current cursor to be used by the program to the 
arrow cursor with the arrow facing north- northwest. It also sets the cursor level to 
zero, making the cursor visible. This is one example of how Microsoft BASIC 
accesses the ROM routines. For more detailed discussions, consult the Microsoft 
BASIC Manual and other technical works. See User Interface Toolbox. Quickdraw, 
ROM. 

Toronto One of the fonts available on the first release of MacWrite and MacPaint. 
This font was moved from MacPaint and MacWrite to a font file on the Macintosh 
System disk to conserve space. You may wish to move it onto your MacWrite/MacPaint 
disk with Font Mover. 

This is an ezample of the Toronto 0 point plain text font.. 
This is an example of the Toronto 12 point plain text font. 
This Is an example of the Toronto 12 point bold fon 
This is an example of Toront.o 14 point. bold. 

Th111l11 Toronto 11 point outline. 

Thll II Taranto 24 poiD' 
Fig. T2 An example of Toronto from MacWrite. 

Totem Pack• A nylon carrying case for the Macintosh. It may be carried as a 
backpack or a tote bag and is fully padded. There is space for the Macintosh, the 
keyboard, the mouse, an external disk drive, disks and cables. Braun-Cooper. 

Track One circle of data around the surface of a disk. The Macintosh disk has 80 
tracks, each further subdivided into sectors of data. See Sector. 

Trade*Pius• This is an investors' service that quotes sales price and other stock 
market data. It connects the user to the stock market via the Trade* Plus network and 
allows all stock transactions to be carried out. Data can be transferred into Multiplan 
worksheets. Three portfolios can be tracked by the software. The system is open 24 
hours a day, 7 days a week. Trade*Pius. 

Transistor An electronic device which uses one electrical signal to influence another. 
The two main uses of transistors are as amplifiers and switches. Used as an amplifier, 
a transistor uses the changes in a small signal to make large changes in a large signal. 
Used as a switch, the transistor opens or closes a circuit depending on the state of a 
controlling signal. 
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Transylvania* Transylvania is an adventure game that combines graphics, text and 
mouse activity. The mouse is used to select directions of movement in the game. 
Text entries are made to accomplish things during the game. Pictures are displayed 
in the upper left quadrant of the screen. This game places the player in a fantasy 
realm where he must rescue a maiden before the time runs out. He encounters a 
werewolf, a vampire and other creatures. Each of the objects that the player 
discovers in the game is useful in solving a part of the puzzle. Penguin Software. 
In UK: Softsel. 

Trash The name given to Trash Can icon on the Macintosh Desktop. When any icon 
is dragged from the Desktop into the Trash, it will be erased from a disk when the 
Empty Trash command is selected from the Special menu, or when the disk is 
ejected. The Trash icon may be opened like other icons by double-clicking it. Once 
opened, a window will bedisplayed.lcons may be moved from the Directory display 
on the Desktop into this window or they may be moved back out at any time before 
the Trash is emptied or the disk is ejected. See Window, Double-clicking, Special 
Menu, Desktop. 

Tree Structure A collection of data organized so that each item is linked to one or 
more other items, creating a spreading network of linkages, analogous to the 
branches of a tree. Genealogical data provides the classical model. Each person has 
exactly one mother, but may have zero or more daughters. An example might be the 
parts list of an airplane. The main entry is for the entire airplane. It is linked to the 
major components, such as wings, fuselage, tail. Wings, in turn, are linked to their 
smaller components, such as flaps, engine supports, engines, etc. Each of these can 
be further linked to smaller and smaller subassemblies, until individual parts such as 
nuts and bolts are reached. 

TROFF/TRON One of the tools available in Microsoft BASIC for debugging pro
grams is the Trace function. When trace is on, each program line is listed as the 
program runs. Trace may be turned on and turned off from the Control menu on the 
menu bar or with TRON, and turned off with TROFF from within a program line. The 
syntax for these statements is: 

TRON 
TROFF 

Troubleshooting The process of determining what has caused a malfunction or 
other problem with a computer system. It is similar to a doctor starting with the 
symptoms to determine what ails a patient. He examines the patient more and more 
closely, making note of each symptom he encounters. Then he checks his medical 
books and other sources based on the symptoms encountered until he finds a 
number of things that exhibit the symptoms. Further investigation finally eliminates 
everything except the cause of the problem. If you encounter a problem with the use 
of your Macintosh, write down what has occurred. Note what has happened to the 
screen display, and note any alert boxes with error IDs that may have been displayed. 
Check pages 135 through 139 of your Macintosh Manual, which contain very basic 
information about troubleshooting and advice on what to do. 

Truth Table A table showing the logical value (true or false) of a compound logical 
expression, based on the logical value of the simple components of the expression. 
Example: 
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A B AORB 

T T T 
T F T 
F T T 
F F F 

This table reflects the definition of OR: A orB is true if and only if either A orB or 
both are true. 

TTL Transistor-Transistor Logic. Logic circuits based on bipolar devices, usually 
low-power Schottky circuits. These are fast but expensive because gold-plated 
Schottky diodes are required on every TTL bus input. 

Turtle See Macintosh Logo. 

Two-pass A two-pass operation or program has to manipulate its data twice. It 
partially accomplishes its purpose on the first pass through the data. The operation 
is completed in the second pass through the data. Some processes can only be 
accomplished in two passes, while others are organized as a two- pass operation 
because inadequate resources are available to do everything at once. RAM memory 
and disk space are the two most frequent limiting resources. 

Type Declaration Character or Statement See BASIC, Variable Names. 

Types of Variable Names In Microsoft BASIC. See BASIC, Variable Names. 

Typing Tutor 111• This is both a game and a typing tutor. The typing tutor consists of 
lessons that improve typing skills. These lessons include practice paragraphs, key 
combination lessons and speed drills. Performance graphs are maintained. The 
game portion is an arcade game called Letter Invaders. Simon and Schuster Electronic 
Publishing. In UK: Softsel. 
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U ASCII 85, HEX 55. u ASCII 117, HEX 75. 

U Underflow. Also a lower-case u is sometimes used to represent the Greek letter 
mu meaning micro. 

UCSD P-System An integrated program development system created by Kenneth 
Bowles at the University of California at San Diego. It includes an operating system, 
a full-screen text editor and compilers for Pascal, FORTRAN and Microsoft BASIC. 
Although originally developed to teach programming, it has been enhanced to 
provide the tools necessary for large-scale programming projects. 

The Prefers to a Pseudocomputer. The system compilers produce a very compact 
P-code, which runs on a pseudocomputer. An interpreter converts the P-code into 
acceptable code for the actual computer on which the program is run, making the 
system very portable. Only a very small interpreter need be written for each 
computer on which the P-System runs. The P-System now works on over 50 different 
computers, with new ones being added all the time. 

The system is highly interactive and consists of five main parts: 

1) The full-screen Editor allows you to write both programs and text. It is easy to learn 
and to use. There is also an Advanced Screen Editor with editing capabilities equal to 
sophisticated word processors. 
2) The System Compilers convert the source code which you write into P-code. The 
Pascal Compiler is integrated with the Editor. When a syntax error occurs, you can 
return to the Editor at exactly the point where the error was detected. The Compiler 
error messages are accurate and informative. 
3) The System Filer allows you to format disks, and to list, copy, rename and remove 
files. File names may be up to sixteen characters long. The Filer will also check for 
errors on the disk and mark any bad areas located. 
4) The System Linker will automatically link together separately compiled units of 
P-code. This allows you to build up libraries of useful procedures which can then be 
used by many different programs. 
5) Finally, the Interpreter automatically converts the P-code to executable code, 
when the program is run. 

The system is relatively easy to learn, and since it is highly integrated, is very easy 
to use. Although expensive, it is useful for beginners as well as professional programmers. 
There is a full range of application programs available which run under the P
System, including spreadsheets, word processors, accounting programs and a host 
of others. Several well known programs were developed using the P-System, including 
VisiSchedule from VisiCorp and MBA from Context. 

The excellent documentation is in five manuals, from the first volume Beginner's 
Guide to the last System Architecture. Many examples of useful programs are 
provided, along with a tutorial in Pascal programming. 

There is a version of Pascal available for the Macintosh that closely resembles 
UCSD Pascal. See Pascal. 
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Underline One of the options available from the Style menu on the menu bar of 
MacWrite and MacPaint. When selected, the text that follows until it is unselected 
will be underlined. See Style Menu, Menu Bar. 

Understanding the Macintosh Computer• By Rick Dayton. A conversational 
book about the Macintosh hardware and hardware application. It explains how the 
Macintosh works. Reston. 

Undo Option Available in many Macintosh applications from the Edit menu on the 
menu bar, and allows the user to cancel the last action carried out. For example, if a 
crooked line is drawn in MacPaint or a filled rectangle is placed in the wrong 
position on the screen, the Undo command will erase the line or the rectangle and 
leave the rest of the screen intact. The Undo command will function until the mouse 
button has been clicked for the first time after an action has been taken or, until the 
Return key has been pres~ed. Undo is available in such applications as MacWrite, 
Mac Paint, Multiplan and others. The Undo Typing command in MacWrite accomplishes 
the same function as the Undo commands in other applications. Undo commands 
may be undone by using the Undo command again before clicking the mouse 
button or pressing Return. 

Undo Typing See Undo Option. 

Unix A mini- and microcomputer operating system developed by Bell Labs which 
features multiprogramming, a hierarchical file structure and numerous useful utilities. 
See XENIX. 

Untitled Document When a new document is generated by applications such as 
Mac Paint and MacWrite, the title bar for the document is displayed at the top of the 
document window as Untitled. When a document is saved for the first time, a dialog 
box is displayed on the screen, containing an input rectangle for the user to enter the 
document's name. Document names can have a length up to 63 characters but may 
not contain a colon. All other keyboard characters including spaces are allowed. 
Upper and lower case are also allowed. See Dialog Box, Document, Title Bar. 

Unwanted Returns When using a word processor such as MacWrite to edit a block 
of text, you may find that half of a line is displayed above the current insertion point. 
As you add more text, the half-line remains above the text you have entered. It is 
likely that a Return was used at the end of the half-line for some reason. The best way 
to remedy this situation is to move the 1-beam pointer back to the insertion point, 
click the mouse button, press the Backspace key one time and press the space bar 
one time. This will clear the Return character and should merge the two lines 
together. See Insertion Point, 1-beam, Clicking. 

uP Microprocessor. The u represents the Greek letter mu, which is not available in 
most character sets. 

Up Arrow j Key Pressing the up arrow will move the cursor up one line in the 
same position on the screen it previously occupied. This function is commonly 
used in text entry and in entering commands. Although these are the recommended 
values, this key may be defined differently by various application programs, and 
is only available from the numeric keypad accessory. 

Upward Compatible Indicates that programs developed for one version of a 
programming language, operating system, application software package or com-
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puter wi II work without alterations on an expanded, more powerfu I version of the 
same language, system or package. 

us Microsecond, one-millionth of a second. 

USASCII Same as ASCII. See ASCII. 

User A person who owns or uses a computer. 

User Friendly For programs you write, the operator will often be you. But if others 
will ever use your program, you need to give some thought to issues like giving clear 
prompts for every item of input data, freezing the screen long enough for them to 
read or act on the information displayed, providing clear error messages if anything 
is entered incorrectly or error situations arise, etc. This is often referred to as human 
engineering, making the program easy to use as well as technically correct. Another 
term for this side of programming is making the program user friendly. 

Several other guidelines exist for writing user-friendly programs. If a complex 
series of data items has been typed in but some entries turn out to be invalid, the user 
should be able to reenter only the bad items. Error messages should indicate not only 
that an entry is invalid, but also in just what way it is invalid and, if at all possible, 
some hints as to how to correct it (such as a list of possible correct values). 

User Group A group or club focused on an aspect of computers. Some clubs direct 
their attention to one particular computer. There are many Macintosh User Groups, 
some of which are listed below. Other groups focus on a language (FORTH Users 
Group, Pascal Users Group, etc.), on an operating system (CP/M, etc.), on an area of 
application (accounting, education, science, graphics. etc.), or other aspects of 
computing. Many large user groups have Special Interest Groups (SIGs) that specialize 
in a single type of computer. such as the Macintosh, or specialize in a particular 
application, such as spreadsheets. Many magazines on computing carry lists of 
clubs/groups and report on their activities. 

User groups provide a valuable opportunity to get and give advice on Macintosh 
hardware, software and applications. Often you can talk to someone who used a 
product you are considering buying. User group newsletters also offer useful information. 
If you need a programmer or consultant, you may meet or hear about a good one at a 
user group meeting. 

Macintosh User Groups 

Association of Apple 32 Users 
c/o Sid Hymes 
P.O. Box 634 
Santa Clara, CA, 94032 
415-392-2800 

Boston Computer Society 
Macintosh Users Group 
c/o Jack Hodgson 
One Center Plaza 
Boston, MA, 02108 
617-354-7899 



British Apple Systems User Group 
PO Box 174 
Watford, England 
WD2 6NF 
0344-483713 

Club Mac 
c/o Steve Elliott 
735 Walnut 
Boulder, CO, 80302 
303-449-6917 

International Apple Core* 
908 George Street 
Santa Clara, CA, 95050 

MAC User Group 
c/o Betsy Radner 
1077 Vallejo Strett 
San Francisco, CA, 94133 
415-441-8648 

Mid Columbia MAC 
% Edward Taylor 
(Alpha Compute Ctr) 
1341 D. George Washington Way 
Richland, WA 99352 
509-943-5608 

New York Mac Users' Group 
Box 6686 
Yorkville Station, NY, 10128 
212-535-1943 

San Diego Macintosh Users' Group 
c/o Charlie Jackson 
Box 12561 
La Jolla, CA. 92037 
619-566-3939 

San Francisco Apple Core 
· Mac/Lisa User Group 

c/o Stan Guidera 
1515 Sloat Blvd. 
San Francisco, CA, 94132 
415-566-2342 
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*NOTE: Newly formed user groups may wish to contact the International Apple 
Core as it is maintaining records of Macintosh user groups throughout the United 
States. 

User Interface The method used to communicate events, results, alternatives and 
questions from the computer to the user, and to accept commands and instructions 
from the user. The most common user interfaces are menus that list alternatives.and 
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include a data entry area where the user indicates his choice. User interfaces may 
also include Help screens that explain what is needed or what is occurring at a 
particular point in a program. The Macintosh and Macintosh applications use the 
User Interface Toolbox to implement its user interface. 

User Interface Toolbox A collection of more than 400 subroutines accessed by the 
programmer to carry on critical communication between the computer and its user. 
These subroutines are stored in the Macintosh ROM, and are arranged into units that 
carry out particular tasks. The most important Toolbox units are the Control 
Manager, the Desk Manager, Tlie Dialog Manager. the Event Manager, the Font 
Manager, the Menu Manager, QuickDraw, the Resource Manager. the Segment 
Loader. TextEdit, the Scrap Manager, the Toolbox Utilities and the Window Manager. 

The Control Manager is made up of about 26 subroutines, which create, manage 
and interpret Macintosh control features such as scroll bars. check boxes. close 
boxes and buttons. The Desk Manager is made up of about seven subroutines that 
handle the desk accessories. The Dialog Manager is made up of about 23 subroutines 
that create and interpret dialog boxes and alert boxes. The Event Manager is made 
up of about eleven subroutines used to interpret and keep track of keypresses. 
mouse button clicks, disk inserion and disk ejection. The Font Manager is made up 
of about five subroutines used to select fonts for QuickDraw and to tie a particular 
font to an application. QuickDraw is made of about 130 subroutines used to draw 
images on screen. It is the heart of the Macintosh. The Resource Manager is made up 
of about 34 subroutines used to give an application access to data structures stored 
in resource files. These data structures include the graphics images and the warning 
messages that appear in alert boxes. The Segment Loader is made up of about six 
subroutines that govern the loading and saving of parts of programs up to 32K in 
length. These routines make memory use more efficient by ensuring that only the 
portions of programs in use are in memory. The Scrap Manager is made up of about 
six subroutines that handle Clipboard functions. TextEdit is made up of about 21 
subroutines used to format and edit text in applications. Toolbox utilities are made 
up of about 24 subroutines used to perform fixed-point arithmetic, bit manipulation. 
byte manipulation and string manipulation and also handle the loading and plotting 
of icons. The Window Manager is made up of about 43 subroutines used to create 
and manipulate windows. The User Interface Toolbox makes Macintosh applications 
and the Macintosh a wonderful experience to use. 

Using Mac Write and Mac Paint• By Tim Field. A complete explanation of MacWrite 
and MacPaint, which leads the user through the full potential of both applications. 
The book is full of ideas and examples. Osborne/McGraw-Hill. 

Using Your Apple Macintosh: Beginning Basic and Applications• By Richard 
Swadley and Joseph Wikert. This book describes how to operate the Macintosh and 
introduces BASIC programming. It discusses the features of the Macintosh in depth 
and explains what the Macintosh can do for the user. The book may be purchased 
with or without the disk. Prentice-Hall. 

Using &Programming the Macintosh* By Frederick Holtz. This book describes 
the use of the Macintosh for the novice. It explains programming in Microsoft 
BASIC and book includes 32 ready to run programs. Tab Books. Inc. 

Utilities The software used for routine tasks. Utilities an-· dPsignPd to facilitat<• or 
aid the operation and use of the computerfor a number oi difierPnt applications and 
uses. Examples of utilities are an editor. a sort. a debugger and a iiiP handl(•r. Most oi 
the current utilities are available only to software developPrs irorn AppiP ComputPr. 
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and include programs to edit icons, resources, windows, fonts and other aspects of 
the User Interface Toolbox. Other utilities include memory dump programs, to 
examine the contents of various memory locations and disk dump programs, or to 
view the contents of specific tracks on a disk. The availablity of such utilities will 
improve as these tools are disseminated through the developer community by Apple 
and, as they are eventually released commercially for the hobbyist, either by Apple 
or by other independent developers. See Link Module, Mac. Transfer, Mac Works, 
Utilities for the Macintosh Computer. 

Utilities for the Macintosh Computer• A disk containing eight utility programs 
which run in Microsoft BASIC on the Macintosh. These programs include Typer, 
Dump, Remove, XRef, Lister, SetBaud, Rename, and Transfer. Typer displays ASCII 
files on the screen. It can scroll from left to right and page through text screen by 
screen. Dump is used to display the contents of any file on the screen. Both the Hex 
value and ACSII value of each character is shown. Remove allows files to be erased 
from disks without using the Trash Can. XRef will cross-reference the variables in a 
Microsoft BASIC program. Lister lists any ACSII file on a printer. Each page of the 
listing contains a header which includes the page number, the date, and the user's 
company name. SetBaud will set the baud rate for the COM1 1/0 port. Rename 
allows the user to renamP any file on a disk. Transfer can be used to transfer any file 
in ASCII format to the Macintosh via the COM1 port. Basic Business Software, Inc. 
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V ASCII 86, HEX 56. v ASCII118, HEX 76. 

VAL A Microsoft BASIC function which returns the numerical value of the begin
ning of string <x$>. The format is: 

variable = VAL(<x$>) 

<X$> is a string expression. 
The VAL function strips blanks, tabs, and line feeds from the argument string and 

selects numeric characters in order to determine the result. If the first characters of 
x$ are not numeric, then VAL(<x$>) will return 0. See STR$. Here is an example of this 
function: 

PRINT VAL ("52 CASES") 
52 
OK 

Variable A symbolically named entity which may assume an assigned value, or a 
number of values. 

Variable Names In Microsoft BASIC. See Variable Names. 

Variable, Type and Address See VARPTR$. 

VARPTR A Microsoft BASIC function which returns the address in memory of the 
variable or file control block. The formats are: 

variable = VARPTR(<variable>) 

<variable> is the name of a numeric or string variable or array element in your 
program. You must assign a value to <variable> prior to the call to VARPTR, or an 
"Illegal function call" error will result. 

The first format returns the address -of the first byte of data identified with 
<variable>. All simple variables should be assigned before calling VARPTR for an 
array, since addresses of arrays change whenever a new simple variable is assigned. 
The address returned will be a number between 0 and 16777215. 

VDT Video Display Terminal. The term used in the newspaper community for CRT. 

VDU Video Display Unit. The British term for CRT. 

Vector Display A CRT which moves the electron beam randomly to trace figures on 
the screen. Contrast this with a raster display, which sweeps the beam through a 
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fixed pattern, building up an image with a matrix of points. Vector displays are used 
in many arcade games. 

Fig. V1 This is a sample of the Venice font from MacWrite. 

Versions, Program and Software Programs and software packages are changed from 
time to time to correct errors or add new capabilities. To keep programs from being 
in a constant state of flux and to simplify distributing modified programs to users, a 
number of changes are made, tested and packaged as a new version or release of the 
program. 

Versions or releases are typically numbered as follows: 1.0 for the first version, 1.1 
for the first minor revision, 1.2 for the second minor revision, etc. When a major 
change or large number of minor changes have been made, a new number may be 
assigned (Version 2.0). Version numbers help programmers support a program by 
letting them know with which version the user has encountered problems. Numbering 
also helps users know which changes are effective in the version they possess. 

Versions, Upward Compatible Upward compatible indicates that programs developed 
for one version of a programming language, operating system, application software 
package or computer will work without alterations on an expanded, more powerful 
version of the same language, system or package. 

Vertical Bar Cursor An 1-beam pointer is displayed on the Macintosh screen when 
text is being edited. It is displayed when the mouse pointer touches an icon name on 
the Desktop, when program lines are being edited in Macintosh BASIC, and when 
text is being inserted or edited in Mac Paint or in MacWrite. This pointer is used to 
locate the text insertion point in a document. When this point is located by moving 
the pointer to the selected insertion point, the mouse button is clicked. As soon as 
the mouse button has been clicked, a flashing vertical bar is displayed. This is the 
vertical bar cursor. It denotes the location where characters will be entered or 
deleted from a program line or document. It is also used to denote the insertion 
point and deletion of characters in the Note Pad. The vertical bar cursor will be 
displayed at any point where the mouse button is clicked when the 1-beam is present 
on the screen. 

Video-Digitizer• Used to capture an image, store it on the Macintosh and print it. It 
requires any home video camera to operate. Discrete Time Systems. 
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Video RAM A specific portion of the Macintosh RAM contains a map of the 
Macintosh screen display and takes up about 22K of space. Each pixel or screen 
location has been assigned a corresponding location in memory. This method is 
called "bit- mapped" video. 

Video Signal An electronic signal containing information specifying the location 
and brightness of each point on a CRT screen, along with timing signals to place the 
image properly on the screen. 

View Menu One of the pull-down menus available from the Finder. When a disk is 
first booted, the Desktop is displayed. If a disk icon is opened, a Directory window is 
displayed. The manner in which the Directory displays the contents of the disk is 
determined by the selection made from the View menu which offers the choice of 
viewing a disk directory by Icon, by Name, by Date, by Size and by Kind. Each file 
type on the Macintosh has a specific icon and must have a name. Each time a file is 
modified, the date and size of each file is recorded. The file Kind is also identified 
and recorded in the disk Directory. There are times when the user may wish to sort 
the Directory by one of these file characteristics and display the file according to 
one of these characteristics. The View menu is used to make this happen. See By 
Date, By Icon, By Kind, By Name, By Size. 

Virtual Memory The memory address space available to any process running on the 
processor. It may be larger than the physical memory. 

Volatile Storage Storage which loses its contents when power is removed. 

Volksmodem• This is a portable 300 baud modem, which offers full-duplex and 
half-duplex capability. It requires an additional cable called a "C" cable to be 
connected to the Macintosh. It may be operated with a nine volt battery and will 
supplement this with power from the phone line. Anchor Automation. 

Volumes The Macintosh Disk Operating System uses a particular method to direct 
the computer to a particular disk drive for saving or reading data. The internal disk 
drive is assigned the number 1. The external disk drive is assigned the number 2. 
Either drive is assumed to have the same name as the disk booted from that disk 
drive if numbers are not used to access the disk drive. The name or number is used to 
refer to a particular disk drive is called the "volume" or "volume name." When a 
SAVE command is given from BASIC, first supply the volume name (1, 2, Mac BASIC, 
or whatever applies), then enter a colon(:), then the file name of the file to be saved. 
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Wait State A microcycle or internal state entered by an MPU when a synchronizing 
signal is not present. It is used to synchronize a fast processor with a slower memory. 

Warm Boot The term "warm boot" describes the process of fooling the computer 
into thinking that its power has been turned off although power is still on. A warm 
boot is accomplished by pressing the Reset button on the Programmer's switch. 

WHILE ... WEND Microsoft BASIC statPrnents which execute a series of statements 
in a loop as long as a given condition is true. The format is: 

WHILE <expression> 

<loop statements> 

WEND 

<expression> is any numeric exprt>ssion. 
When <expression> is tru{' (not zero). <loop statements> are executed until the 

WEND statement is found. Microsoft BASIC then r<>turns to the WHILE statement 
and checks <expression>. This procPss continues until the <expression> is not true and 
execution resumes with th<' statement following the WEND statement. 

WHILE ... WEND loops may bt> nestPd to any levt>l. hut each WEND will match the 
most recent WHILE. An unmatched WHILE statement will cause a "WHILE without 
WEND" error to occur. and an unmatched WEND statement causes a "WEND 
without WHILE" error. 

WIDTH A Microsoft BASIC statement which sets the output line width in number of 
characters. When the indicated number of characters has been output, Microsoft 
BASIC adds a carriage return. The formats are: 

WIDTH <size> 
WIDTH <filenum,size> 
WIDTH <device,size> 

<size> is a numeric expression in the range 0 to 2.SS. This will lw the new width. 
WIDTH 0 is the same thing as WIDTH 1. 

<filenum> This is a numeric expression. This is the number of a file opened to one of 
the devices listed below. 

<device> is a string expression identifying devices. Valid entries are SCRN :, CLIP:. 
LPT1 :, COM1 :. 



302 • Winchester Disk 

The following actions are possible, depending on the device specitied: 

WIDTH <size> or WIDTH "SCRN:",<size> 
WIDTH <device>, <size> 

This format using the device nam£> is used as a deferred width assignment for the 
device which stores the new width valuP without actually changing the current 
width setting. A subsequent OPEN to the device will use this value for width while 
the file is open. The width does not changP .immediately if the device is already 
open. The following program prints at 80 column width from lines 20 and 30. The 
WIDTH 40 statement at line 30 does not affect the following print at line 40, it is 
"deferred" until the OPEN at line 60. The WIDTH 40 then takes effect and causes the 
PRINT at line 70 to print in 40 column width, providing two lines, 40 columns wide. 
The output is two lines 80 characters long followed by two lines 40 characters long. 

The final WIDTH 80 and OPEN are to leave your lmageWriter in 80 column mode 
for subsequent operations. 

10 OPEN "LPT1 :"FOR OUTPUT AS #1 
20 PRINT #1 ,"12345678901234567890123456789012345678901234567890 

123456789012345678901234567890 
30 WIDTH "LPT1 :",40 
40 PRINT #1,"1234567890123456789012345678901234567890 

123456789012345678901234~678901234567890 

50 CLOSE 
60 OPEN "LPT1 :"FOR OUTPUT AS #1 
70 PRINT # 1, "1234567890123456789012345678901234567890 

1234567890123456789012345678901234567890 
80 WIDTH "LPT1 :", 80 
90 CLOSE 
100 OPEN "LPT1 :"FOR OUTPUT AS #1 
110 END 

It should be noted that LPRINT, LLIST and LIST,"LPTn:" do an implicit OPEN and 
are therefore affected by the WIDTH <device>,<size> this statement. 

WIDTH <filenum>,<size> 

This format changes the width of the device associated with <filenum> to the new 
size specified, allowing the width to be changed at will while the file is open. 

Any invalid entry in the parameters will cause an "Illegal function call" error to 
occur. WIDTH has no effect for the keyboard (KYBD:). 

Winchester Disk A hard disk system characterized by very light read/write heads, 
low head-to-disk clearance and complete enclosure of the magnetic media in a 
dust-free environment to achieve high-information density and fast access-time. In 
the world of microcomputers, hard disk and Winchester disk are the same. 

Window A section of a CRT screen dedicated to displaying specific types of 
information. Windows are used by the Macintosh's User Interface Toolbox to 
accomplish many tasks. The Desktop directory is displayed in a window. Alert boxes 
and dialog boxes are windows. When the Clipboard and scrapbook are opened, they 
are displayed as windows. The header and footer displays in MacWrite are displayed 
in windows. Microsoft BASIC uses a Command window, a List window and an 
Output window to display each of these activities. Most windows may be closed by 
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clicking the close box in the upper left-hand corner. Many windows use scroll bars to 
scroll the document or file through the visible portion of the window. Most have a 
size box in the lower right-hand corner. All windows except alert boxes and dialog 
boxes have a title bar across the top. Windows are used in MacBASIC and MacPascal 
to run two or more programs at the same time. 

Window Manager A collection of programs and routines in the User Interface 
Toolbox in the Macintosh ROM. It consists of about 43 subroutines used to create. 
display and manipulate windows. The routines it carries out include dragging 
windows from one place to another on the screen, scrolling the contents of a 
window, sizing a window, opening and closing windows and keeping track of active 
and inactive windows. The Window Manager uses Quickdraw to display windows 
and the contents of windows. 

Wizardry* One of the most entertaining and .popular adventure games for the 
predecessors of Macintosh. It has been rewritten for the Macintosh. This game 
combines 3-D mazes with text and illustrations to involve the player in a high-level 
fantasy role-playing game. The player builds a party of six characters with distinct 
skills and powers to challenge the multilevel maze. He outfits the characters at an 
armorer's shop and gathers his party together at an inn before entering the maze. 
Once he enters the maze with his party, they encounter a large variety of men and 
monsters. If characters are not killed, they gain skill and wealth by overcoming their 
opponents. SirTech. 

WOM Write-Only Memory. Used as a semi humorous term for parts of the address 
space of a computer not actually populated with memory devices, or which must be 
disabled for some reason. 

Word A logical unit of information. It may have any number of bits, but for MPUs. 
usually 4, 8, 16, or 32 bits. For the Macintosh, a word is two bytes or sixteen bits. The 
Macintosh's microprocessor can also handle 32-bit words that are called "long 
words." 

Word Processing on Your Macintosh* By Rudolph Langer. A complete treatment 
of word processing with the Macintosh. The book is written for inexperienced users. 
Sybex. 

Word Processor A computer-based system for writing, editing and formatting doc
uments such as letters. reports and books. It may be either a specialized hardware 
system dedicated to these tasks or a program package run on a general purpose 
computer. See MacWrite. Microsoft Word. 

Word Processors See DocuPian, Jack 2, Lotus Macintosh Product, MacWrite. 
MegaMerge, Microsoft Word, PFS Write, ThinkTank 128. 

Words, Reserved Microsoft BASIC reserved words have particular meanings and are 
used for commands, statements, function and operator names. These words cannot 
be used as variable names and variable names cannot be a reserved word followed 
hy a type declaration character($, %, !, #). 

The reserved words are to be delimited (separated with space or spaces around 
them) so that they are easily recognized by Microsoft BASIC. If you accidentally use 
one of the reserved words, you may see an error message or have strange results 
when you execute the program. See Debugging; BASIC, Reserved Words for the 
complete list. 
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Word Wrap A common characteristic of word processors which allows the user to 
continue typing beyond the end of a line without entering a Return character. When 
the end of the line is reached, the whole word that extends beyond the right margin 
is automatically moved down to the next line of text. 

Worksheet Worksheet is a term that is used to describe working spreadsheets that 
are created by users of electronic spreadsheet programs. Worksheets contain labels, 
formulas, and data entered by the user to solve particular problems. Worksheets 
may be blank master forms that contain labels and formulas but do not yet contain 
data. They may also be completed forms that have archival significance. Some 
worksheets that contain complex investment analysis procedures or similar applications 
are written by commercial software companies for the convenience of spreadsheet 
users. 

Workspace An area of memory allocated for working storage. 

Wristwatch A symbol employed to warn the user to wait for the current process to 
end before continuing. For example, it is displayed during the time it takes a 
program to load from disk into the computer's memory or the time it takes to save a 
program to disk. 

WRITE A Microsoft BASIC statement which is used to output data to the screen. The 
format is: 

WRITE [<list of expressions>! 

dist of expressions> is a list of numeric and/or string expressions. separated by 
commas or semicolons. 

If <list of expressions> is left out. a blank line is output. When included, the values 
of the expressions are output on the screen. 

Wilen the values of the expressions are output, each item is separated from the 
last by a comma. Strings are delimited by quotation marks. After the last item in the 
list is printed, Microsoft BASIC adds a carriage return/line feed. 

WRITE is similar to PRINT except that WRITE inserts commas between the items 
as they are displayed and delimits strings with quotation marks. Also, positive 
numbers are not preceded by blanks. 

WRITE # A Microsoft BASIC statement which writes data to a sequential file. The 
format is: 

WRITE #<filenum>,dist of expressions> 

<filenum> is the number under which the file was opened for output. 
dist of expressions> is a list of string and/or numeric expressions, separated by 

commas or semicolons. 
The difference between WRITE # and PRINT # is that WRITE # inserts commas 

between the items as they are written and delimits strings with quotation marks. It is 
therefore necessary for the user to put explicit delimiters in the list. WRITE # also 
does not put a blank in front of a positive number. A carriage return/line feed 
sequence is inserted after the last item in the list is written. 

Write Data to File See PUT. 

Write-protect Describes the act of preventing information from being written onto 
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a storage medium. Microfloppy disk jackets often have lock tabs which can be 
opened to write-protect the disk by disabling the disk drive's write circuitry. 

Write-protected Disk A disk is write-protected if its lock tab is open. This frees a 
small spring-loaded switch or a light beam inside the disk sensed by Macintosh's disk 
driver programs. You will get an error message (Locked Disk) anytime you attempt to 
alter a file on a write-protected disk by changing it, deleting it, copying a file onto 
the write protected disk or formatting the disk. 

You are allowed to use files, load them or copy from the write-protected disk. The 
purpose of these limitations is to prevent accidental loss of the only copy of 
programs or data. In most cases the procedure is to copy the write-protected disk 
onto an unlocked disk, put away the write-protected disk as a permanent copy, then 
modify the unlocked disk. In some cases you will close the locking tab of a locked 
disk (after thinking it over) and proceed to change the disk. 

It is a good practice to lock any important disk you will backup. Then if you 
accidentally ask for the backup in the wrong direction (from the old disk to your 
important disk), you will get a second chance to make the backup rather than losing 
your data. 



X 
X ASCII 88, HEX 58. x ASCII 120, HEX 78. 

XENIX The Microsoft implementation of the UNIX Operating System for 
microcomputers. 

Xyphus• A combined fantasy role-playing adventure game that places the player on 
the Lost Continent of Arroya. The player must seek out Xyphus, the Lord of Demons. 
Xyphus and his minions must be conquered through the use of spells and weapons. 
The game is made more interesting by six different scenarios, each more difficult 
than the last. Penguin Software. 

X·Y Plotter A device which draws points or lines on a sheet of paper based on X andY 
coordinates from a computer. 



z 
Z ASCII 90, HEX SA. z ASCII122. HEX 7A. 

Zero Byte A byte with all bits set to zero. The zero byte is used to mark the end of 
variable length strings of data. 

Zones On the Printer Line Each group of spaces across the print line as defined by 
the WIDTH command is called a "print zone." A comma(,) in an LPRINT list of items 
to be printed means "start printing the following item at the start of the next print 
zone." Contrast this with the semicolon(;). which means the next item is to print 
immediately after this one, without even a single space between. See also Print Line 
(Spacing). 

Zork 1: The Great Underground Empire• This fantasy adventure is the first chapter 
in the Zork trilogy. The players journey through the caverns and mazes of the 
Underground Empire, and encounter perils ranging from the mystical to the macabre. 
lnfocom, Inc. 

Zork II: The Wizard of Frobozz• More wonders and dangers unfold before the 
adventurers when Zork II steers them into new depths of th~ subterran~an realm. 
Surrounded by dragons and demons, players meet the Wizard. exiled from the Great 
Underground Empire ages ago. lnfocom. Inc. 

Zork Ill: The Dungeon Master• Zork Ill is the final t~st of courage and wisdom. 
Players meet new dimensions of clever opponents and harrowing predicaments 
while wandering from the shores of an underground ocean to the Royal Museum 
where players finally encounter the Master of thP Dungeon himself. lnfocom. Inc. 



SPECIAL 
SYMBOLS 

1-2-3 See Lotus Macintosh Product. 

68000 Assembly Language Programming• By Gerry Kane, Doug Hawkins and 
Lance Leventhal. A complete guide to writing assembly language programs for the 
MC68000 chip. It guides the assembly language prgrammer through the intricacies 
of dealing with this chip. Each mnemonic is explained completely and clearly. 
Osborne/McGraw Hill. 

68000 Microprocessor Handbook• By Gerry Kane. This book deals with 68000 
signal conventions, timing diagrams, logic and all of the other intricacies of the 
powerful microprocessor that is the heart of the Macintosh. Osborne/McGraw-Hill. 

! See BASIC, Rules for Variable Names. 

" In Microsoft BASIC a special character indicating the double quotation mark or 
string delimiter which cannot be used for any other purpose. 

# See BASIC, Rules for Variable Names. 

$ See BASIC, Rules for Variable Names. 

% See BASIC, Rules for Variable Names. 

& In Microsoft BASIC, the ampersand is a special character, indicating an octal 
number, or H indicating Hex numbers. It cannot be used for any other purpose. 

! A synonym for REM in Microsoft BASIC. See REM. 

' In Microsoft BASIC, a special character indicating the single quotation mark, 
apostrophe or remark delimiter which cannot be used for any other purpose. 

( In Microsoft BASIC, a special character indicating the left parenthesis which 
cannot used for any other purpose. 

) In Microsoft BASIC, a special character indicating the right parenthesis which 
cannot be used for any other purpose. 

• In Microsoft BASIC, a special character indicating the times sign (multiplication) 
which cannot be used for any other purpose. 
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+ In Microsoft BASIC. a special character indicating the plus sign (addition) which 
cannot be used for any other purpose. 

, In Microsoft BASIC. a special character indicating the comma delimiter, which 
cannot be used for any other purpose. 

On the printer, each group of spaces across the print line as defined by the WIDTH 
command is called a "print zone." A comma (,) in an LPRINT list of items to be 
printed means "start printing the following item at the start of the next print zone." 
Contrast this with the semicolon(;), which means the next item is to print immediatly 
after this one, without even a single space between. 

- In Microsoft BASIC. a special character indicating the minus sign (subtraction) 
which cannot be used for any other purpose. 

• In Microsoft BASIC. a special character indicating the period or decimal point 
which cannot be used for any other purpose. 

In a file name, the period(.) and colon(:) are specified to delimit extension and 
drive name, respectively . 

. BAS (.BAS) The suggested file extension for a Microsoft BASIC source program . 

. TXT (.TXT) The suggested file extension for a text or documentation file. 

I In Microsoft BASIC, a special character indicating the division symbol or slash 
which cannot be used for any other purpose. 

: In Microsoft BASIC, a special character indicating the colon or statement separator 
which cannot be used for any other purpose. 

In a file name, the colon(:) and period(.) are specified to delimit drive name and 
extension, respectively. 

Also used for multiple Microsoft BASIC statements on a line. You can put a colon 
(:)at the end of one statement and continue entering another statement on the same 
line, without giving a new line number. The line number at left refers to all 
statements on the line. An apostrophe(') allows a comment or remark to be added 
after a statement with or without a separating colon. 

; In Microsoft BASIC, a special character indicating the semicolon symbol which 
cannot be used for any other purpose. 

On the printer each group of spaces across the print line as defined by the WIDTH 
command is called a "print zone." A comma {,) in an LPRINT list of items to be 
printed means "start printing the following item at the start of the next print zone." 
Contrast this with the semicolon (;),which means the next item is to print immediately 
after this one, without even a single space between. 

c In Microsoft BASIC, a special character indicating the less than symbol which 
cannot be used for any other purpose. 

= In Microsoft BASIC, a special character indicating the equal sign or an assignment 
symbol which cannot be used for any other purpose. 

> In Microsoft BASIC, a special character indicating the greater than symbol which 
cannot be used for any other purpose. 

l In Microsoft BASIC, a special character indicating the question mark or PRINT 
abbreviation which cannot be used for any other purpose. 
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\ In Microsoft BASIC, a special character indicating the integer division symbol or 
backslash which cannot be used for any other purpose. 

" In Microsoft BASIC, a special character indicating the exponentiation symbol or 
caret which cannot be used for any other purpose. 

_ In Microsoft BASIC, a special character indicating the underline symbol which 
cannot be used for any other purpose. 
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Vendors of Products Described in the 
Apple Macintosh Encyclopedia 

Categorized listings of products will be found alphabetically in the main text. 
The highest level categories are Software, Hardware, Publications, and Accessories. 
These will in turn point you to more detailed categories such as Modems, Database 
Programs, or to specific product descriptions. Product descriptions are distinguished 
from informational entries in the main text by an asterisk(*) following the product 
name. The name of the vendor is the last item in each product description. 
Magazine descriptions and addresses are listed only in the article under Magazines. 
New products for the Macintosh are appearing regularly. The magazines and 
computer fairs are excellent sources for up-to-the-instant news on new products 
and programs for the Macintosh. 

Aardvark-McGraw-Hill 
1020 North Broadway 
Milwaukee, WI 53202 
414-225-7500 
Products: 

Personal Tax Planner (Personal Management) 
Programming the MC68000 (Book) 

Alpha Delta Communications, Inc. 
P.O. Box 571 
Centerville, OH 45459 
513-435-4772 
Products: 

MACC and MACC-4 (Power Supply) 

American Training International 
3770 Highland Ave. 
Ste. 201 
Manhattan Beach, CA 90266 
213-823-1129 
Products: 

How to Use Your Macintosh (Education) 

Anchor Automation 
6913 Valjean Avenue 
Van Nuys, CA 94106 
818-997-6493 
Products: 

Volksmodem (Modem) 

Anchor Pad International, Inc. 
3224 Thatcher Avenue 
Marina Del Rey, CA 90292 
213-306-3881 
Products: 

Anchor Pad (Security Kit) 
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Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, CA 95014 
800-662-9238 

Apple Computer {UK) Ltd. 
Eastman Way 
Hemel Hempstead 
Hertfordshire, HP2 7HQ 
0442 60244 
Products: 

Apple Modem 300 (Modem) 
Apple Modem 1200 {Modem) 
AppleBus {Interface) 
Appleli ne {Interface) 
I mage Writer (Printer) 
Lisa (Computer) 
MacBASIC (Programming Language) 
MacDraw (Graphics) 
Macintosh Assembler/Debugger (Programming Language) 
Macintosh Logo (Programming Language) 
Macintosh Pascal {Programming Language) 
MacPaint (Graphics) 
MacProject (Business Software) 
MacTerminal (Communications) 
MacWorks (Utility) 
MacWrite {Word Processing) 
Security Accessory Kit (Security Kit) 

Applied Creative Technology 
2156 Northeast Highway 
Building C-303 
Dallas, TX 75220 
214-556-2916 
Products: 

Printer Optimizer {Printer Buffer) 

Artsci, Inc. 
5547 Satsuma Avenue 
North Hollywood, CA 91601 
818-985-2922 
Products: 

MAGICphone (Accessory) 

Ashton-Tate 
10150 W. Jefferson Blvd. 
Culver City, CA 90230 
213-204-5570 

A TS Cases, Inc. 
25 Washington Ave. 
Natick, MA 10760 
617-653-6724 
Products: 

Carrying Case (Carrying Case) 



Banbury Books 
353 West Lancaster Ave. 
Wayne, PA 19087 
Products: 

Macintosh: The Appliance of the Future (Book) 

Basic Business Software, Inc. 
P.O.Box 26311 
Las Vegas, NV 89126 
Products: 

Utilities for the Macintosh Computer (Utility Program) 

Blackwells Scientific Publications Ltd. 
Osney Mead 
Oxford, OX1 4H B 
722146 

Products: 
dBase Ill (Database) 
Friday (Database) 

Blue Chip Software 
6744 Eton Avenue 
Canoga Park, CA 91303 
213-246-0720 
Products: 

Millionnaire (Game) 

Blythe Computers 
Wenhaston 
Hadesworth 
Suffolk, IP19 9DM 
050 270 371 

Brady Communications, Inc. 
Routes 197 and 450 
Bowie, MD 20715 
301-262-6300 
Products: 

Inside the Macintosh (Book) 
Macintosh Assembly Language (Book) 
Macintosh Programmer's Handbook (Book) 

Braun-Cooper 
207 Gough Street # 38 
San Francisco, CA 94102 
415-621-4909 
Products: 

Totem Pack (Carrying Case) 

Brock Software Products, Inc. 
P.O. Box 799 
Crystal Lake, IL 60014 
815-459-4210 
Products: 

Keystroke Data Base (Database) 
Keystroke Report Base (Database) 
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Business Solutions, Inc. 
60 East Main St. 
Kings Park, NY 11754 
516-269-1120 
Products: 

Jack 2 (Integrated Software System) 

CBS Computer Books 
383 Madison Avenue 
New York, NY 1 0017 
212-872-2619 
Products: 

MAC Book: Using Your Macintosh Computer. The (Book) 
Macintosh Computer Graphics (Book) 

CBS Software 
One Fawcett Pl. 
Greenwich, CT 063836 
203-622-2615 
Products: 

Murder by the Dozen (Game) 

Chang Labs 
5300 Stevens Creek Boulevard 
San Jose, CA 95129 
800-972-8800 
800-831-8080( CA) 
Products: 

DocuPian (Word Processing) 
FilePian (Database) 
GraphPian (Graphics) 
Link Module (Utility Program) 

Chapman & Hall 
733 Third Avenue 
New York, NY 10017 
212-922-3550 

11 New Fetter Lane 
London, EC4P 4EE 
01-583 9855 
Products: 

Apple Macintosh Encyclopedia (Book) 

Computer Bookshops Ltd. 
30 Lincoln Road 
Olton 
Birmingham 
021-707 7544 
Products: 

Complete Guide to Your Macintosh, The (Book) 
Doing Business with Your Macintosh (Book) 
Easy Guide to Your Macintosh, The (Book) 
Macintosh for College Students (Book) 
Programming the MC68000 (Book) 
Word Processing on Your Macintosh (Book) 



Computer Cover Co. 
P.O.Box 3080 
Laguna Hills, CA 92654 
714-380-0085 
Products: 

Macintosh Covers (Cover) 

Continental Software 
11223 Hindry Ave. 
Los Angeles, CA 90045 
213-410-3977 
Products: 

Home Accountant (Financial Management) 

Creative Solutions 
4801 Randolph Road 
Rockville, MD 20852 
31 0-984-0262 
Products: 

Macforth (Programming Language) 

Cuesta Systems 
3440 Roberto Ct 
San Luis Obispo, CA 93401 
805-541-4160 
Products: 

Datasaver (Power Supply) 

Davong Systems 
217 Humboldt Court 
Sunnyvale, CA 94086 
408-734-4900 
Products: 

Mac Disk (Hard Disk) 

Desktop Software Corporation 
238 Alexander St. 
Princeton, NJ 08540 
609-924-7111 
Products: 

NPL Information Management System (Database) 

DIG I-GRAPHICS 
P.O.Box 273 
Logan, UT 84321 
Products: 

Picture Disk (Graphics) 
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dilithium Press 
8285 Southwest Nimbus 
Ste 151 
Beaverton, OR 97005 
800-547-1842 
503-646-2713 
Products: 

Presenting the Macintosh Computer (Book) 
Teleofacts 2 (Database) 

Discrete Time Systems, Inc. 
6649 E Roswell Rd. 
Ste 240 
Atlanta, GA 30328 
Products: 

Video-Digitizer (Digitizer) 

Dow Jones Software 
P.O. Hox 300 
Princeton. NJ 08540 
609-452-2000 
Products: 

Dow Jones Market Manager (Business Software) 
Dow Jones Spreadsheet link (Business Software) 

Dreams of the Phoenix, Inc. 
P.O. Box 10273 
Jacksonville, FL 32247 
904-396-6953 
Products: 

Cut 'N' Paste (Graphics) 

Electronic Specialists. Inc. 
171 S. Main St. 
Natick, MA 01760 
800-225-4876 
617-655-1532 
Products: 

Kleen Line Conditioner (Power Supply) 

FactF inder Software 
P.O. Box 206 
DeN Harhor, WA 98243 
206-376-4912 
Products: 

FactF inder (Database) 

Frazier. Peper & Associates 
P.O.Box 3019 
Santa Cruz, CA 95063 
408-476-2358 
Products: 

Clip 1 (Graphics) 



R.J.Gear 
8760-A Research Blvd. #136 
Austin. TX 78758 
512-345-0642 
Products: 

Mac Sac (Carrying Case) 

Haba Systems 
15154 Stagg Street 
Van Nuys, CA 91405 
818-901-8828 
Products: 

Habadex (Business Software) 

Harris Technical Systems 
624 Peach Street 
P.O. Box 80837 
Lincoln, NE 68501 
402-476-2811 
Products: 

AgDisk (Agriculture) 

Harvard Associates 
260 Beacon Street 
Somerville, MA 02143 
617-492-2999 
Products: 

MacManager (Business Software) 

Hayden Book Company 
10 Mulholland Drive 
Hasbrouck Heights, NJ 07604 
201-393-6000 
Products: 

MacBASIC Programmer's Reference Manual (Book) 
MacBASIC: Programming Power (Book) 
Mac Multiplan (Book) 
MacPascal (Book) 
Mac Revealed: Programming with the Mac Toolbox (Book) 

Hayden Software 
600 Suffolk Street 
Lowell, MA 01853 
800-343-1218 

Hippopotamus Software 
1250 Oakmead Parkway 
Ste. 210 
Sunnyvale, CA 94086 
408-730-2601 
Products: 

C for the Macintosh (Programming Language) 
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Human Edge Software Corporation 
2445 Faber Place 
Palo Alto, CA 94303 
800-624-5227 
800-824-7325 (CA) 
Products: 

The Management Edge (Business Software) 
The Negotiation Edge (Business Software) 
The Sales Edge (Business Software) 

Industrial Computations 
40 Washington St. 
Wellesley, MA 02181 
617-235-5080 
Products: 

MacPuzzle (Graphics/Game) 

lnfocom, Inc. 
55 Wheeler St. 
Cambridge, MA 02138 
617-492-1031 
Products: 

Deadline (Game) 
Enchanter (Game) 
Infidel (Game) 
Planetfall (Game) 
Seastalker (Game) 
Sorcerer (Game) 
Starcross (Game) 
Suspended (Game) 
Zork I (Game) 
Zork II (Game) 
Zork Ill (Game) 

Integrated Systems 
P.O. Box 2618 
Ann Arbor, Ml 48106 
Products: 

MacAnimation (Graphics) 
MacMath (Education) 
MacSpell (Education) 

International Datawares 
910 George Street 
Santa Clara, CA 95050 
408-988-5594 
Products: 

Microdisk Minder (Accessory) 

Justin Case 
334 Main St. 
Port Washington, NY 11050 
416-883-2299 
Products: 

Basket Case (Carrying Case) 



Kensington Microware Ltd. 
251 Park Avenue South 
New York, NY 10010 
212-475-5200 
Products: 

Portable Modem, Maccessories (Modem) 
Maccessories Swivel (Accessory) 
Maccessories Surge Protector (Power Supply) 
Maccessories Starter Pack (Accessory) 
Maccessories Printer Stand (Accessory) 
Maccessories Printer Buffer (Printer Buffer) 
Maccessories Cleaner Kit (Accessory) 
Maccessories Disk Case (Carrying Case) 

Kearsarge Industries 
12310 Pinecrest Rd. 
Reston, VA 22091 
703-620-5760 
Products: 

Kearsarge SX-70 Switcher/Spooler (Printer Buffer) 

Living Videotext Inc. 
1000 Elwell CT 
Palo Alto, CA 94303 
41 5-964-6300 
Products: 

ThinkTank 128 (Word Processing) 

Lotus Development Corporation 
161 First Street 
Cambridge, MA 02142 
617-412-7171 
Products: 

Lotus Macintosh Product (Integrated Software System) 

McGraw-Hill Book Co. 
1221 Avenue of the Americas 
New York, NY 10020 

McGraw-Hill Book Co. (UK) Ltd. 
McGraw-Hill House 
Shoppenhangers Road 
Maidenhead 
Berkshire, SL6 2QL 
0628 23432 

Macinsoft 
P.O.Box 27853 
San Diego, CA 92127 
Products: 

Paintmover (Graphics) 
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Mac Packs 
P.O. Box 3928 
Kent, WA 98032 
Products: 

MacBag (Carrying Case) 
MacCover (Cover) 
MacFreighter (Carrying Case) 
MacPak (Carrying Casp\ 
MacSak (Carrying Cast·) 

Macro Micro Software 
19909 N E I 45th St. 
Woodinville, WA 98072 
Products: 

Shapes 'N' Shots (Graphics) 

Magnum Software 
27115 Devonshire St. 
Chatsworth, CA 91311 
818-700-0510 
Products: 

McPic (Graphics) 

Main Street Software 
700 Larkspur Landing 
Larkspur, CA 94939 
800-824-8757 
415-332-1274 
Products: 

Main Street Filer (Database) 

Mark of the Unicorn 
222 Third Street 
Cambridge, MA 02142 
617-576-2769 
Products: 

Professional Composer (Music) 

Matrix Advocates Company 
P.O. Box 1238 
Brick, NJ 08723 
201-899-4739 
Products: 

Images (Graphics) 

Megahaus Corporation 
5703 Oberlin Dr. 
San Diego, CA 92121 
619-450-1230 
Products: 

MegaFinder (Database) 
MegaMerge (Word Processing) 



Micro-Design 
6301 B Manchaca Rd. 
Austin, TX 787 45 
800-531-5002 
512-441-7890 
Products: 

PRO 10 (Hard Disk) 
PRO 20 (Hard Disk) 
SQ 5 (Hard Disk) 

Micrographic Images Corporation 
19612 Kingsbury St. 
Chatsworth, CA 91311 
Products: 

CineMAC (Monitor Adaptor) 

Microrim, Inc. 
1750 112th NE 
Bellevue, WA 98004 
206-452-6017 
Products: 

Era 2 (Communications) 
R:base 2000 (Database) 

Microsoft Corporation 
10700 Northrup Way 
Bellevue, WA 98004 
206-828-8080 
Products: 

Microsoft BASIC (Programming Language) 
Microsoft Chart (Graphics) 
Microsoft File (Database) 
Microsoft Multiplan (Spreadsheet) 
Microsoft Word (Word Processing) 

Microsoft Press 
10700 Northrup Way 
Bellevue, WA 98004 
Products: 

Apple Macintosh Book. The (Book) 
Presentation Graphics on the Apple Macintmh (Book) 

Miles Computing, Inc. 
7136 Haskell Avenue 
Ste. 300 
Van Nuys, CA 91406 
818-994-7901 

Mac the Knife (Graphics) 

Monogram 
8295 South La Cienega Blvd. 
Inglewood, CA 90301 
213-215-0529 
Products: 

Dollars & Sense (Personal Management) 
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Odesta 
3186 Doolittle Drive 
Northbrook, IL 60062 
800-323-5423 
312-498-5615 (IL) 
Products: 

Helix (Database) 

Optimum Computer Luggage 
4445 Fiftieth Street 
San Diego, CA 92115 
800-632-4200 (CA) 
619-287-2886 
Products: 

MacTote (Carrying Case) 

Organizational Software Corporation 
2655 Campus Drive 
Ste. 150 
San Mateo, CA 94403 
415-571-0222 
Products: 

Omnis 1 (Database) 
Omnis 2 (Database) 
Omnis 3 (Database) 

Osborne/McGraw-Hill 
2600 Tenth Street 
Berkeley, CA 94710 
415-548-2805 
Products 

MacTelecommunications (Book) 
Microsoft Word Made Easy- Macintosh Edition (Book) 
Multiplan Made Easy- Macintosh Edition (Book) 
Using MacWrite and MacPaint (Book) 
68000 Assembly Language Programming (Book) 
68000 Microprocessor Handbook (Book) 

P+ P Micro Distributors 
1 Gleneagle Road 
Streatham 
London 
01-677 7631 

Peat Marwick Mitchell & Co. 
345 Park Ave. 
New York, NY 10154 
212-758-9700 
Products: 

SEACAS (Business Software) 



Penguin Software 
Box 311 
Geneva, I L 60134 
312-232-1984 
Products: 

Graphics Magician, The (Graphics) 
Pensate (Came) 
The Coveted Mirror (Game) 
The Quest (Game) 
Transylvania (Came) 
Xyphus (Came) 

Plume Computer 
New American Library 
1633 Broadway 
New York, NY 10019 
212-397-8132 
Products: 

MacCraphics (Book) 
MacCuide (Book) 

Practical Peripherals 
31245 La Baya Dr. 
Westlake Village, CA 91362 
213-991-8200 
Products: 

MBIS Microbuffer (Printer Buffer) 

Prentice-Hall 
Englewood Cliffs, NJ 07632 
210-592-2000 
Products: 
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Using Your Apple Macintosh: Beginning Basic and Applications(Book) 

Prentice-Hall International 
66 Wood Lane 
Hemel Hempstead 
Hertfordshire 
0442 58531 
Products: 

Macintosh Connection, The (Book) 
Macintosh Data Files (Book) 
Understanding the Macintosh Computer (Book) 

Professional Data Systems 
6416 Friars Rd. 
Suite117 
San Diego. CA 92108 
619-291-2300 
Products: 

Mach 1 Projection System (Monitor Adaptor) 
Mach 2 Projection System (Monitor Adaptor) 
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Prometheus Products, Inc. 
45277 Fremont Blvd. 
Fremont, CA 94538 
415-490-2370 
Products: 

Promodem 1200 (Modem) 

Pterodactyl Software 
200 Bolinas Road, #27 
P.O. Box 538 
Fairfax, CA 94930 
415-485-0714 
Products: 

PC BASIC Developers Compiler (Programming Language) 

Quality Software 
21601 Marilla Street 
Chatsworth, CA 91311 
818-709-1721 

Random House 
201 East Fiftieth Street 
New York, NY 10022 
212-751-2600 

Rapid Recall Ltd. 
Rapid House 
Denmark Street 
High Wycombe, England 
HP11 2ER 
0494 45011 

rds labs 
P.O.Box 1218 
Cookeville, TN 38503 
Products: 

Basic Disk (Game) 
Template Disk No. 1 for Multiplan (Business Software) 

Reston Publishing Company 
11480 Sunset Hills Road 
Reston, VA 22090 
703-437-8900 

Rio Grande Software 
P.O. Box 77 
West Liberty, lA 52776 
319-627-2272 
Products: 

RGS Softmaker II (Database) 



Howard W. Sams & Company 
4300 West Sixty-Second Street 
Indianapolis, IN 46268 
317-298-5419 
Products: 

Introducing .the Apple Macintosh (Book) 

Scarborough Systems 
25 N. Broadway 
Tarrytown, NY 10591 
914-332-4545 
Products: 

Run for the Money (Education/Game) 

Sentient Software 
Box 4929 
Aspen, CO 81612 
303-925-9293 
Products: 

Cyborg (Game) 

Simon and Schuster Electronic Publishing 
Simon and Schuster Bldg. 
1230 Avenue of the Americas 
New York, NY 10020 
BOQ-442-7070 (NY) 
BOQ-223-2336 
Products: 

Typing Tutor Ill (Education) 

Sir Tech Software Inc. 
6 Main St. 
Ogdensburg, NY 13669 
315-393-6633 
Products: 

Wizardry (Game) 

Softsel 
Softsel House 
Central Way 
N. Feltham Trading Estate 
Feltham 
Middlesex, TW14 OXQ 
01-844 2040 

Softalk Books 
7250 Laurel Canyon Blvd. 
North Hollywood, CA 91605 
818-980-507 4 
Products: 

Macintosh! Complete (Book) 
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Soft-Life Corporation 
2950 Los Feliz Blvd. 
Suite 103 
Los Angeles, CA 90039 
213-660-7940 
Products: 

Mac-Slots (Games) 

Software Publishing Company 
1901 Landings Dr. 
Mountain View, CA 94043 
415-962-891 0 

PFS File (Database) 
PFS Graph (Graphics) 
PFS Report (Database) 
PFS Write (Word Processing) 

Southeastern Software 
7743 Briarwood Dr. 
New Orleans, LA 70128 
504-246-8438 
Products: 

Mac.Transfer (Utility Program) 

Sybex 
2344 Sixth Street 
Berkeley, CA 94710 
415-848-8233 

TAB Books Inc. 
P.O. Box 40 
Blue Ridge Summit, PA 17214 
717-794-2191 

Fulsham ltd. 
Yeovil Road 
Slough 
Buckinghamshire 
0753 26769 
Products: 

Mac Graphics (Book) 
Macintosh Expansion Guide, The (Book) 
Using & Programming the Macintosh (Book) 

Tecmar, Inc. 
6225 Cochran Road 
Solon, OH 44139-3377 
216-349-0600 
Products: 

Candy Apple IEEE-488 (Interface) 
Mac Drive (Hard Disk) 



The CaseMaker 
1757-B Junction Avenue 
San Jose, CA 95112 
800-428-7824 Ext. 113 (CA) 
800-428-7825 Ext. 113 
Products: 

The Scottie Mac Case (Carrying Case) 

Thermodyne I nternationa I 
20850 S. Alameda St. 
Long Beach, CA 90810 
213-603-1976 
Products: 

Shok Stop (Carrying Case) 

Think Educational Software 
16 Market St. 
Potsdam, NY 13676 
315-265-5636 
Products: 

MacEdge (Education) 
Mind Over Mac (Games) 

Think Technologies 
420 Bedford Street 
Lexington, MA 02173 
617-863-5590 
Products: 

Mac Pascal (Programming Language) 

T /Maker Graphics 
2115 Landings Drive 
Mountain View, CA 94043 
415-962-0195 
Products: 

ClipArt (Graphics) 

TNT Software, Inc. 
34069 Hainesville Rd. 
Round Lake, I L 60073 
312-223-8595 
Products: 

Creator, The (Database) 

Trade* Plus 
460 California Avenue 
Palo Alto, CA 94306 
800-952-9900 
800-972-9900 (CA) 
415-324-4554 
Products: 

Trade*Pius (Business Software) 
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Volition Systems 
P.O. Box 1236 
Del Mar, CA 92014 
619-481-2286 
Products: 

Modula-2 (Programming Language) 

John Wiley & Sons Ltd. 
605 Third Avenue 
New York, NY 10158 

Baffins Lane 
Chichester 
Sussex, P019 1 UD 
0243 784531 
Products: 

DaVinci (Graphics) 
The Calandar (Personna! Management 
Sargon Ill (Game) 
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European APPLE 
Marketing Managers 

England 

Mr. Bob Kissach 
Apple Computer Ltd. 
Eastman Way 
Hemel Hempstead 
Herts H P2 7HQ 
Tel: 0442 60244 

France 

Monsieur Francois Benveniste 
Apple (Seedrin) SARL 
Avenue de I'Oceanie 
Zl de Courtaboeuf 
BP 131 
91944 Les Ulis 
Tel: 33-6-9287 432 

Germany 

Herr Peter Batz 
Apple Computer GmbH 
I ngolstaderstrasse 20 
8000 Munich 
Tel: 49-89-3591010 

Holland 

Mr. Roger Cutler 
Apple Computer BV 
Postbus 7 
3712 ZG Huis ter Heide 
The Netherlands 
Tel: 31-3404-8691 

Italy 

Sig. Franco del Vecchio 
Apple Computer SpA 
Palazzo Q8 - Milanofiori 
20089 Razzano 
Tel: 39-2-8241153 

Sweden 

Mr. Magnus Lind 
Apple Computer AB 
lndustrivagen 7 
S-171 48 Solna 
Tel: 46-8-835020 




